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Functions Newly Supported in Version 6.00

The functions newly supported in the MVS-8000 system version 6.00 are as
follows.

Functions relating to switcher processor

a) The MVS-8000A system only. The MVS-8000 system uses the same menus as those of Version 
5.30. For its operating procedures, see the user’s guide of Version 5.30 or earlier.

b) The MVS-8000A system only. Not supported on the MVS-8000.

Functions relating to setup

Classification Functions supported Menu No. See page

Vol. 1 Vol. 2

Frame memory a) • Increased image capacity 
• freeze and store mode

2517 78, 
80, 
455

–

Frame memory clip function 2521, 2522 83, 
469

–

Pair file processing 2541 83, 
473

–

Saving and recalling files using an external hard 
disk

2561, 2562 85, 
477

–

Selecting clip playback, stop, cue-up, and 
recording as GPI input actions

7325, 7337, 
7352

– 360, 
400, 
416

Selecting clip event and auto play as snapshot 
attributes

6321 171 264

Multi Program 2 b) • Wipe snapshots/DME wipe snapshots for sub 
• DME wipe transitions for sub in snapshots 

and keyframes

– 222 –

Assigning separate cross-point assign tables for 
sub and main

7322 222 –

DME wipes Adding a border or soft border to a user-
programmable DME pattern for a key 
transition b)

– 75, 
430

–

Selecting no “Dead zone (Last 5%)” for a DME 
wipe crop transition b)

1165.1 436 –

Classification Functions supported Menu No. See page

Vol. 1 Vol. 2

Button assignment Assigning functions to the device control block 
(search dial) buttons

7321.16 – 332
3
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Additional control block and window functions

Preventing 
misoperation

Inhibiting M/E and PGM/PST utility 2 bus and 
key operations

7321.18 – 333

Classification Functions supported Menu No. See page

Vol. 1 Vol. 2

Device control block 
(search dial)

Direct control of a disk recorder or VTR; jog and 
shuttle operations enabled

– 256 170

Menu operations Using the color palette window – 309 –

Classification Functions supported Menu No. See page

Vol. 1 Vol. 2
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Introduction

This manual is the User’s Guide for the MVS-8000/8000SF Multi Format 
Switcher system. The MVS-8000 and MVS-8000SF have different numbers of 
M/E banks and input/output signals, but are otherwise functionally identical.
This manual refers to these generically as the “MVS-8000 system,” and 
describes principally the operation of the system using the CCP-8000 series of 
center control panels.

The User’s Guide for this system comprises two volumes.

Contents of Volume 1
Overview of functions of the MVS-8000 system, and basic switcher operations 
including transitions, keys, and wipes.

Contents of Volume 2
DME effects, snapshots, keyframes, and various operations such as setup 
which affect the overall system.

Devices and system nomenclature
In this manual, when discussing the principal components of the MVS-8000 
system, in place of the formal product names, abbreviated names 
characterizing the functions and features are sometimes used. When 
distinctions between system configurations must be drawn, the terms in the 
following table are used.

Principal components and naming
The formal product names of the principal components of the MVS-8000 
system, and the terms used in this manual are as follows.

Formal product name Term used in this manual

MVS-8000/8000SF/8000A/8000ASF Multi 
Format Switcher Processor a)

Switcher or switcher processor b)

MVE-8000 (MKS-8800)/8000A Multi Format 
DME Processor

DME or DME processor or MVE-8000/
8000A

MVE-9000 Multi Format DME Processor DME or DME processor or MVE-9000

CCP-8000-series Center Control Panel Control panel or center control panel

DCU-8000 (MKS-8700) Device Control Unit DCU or MKS-8700

DCU-2000 (MKS-2700) Device Control Unit DCU or MKS-2700
17Introduction
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a) Where there are differences between the MVS-8000/8000SF system and MVS-8000A/
8000ASF system, these may be noted specifically in the relevant place.

b) Where differences between the MVS-8000/8000SF system and MVS-8000A/8000ASF system 
are noted, these are referred to as “MVS-8000 (system)” and “MVS-8000A (system).”

System nomenclature
The following terms are used for systems, depending on the combination of 
installed options, and the signal format.

Related manuals
The following manuals are supplied with the individual products of the MVS-
8000 Multi Format Switcher system.

MVS-8400/8300/8200 Switcher Processor Pack
• MVS-8400/8300/8200 Operation Manual
• MVS-8400/8300/8200 Installation Manual

MVS-8000A-C/8000AS-C Switcher Processor Pack
• MVS-8000A-C/8000AS-C Operation Manual
• MVS-8000A-C/8000AS-C Installation Manual

MVS-8000SF-C Switcher Processor Pack
• MVS-8000SF-C Operation Manual
• MVS-8000SF-C Installation Manual

MVE-8000-C DME Processor Pack
• MVE-8000-C Operation Manual
• MVE-8000-C Installation Manual

MVE-8000A DME Processor Pack
• MVE-8000A Operation Manual
• MVE-8000A Installation Manual

System configuration and features Term for system

System with installed option boards and 
settings to support HDTV format

HD system

System with installed option boards and 
settings to support SDTV format

SD system

A system in which the center control panel has 
four M/E banks

4M/E system

A system in which the center control panel has 
three M/E banks

3M/E system

A system in which the center control panel has 
two M/E banks

2M/E system
Introduction
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MVE-9000-C DME Processor Pack
• MVE-9000-C Operation Manual
• MVE-9000-C Installation Manual

CCP-8000 Center Control Panel Pack
• CCP-8000 Operation Manual
• CCP-8000 Installation Manual

DCU-8000 Device Control Unit Pack
• DCU-8000 Operation Manual
• DCU-8000 Installation Manual

DCU-2000 Device Control Unit Pack
• DCU-2000-C Operation Manual
• DCU-2000-C Installation Manual
19Introduction
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Features of the MVS-8000 Multi Format 
Switcher System

The MVS-8000 Multi Format Switcher system boasts extensible high 
performance and multifunctionality. The following are some of the principal 
features of this system.

System configuration flexibility

Multiformat support
This system supports both HDTV and SDTV signal formats. The format 
selection can be switched by a simple control panel operation. The switcher 
supports either HDTV or SDTV signal format depending on the installed 
option boards.

Extensible system configuration
By suitable combination of options, the switcher can be configured with 
various inputs and outputs, and different numbers of M/E banks. The system 
offers the flexibility to change and expand as required.
You can connect up to two MVE-8000/8000A or MVE-9000 extensible DME 
processors, each of which provides any number from one to four channels, for 
a maximum of eight channels of DME functionality.

Powerful external device interfaces
By connecting to a Sony routing switcher or similar, a large system can be 
built. From the control panel, it is also possible to operate other equipment, 
including VTRs and disk recorders.

Powerful tally system
The complete system including routing switcher provides an all-inclusive tally 
system. The system can be adapted to different applications and settings, using 
multiple tally outputs, including both on-air and recording tallies.

Comprehensive video manipulation

M/E banks
Each mix/effects bank (M/E bank) is equipped with four keyers, and each 
keyer is capable not only of chroma keying, but also independent key 
transitions separate from the background transitions. The four keys can be 
freely combined, to carry out four different program outputs.
Features of the MVS-8000 Multi Format Switcher System
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Powerful frame memory functions
In an MVS-8000 system, an HDTV system can hold 58 still image frames (88 
frames in 720p/59.94 format), and an SDTV system can store 222 frames in 
memory, while up to eight frames can be recalled and used simultaneously.
In an MVS-8000A system, an HDTV system can hold approximately 1,000 
still image frames or 2,000 frames in 720p/59.94 format, and an SDTV system 
can hold approximately 5,000 frames in 480i/59.94 format or 4,000 frames in 
576i/50 format in memory, and up to eight frames can be recalled and used 
simultaneously.

Link operation with DME
By means of the dedicated DME interface, a range of DME functions including 
DME wipes and processed keys can be handled as switcher functions.
By connecting two MVE-8000/8000A or MVE-9000 units, in any 
combination, you can interface to a maximum of eight DME channels.
Note that the MVE-8000A and MVE-9000 can also be used with this system 
by connecting through an SDI interface.

Designed for use in a live broadcasting environment

Flexible control panel layout
Because of its modular design, the various sections of the control panel can be 
laid out as required. This allows a flexible layout appropriate to the system 
operation.

High-performance user interface
The menu control block provides a large color LCD panel, with rapid touch-
panel menu selection.
The source name displays and buttons in the Flexi PadTM and shotbox control 
blocks have color backlit LCD displays. The signal names, and graphical 
representations of the patterns associated with buttons provide intuitive 
feedback, and allow the immediate decisions that are required in a live 
operating environment.
21Features of the MVS-8000 Multi Format Switcher System
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Video Processing Flow

The following illustration shows the flow of operations for carrying out a 
transition on an M/E bank or the PGM/PST bank.
]

Select next transition (page 30)

Make key settings (page 44)

Keys 1 to 4

Select new background video (page 23)

Select transition type (page 37)

Select current background video 
(page 23)

Background

Cut Mix Super 
mix

Preset color 
mix

Wipe DME wipe

Make wipe 
settings (page 54)

Make DME wipe settings
(page 67)

Preview the effect of transition (page 42)

Execute the transition (page 40)

NAM
Video Processing Flow
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Signal Selection

You carry out signal selection with the cross-point buttons in the cross-point 
control block of each M/E bank or the PGM/PST bank, and the buttons in the 
auxiliary bus control block.
The number of buttons in each cross-point row may be 16, 24, or 32, but here 
the description is of the 32-button case as an example.

Cross-point control block

M/E
1

M/E
1

SHIFT

SHIFT
XPT

HOLD

XPT
HOLD

MCRO
ENBL

KEY3

KEY4

MCRO
ASGN

XPT
HOLD

XPT
HOLD

AUTO
RUN

UTIL

M/E
1

M/E
1

M/E
2

M/E
2

M/E
2

M/E
2

M/E
3

M/E
3

M/E
3

M/E
3

SHIFT

SHIFT

SHIFT

Source name displays

Key 2 row

Key 1 row Reentry buttons

KEY4 button

KEY3 button

Cross-point buttons

Background A row

Background B row

SHIFT button

Reentry buttons

UTIL button
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Basics of Signal Selection

Each of the M/E banks, PGM/PST bank and auxiliary bus control block has 32 
cross-point buttons and three reentry buttons (four in the case of the auxiliary 
bus control block).
These buttons are identified by numbers common to all of the banks and block, 
and a signal is assigned to each number.
The basis of signal selection is to select, in a cross-point button row, the cross-
point button to which is assigned the desired signal.

Reentry buttons
To use the output of one M/E bank as background input to another bank, use 
the reentry buttons [M/E1], [M/E2], and [M/E3] (on the auxiliary bus control 
block, [M/E1], [M/E2], [M/E3], and [PGM]) in the cross-point control block 
of the destination bank.
For example, to feed the output from the M/E-1 bank as the background B input 
to M/E-2, in the M/E-2 cross-point control block, press the [M/E1] button in 
the background B row.

Bus Selection

Each row of 32 cross-point buttons is shared by multiple buses.
For example, in the M/E-1 bank, the key 1 row of buttons can be assigned either 
to the key 1 bus or to the key 3 bus. The [KEY3] button switches between these 
two assignments.
To assign a bus to the cross-point buttons in the auxiliary bus control block, 
press one of the AUX delegation buttons to select the bus. 

The following table illustrates the correspondence between buses and cross-
point button rows, and the delegation operations.

Bank Bus name Cross-point 
button row

Delegation operation

M/E-1, 
M/E-2, 
M/E-3

Background A bus Background A 
row

–

Background B bus Background B 
row

–

Key 1 bus Key 1 row Turn off the [KEY3] button

Key 2 bus Key 2 row Turn off the [KEY4] button

Key 3 bus Key 1 row Turn on the [KEY3] button

Key 4 bus Key 2 row Turn on the [KEY4] button
Signal Selection
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PGM/PST Program bus Program row –

Preset bus Preset row –

DSK 1 bus DSK1 row Turn off the [DSK3] button

DSK 2 bus DSK2 row Turn off the [DSK4] button

DSK 3 bus DSK1 row Turn on the [DSK3] button

DSK 4 bus DSK2 row Turn on the [DSK4] button

M/E-1, 
M/E-2, 
M/E-3, 
PGM/PST

Utility 1 bus Background A 
row

When [UTIL] button mode 
is Hold, hold down the 
[UTIL] button

Utility 2 bus Background B 
row

DME external video bus Key 1 row Hold down the [UTIL] 
button

DME utility 1 bus Key 2 row Hold down the [UTIL] 
button, and press the 
[KEY4] button, turning it 
off

DME utility 2 bus Hold down the [UTIL] 
button, and press the 
[KEY4] button, turning it 
on

Bank Bus name Cross-point 
button row

Delegation operation
25Signal Selection
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Auxiliary 
bus control 
block

AUX1 to AUX48 buses 1st row, 2nd row Turn on the appropriate 
buttons in accordance with 
the signal assignment 
made in the Setup menu.

MONITOR 1 to 
MONITOR 8 buses

Frame memory source 1 
and frame memory 
source 2 buses

DME 1 to DME 8 video 
buses

DME 1 to DME 8 key 
buses

Edit preview bus

M/E-1 UTILITY 1 and 
M/E-1 UTILITY 2 buses

M/E-2 UTILITY 1 and 
M/E-2 UTILITY 2 buses

M/E-3 UTILITY 1 and 
M/E-3 UTILITY 2 buses

P/P UTILITY 1 and P/P 
UTILITY 2 buses

M/E-1 Key 1 fill to M/E-1 
Key 4 fill buses

M/E-1 Key 1 source to M/
E-1 Key 4 source buses

M/E-2 Key 1 fill to M/E-2 
Key 4 fill buses

M/E-2 Key 1 source to M/
E-2 Key 4 source buses

M/E-3 Key 1 fill to M/E-3 
Key 4 fill buses

M/E-3 Key 1 source to 
M/E-3 Key 4 source 
buses

DSK 1 fill to DSK 4 fill 
buses

DSK 1 source to DSK 4 
source buses

M/E-1 external DME bus

M/E-2 external DME bus

M/E-3 external DME bus

P/P external DME bus

DME UTILITY 1 and 
DME UTILITY 2 buses

Bank Bus name Cross-point 
button row

Delegation operation
Signal Selection



  C
hapter 1 

M
V

S
-8000 F

unctions
Signal Assignment and Selection

Assigning signals to buttons
Each of the 32 cross-point buttons and reentry buttons has a corresponding 
button number, to which you assign a signal.
In addition to the signals input to the PRIMARY INPUTS 1 to 80 connectors 
on the rear panel of the switcher, you can also select signals generated within 
the switcher.
Each button has assigned to it a video signal and a key signal, forming a pair. 
You can set these video and key combinations in a Setup menu. 

For details of Setup menu operations, see “Cross-Point Settings (Xpt Assign 
Menu)” in Chapter 16 (Volume 2).

Cross-point button control block button numbers

On each M/E bank and the PGM/PST bank, each cross-point button and reentry 
button has two button numbers, and you use the shift button to switch between 
these numbers.
In the case of a 32-button layout, the button numbers are as follows.

M/E
1

M/E
1

SHIFT

XPT
HOLD

XPT
HOLD

MCRO
ENBL

DSK3

KSK4

MCRO
ASGN

XPT
HOLD

XPT
HOLD

AUTO
RUN

UTIL

M/E
1

M/E
1

M/E
2

M/E
2

M/E
2

M/E
2

M/E
3

M/E
3

M/E
3

M/E
3

1, 2, 3, 4, ....... ....... 29, 30, 31 121 123

32, 33, 34, 35, ....... ....... 60, 61, 62 125 127
(first button numbers)

(second button numbers)

Shift button

Shift button

Cross-point control block button numbers

Button Number when the shift 
button is not pressed

Number when the shift 
button is pressed

From the left end to the 31st 
button

1 to 31 32 to 62

Reentry buttons 121 to 123 125 to 127
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Note 
On the MVS-8000A, you can use the rightmost button (number 32) as a [SIDE 
FLAG] button. In this case, the shift button moves one to the left, to number 
31, and the button numbers are offset by one.

For details of the [SIDE FLAG] button, see “Cross-Point Settings (Xpt Assign 
Menu)” in Chapter 16 (Volume 2).

Switching button numbers
The rightmost (32nd) button functions as a shift button.
(The shift button function can be disabled in a Setup menu.)
When selecting the signals of button numbers 1 to 31, press the cross-point 
button for the desired signal.
To select button numbers 32 to 62, hold down the shift button, and press the 
cross-point button for the desired signal.

Button numbers in the auxiliary bus control block

When the [2ND] button is unlit
The cross-point buttons and reentry buttons in the auxiliary bus control block 
have separate upper (1st row) and lower (2nd row) numbers.
In the case of a 32-button layout, the button numbers are as follows.

LEVEL
1

DEST

SHIFT

RTR

2ND

KEY

XPT
HOLD

XPT
HOLD

M/E
1

M/E
1

LEVEL
2

MCRO
1

M/E
2

M/E
2

LEVEL
3

MCRO
2

M/E
3

M/E
3

LEVEL
4

MCRO
3

P/P

P/P

EDIT
PVW

AUX
1

AUX
2

AUX
3

AUX
4

AUX
5

AUX
6

AUX
7

AUX
8

AUX
9

AUX
10

AUX
11

AUX
12

AUX
13

AUX
14

AUX
15

AUX
16

AUX
17

AUX
18

AUX
19

AUX
20

AUX
21

AUX
22

AUX
23

AUX
24

AUX
25

AUX
26

AUX
27

DME
UTIL1

DME
UTIL2

FM
1

FM
2

1, 2, 3, 4, ....... ....... 29, 30, 31 121 124

32, 33, 34, 35, ....... ....... 60, 61, 62 125 128

(1st row)

(2nd row)

2ND button

Auxiliary bus control block button numbers ([2ND] button unlit)

Button Button Button numbers

1st row From the left end to the 31st button 1 to 31

Reentry buttons 121 to 124

2nd row From the left end to the 31st button 32 to 62

Reentry buttons 125 to 128
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When the [2ND] button is lit
Different buses can be assigned to the 1st-row buttons and 2nd-row buttons. 
When the 32nd button is set as a shift button, the 1st-row buttons and 2nd-row 
buttons both have the following button numbers.

Auxiliary bus control block button numbers ([2ND] button lit)

Signal Name Display

You can attach a name (source name) to each signal assigned to a cross-point 
button, with a maximum of 16 characters.

• The source name displays in the cross-point control block and auxiliary bus 
control block show the source names of the video signals assigned to 
numbers 1 to 31.

• To display the source names for numbers 32 to 62, press the [SHIFT] button 
to the right of the source name displays.

• To display the source names of the key signals assigned to buttons, hold 
down the [SPLIT] button in the key control block or the [KEY] button in the 
auxiliary bus control block.

Colors of lit cross-point buttons
In a particular row of cross-point buttons, only the last pressed button is 
effective, and lights amber or red. The amber indicates the “low tally” state, 
and the red indicates the “high tally” state, to indicate whether or not the 
selected signal appears in the final output video.

Button Number when the shift 
button is not pressed

Number when the shift 
button is pressed

From the left end to the 31st 
button

1 to 31 32 to 62

Reentry buttons 121 to 124 125 to 128

Significance of colors of lit cross-point buttons

Color State Significance

Amber Low tally Does not appear in final output video

Red High tally Appears in final output video
29Signal Selection
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Transitions

In the M/E banks and PGM/PST bank, the switch from the current video stream 
(appearing on the corresponding program monitor) to a new video stream is 
referred to as a transition.

Selecting the Next Transition

To execute a transition, it is first necessary to decide how the image will be 
changed as a result of the transition. This selection is carried out using the next 
transition selection buttons (see page 241) in the transition control block of the 
M/E or PGM/PST bank.

For details of operations, “Basic Operating Procedure” (page 312).

In the M/E banks and PGM/PST bank, you can change one of the images, the 
background, and keys 1 to 4 (downstream keys 1 to 4 in the PGM/PST bank), 
and also vary combinations of these simultaneously.
The following are examples of transition.

Changing the background
A background transition switches from the video currently selected on the 
background A bus (the current video) to the video selected on the background 
B bus (the new video).

In the default selection of flip-flop mode (see page 41), the background always 
switches in the direction from the A bus to the B bus. When the transition 
completes, the cross-point selections on the A and B buses are interchanged.

Background BBackground A

Transition
Transitions
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Inserting and deleting a key

You can insert one or more of the four keys (downstream keys on the PGM/
PST bank).
If you select a key which is already inserted, the transition will delete the key.
A simultaneous combination of deleting and inserting keys is also possible.

Inserting or deleting key 1 and key 2

Deleting key 1 and inserting key 2

Delete

Insert

Key 1

Key 2

Key 1

Key 2

Transition
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Simultaneously changing the background and keys
You can change any of the four keys (downstream keys on the PGM/PST bank) 
and the background at the same time.

Changing the background and key 2 simultaneously

Changing the background and keys 1 to 4 simultaneously

Selecting the key priority
If a number of keys are already inserted in the current video, you can check or 
change the key priority, that is to say, the order in which the keys are overlaid.
When a key priority ([KEY PRIOR]) is selected as the next transition, you can 
also change the key priority in the new video.

For details of this operation, see “Key Priority Setting” (page 315).

Key 1

Key 2

Transition

Key 1

Key 2 Key 3 Key 4

Transition
Transitions
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The key priority values go from 1 to 4, with a higher priority key being “in 
front” as seen on the screen.

Priority sequence on the screen

Independent Key Transitions

What is an independent key transition?
In addition to common transitions, it is possible to carry out independent 
transitions on the keyers of the M/E banks and PGM/PST bank. These are 
called “independent key transitions.”
By carrying out an independent key transition in combination with a common 
transition, different transition types can be used for the background and keys. 
It is also possible to use different transition types for key insertion and key 
deletion by means of a Setup menu setting.

For details of this operation, see “Basic Independent Key Transition 
Operations” (page 337).

The following description compares the independent key transition with a 
common transition, taking a simultaneous change of the background and key 
as an example.

Video used in the transition

4
3

2
1

Background A Background B Key to insert
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Effect of a common transition
In the case shown in the previous illustration, carrying out a common transition 
produces the following change in the image.

Effect of a common transition

Effect of use with an independent key transition
The key is inserted with an independent key transition as the background 
changes with a common transition, providing the following result.

Effect of a background transition and independent key transition

Combining other transitions with independent key transitions
When you set a common transition and a key independent transition for the 
same key, you can apply two different effects such as a wipe and mix (dissolve) 
(see page 37) to the key simultaneously.
When carrying out such a combination of transitions simultaneously on a key 
as auto transitions (see page 40), the result depends on the timing of pressing 
the respective [AUTO TRANS] buttons.

Same wipe is applied to 
background and key.

Transition type: wipe

Different wipe patterns are applied to 
the background and key transitions.

Transition type: 
wipe

Independent key 
transition type: 
wipe
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Simultaneous execution
If the [AUTO TRANS] buttons for the two transitions are pressed 
simultaneously, the following is the result.
Note that in both cases the common transition is a wipe and the independent 
key transition is a mix (dissolve).
Deleting a key with simultaneous transitions: With the key inserted, it is 

deleted simultaneously with the two transitions.
When the common transition completes, even if the independent key 
transition is still not completed, the two end simultaneously.

Deleting a key with simultaneous transitions

Inserting a key with simultaneous transitions: With the key not inserted, it 
is inserted simultaneously with the two transitions. If the common 
transition or independent key transition ends first, the other continues to 
completion.

Inserting a key with simultaneous transitions

Time offset execution
If the [AUTO TRANS] buttons for the two transitions are pressed with a time 
offset, the following is the result.
Note that in both cases the common transition is a wipe and the independent 
key transition is a mix (dissolve).

Wipe and mix 
(dissolve) are 
carried out 
simultaneously.

The key is deleted, 
even if the 
independent key 
transition has not 
completed.

Wipe and mix 
(dissolve) are 
carried out 
simultaneously.

The transitions 
continue until both 
are completed.
35Transitions
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Time offset execution with the key inserted: With the key inserted, it is 
deleted with the two transitions acting with a time offset.
Whichever button is pressed first, when the common transition completes, 
even if the independent key transition is still not completed, the two end 
simultaneously.
Example: When the independent key transition [AUTO TRANS] button 
is pressed later

Time offset execution with the key inserted

Time offset execution with the key not inserted: With the key not inserted, 
it is inserted with the transition whose [AUTO TRANS] button is pressed 
first.
Since the key is then in the inserted state, with the transition whose [AUTO 
TRANS] button is pressed later, the key is deleted. When the key is 
completely deleted, both transitions complete.

Common transition 
(wipe) start

Independent key 
transition (mix) start

The key is deleted, 
even if the 
independent key 
transition has not 
completed.
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Time offset execution with the key not inserted

Transition Types

Selecting the transition type determines the way in which the transition occurs.
Carry out the type selection with the transition type selection buttons in the 
transition control block of the M/E or PGM/PST bank.

For details of this operation, see “Basic Operating Procedure” (page 312).

The following are the transition types.

Mix
This is a dissolve, in which the new video progressively fades in over the 
current video, with the sum of the two video outputs maintained constant. At 
the mid-point of the transition (when the fader lever is in the center position), 
the output of each is 50%.
This transition type can also be selected for an independent key transition. In 
this case, the key either dissolves in or dissolves out similarly, with the 
progress of the transition.

Common transition 
(wipe) start

Independent key 
transition (mix) 
start

The transition 
completes with the 
key deleted.

Example 1: When the independent key transition [AUTO TRANS] 
button is pressed later

Common 
transition (wipe) 
start

Independent 
key transition 
(mix) start

The transition 
completes with the 
key deleted.

Example 2: When the common transition [AUTO TRANS] button is 
pressed later
37Transitions
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NAM (non-additive mix)
In this dissolve, the current video and new video signals are compared, and the 
signal with the higher luminance level is given priority in the output. The 
current video is maintained at 100% output for the first half of the transition as 
the new video increases progressively to 100%, then the current video is 
progressively reduced from 100% to zero in the second half with the new video 
maintained at 100% output.

Note 
This transition type is not available for an independent key transition.

Super mix
In this dissolve, the current video is maintained at 100% output for the first half 
of the transition as the new video is mixed while increasing progressively to 
100%, then the current video is progressively reduced from 100% to zero in the 
second half with the new video maintained at 100% output.
Note that you can set the output levels of the current and new video signals at 
the mid-point of the transition, in the range 0 to 100%. (See “Super Mix 
Settings” (page 321).)

Note 
This transition type is not available for an independent key transition.

Preset color mix
This is a two-stage dissolve, comprising two transitions, the first a dissolve to 
a color matte, and the second from the color matte to the new video.
In the first transition, the current video is replaced by the color matte in a mix 
(dissolve), then in the second transition the color matte is replaced by the new 
video also in a mix (dissolve). You can specify the color matte by luminance, 
saturation, and hue values. (See “Color Matte Settings” (page 322).)

Notes
• This transition type is not available for an independent key transition.
• In the multi-program mode, a preset color mix cannot be used.

One-stroke mode and one-time mode
• You can make a setting such that a preset color mix is carried out in a single 

transition. This is called “one-stroke mode.”

Note 
When the bus fixed mode is selected with a Setup menu setting, a preset color 
mix is always carried out in the one-stroke mode.
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• You can also make a setting such that when a preset color mix is completed, 
the next transition switches to the previous transition type automatically. 
This is called “one-time mode.”

When only the background is changed

Preset color mix (changing background only)

When a key is inserted

Preset color mix (transition including key)

By means of a Setup menu setting, it is possible to preserve the key state while 
carrying out the color matte mix.

When, with a key inserted, a key is selected in the next transition

Preset color mix (when set to preserve key state)

Current video Color matte New video

Key fades out

Key

When a key is 
selected as the next 
transition

When no key is selected

Key fades in

Key

Key state preserved
Key gradually 
removed
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Wipe
A wipe replaces the current video by the new video according to a 
predetermined pattern. This transition type can also be selected for an 
independent key transition.

For details, see “Wipes” (page 54) and Chapter 5 “Wipes” (page 397).

DME wipe
Using a DME effect, it is possible to obtain a transition to a new image from 
the current image, as in a wipe. You can also use this transition type as an 
independent key transition.

For details, see “DME Wipes” (page 67) and Chapter 6 “DME Wipes” (page 
425).

Cut
A cut switches instantaneously from the current video to the new video. When 
the next transition is a key transition, the key cuts in or out instantaneously.

Executing a Transition

There are two modes of executing a transition: an auto transition by button 
operation or a manual transition using the fader lever.
It is also possible to combine both methods, taking control with the fader lever 
of an auto transition which has partly completed, or complete a transition 
started with the fader lever as an auto transition.
By combining common transitions with independent key transitions, different 
transition types can be applied to the background and keys, for example 
allowing a key wipe combined with a background dissolve. (See “Executing a 
Transition” (page 323).)

Auto transitions

Cut
A cut switches instantaneously from the current video to the new video. When 
the next transition is a key transition, the key cuts in or out instantaneously.

Auto transition
The transition from the current video to the new video is carried out 
automatically at a constant rate, using the transition effect selected as the 
transition type.
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You can set the transition rate in advance. (See “Setting the Transition Rate” 
(page 324).)

Manual transitions
Using the fader lever, you can manually control the progress of the transition. 
Moving the fader lever from one end of its travel to the other completes the 
transition.

Flip-flop mode and bus fixed mode
The following describes the difference between flip-flop mode and bus fixed 
mode, taking an M/E bank as an example; the functionality is the same, 
however, on the PGM/PST bank.
Normally, when a background transition is carried out on an M/E bank, the 
signals selected on the A and B rows of cross-point buttons are interchanged at 
the end of the transition. That is to say, except during a transition, the 
background output is always from the background A bus. This is called “flip-
flop mode.”
The alternative is known as “bus fixed mode,” in which there is no bus 
interchange. In this mode, when the fader lever is at the top of its travel the 
output from the A bus is always 100%, and when the fader lever is at the bottom 
of its travel the output from the B bus is 100%.

Flip-flop mode and bus fixed mode

For details of fader lever operation in bus fixed mode, see page 333.

A

B

BLACK

BLACK

A

B

BLACK

BLACK

A

B

BLACK

BLACK

Buttons lit

Fader 
lever

Flip-flop mode

Bus fixed mode
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Transition preview
With the preview output of the M/E banks and PGM/PST bank, you can check 
the effect of a transition in advance. To carry out a transition preview, press the 
[TRANS PVW] button in the transition control block. (See “Transition 
Preview” (page 335).)

Note 
In multi-program mode, DSK mode (page 185) or bus fixed mode (page 41), 
it is not possible to carry out a transition preview.

Pattern limit
When a wipe or DME wipe pattern is selected for the transition, you can 
specify the range of movement of the wipe pattern through the course of the 
transition, for each bank independently.
When the pattern limit function is enabled, carrying out a transition results in 
the following effect for example settings.
• When the limit value is set to 50%, the effect at the end of the transition is 

the same as when the fader lever is at the center position in the normal case 
(with the pattern limit function disabled); the wipe pattern does not complete.

• When the limit value is set to 0%, the wipe effect is completely disabled, and 
carrying out the transition produces no change in the image.

• When the limit value is set to the maximum 100%, the image changes in 
exactly the same way as when the pattern limit function is off, but when the 
transition is completed, the cross-point selections on the background A and 
B buses do not interchange.

You can specify the limit value either by entering a numeric value in the menu, 
or by operating the fader lever to set the fader lever position. (See “Pattern 
Limit” (page 327).)

Note 
The pattern limit function is not available in an independent key transition.

Fade to black
The PGM/PST bank provides a fade-to-black function, controlled with the 
[FTB] button in the fade to black control block. (See “Fade to Black” (page 
342).)

Note
In multi-program mode or DSK mode, it is possible to carry out a fade-to-black 
on a number of programs simultaneously.
You can also make a Setup menu setting such that a fade-to-black does not 
apply to particular programs.
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For details of the setting, see “Settings Relating to Video Switching (Transition 
Menu)” in Chapter 16 (Volume 2).
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Keys

A key is an effect in which a part of the background image is replaced by an 
image or superimposed text. The signal determining how the background is cut 
out is termed “key source,” and the signal that replaces the cut-out part is 
termed “key fill.” The system component responsible for processing a key is 
referred to as a keyer.
Each M/E bank and the PGM/PST bank has four keyers, and all of these keyers 
provide the same functions.

Key Types

The key type indicates the manner in which the key source signal is used to cut 
out the background. In each bank, you can use the following key types. You 
can select the key type using the key type selection buttons in the key control 
block, or by a setting in the Type menu for the keyer. (See “Key Type Setting” 
(page 353).)
• Luminance key
• Linear key
• Color vector key
• Chroma key
• Wipe pattern key
• Key wipe pattern key

Luminance key
The background is cut out according to the luminance (Y) of the key source 
signal, and at the same time the key fill signal is cut out and then added to the 
background signal.

Linear key
This is a type of luminance key, but there is a reduced variability in gain, 
allowing more precise adjustment.

Color vector key
The key signal is created from a combination of the luminance and 
chrominance components of the key source signal. When perfect keying is not 
possible with a luminance key, this allows a key signal to be created even if the 
luminance level is low, provided that the colors have high saturation.
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Clean mode
In a luminance key, linear key or color vector key, you can enable the clean 
mode. When the clean mode is on, the key source does not affect the key fill, 
which is added unchanged to the background. This improves the keyed image 
quality, but means that the part of the key fill signal which is not to be inserted 
must be completely black, or it will color the background. You set the clean 
mode with the Type menu of the respective keyer. (See “Setting the key type in 
a menu” (page 353).)
Note that in the following situations, the clean mode goes off, and cannot be 
turned on.
• When the key type is a pattern key
• When key inversion is on
• When the key fill is a matte
• When the key edge is an outline
• When the key edge is normal with soft edge being on
• When fine key is on
• When the key positioner is on

Chroma key
A key signal based on a particular color is used to cut out the background, and 
the key fill is then inserted. The inserted signal is also referred to as the 
foreground, and the composite image is called a chroma key image.

Normal mix and additive mix
In creating a chroma key image, either a normal mix or an additive mix can be 
used. To select which, use the Type >Chroma Adjust menu for the keyer. (See 
“Chroma Key Composition” (page 355).)

Foreground Background

Chroma key image
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Normal mix: The foreground is cut out with the key signal, and then combined 
with the background, which has also been cut out with the key signal.

Additive mix: The background, which has been cut out with the key signal, is 
combined with the unshaped foreground. This is effective for a natural-
looking composite when the scene includes glass or other translucent 
objects.

Plane function
In an additive mix, the foreground is not shaped by the key signal, and 
variations in the (blue) background appear in the composite image. To prevent 
this, it is possible to set a particular luminance level for the background, and 
any parts below this level are cut forcibly.

Methods of adjusting the composite obtained from chroma keying include 
automatic adjustment with the auto chroma key function, and manual 
adjustment carrying out the necessary processing separately. The optimum 
results will be obtained by first carrying out adjustments with the auto chroma 
key function, then making any fine adjustments as required.
The following manual adjustments are possible.

Key active
When this function is off, only the foreground is output and you can make 
adjustments of color cancel (see the next paragraph).

Color cancel
If the foreground image includes shades of the background color, turn this 
function on to remove the color from the foreground image.

Chroma key window
You can adjust the range over which the key signal is determined as matching 
the specified hue. When this adjustment is off the default ranges are used.

Chroma keying generates a key signal based on a particular color (reference 
color) in the foreground (typically a plain blue background), and the “window” 
refers to the range of colors which are regarded as matching this specified 
reference color to create the key signal.
As seen on a vectorscope (that is, in the hue-saturation color space), the range 
for this matching corresponds to a truncated sector. This range is specified by 
two parameters: the “Angle” parameter, which determines the range of the hue 
parameter, and the “Crop” parameter, which determines the degree of 
truncation (see the following figure).
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Window adjustment

Y balance
In normal chroma keying, the key signal is based on the chrominance 
component only, and all elements of the foreground with the same hue are 
replaced by the background. Using the Y balance function, you can specify a 
luminance level range within which the key is active, and replace the specified 
part by the background.
You can use the Y balance function independently on the key signal for the 
composition and the key signal for the color cancel function. When applied to 
the key signal for the composition, this produces the foreground with the color 
cancel effect applied. This can therefore be used to provide an impression of 
smoke, for example.
When the Y balance function is applied to the color cancel key, the relevant 
part is output in its original color without canceling, and therefore it is possible 
to combine colors which are the same color as the background (i.e. typically 
blue) in the foreground.

Chroma key shadow
This function provides a more realistic treatment when the shadow of an object 
in the field of view falls on the blue background. Since parts of the blue 
background darker than a specified intensity are treated as shadows, there is no 
effect on cutting out of the foreground.

Video signal adjustment
You can vary the foreground signal gain, or change the hue. There are separate 
adjustments for the gain of the overall video signal, and Y and C components.

Reference color 
specified by Hue 
setting

Range of colors creating the key signal 
(to be replaced by background signal)

Range of colors remaining 
as foreground

a) The Crop and Angle values do not change even if 
you use the auto chroma key function.

Angle a)

Crop a)
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For details of video adjustment operations and the adjustment items, see 
“Chroma Key Adjustments” (page 356).

Wipe pattern key
This uses the wipe pattern selected for a transition as the key source.

Key wipe pattern key
This uses the wipe pattern selected for an independent key transition as the key 
source.

Note on wipe pattern modifiers
In a wipe pattern key or key wipe pattern key, you can apply various 
modifications, depending on the pattern used, and the modifiers in common 
with a wipe.
However, modifiers which relate to the wipe direction and edge are not 
reflected.

Key Modifiers

Edge modifiers
You can apply borders and other effects to the edge of the key. (See “Key Edge 
Modifications” (pages 363 and 383).)

Normal
This is the state with no key edge modifiers applied.
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Border
This applies a uniform width border to the edge of the key. You can adjust the 
border width and density. You can also enable the separate edge function, and 
adjust the top, bottom, left, and right border widths separately.

Drop border 
This applies a border below and to the right for example, of the key. You can 
adjust the border width, position, and density.

Shadow
This applies a shadow below and to the right for example, of the key. You can 
adjust the shadow width, position, and density.
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Outline
This uses the outline of the original key as the key. You can adjust the width 
and density of the outline. You can also enable the separate edge function, and 
adjust the top, bottom, left, and right outline widths separately.

Emboss
This applies an embossing effect to the outline of the key. You can adjust the 
width and position of the embossing, and the density. You can adjust the 
density separately for key fill and key edge. When embossing is on, the Fine 
Key and zabton functions go off.

Soft edge
This softens the edge of the key.

Zabton
This inserts a translucent pattern behind a key. You can adjust the pattern size, 
softness, density and color.

Edge type and key fill/key source position
The key edge modification function has two modes: a mode (“key drop ON 
mode”) in which the key fill/key source position moves downward, and a mode 
(“key drop OFF mode”) in which it does not move downward.
Key drop ON mode: The key fill/key source position moves downward by 

eight scan lines or four scan lines. When a drop border or shadow is 
selected, it is possible to apply a border to the top edge of the key.

Key drop OFF mode: The key fill/key source position does not move. When 
a drop border or shadow is selected, it is not possible to apply a border to 
the top edge of the key.

In the key drop ON mode, a menu setting selects between the mode (“4H 
mode”) in which the key fill/key source position is lowered by four scan lines, 
and the mode (“8H mode”) in which the key fill/key source position is lowered 
by eight scan lines.
When Fine Key is on, the edge width is forced to the range 0.00 to 4.00.

Note that in the following situations, the key drop mode is forcibly turned on.
• When the edge type is border, outline, or emboss
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• When the edge type is normal with soft edge being on
• When Fine Key is on

Edge fill
When a border, drop border, or shadow modifier is selected, you can select a 
signal to fill these edge effects.
The edge fill may be either the signal from the dedicated color matte generator, 
or the signal currently selected on the utility 1 bus.
In the case of an outline, there is no edge fill signal selection, because the key 
fill signal fills the outline, and the rest of the image remains as the background.
For the emboss effect, in place of the edge fill signal, the emboss fill matte 1 
and emboss fill matte 2 signals are used.

Masks
A mask is used to inhibit the effect of a key over a part of the image. This 
allows parts of the background which would otherwise be keyed to be 
protected, or to correct the key if it is not of the desired shape.

For details of masking operations, see “Masks” (pages 370 and 387).

Key mask and background mask
There are two types of mask: a key mask and a background mask.
Key mask: This masks out a part of the key, which will result in the 

background appearing.
Background mask: This masks out a part of the background, which will result 

in the key fill appearing.

Main mask and subsidiary (“sub”) mask
Each keyer allows two masks to be used simultaneously, and these are referred 
to as the main mask and the sub mask. The signal that determines the mask 
shape and size is termed the mask source, and different sources are used for the 
main mask and sub mask.
Main mask: This uses the signal from the dedicated box generator provided 

on each keyer, or the signal from the dedicated pattern generator as the 

Key mask

Masked area (box)

Background mask
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mask source.
When the box generator is selected, a rectangular mask is formed. You can 
adjust the positions of the four sides of the box separately.
When the pattern generator is selected, you can select the pattern and apply 
modifiers.

Sub mask: This uses the wipe generator signal or the signal selected on the 
utility 1 bus, as the mask source.
When the wipe generator is selected, the patterns and the pattern modifiers 
are the same as in a wipe transition.

Key Memory

The key memory function allows the keyer settings on each cross-point button 
to be automatically stored, so that the next time the same cross-point button is 
selected these settings are recalled automatically.
There are two modes for key memory: simple mode and full mode. 
The parameters stored in each mode are as follows.
Simple mode: key type, clean mode (including the plane setting for chroma 

keying), key position, key inversion, and adjustment values for the 
particular key type (Clip, Gain, Density, Filter, etc. This includes color 
vector key, wipe pattern key, key wipe pattern key, and chroma key. 
However, in the case of a chroma key, it excludes color cancel, Y balance, 
foreground CCR, window, and shadow.)

Full mode: All settings except transition (the same parameters as simple mode, 
Fine Key, key modifiers, main and sub mask settings, chroma key detailed 
settings, and so on)

For the settings for these modes, see “Settings Relating to Keys, Wipes and 
Frame Memory (Key/Wipe/FM Menu)” in Chapter 16 (Volume 2).

Key Snapshots

Key settings other than the key on/off status and the key priority can all be 
instantaneously saved in a dedicated register, for recall when required. A key 
snapshot comprises three values: a cross-point button number, key memory full 
mode, and independent key transition, and can be called in any combination.
There are four key snapshot registers for each keyer.

For details of key snapshot operations, see “Key Snapshots” (page 392).
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Blink

The blink function provides the following effects.
Key blink: The key is inserted and deleted at the specified frequency.

You can also set the frequency and the proportion of the cycle for which 
the key is inserted.

Edge blink: Key fill and key edge fill are interchanged at the specified 
frequency. You can specify both the frequency and the proportion of the 
cycle for which the interchange occurs.

The blink settings are in the Transition menu for each key. (See “Blink 
Function” (page 377).)

Key Default

With a simple operation you can return the key adjustment values to their 
defaults.
The adjustment values which can be returned to their default values are as 
follows.
• Adjustment values for the particular key type (Clip, Gain, Density, Filter, 

etc.)
In the case of chroma keying, all adjustment values return to their default 
values.

• Key position
• Key inversion
• Clean mode

For details, see “Returning the key adjustment values to their defaults” (page 
391).
For the menu operation to return the key adjustment values to their defaults, 
see “Returning to default state in function groupings” (page 300).

Key Modify Clear

A simple button operation or a menu operation returns the key settings to the 
initial status settings.

For details of the initial status, see “Selecting the State After Powering On 
(Start Up Menu)” in Chapter 16 (Volume 2).
For the menu operation to return the key state to that set in initial status, see 
“Returning to default state in function groupings” (page 300).
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Wipes

A wipe is a transition from the current video stream to a new video stream, 
using a wipe pattern.
Changing the background by means of a wipe is referred to as a “background 
wipe,” and inserting or deleting a key with a wipe is termed a “key wipe.”
There are two types of wipe: those that can be selected in a common transition, 
and those that can be selected in an independent key transition.

For details of independent key transitions, see page 33.

Types of Wipe Pattern

The patterns that can be used for a wipe are divided into a number of groups, 
as follows. Note that only the standard wipe patterns can be used for an 
independent key transition.

For wipe patterns, see the appendix “Wipe Pattern List” (Volume 2).

Standard wipe patterns
Patterns consisting of straight lines vertically, horizontally, or diagonally, and 
circular patterns.

Enhanced wipes
More complex shapes such as hearts, stars, and round corners.

Rotary wipes
These patterns involve rotation of the image about a point.

Mosaic wipe pattern
This divides the image into small tiles.

Random and diamond dust wipe patterns
These patterns consist of small random tiles, or fine particles.

Pattern Mix

You can create a new pattern by combining two selected patterns (main and 
“sub”).
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Note
It is not possible to apply a pattern mix to an independent key transition.

For details, see “Pattern Mix” (page 401).

Types of pattern mix
There are four ways in which patterns can be combined in a pattern mix, as 
follows.
Mix: The effect of the sub pattern is applied to the main pattern, modifying the 

outline or nature of the main pattern.
Positive NAM (+Nam): Creates a pattern with an outline which contains all 

points within the outlines of either of the main pattern and the sub pattern.
Negative NAM (–Nam): Creates a pattern with an outline which contains all 

points within the outlines of both of the main pattern and the sub pattern. 

Morphing: As the transition progresses, the pattern morphs from the main 
pattern, through the “mix” combination, to the sub pattern.

Mix Positive NAM Negative NAM
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• A value of 0.00 corresponds to the beginning of the transition, and a value of 
100.00 to the end of the transition.

• A negative Start value signifies that the main and sub patterns are already 
combined when the transition starts.

• An End value of 100.00 or more signifies that the main and sub patterns are 
still combined when the transition complete.

• If the Start and End values are the same, the main and sub patterns are 
interchanged instantaneously at the corresponding point in the transition.

• If End is less than Start, as the transition proceeds, it changes from the sub 
pattern to the main pattern.

Dust mix
You can apply the effect of a diamond dust wipe to a selected pattern. You can 
also apply the diamond dust wipe effect to the pattern resulting from a pattern 
mix. (See “Pattern Mix” (page 401).)
When the pattern mix function is off, turning dust mix on results in the main 
pattern and the diamond dust pattern being mixed. This state is the same as a 
pattern mix when the diamond dust pattern is selected for the sub pattern.

10.00

0.00

–10.00

110.00

100.00

0.00 100.00

90.00

Mix ends during 
transition, which 
ends with sub 
pattern at 100%

Main pattern at 100%

Sub pattern at 100%

Parameter settings
Start: Point in the course of the 

transition at which the main pattern 
is at 100%

End: Point in the course of the transition 
at which the sub pattern is at 100%

Transition (0.00 - 100.00)

Start 
value

End 
value

Mix combination of 
main and sub 
patterns already 
begun

Ends with sub 
pattern at 100%

Begins with main 
pattern at 100%

Transition ends 
with main and 
sub patterns 
still in mix 
combination

Mix begins after 
transition starts
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Main and sub modifier link function

When carrying out a pattern mix, it is possible to link the modifier settings for 
the main pattern and sub pattern. There are two modes for this function.

FULL LINK (fully linked) mode
In this mode, all modifier settings are the same for the main pattern and sub 
pattern.
Changing the modifier settings for one pattern automatically changes the 
settings for the other.

SEMI LINK (semi-linked) mode
Only the parameter settings of the modifiers are linked. The modifier on/off 
settings are not linked. When the parameter values for the modifiers of the main 
pattern and sub pattern are different, then after this link mode is selected, 
changing the value of a parameter for one pattern changes the value of the 
parameter for the other pattern to maintain the same difference between the 
two.

Note 
When carrying out a wipe transition using a pattern mix, it is recommended that 
you set the modifier link function to “FULL LINK” mode.
If the link function is off, or SEMI LINK mode is selected, the desired effect 
may not be obtained at the start or end of the transition.

Wipe Pattern Variation and Modifiers

You can carry out a wipe with the following variations and modifications to the 
selected pattern. 

For details, see “Setting Wipe Modifiers” (page 403).
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Direction
You can specify the direction of the wipe: the regular direction is referred to as 
“normal,” and the other direction as “reverse.” You can also select alternating 
directions each time the transition is completed (normal/reverse mode).

Split
This splits the pattern, making the parts of the wipe move in opposite 
directions.

The parameter Split No specifies the number of splits.
The parameter Spacing specifies the spacing between adjacent patterns.

Normal Reverse

Split onSplit off
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Edge

You can apply a border to the pattern, soften the edges, or soften the applied 
border.
In an independent key transition, only the “Soft” setting is available.

Border: You can adjust the border width.
Soft: You can adjust the edge softness.
Soft border: You can adjust the border width, and the softness of the inner and 

outer edges of the border.
When a border or soft border is selected, the signal filling the border is called 
edge fill. For the edge fill, you can use a matte generated by the dedicated color 
matte generator, or the signal selected on the utility 2 bus. A matte can include 
color 1 and color 2, and a combination of the two colors (a “color mix”).

Positioner
You can move the wipe pattern to any position.

• The parameter H Position controls the horizontal position of the pattern.
A negative value moves the pattern to the left, and a positive value moves the 
pattern to the right.

• The parameter V Position controls the vertical position of the pattern. 
A negative value moves the pattern down, and a positive value moves the 
pattern up.

Rotation
You can rotate the pattern. There are three rotation modes, as follows.

Border Soft Soft border

Positioner onPositioner off
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Angle
This carries out a wipe with the pattern in a fixed angle.

The parameter Angle determines the angle of pattern rotation. 
A value of –100.00 of the parameter Angle corresponds to one whole turn 
counterclockwise; a value of +100.00 corresponds to one whole turn 
clockwise.
With a value of 0.00 there is no rotation.

Speed
Through the course of the transition the wipe pattern rotates at a fixed specified 
speed.

The parameter Speed determines the speed of pattern rotation. 
A value of –100.00 of the parameter Speed corresponds to one turn per second 
counterclockwise; a value of +100.00 corresponds to one turn per second 
clockwise. With a value of 0.00 the pattern is stationary.

Magnitude
Through the course of the transition the wipe pattern rotates through the 
specified angle. 

Angle off Angle on
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The parameter Angle determines an angle of pattern inclination at the 
beginning of the transition.
• A value of –100.00 corresponds to the angle rotated one whole turn 

counterclockwise.
• A value of +100.00 corresponds to the angle rotated one whole turn 

clockwise.
• With a value of 0.00 the pattern is stationary.

The parameter Magnitude determines an angle of pattern rotation through the 
course of the transition.
• A value of –200.00 corresponds to a rotation of two turns counterclockwise.
• A value of +200.00 corresponds to a rotation of two turns clockwise.
• With a value of 0.00 the pattern is stationary.

Aspect ratio
You can freely change the aspect ratio of the pattern.

A negative value of the parameter Aspect stretches the pattern vertically; a 
positive value stretches the pattern horizontally.

Pattern replication (“Multi”)
The same pattern can be repeated horizontally and vertically or both, up to 63 
times. You can also change the orientation of alternate copies, or change the 
position.

Aspect off Aspect on

“Multi” off “Multi” on
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• The parameter H Multi determines the number of pattern replications 
horizontally, and the parameter V Multi determines the number of pattern 
replications vertically.

• The parameter Shift determines the manner of replication.
At a value of –100.00, the pattern of the adjacent odd-numbered column on 
the left lines up with the central coordinate horizontally.
At a value of +100.00, the pattern of the adjacent odd-numbered column on 
the right lines up with the central coordinate horizontally.

For an independent key transition wipe, you can use the “Invert Type” 
parameter to select from the following four types of replication pattern.

1: All replications in the same orientation
2: Even-numbered rows staggered
3: Even-numbered columns and rows inverted
4: Even-numbered columns and rows inverted, and even-numbered rows 

staggered

Pairing
This slits the pattern into multiple strips, making it like a venetian blind.

H: Create slits in the horizontal direction.
V: Create slits in the vertical direction.
• The parameter Width determines the width of the slits.
• The parameter H Offset determines the spacing in the horizontal direction.

If a negative value is set, the even-numbered pairs of strip and slit move to 
the left, and the odd-numbered pairs move to the right. The value –100.00 
represents the maximum movement.
If a positive value is set, the even-numbered pairs of strip and slit move to 

1 2 3 4

Pairing off Pairing on
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the right, and the odd-numbered pairs move to the left. The value +100.00 
represents the maximum movement.

• The parameter V Offset determines the spacing in the vertical direction.
If a negative value is set, the even-numbered pairs of strip and slit move 
upward, and the odd-numbered pairs move downward. The value –100.00 
represents the maximum movement.
If a positive value is set, the even-numbered pairs of strip and slit move 
downward, and the odd-numbered pairs move upward. The value +100.00 
represents the maximum movement.

Modulation
The pattern signal can be modulated, giving waves on the horizontal or vertical 
edges, or radially. 
The parameter Shape determines the form of the modulation.
1: sine wave, 2: triangular wave, 3: rectangular wave

Note
When using 1080PsF mode in an HD system, the modulation function is not 
available.

Horizontal modulation
This modulates the pattern, applying waviness in the horizontal direction to 
edges.

The parameter Speed determines the speed of waves.
A value of –100.00 generates the maximum downward speed of waves, and a 
value of +100.00 the maximum upward speed.
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Vertical modulation
This modulates the pattern, applying waviness in the vertical direction to 
edges.

The parameter Speed determines the speed of waves.
A value of –100.00 generates the maximum leftward speed of waves, and a 
value of +100.00 the maximum rightward speed.

Fringe
This modulates the pattern, applying waviness in the radial direction to edges.

The parameter Speed determines the speed of waves. 
A value of –100.00 generates the maximum counterclockwise speed of waves, 
and a value of +100.00 the maximum clockwise speed.

Spring
As the transition progresses, the edge of the pattern is subjected to barrel or 
pincushion distortion.

Spring off Spring on
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A negative parameter value produces pincushion distortion, and a positive 
value produces barrel distortion.

Spiral
This deforms the pattern spirally.

• The parameter Magnitude determines the size and direction of the spiral.
A value of –100.00 represents the maximum movement in the 
counterclockwise direction, and a value of +100.00 represents the maximum 
movement in the clockwise direction.

• The parameter Wave Speed determines the speed of the lateral waves.
A value of –100.00 represents the maximum speed to the left, and a value of 
+100.00 represents the maximum speed to the right.

Wipe Snapshots

You can snapshot and save a wipe pattern together with the current settings of 
its modifiers and pattern limit in a dedicated register for recall when required.
There are 10 wipe snapshot registers on each M/E bank and the PGM/PST 
bank. Use the Flexi Pad control block in the bank to save and recall wipe 
snapshots.

For details, see “Wipe Snapshots” (page 421).

For simple transitions (see page 344), there are eight wipe snapshot registers 
on each M/E bank and the PGM/PST bank.

Wipe Modify Clear

By a simple operation, you can return the wipe state to that set in initial status.

Spiral off Spiral on
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For details of the menu operation to return the wipe state to that set in initial 
status, see “Returning to default state in function groupings” (page 300).
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DME Wipes

A DME wipe is a wipe transition that uses a DME effect to change from one 
video image to the next.
There are two types of DME wipe: those which can be selected for a normal 
transition, and those which can be selected for an independent key transition.

For independent key transitions, see page 33.

Types of DME Wipe Pattern

The patterns used for a DME wipe fall into two broad classes.
Preset patterns: predetermined fixed patterns
User programmable DME patterns: patterns which you can create using 

keyframe effects

DME wipe execution mode and pattern numbers that can be used
There are three DME wipe execution modes, depending on the number of 
DME channels available: one-channel mode, two-channel mode and three-
channel mode. The pattern numbers that can be used in these modes are as 
follows.

DME wipe pattern groups
The patterns used in DME wipes fall into the following groups.

For each group (excluding user programmable DMEs), for schematic patterns 
and numbers, see the appendix “DME Wipe Pattern List” (Volume 2). The 
black part of the pattern represents the old video, and the white part the new 
video, with the wipe taking place in the direction of the arrow.

Slide: The new video slides in over the old video.
(Pattern numbers: 1001 to 1008 (one-channel mode), 2601 to 2608 (two-
channel mode))

Execution mode Preset pattern numbers 
that can be used

User programmable DME pattern 
numbers that can be used

One-channel mode 1000 series 1901 to 1999

Two-channel mode 2000 series 2901 to 2999

Three-channel mode 3000 series 3901 to 3999
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Squeeze: The new video appears squeezed over the old video, and 
progressively expands to cover it.
(Pattern numbers: 1021 to 1031 (one-channel mode), 2621 to 2628 (two-
channel mode))

Split: The old video splits, and the new video appears in the gap.
(Pattern numbers: 1011 to 1013 (one-channel mode))

Door: The new video moves like a door closing, and progressively covers the 
old video.
(Pattern numbers: 1041 to 1048 (one-channel mode))

Flip tumble: The old video rotates about an axis and is replaced by the new 
video. During the transition, the signal from the utility 2 bus of the M/E 
bank appears as the background.
(Pattern numbers: 1101 to 1104, 1109, 1110, 1121, 1122, 1124, 1131 to 
1133, 1135 (one-channel mode))

Mirror: The new video appears over the old video as a mirror effect slides in 
all four directions.
(Pattern numbers: 1355 to 1358 (one-channel mode))

Sphere: The new video appears wrapped around a sphere over the old video, 
then returns to the original video while unwrapping.
(Pattern number: 1365 (one-channel mode))

Character trail: The new video appears with a trail over the old video. Next 
this gradually returns to the original from the periphery.
(Pattern numbers: 1371, 1372 (one-channel mode))

Wave: The new video appears with a wave-like effect over the old video. Next 
this returns to the original video as the effect reduces.
(Pattern numbers: 1378, 1379 (one-channel mode))

Ripple: The new video appears over the old video like outwardly moving 
ripples.
(Pattern number: 1381 (one-channel mode))

Page turn: The old video moves like a page turning, and the new video appears 
behind it.
(Pattern numbers: 1301 to 1313, 1315 to 1318, 1341 to 1345 (one-channel 
mode), 2701 to 2713, 2715 to 2718, 2741 to 2745 (two-channel mode))

Page roll: The new video unrolls like a scroll over the old video. This is a type 
of page turn.
(Pattern numbers: 1321 to 1333, 1335 to 1338, 1346 to 1350 (one-channel 
mode), 2721 to 2733, 2735 to 2738, 2746 to 2750 (two-channel mode))

Frame in-out: Completed in two transitions. In the first transition, the new 
video appears, then on the second transition the new video goes out and the 
old video returns.
(Pattern numbers: 1201 to 1208, 1221 to 1224 (one-channel mode), 2851 
to 2854, 2861 to 2864 (two-channel mode))

Picture-in-picture: The one-channel mode and two-channel mode differ as 
follows.
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In one-channel mode, this completes in two transitions. In the first 
transition, the old video shrinks, and the new video appears behind it.
In the second transition, the old video expands again until it is its original 
size.
(Pattern number: 1251 (one-channel mode))
In two-channel mode, in the first half of the transition, the old video 
shrinks, and the new video appears. In the second half of the transition, the 
new video expands, and the old video disappears. You can move the 
pattern from the current position by a relative amount. During the 
transition, the signal from the utility 2 bus of the M/E bank appears as the 
background.
(Pattern numbers: 2651 and 2652 (two-channel mode))

2D trans: The new video appears over the old video, while undergoing 
expansion, two-dimensional rotation and translation.
(Pattern numbers: 1051 to 1058, 1061 to 1064, 1068 (one-channel mode))

3D trans: In one-channel mode, the new video appears over the old video, 
while undergoing expansion, three-dimensional rotation and translation.
(Pattern numbers: 1071, 1072, 1074, 1076, 1077, 1088, 1091 to 1094 (one-
channel mode))
In two-channel mode, the old video changes to the new video while both 
undergo expansion, three-dimensional rotation and translation.
(Pattern numbers: 2631 to 2634, 2642, 2644 (two-channel mode))

Sparkle: The new video appears over the old video with a nonlinear effect 
applied, such as broken glass, explosion, or melt. Next this returns to the 
original video as the effect gradually reduces.
(Pattern numbers: 1391, 1393, 1394, 1396, 1398, 1399 (one-channel 
mode))

Split slide: The new video appears in strip form while sliding interleaved in the 
opposite direction over the old video.
(Pattern numbers: 1384 to 1389 (one-channel mode))

Mosaic: In the first half of the transition, a mosaic is gradually applied to the 
old video, then at the 50% point the inner image changes to the new video. 
In the second half, the mosaic effect on the new video is gradually reduced, 
returning to the original image at 100%.
(Pattern number: 1701 (one-channel mode))

Defocus: In the first half of the transition, the old video is gradually defocused, 
then at the 50% point the inner image changes to the new video. In the 
second half, the defocusing effect on the new video is gradually reduced, 
returning to the original image at 100%.
(Pattern number: 1702 (one-channel mode))

Brick: In two-channel mode, a brick such that the side surface is visible slides 
in over the old video, then rotates so that the new video can be seen.
(Pattern numbers: 2801 to 2804, 2811 to 2814 (two-channel mode))
In three-channel mode, a brick appears over the old video as the image is 
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expanding and rotating, and switches to the new video.
(Pattern number: 3601 (three-channel mode))

User programmable DME: Using a DME keyframe effect created with a 
keyframe operation, this executes a DME wipe.
(Pattern numbers: 1901 to 1999 (one-channel mode), 2901 to 2999 (two-
channel mode), 3901 to 3999 (three-channel mode))

For details of creating keyframe effects, see “Creating User 
Programmable DME Patterns” (page 442).

Notes 
• To use the Split, Page Turn, and Page Roll effects on the MVE-8000 requires 

the optional MKS-8830M Nonlinear Effect Board.
• In an independent key transition, the following patterns can be used.

User programmable DME in transition mode
For the transition mode set when creating a keyframe effect for a user 
programmable DME pattern, the following can be used.

• Single: single transition mode
• Flip tumble (Flip Tumble): flip tumble transition mode
• Dual: dual transition mode
• Picture-in-picture (PinP): one-channel and two-channel picture-in-picture 

transition mode
• Compress: a type of picture-in-picture, in which the new image is the 

background, and the currently visible image shrinks, and then expands to its 
original size. (See example in the next item.)

• Frame in-out (Frame I/O): frame in-out transition mode. When the first 
transition completes, if you move the position of the image, you can move it 
both horizontally and vertically.

• Frame in-out H (Frame I/O H): a type of frame in-out mode, which is 
specified when creating a transition effect in the horizontal direction.
The image movement is reflected at both the transition start point and end 
point. (See page 72.)
The operation is carried out according to DME wipe patterns 1202, 1203, or 
1204.

• Frame in-out V (Frame I/O V): a type of frame in-out mode, which is 
specified when creating a transition effect in the vertical direction.
The image movement is reflected at both the transition start point and end 
point. (See page 73.)

Execution mode DME wipe patterns that can be used

One-channel mode Slide, split, squeeze, door, 2D trans, 3D trans, frame in-out, 
page turn, page roll, mirror, sphere, character trail, wave, ripple, 
split slide, sparkle, user programmable DME

Two-channel mode Page turn, page roll
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Transition mode “Compress”
The change in the image when the transition mode is set to “Compress” is as 
follows, in comparison to the case of “Picture-in-picture.”

• Example of the image change in the transition mode “Picture-in-
picture” (one-channel mode)

• Example of the image change in the transition mode “Compress”

Transition mode “frame in-out”
In this mode, when the first transition has completed, you can move the image 
with the positioner in both horizontal and vertical directions, but the image 
position at the transition start point and end point does not change.
The description is of an example of creating an effect such as the following.

Second strokeFirst stroke

First stroke Second stroke
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At the first transition completion point, if you move the image with the 
positioner, the transition appears as in the following figure.

Transition mode “frame in-out H”
This mode is specified when creating a transition effect in the horizontal 
direction.
In this mode, when the first transition has completed, you can move the image 
with the positioner in both horizontal and vertical directions. The image at the 
transition start point and end point also moves.
The description is of an example of creating an effect such as the following.

Transition start Transition end
First transition 
completion point

Image created 
by interpolation

Background B

Background A

Effect execution

State before 
modification

Image created 
by interpolation

Background B

Background A

Transition start Transition end
First transition 
completion point

Effect execution
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At the first transition completion point, if you move the image with the 
positioner, the transition appears as in the following figure.

Transition mode “frame in-out V”
This mode is specified when creating a transition effect in the vertical 
direction.
In this mode, in the state at completion of the first transition, you can move the 
image with the positioner in both horizontal and vertical directions. The image 
at the transition start point and end point also moves.
The description is of an example of creating an effect such as the following.

Transition start Transition end
First transition 
completion point

Image created 
by interpolation

Background B

Background A

Effect execution

State before 
modification

Image created 
by interpolation

Background B

Background A

Transition start Transition end
First transition 
completion point

Effect execution
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At the first transition completion point, if you move the image with the 
positioner, the transition appears as in the following figure.

Transition start Transition end
First transition 
completion point

Image created 
by interpolation

Background B

Background AEffect execution

State before 
modification

Image created 
by interpolation

Background B

Background A

Transition start Transition end
First transition 
completion point

Effect execution
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Signals forming part of the background for a DME wipe

For a two-channel mode page turn, page roll, brick, frame in-out, and so on, the 
part of the pattern shown in gray (see Appendix (Volume 2)) is filled with the 
signal selected on the DME external video bus.
For three-channel mode brick, the part of the pattern shown in dark gray is 
filled with the DME external video signal, and the light gray portion with the 
signal selected as follows.

For a DME dedicated interface
When the DME channel used is 3 or 4, the signal selected on the DME utility 
1 bus. For channel 7 or 8, the signal selected on the DME utility 2 bus.

For an MVE-8000A or MVE-9000 SDI interface
Signal selected on the AUX bus assigned in the Engineering Setup >Switcher 
>Device Interface >DME Type Setting >DME SDI interface menu. (The AUX 
bus is determined by which DME channel is being used.)

DME Wipe Pattern Variation and Modifiers

You can modify the selected DME wipe pattern in the same way as an ordinary 
wipe pattern, as follows.

For the setting operations, see “Setting DME Wipe Modifiers” (page 429).

Direction: You can set the DME wipe direction to normal, reverse, or 
alternating normal/reverse (page 58), except for a key transition, which is 
always in normal/reverse mode.

Edge: You can apply a border or soft border (see page 59). For key DME 
wipes, however, this modifier cannot be used with any DME wipe patterns 
other than the user programmable DME wipe patterns. 
In the case of those user programmable DME patterns for keys in which an 
edge has already been applied to the effect, the bahavior is as follows.
• When the DME wipe edge setting is on, only part of the edge applied in 

the effect is enabled, and that portion can be adjusted (page 430).
• When the DME wipe edge setting is off, the edge applied in the effect is 

enabled as is.
Edge cannot be used for DME wipes in the independent key transition 
control block.

Positioner: 
• 1031, 1201 to 1208, 1221 to 1224, 1251, 1381, 1391, 1393, 1394, 1396, 

2651, 2652, 2801 to 2804, 2811 to 2814, 2851 to 2854, 2861 to 2864
When one of the above DME wipe pattern numbers is selected, with the 
progress of the transition, the center of the pattern automatically moves 
from its initially set position toward the center of the image (see page 
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59). That is to say, the same effect is obtained as in a normal wipe when 
the positioner is set to “AUTO CENTER.” Again, by using the position 
select function, you can move the pattern instantaneously.

• 2651, 2652
When either of the above pattern numbers is selected, you can move the 
patterns on the two channels simultaneously by a relative amount from 
the current position.

Pattern limit: You can restrict the range of the transition as desired. However, 
this is not available for a DME wipe in the independent key transition 
control block. 

For more details, see “Pattern Limit” (page 327).

Size: This can only be used when one of the following pattern numbers is 
selected.
• 1201 to 1208, 1221 to 1224, 1251
• 2651, 2851 to 2854, 2861 to 2864 

You can set the size of the image.
Crop: You can crop the image. It is also possible in 16:9 mode to crop both 

sides, to convert the image to a 4:3 aspect ratio. For the execution of a 
DME wipe crop transition, you can select from the following three 
possibilities.
• Cut
• Last 5%
• Linear
When [Last 5%] is selected, you can set the [Release Transition] as 
follows. 
• Last 30%
• Last 5%
• Off

Note
When pattern numbers 1701 and 1702 are selected, crop cannot be used.

Relation Between DME Wipes and Other Effects

The relations between DME wipes and other effects are as follows.

Relation to ordinary wipes
• DME wipes do not use the wipe generator built into the switcher. Therefore, 

during the execution of a DME wipe, you can still use a pattern produced by 
the wipe generator as the source for a pattern key or mask.

• A DME wipe pattern cannot be used as the source for a pattern key or mask.
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Relation to processed keys

When using the DME for a processed key, if you select a DME wipe, an 
available DME is automatically allocated to the DME wipe. If all of the DME 
channels are in use, then it is not possible to select a DME wipe.
If in a Setup menu a setting has been made for DME allocation, that Setup 
menu setting takes precedence (see “Setting the assignments of DME channels 
to use on the individual M/E banks” in Chapter 16 (Volume 2).

Number of DME wipes that can be used simultaneously on a 
single M/E bank

DME wipes can be used in five places, including the four independent key 
transitions. When the DME dedicated interface is used, a maximum of two 
DME wipes can be used simultaneously, and when the SDI interface is used, 
only one DME wipe can be used at one time.

DME Wipe Snapshots

You can snapshot and save a DME wipe pattern together with the current 
settings of its modifiers and pattern limit in a dedicated register for recall when 
required.
There are 10 DME wipe snapshot registers for each of the M/E and P/P banks. 
To save and recall these registers, use the Flexi Pad control block in each 
switcher bank. (See “DME Wipe Snapshots” (page 441).)
In the case of a simple transition system, there are eight DME wipe snapshot 
registers for each switcher bank.

DME Wipe Modify Clear

By a simple operation, you can return the DME wipe state to that set in initial 
status.

For details of the menu operation to return the DME wipe state to that set in 
initial status, see “Returning to default state in function groupings” (page 
300).
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Frame Memory

Overview

Frame memory is a function whereby a frame of input video can be frozen and 
written to memory, for further use as material for editing. 
You can also play recorded frame memory clips (movies).

Frame capacity
The maximum number of images that can be written to memory is as follows.

MVS-8000 system
HD system: 58 frames (88 frames in 720p/59.94 format)
SD system: 222 frames

MVS-8000A system
HD system: Approx. 1,000 frames (approx. 2,000 frames in 720p/59.94 

format)
SD system: Approx. 5,000 frames in 480i/59.94 format, and approx. 4,000 

frames in 576i/50 format

For details of operations, see “Still Image Operations” (page 448).

Types of image and terminology used
The following types of image are handled in frame memory.
Freeze image: An input image that has been frozen, but not saved to memory.
Still image: A freeze frame that has been saved to memory as a file. Each file 

(still file) holds just one still image.
Frame memory clip: A clip consists of a sequence of still images, which 

appears as a movie on playback. In this manual this is also referred to 
simply as a “clip.” The files (still files) constituting clips are referred to as 
a “clip file.”

When the above distinctions are not being made, an image is simply referred 
to as an “image.”

Use of frame memory
There are eight frame memory channels, FM1 to FM8, and each channel 
independently allows a freeze image to be saved or recalled.
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By allocating FM1 to FM8 to cross-point buttons you can use the still image 
output or clip output from each channel as input material.

Correspondence between input and output
There are two buses for capturing frame memory material: the frame memory 
source 1 bus and the frame memory source 2 bus.
These input buses are used by allocation to one of the pairs of output, FM1&2, 
FM3&4, FM5&6, and FM7&8. You can freeze a frame in each channel 
separately, or freeze in the two channels simultaneously.
The source buses allocated to FM1 to FM8 are as follows.

Pair mode
By enabling the pair mode, you can link FM1 and FM2, FM3 and FM4, FM5 
and FM6, and FM7 and FM8. For example, when a freeze or image processing 
is carried out on FM1, the same operation is carried out on FM2. The same 
applies to the other pairs. When a pair of images are captured in pair mode, the 
image frozen in FM1 (3, 5, or 7) is referred to as the main file and the other 
frozen in FM2 (4, 6, or 8) is referred to as the sub file. 

Pair files and single files
A file that can be recalled in pair mode is termed a “pair file.” A pair file can 
be created by setting pair mode and capturing an image, or by using the pair 
combination coupling function (see page 83) to combine two single files.
A file other than a pair file is termed a “single file.” A single file can be created 
by switching off pair mode and capturing an image, or by using the pair 
combination separation function (see page 83) to split a pair file.

Operation modes
The frame memory has the following operation mode. 
V/K mode: When the pair mode is active, the key signal is automatically 

selected on frame memory source bus 2. This is convenient for handling 
the video and key signals together in frame memory. For example, when 
you select a video signal on frame memory source bus 1, the key signal 
assigned to it is automatically selected on frame memory source bus 2. You 

Input Frame memory source bus 1 Frame memory source bus 2

Output FM1 FM2

FM3 FM4

FM5 FM6

FM7 FM8
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can also use the signal automatically selected on frame memory source bus 
2 as a key signal when processing keyframe memory 1.

To change the pair mode or operation mode, use the Frame Memory menu.

Still Image File Functions

The frame memory functions provides the following still image file functions.
• Freezing an input image
• Saving a still image
• Recalling a still image
• Processing an image
• Image output
• Continuously capturing images (record)
• Recalling a continuous sequence of images (animation)

Capturing an input image (freeze)
As the input material for the frame memory, you can use the signal selected on 
the frame memory source bus. For this signal you can use video processing 
(video levels or hue value adjustment) or masking.

Allocating a frame memory source bus signal to one of FM1 to FM8, then 
carrying out a freeze captures a still image in the corresponding frame memory 
output image, and saves it in temporary memory.
For a freeze, an image can be captured either as video frame (a “frame freeze”) 
or a video field (“field freeze”).

Note
When the system is powered off, any freeze images written to temporary 
memory are lost.

Saving a still image (store)
You can save an image in temporary memory which has been placed with the 
freeze function as a file in memory. You can save a single image in a single file 
and apply a name of up to eight characters to the file.
When the system is powered off, all the files saved in memory are erased.

Freeze and store mode
When this mode is set to On, the freeze and store operations occur 
simultaneously. You can set it to On in the Frame Memory >Still >Freeze/Store 
menu (see page 455).
Frame Memory



  C
hapter 1 

M
V

S
-8000 F

unctions

Recalling a still image (recall)

You can recall an image file saved in memory, and allocate to any of the FM1 
to FM8 outputs.

Processing an image
You can combine the background image (a still image file allocated to any of 
FM1 to FM8, a freeze image written to temporary memory, or a black signal) 
and the input signal.
The following types of processing are available.
Pattern key: Using the signal from a dedicated pattern generator, you can cut 

out the background image and insert the signal selected on the frame 
memory source bus or a color matte signal. You can adjust the size and 
position of the pattern, and add modifiers.

External key: When processing an image in FM1 (3, 5, 7), you can use the 
signal selected on the frame memory source bus 2 to cut out the 
background image, and fill with the signal selected on the frame memory 
source bus 1, or a color matte signal.
When processing an image in FM2 (4, 6, 8), you can use the signal selected 
on the frame memory source bus 2 to cut out the background image, and 
fill with a color matte signal (always white).

Note
An external key can only be used when the pair mode is enabled (see page 
79).

MIX: Mix the background image with the signal selected on the frame memory 
source bus or color matte signal. The mix ratio can be set.

NAM: Non-additive mix the background image with the signal selected on the 
frame memory source bus or color matte signal.

Image output

Moving the output image (reposition function)
For up to two channels of FM1 to FM8 (one from FM1, FM3, FM5 and FM7 
and the other from FM2, FM4, FM6 and FM8), you can move the output image 
with respect to the screen. The area of the screen around the image that has 
been moved is filled with black. There are two ways of carrying out this 
repositioning.
Normal mode: Movement in the horizontal direction is in two-pixel 

increments.
Black and white mode: Movement in the horizontal direction is in one-pixel 

increments, and for each pixel moved the color is inverted.
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Note
It is not possible to save an image moved with the reposition function directly 
to frame memory.

Fixing the output image selection (lock function)
For the output of each of FM1 to FM8, this fixes the image at the current 
output. When this lock is enabled, even if the output is recalled in a snapshot 
or keyframe, the images output to FM1 to FM8 are preserved.

Continuously capturing still images (record)
You can continuously capture (freeze) a sequence of input video frames and 
store the sequence of the still images over a specified time interval.
The name of each image recorded in this way consists of a first character string 
followed by a second string.
First character string: A common part of name assigned to all the still images 

captured in one record operation. This string includes a maximum of four 
characters, which can be specified using a menu before carrying out the 
capture. The first string is automatically used as the clip name when the 
images are treated as a frame memory clip. 

Second character string: A four-digit number (0000 or greater), which is 
incremented each time a still image is captured.

Note 
When using the record function to continuously capture frames, it is not 
possible to use the mask function.

Recalling a continuous sequence of still images (animation)
You can use a continuous sequence of images captured with the record function 
as keyframes to create an effect. By executing this effect you can recall the 
continuous sequence (animation).

Notes 
• For example, to create an effect using FM1, FM1 must be assigned to a user 

region. (For details of user region settings, see “Settings for Switcher 
Configuration (Config Menu)” in Chapter 16 (Volume 2).)

• To execute the effect, you must assign the user region to which FM1 is 
assigned to a region selection button in the numeric keypad control block. 
(For details of assigning to region selection buttons in the numeric keypad 
control block, see “Overall Control Panel Settings (Config Menu)” in 
Chapter 16 (Volume 2).)

In the Frame Memory menu, effect creation follows the image file names. Of 
the eight characters in the file names, if files have the same characters except 
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for  the last three characters they are treated as an image file group, and the 
effect is created with the last three (numeric) characters in sequence.

Note 
When creating the effect in pair mode (see page 79), the files used must be 
main files and sub files with the same last three (numeric) characters in the file 
name.

Frame Memory Clip Function

What is a “frame memory clip”?
By recalling images captured with the record function as a sequence of frames, 
they can be treated as a movie.
A frame memory clip can be named using up to four characters.

For details of frame memory clip names, see “Continuously capturing still 
images (record)” (page 82).

Capturing frame memory clips
To capture a frame memory clip, use the continuous capture (record) function 
for still images.

Playing frame memory clips
Images captured with the record function can be recalled sequentially. 
Playback is fixed at normal speed play.

Image Data Management

File management
The following operations are possible on files created to hold images.
Delete: Specify a file to be deleted. It is also possible to delete all files 

simultaneously in a single operation.
Rename file: Change the name of the specified file.
Backup: Save all files to hard disk in a single operation.
Restore: Restore the files which have been backed up.

Pair file processing
Couple: You can create a pair file from two single still image files or clip files.
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Separate: You can also separate a pair file into two single still image files or 
clip files.

Image Data Transfer

Files can be transferred between such devices as a hard disk and memory card. 
In the File menu, files can be saved and recalled.
It is possible to import images such as BMP files or convert frame memory files 
into a different format and save them in an external device.

For details, see Chapter 17 “Files” (Volume 2).

Notes on transferring multiple still images together
• Transferring all of the still image files within frame memory together fails if 

the capacity of the memory card is too small to hold all of the images. In this 
case, replace with a larger capacity memory card, or delete still images until 
saving is possible.
The following table roughly shows the relation between memory card 
capacity and number of images that can be saved.

a) For all available signal formats except 720p

Note that when transferring to the hard disk, there is ample capacity, so that 
problems such as this do not occur.

• If you cancel the operation during a data transfer between frame memory and 
hard disk or memory card, then an image which was not completely 
transferred will not be reproducible. Avoid canceling such operations.

• When loading a still image file from hard disk or memory card, if [Freeze 
Enable] in the Freeze menu is on, the loaded still image file may sometimes 
be overwritten by the frame memory input image.
To avoid this when loading a file, ensure that [Freeze Enable] is turned off.

Notes on saving or recalling a frame memory still image for or by 
a snapshot/keyframe 
• The saving and recalling of frame memory images for snapshots and 

keyframes is restricted to the still images or clips on the eight frame memory 
outputs. The settings made for frame memory images in the Freeze menu, 
Composite menu or other menus do not apply to snapshots or keyframes.

• To reproduce a frame memory still image or a clip of them by recalling a 
snapshot or keyframe, you must have the same images that were present in 
the frame memory when you saved the snapshot or keyframe. Therefore, 

Memory card capacity Number of images that can be saved

SD system HD system a)

256 MB 214 46
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when saving a snapshot or keyframe using frame memory, you must also 
save the images to a storage media such as the hard disk.

External Hard Disk Drive Access

In an MVS-8000A system, you can connect a hard disk drive to the IEEE1394 
port of the switcher processor, to carry out the following operations.
Format: Format the hard disk.
Backup: Batch saving of files from frame memory to the hard disk.
Restore: Restoring frame memory from files saved on the hard disk.
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Color Backgrounds

The dedicated generators generate color signals, and these can be used as color 
backgrounds in video effects.

Color background selection
There are two color backgrounds, color background 1 and color background 2, 
which you use by assigning to cross-point buttons.

Color combinations (“color mix”)
The color generators can output the result of combining two colors, which are 
color 1 and color 2.
Using a pattern from a dedicated pattern generator, color 1 and color 2 can be 
combined in the boundary region, forming a color gradation. This is referred to 
in the menu system as “color mix.”
You can also apply modifiers to the selected pattern.
When the “color mix” function is not used, the result is a flat color, and color 
1 is always output.

For details of operations, see “Color Background Setting Operations” (page 
482).
Color Backgrounds
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Copy and Swap

You can copy and swap the settings among the M/E-1 to M/E-3, and PGM/PST 
banks or between keyers.
The following settings can be copied or swapped.
• Overall settings for the M/E-1 to M/E-3, and PGM/PST banks
• Keyer settings
• Wipe settings in a transition control block
• Wipe settings in an independent key transition control block
• DME wipe settings in a transition control block
• DME wipe settings in an independent key transition control block
• Matte data (color 1, color 2, and how to compose them)
• Color settings
• DME channel settings

You can carry out copy operations with a simple button operation. Swap 
operations, and copy operations on DME data can only be done with a menu 
operation.

For details of the operations, see Chapter 9 “Copy and Swap” (page 487) and 
for color correction settings, “Copy and Swap Operations” in Chapter 19 
(Volume 2).

M/E copy and M/E swap
You can copy and swap the overall bank settings among the M/E-1 to M/E-3, 
and PGM/PST banks.

Note
If a DME is being used on the source M/E bank, then if for example there are 
insufficient DME channels, it may not be possible to select the DME.
There are no such restrictions on a swap.

Target bank Target data

M/E-1
M/E-2
M/E-3
PGM/PST

Bank settings excluding the following data items:
• Setup data
• Flexi Pad settings
• Snapshots
• Keyframe effects
• Key snapshots
• Key memory
87Copy and Swap
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Keyer copy and keyer swap
You can carry out copy and swap operations among the 16 keyers listed in the 
following table.

Note
If a DME is being used on the source keyer for a copy or either keyer for a 
swap, then if for example there are insufficient DME channels, or the limit on 
using DME channels within an M/E bank is exceeded, it may not be possible 
to select the DME.

Wipe copy and wipe swap
You can copy and swap the wipe settings among the banks listed in the 
following table.

Wipe copy and wipe swap in the independent key transition 
control block

You can copy and swap the wipe settings among the 16 keyers listed in the 
following table.

DME wipe copy and DME wipe swap
You can copy and swap the DME wipe settings among the banks listed in the 
following table.

Target bank Target keyer Target data

M/E-1
M/E-2
M/E-3

Keys 1 to 4 Key settings excluding the following data 
items:
• Setup data
• Key snapshots
• Key memoryPGM/PST Downstream keys 1 to 4

Target bank Target data

M/E-1
M/E-2
M/E-3
PGM/PST

Wipe settings.
It is not, however, possible to carry out copy or swap involving 
independent key transition wipe settings.

Target bank Target keyer Target data

M/E-1
M/E-2
M/E-3

Keys 1 to 4 Wipe settings in the independent key 
transition control block.
It is not, however, possible to copy or 
swap wipe settings to or from an external 
downstream keyer.PGM/PST Downstream keys 1 to 4
Copy and Swap
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DME wipe copy and DME wipe swap in the independent key 
transition control block

You can copy and swap the DME wipe settings among the 16 keyers listed in 
the following table.

Matte data copy and swap
You can copy or swap the matte data among the 38 color generators listed in 
the following table.

Color data copy and swap
You can copy or swap the color data among the 152 color generators listed in 
the following table.

Target bank Target data

M/E-1
M/E-2
M/E-3
PGM/PST

DME wipe settings.
It is not, however, possible to carry out copy or swap involving 
independent key transition DME wipe settings.

Target bank Target keyer Target data

M/E-1
M/E-2
M/E-3

Keys 1 to 4 DME wipe settings in the independent 
key transition control block.

PGM/PST Downstream keys 1 to 4

Target bank Target keyer and data

M/E-1
M/E-2
M/E-3
PGM/PST

• Keys 1 to 4
• Downstream keys 1 to 4

• Matte data for key fill
• Matte data for key edge fill

Matte data for wipe border edge

Color background • Matte data for color background 1
• Matte data for color background 2

Target bank Target keyer and data

M/E-1
M/E-2
M/E-3
PGM/PST

• Keys 1 to 4
• Downstream keys 1 to 4

• Colors 1 and 2 for key fill
• Colors 1 and 2 for key edge fill
• “Zabton” color data

Colors 1 and 2 for wipe border

Color data for preset color mix

Color background • Colors 1 and 2 for color background 1
• Colors 1 and 2 for color background 2

Frame memory • FM1 color
• FM2 color
89Copy and Swap
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DME channel copy and swap
You can copy and swap the channel data among DME channels 1 to 4 or DME 
channels 5 to 8.
It is not possible to copy or swap the channel data between DME channels 1 to 
4 and DME channels 5 to 8.

DME ch1 to ch8 • Background
• Border
• Sepia
• Light
• Shade
• Drop shadow (other than DME ch4 and DME ch8)
• Trail

Target bank Target keyer and data
Copy and Swap
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Side Flags

Overview

The term “side flags” refers to the areas to left and right of an image with aspect 
ratio 4:3 embedded within a 16:9 frame, when these areas are filled with a 
separate image selected from the utility 1 bus. (See following figure.)
You can adjust the width of the side flag area.

Note 
The side flag function is only supported on the MVS-8000A.

Side Flag Settings

To use the side flags, the following settings are required.

Input source with aspect ratioImage to fill the side flag 
areas (selected from utility 1 
bus) Turn the side flag 

function on

Side flag area Side flag area
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Input source aspect ratio, auto side flags, and auto crop settings

Aspect ratio 4:3 setting
Set the input signal to aspect ratio 4:3. If set to 16:9, the side flags are disabled.

Auto side flag setting
This function automatically applies side flags when a 4:3 signal is selected in 
the cross-point control block.

Auto crop setting
When carrying out a DME wipe, this function automatically crops the image 
during transition to 4:3.

Adjusting the width of the side flag area
You can set the left and right sides separately.

For the operation for the above setting, see “Settings for Switcher 
Configuration (Config Menu)” in Chapter 16 (Volume 2).

Side flag enable/disable setting
Using the Misc menu or a button operation, you can enable or disable the side 
flags for the background bus of each of the M/E-1 to M/E-3 and PGM/PST 
banks.

For more details, see “Side Flag Settings” (page 494).

Assigning the side flag function to a cross-point button
To switch the side flags on and off with a button operation, it is first necessary 
to assign [SIDE FLAG] to the rightmost cross-point buttons.

For more details, see “Cross-Point Settings (Xpt Assign Menu)” in Chapter 16 
(Volume 2).

Wipe Action on Images With Side Flags

When a wipe is carried out on an image with side flags, all wipe patterns can 
be used.
The following illustration shows the action in a wipe.
Side Flags
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Wipe from a 4:3 image to a 16:9 image

Wipe from a 4:3 image to another 4:3 image (when side flags are 
on for both images)

DME Wipe Action for an Image With Side Flags

When a DME wipe is carried out on an image with side flags, all wipe patterns 
can be used.
Depending on the setting (On/Off) of [Auto Crop] in the Engineering Setup 
>Switcher >Config menu, the appearance of the 4:3 image changes.

Notes
• When using the MVE-9000/MVE-8000A through SDI interface with [Auto 

Crop] being off, side flags are not added to the new image during DME wipe.
• For signals with the following DME wipe pattern selected on the DME 

external video bus (gray part shown in the pattern illustration), side flags are 
not applied when auto side flags are set to Off.
– Two-channel page turn
– Two-channel page roll

Side flag areas

4:3 image (Side flags on)

16:9 image

Side flag areas

4:3 image (Side flags on) The circles indicate the 
position of the wipe pattern 
edge when the transition is 
half finished.

Side flag areas
93Side Flags
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– Two-channel frame in-out
– Two-channel brick
– Three-channel brick

The following illustration shows the action in a DME wipe.

DME wipe from a 4:3 image to a 16:9 image

Wipe action using slide (No. 1001)

Auto crop on

4:3 image (Side flags on)

Auto crop off
Side flag area

16:9 image

Side flag areas
Side Flags
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DME wipe from a 4:3 image to another 4:3 image (when side flags 
are on for both images)

Wipe action using squeeze (No. 1031)

a) When using the MVE-9000/MVE-8000A through SDI interface, side flags are not added during 
a DME wipe.

Auto crop on

4:3 image (Side flags on)

Auto crop off
Side flag areas a)

4:3 image (Side flags on)

Side flag areas

Side flag areas
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Video Process

The term “video process” is applied to adjustments to the luminance and hue 
of the input video signal.
There are two types of adjustment, depending on the application:
• Adjustment of an individual primary input signal
• Image effects on a particular bus

Note
These types of adjustment may be carried out independently. However, since 
they are implemented by the same hardware, if the same signal is subjected to 
processing twice, there may be limitations on the range of effects obtained in 
the final result.

Video Process Adjustments of a Primary Input Signal

For each of primary inputs 1 to 80, you can switch video process adjustments 
on or off, and can adjust the parameters (Video Gain, Y Gain, C Gain, Hue 
Delay, and Black Level) in the Setup menu. The adjustments do not, however, 
apply to the output video on the MON (monitor) bus.

For details of the settings, see “Signal Input Settings” in Chapter 16 (Volume 
2).

Video Process Adjustments on a Particular Bus

Buses to which the adjustments apply
For each of the following buses, you can switch video process adjustments on 
or off, and adjust the parameters.
• Following buses in the M/E-1 to M/E-3, and PGM/PST banks

– Key fill buses for keys 1 to 4
– Background A and background B buses
– Utility 1 and utility 2 buses

• Frame memory source 1 and frame memory source 2 buses
• Aux 1 to 48 buses
These settings also apply to keyframes and snapshots.
Video Process
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Making the adjustments
Adjust VIDEO GAIN, Y GAIN, BLACK LEVEL, C GAIN, and HUE DELAY 
in the following menus.

Video Process Memory

When using video process adjustments for an image effect on a bus, this 
function saves the final values for each pair number for the signals. The video 
process on/off setting is not saved.
When you change the adjustments the values are automatically saved, and 
these last values are recalled when the pair number is selected.
In other words, by switching video process memory on, regardless of the video 
process information for each bus, you can carry out video process adjustments 
for each input signal.
The parameters saved are as follows.

VIDEO GAIN, Y GAIN, BLACK LEVEL, C GAIN, HUE DELAY

Switch the video process memory on or off in the Setup menu.

For details of setting operations, see “Settings Relating to Keys, Wipes and 
Frame Memory (Key/Wipe/FM Menu)” in Chapter 16 (Volume 2).

Applicable bus Menu used for operation See page

M/E-1 to M/E-3 
banks

Key fill buses for keys 
1 to 4

M/E-1 to M/E-3 menus page 377

Background A and B 
buses

Video Process menu page 501

Utility 1 and 2 buses

PGM/PST bank Key fill buses for 
DSK1 to DSK4

PGM/PST menu page 377

Background A and B 
buses

Video Process menu page 501

Utility 1 and 2 buses

Frame memory source 1 and 2 buses Frame Memory menu page 456

Aux 1 to 48 buses AUX/MON menu page 499
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Digital Multi Effects (DME)

DME allows you to add three-dimensional effects such as image movement, 
rotation, magnification and shrinking, as well as a wide variety of special 
effects. DME is the general name for all of these effects.
You can use up to eight channels as dedicated DME channels. Each channel 
can be used on its own or in combination with other channels, which allows 
you to create advanced effects with more complexity.

Functions that can be used differ with the models of DME. For details, see 
“Functional Differences With Models of DME” in the Appendix (Volume 2).

MVE-8000A Multi Format DME Processor
The MVE-8000A is a “Digital Multi Effects” with multi-format support.
For the MVE-8000A, a dedicated interface (MKE-9020M) is available to 
enable the MVE-8000A to be used in an MVS-8000 series switcher. 
Installation of an optional MKE-8021A Input/Output Board in the MVE-
8000A provides an SDI interface.

Note 
When using the SDI interface, the following operations are required.
• Setting the interface between the MVE-8000A and the switcher.

See “Setting the interface between the DME and the switcher” in Chapter 16 
(Volume 2).

• Setting the input signals from the switcher to the MVE-8000A (AUX bus 
outputs), and signals returned to the switcher as primary inputs (reentry 
inputs). However, “Ext In” cannot be set for the DME channel.

See “Setting the AUX bus output and reentry input” in Chapter 16 (Volume 
2).

• Selecting the combiner channels not in the key control block, but in the 
Global Effect menu.

See “Combiner Settings” in Chapter 11 (Volume 2).

MVE-9000 Multi Format DME Processor
The MVE-9000 is a “Digital Multi Effects” with multi-format support.
Two interfaces are available for the MVE-9000: a dedicated interface (MKE-
9020M) for use in an MVS-8000 series switcher, and an SDI interface (MKE-
9021M).
Digital Multi Effects (DME)
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Note
When using the SDI interface, the following operations are different from 
when using the dedicated interface.
• Setting the input signals from the switcher to the MVE-9000 (AUX bus 

outputs), and signals returned to the switcher as primary inputs (reentry 
inputs).

See “Setting the AUX bus output and reentry input” in Chapter 16 (Volume 
2).

• Selecting the combiner channels not in the key control block, but in the 
Global Effect menu.

See “Combiner Settings” in Chapter 11 (Volume 2).

Three-Dimensional Transformations

Transformation is the process of placing a video image in a three-dimensional 
DME coordinate space and subjecting it to manipulations such as movement, 
rotation, magnification or shrinking.

Three-dimensional coordinate space

Source coordinate space and target coordinate space
Images are placed in one of two types of coordinate space: source coordinate 
space and target coordinate space.
• The source coordinate space is a three-dimensional coordinate space with 

reference to the image itself. The x- and y-axes are defined parallel to the 
plane of the image, and the z-axis is defined perpendicular to the plane of the 
image. When you move the image, the coordinate axes also move.

• The target coordinate space is a three-dimensional coordinate space with 
reference to the output monitor screen. The x- and y-axes are defined parallel 
to the plane of the monitor screen, and the z-axis is defined perpendicular to 
the plane of the monitor screen. The coordinates do not move even if the 
image moves.
99Digital Multi Effects (DME)
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Source coordinate space and target coordinate space

For example, as shown in the following figure, the image moves in a different 
direction when you move it along the x-axis of the source coordinate space and 
along the x-axis of the target coordinate space. 

Movement along the x-axes of the source 
coordinate space and target coordinate space

Local coordinate space and global coordinate space
The coordinates of an individual DME channel are called its local coordinate 
space. The coordinates common to all channels are called the global coordinate
space.
By switching from local to global coordinate space, you can add new 
movement to the movement of images in individual channels, and also apply 
transformation effects to multiple channels that have been combined by Global 
effects (page 141).

Z
Y

X X

Y

Z

Source coordinate space Target coordinate space

Source coordinate space Target coordinate space
Digital Multi Effects (DME)
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Local coordinate space and global coordinate space

Three-dimensional parameters
Three-dimensional parameters are x, y, and z values which define the position 
of an image, its axis of rotation, the position of an imaginary point of view on 
the image, and so on. 
The standard values of parameters are as follows, depending on the aspect ratio 
of your monitor (4:3 or 16:9).

Values for 4:3 mode
• Origin at center of image (source coordinate space) or center of monitor 

(target coordinate space)
x = 0.00, y = 0.00, z = 0.00

• Upper right corner of image or monitor
When using SD format signals: x = 4.00, y = 3.00, z = 0.00
When using HD format signals: x = 12.00, y = 9.00, z = 0.00

Rotation around y-axis in 
local coordinate space

Rotation around y-axis in 
global coordinate space
101Digital Multi Effects (DME)
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• Lower left corner of image or monitor
When using SD format signals: x = –4.00, y = –3.00, z = 0.00
When using HD format signals: x = –12.00, y = –9.00, z = 0.00

Values for x-, y-, and z-axes (4:3 mode)

Values for 16:9 mode
• Origin at center of image (source coordinate space) or center of monitor 

(target coordinate space)
x = 0.00, y = 0.00, z = 0.00

• Upper right corner of image or monitor
When using SD format signals: x = 4.00, y = 2.25, z = 0.00
When using HD format signals: x = 16.00, y = 9.00, z = 0.00

–4(–12) a)

+4(+12) a)

+3(+9) a)

–3(–9) a)

x-axis

z-axis –
y-axis

y-axis
z-axis +

The plus direction on the 
z-axis is depth into the 
image or monitor screen.

a) The value in parentheses is for HD format.

x-axis
Digital Multi Effects (DME)
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• Lower left corner of image or monitor

When using SD format signals: x = −4.00, y = −2.25, z = 0.00
When using HD format signals: x = −16.00, y = −9.00, z = 0.00

Values for x-, y- and z-axes (16:9 mode)

Limits of three-dimensional parameters
The following table shows the limits of three-dimensional transformation 
parameters.
The three-dimensional parameters of an image change when you use the 
trackball or Z-ring to execute a transformation. You can also execute a 
transformation by entering parameter values from the numeric keypad control 
block.

 

Operation mode Limits of three-dimensional transformation parameters

Location XYZ HD format: –999.9999 to +999.9999 
SD format: –333.3333 to +333.3333

Rotation, Spin –999.9999 to +999.9999

Axis Location HD format: –999.9999 to +999.9999 
SD format: –333.3333 to +333.3333

Location Size 0.0000 to +999.9999

Aspect 0.0000 to +2.0000

Perspective (x, y) Perspective
HD format: –999.9999 to +999.9999
SD format: –333.3333 to +333.3333

Perspective (z) Perspective
HD format: 0.0000 to 333.3333
SD format: 0.0000 to 999.9999

Skew HD format: –9.9999 to +9.9999
SD format: –3.3333 to +3.3333

–4.00 (–16.00)a)

+4.00 (+16.00)a)

+2.25 (+9.00)a)

–2.25 (–9.00)a)

x-axis

z-axis –

y-axis

y-axis

z-axis +

The plus direction on the z-axis is depth 
into the image or monitor screen.

x-axis

a) The value in parentheses is for HD format.
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Detents
The system defines points called detents at regular intervals on the three-
dimensional space. Pressing the [CTR] button in the device control block sets 
the current three-dimensional parameter values to the closest detent points. 
(For details, see “Three-Dimensional Transformation Operations” in Chapter 
11 (Volume 2).)

The following table shows the interval between successive detents for each 
transformation operation mode (see page 105).

a) When a value is smaller than 1, 1/Aspect or 1/Perspective (z) is adjusted to an integral value.

Three-dimensional parameter default values
Each of the transformation operation modes has default values for three-
dimensional parameters. If required, you can return the current value to the 
defaults by pressing the [CTR] button in the device control block twice in rapid 
succession. (For details, see “Three-Dimensional Transformation 
Operations” in Chapter 11 (Volume 2).) 

The following table shows the default parameter values for each 
transformation operation mode.

Operation mode Detent interval

Location XYZ 1.00

Rotation, Spin 0.25

Axis Location 1.00

Location Size 0.25

Aspect 1.00 a)

Perspective (x, y)
Perspective (z)

1.00
1.00 a)

Skew 0.10

Operation mode Default value

Location XYZ 0.00

Rotation, Spin 0.00

Axis Location 0.00

Location Size 1.00

Aspect 1.00

Perspective (x, y)
Perspective (z)

0.00
1.00

Skew 0.00
Digital Multi Effects (DME)
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Resetting of parameter values set in the source coordinate space

In some transformation operation modes, if you switch to the target coordinate 
space after setting up a three-dimensional transformation in the source 
coordinate space, the setting values in the source coordinate space (three-
dimensional parameter values) are converted to values in the target coordinate 
space (source/target conversion).
Once a conversion has taken place, the original source coordinate space 
parameters do not return to their original values when you switch back to the 
source coordinate space. They are reset to zeros.
Source/target conversion occurs in the following operation modes: 
• Location XYZ
• Rotation

Transformation Operation Modes

The following operation modes are available for three-dimensional DME 
transformations. These operations are carried out in the device control block 
(trackball or joystick). (For details, see “Three-Dimensional Transformation 
Operations” in Chapter 11 (Volume 2).)

Location XYZ
Moves the image on the x-axis, y-axis, or z-axis. The direction of movement 
differs depending on whether you are manipulating the image in the source 
coordinate space or the target coordinate space.

Image movement in the source coordinate space

Movement on the x-axis Movement on the y-axis Movement on the z-axis
105Digital Multi Effects (DME)
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Image movement in the target coordinate space

Rotation
Rotates the image on the x-axis, y-axis, or z-axis. The type of rotation differs 
depending on whether you are manipulating the image in the source coordinate 
space or the target coordinate space.

Image rotation in the source coordinate space

Image rotation in the target coordinate space

Spin
When rotating the image in Rotation mode, it may not always be possible to 
achieve the kind of rotation around an axis that you want. Combining Rotation 
mode with Spin mode creates an effect that rotates the image around a specified 
axis. The type of rotation differs depending on whether you are manipulating 

Movement on the x-axis Movement on the y-axis Movement on the z-axis

Rotation around the y-axis Rotation around the x-axis Rotation around the z-axis

Rotation around the y-axis Rotation around the x-axis Rotation around the z-axis
Digital Multi Effects (DME)
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the image in the source coordinate space or the target coordinate space. (The 
way the image rotates around an axis is the same as in Rotation mode.)

Axis Location
Moves an axis of rotation in the source coordinate space.

Axis movement

Location Size
Changes the size of the whole image. 
• Because shrinking and magnification of the image in the source coordinate 

space is done in three-dimensional space, magnifying the image emphasizes 
the sense of perspective.

• Because shrinking and magnification of the image in the target coordinate 
space is a conversion of the two-dimensional image displayed on the 
monitor, shrinking and magnification does not change the shape of the 
image.

Magnification and shrinking in the source coordinate space

Z Y Z' Y' Z

X

Z'

X'

Y X

Y' X'

Movement on the x-axis Movement on the y-axis Movement on the z-axis
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Magnification and shrinking in the target coordinate space

Aspect
In the source coordinate space, changes the aspect ratio in the x-axis direction 
and y-axis direction, either independently or simultaneously.

Perspective
In the target coordinate space, changes the perspective on the image by 
changing an imaginary view point, without changing the position of the image.
The x-axis and y-axis values define the position of the view point. The z-axis 
value defines its distance from the image.

Change of aspect ratio in 
x-axis direction

Change of aspect ratio in 
y-axis direction

Simultaneous change 
aspect ratio in x-axis 
direction and y-axis direction

Change of view point on 
x-axis

Change of view point on y-
axis

Change of distance from 
view point to image
Digital Multi Effects (DME)
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Skew

In the source coordinate space, change the skew of the image on the x-axis or 
y-axis.

Graphics Display

Graphics display is a function that allows you to display wire frames, 
coordinate axes and a grid over the current DME image, to make it easier to 
create effects in three-dimensional coordinate space.
Graphics displayed by this function can also be output to the monitor output 
connector.

Note
On the MVE-8000 and the MVE-8000A (when using the DME dedicated 
interface), these graphics cannot be output to the monitor output connector.

To make graphics display settings, use the DME menu. (For details, see 
“Graphics Display” in Chapter 11 (Volume 2).)

You can display the following kinds of graphics.

Wire frames
A wire frame displays an image enclosed in a frames, so that you can check the 
position and size of the image. If there is a shadow (see page 146), a frame is 
shown for the shadow as well.

Coordinate axes
This is a three-dimensional display of coordinates in local or global coordinate 
space. You can check the origin of the axes and the directions of the x-, y-, and 
z-axes.

Change of skew on x-axis Change of skew on y-axis
109Digital Multi Effects (DME)
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Channel ID
This displays the channel number so that you can check which channel you are 
using, a useful feature when you are working with multiple channels.
Channel IDs are displayed differently in local and global coordinate space.
• In local coordinate space, the channel number is displayed along with “F” or 

“B” to indicate whether you are looking at the front (F) or back (B) of the 
current wire frame. For example, “1F” means the front of the wire frame on 
channel 1 in local coordinate space.

• In global coordinate space, the channel number is displayed along with “G” 
to indicate global. For example, “G2” means channel 2 in global coordinate 
space.

Wire frame, local coordinate space axes, and channel ID

Grid
This is a grid pattern representing the whole of the monitor screen. The grid 
makes it easy to set the position of an image in two-dimensional coordinates.

Grid (SD format, 4:3 mode)

Shrinking the graphics display
You can shrink the graphics display so that you can see beyond the range 
displayed on the normal monitor screen. This makes it possible to visually set 
the location of images in a larger space. The range displayed on a normal 
monitor screen is indicated by a frame.

Wire frame

Local coordinate space axes

Channel ID

Y

XZ
1F

–4 –3 –2 –1 0 +1 +2 +3 +4
+3

+2

+1

0

–1

–2

–3
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To automatically erase the graphic display
Turn Auto Erase on. The graphic display is erased automatically whenever a 
keyframe is executed. It is displayed again after the keyframe ends, after the 
time set in Recovery Time.

Flex Shadow center axis
When using the Flex Shadow function (see page 114), turn Flex Shadow Axis 
on to display the Flex Shadow center axis. This is an effective aid in making 
settings for this function.

Note
The Flex Shadow center axis function is not supported on the MVE-8000/
8000A.

Three-Dimensional Parameter Display

You can display a three-dimensional parameter list for the currently controlled 
image. When more than one DME channel is selected, the status of the 
reference channel is displayed.

For the method of displaying a parameter list and an example display, see 
“Three-Dimensional Parameter Display” in Chapter 11 (Volume 2).

DME Special Effects

You can use DME to add a variety of special effects. To add effects, use the 
DME menu. (See “DME Special Effect Operations” in Chapter 11 (Volume 
2).)

Range displayed 
on normal monitor 
screen

Wire frame
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Border
This effect adds a border to the image frame. You can adjust the width (or 
thickness) of the border, its color, and the softness of the border edges.

Crop
This effect crops away the edges of the image. You can crop the top, bottom, 
left, and right sides individually or all together. You can also soften the cropped 
edges.

Defocus
Defocuses the whole image. The degree of defocusing can be set 
simultaneously or separately for video and key signals. (However, when the 
DME dedicated interface is used, the degree of defocusing can be set for video 
signals only.) You can also cancel the black level leaking that occurs at the 
edge of the screen when the Defocus effect is used.
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Blur

Applies a rounded blurring to the whole image.

Beveled Edge
This gives an image a beveled edge. You can set the edge width and color. The 
inner edge softness and edge boundary softness can also be set.

Key Border
This effect adds borders to keys or gives a key consisting of an outline only.

Note
The Key Border function is not supported on the MVE-8000/8000A.

Art Edge
Adds edges to the inner and outer side of the input image.
The following items can be set.
• Art edge width and position
• Separate softening of the art edge inner and outer sides
• Color of art edges

Light Color
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Examples of Art Edge source

Example effect using Art Edge source [Rainbow Matte]

Note
The Art Edge function is not supported on the MVE-8000/8000A.

Flex Shadow
This effect allows a shadow to be added to the image using only one DME 
channel.
The following settings can be made for the shadow.
• The signal to use for the shadow

– External: Generate shadow using input key signal.

Gradation Matte Radial Gradation

Rainbow Matte Radial Rainbow
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– Internal: Generate shadow using an internally generated, full-size DME 

key signal.
• Shadow shrinking and magnification
• Shadow position
• Shadow color and density
• Center axis of deformation
• Shadow slant and perspective

    

Note
The Flex Shadow function is not supported on the MVE-8000/8000A.

Wipe crop
This effect crops the video image to be visible inside or outside a wipe pattern.

Note 
The Wipe Crop function is not supported on the MVE-8000/8000A.

External Internal

Video image

Background

When Invert is On
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Color mix
This is a combination of two colors with a pattern generator. This color mix 
signal can be used to fill parts such as a background or border.

Note 
The Color Mix function is not supported on the MVE-8000/8000A.

Multi Move
Shrinks the image and lines up a number of copies vertically and horizontally. 
You can specify the center point of the shrinking, the shrinking ratio, and the 
aspect ratio of the image screen.

Sepia
Overlays a specified color onto the image. You can adjust the sepia color that 
is overlaid, and specify the degree of mixing between the original image and 
the sepia image.

Mono
Converts the image into a monochrome image.

Color 2

Color 1
Digital Multi Effects (DME)



  C
hapter 1 

M
V

S
-8000 F

unctions

Posterization

Coarsens the luminance gradations of the image, for a painting-like effect. You 
can specify the degree of luminance coarsening.

Solarization
Like the Posterization effect, creates a painting-like effect, but does so by 
coarsening the chroma gradations of the image. You can specify the degree of 
chroma coarsening.

Nega
Reverses the luminance and/or chroma of the image.

Contrast
Changes the contrast of the luminance and/or chroma of the image.

Mosaic
Divides the image into small tiles so that it looks like a mosaic. You can specify 
the size and aspect ratio of the tiles.
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Sketch
Provides a sketch-like effect based on the outlines of the image, using different 
touches such as sketch, edge color, drawing, relief, and sharp.

Note
The Sketch function is not supported on the MVE-8000.

Metal
Provides a metallic gloss like that from gold, silver, or a rainbow colored 
surface. A metallic gloss can also be given to a freely selected color.

Note
The Metal function is not supported on the MVE-8000.

Sketch
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Dim and Fade

Dim makes the picture progressively dimmer into its depths. Fade 
progressively makes the depths of the picture fade into the background.

Note
The Dim and Fade functions are not supported on the MVE-8000/8000A.

Glow
Softens the edges of highlights, giving an effect like being struck by a soft light.

Note
The Glow function is not supported on the MVE-8000.

Mask
Masks part of the image so that special effects are applied only inside a selected 
pattern.
The mask function is applied in units made up of the following groups.
The Mask effect can be applied using effect group 1 and effect group 2 
simultaneously.
Effect group 1: Posterization, Solarization, Nega, Sepia, Mono, Contrast, 

Mosaic, Sketch, Metal
Effect group 2: Defocus, Blur, Glow

Fade
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Notes
• The Mask function is not supported on the MVE-8000.
• On the MVE-8000A, the Mask function cannot be applied to both effect 

group 1 and effect group 2 simultaneously.

Freeze
Freezes the input video. The following types are available:
Hard Freeze: Freezes the input video at an arbitrary timing.
Time Strobe: Freezes the input video at specified intervals for a specified 

length.
Film: Slows the apparent frame rate, for an effect like film. You can specify 

the ratio of advancement.
For Hard Freeze and Time Strobe, you can select the first field or the frame as 
the freeze timing.

Nonlinear Effects
You can add a variety of effects, including effects that change the shape of the 
image as a whole.
The following nonlinear effects are available.

For more information about settings and operations with nonlinear effects, see 
“Nonlinear Effect Settings” in Chapter 11 (Volume 2). 

Note
It is not possible to apply two or more nonlinear effects at the same time. 
Turning any nonlinear effect on automatically turns all other nonlinear effects 
off.

Wave
Produces a wave-like effect in the image.

Video image
Effect video 
image (Mosaic) Video image

Effect video 
image (Mosaic)

Mask (normal) Mask (invert)
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There are two modes: H&V and Size. You can set the size and frequency of the 
waves, the wave form, the amount of wave movement, and the range. In H&V 
mode, you can also set the wave angle.

Note
When 720p/59.94 signal format is used, the wave effect is not supported on the 
MVE-8000.

Mosaic Glass
Makes the image rougher and finer at a specified interval.
There are two modes: H&V and Size. You can set the size and frequency of 
waves in the image, the wave form, the amount of wave movement, and the 
range. In H&V mode, you can also set the wave angle.
.

Flag
Applies an effect like a flag waving in the wind.
There are two modes: H&V and Size. You can set the size and frequency of 
waves in the image, the wave form, the amount of wave movement, and the 
range. In H&V mode, you can also set the wave angle.
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Twist
Twists the image.
You can twist the image in the horizontal or vertical direction.
You can set the size and frequency of waves in the image, the wave form, the 
amount of wave movement, and other parameters.

Ripple
Applies an effect like ripples moving across the image.
There are four modes: Radial, Angular, Both, and Shape. The direction of 
modulation differs depending on the mode. You can set the size and frequency 
of the ripples, their direction and speed, their center point, and other 
parameters. In Shape mode, you can select ripple shapes other than circles 
(stars, etc.). 

Rings
Partitions the image into rings that rotate while moving in the same direction.
You can set the degree of transition, the degree of randomness in the distance 
moved by each block, the amount of movement, the width of the partitions, the 
degree of randomness in partition width, the center point, the starting angle, 
and other parameters.
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Broken Glass
Partitions the image like broken glass, with shards flying outward.
You can set the degree of transition, the degree of randomness in the distance 
moved by each block, the amount of movement, the width of the partitions, the 
degree of randomness in partition width, the center point, the starting angle, 
and other parameters.
You can also fix the direction in which shards scatter.

Flying Bar
Divides the image into bars which peel off in two blocks as they move. 
You can set the degree of transition, the degree of randomness in the distance 
moved by each block, the direction of movement, the width of the partitions, 
the degree of randomness in partition width, the partition angle, and other 
parameters.

Blind
Divides the image into bars or wedges, with blocks rotating like the slats of 
venetian blinds. 
There are two modes: Bar and Wedge. You can set the number of rotations by 
blocks, the perspective, the width and position of blocks, the direction, the 
center position, and other parameters. 
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Split
Splits the image upper and lower, left and right. 
You can set the degree to which the image is split, the split positions, and other 
parameters.

Split Slide
Divides the image into bars which slide alternately in reverse directions.
You can set the degree of transition, the degree of randomness in the distance 
moved by each block, the degree of sliding, block width, block angle, and other 
parameters.

Mirror
Partitions the image vertically and horizontally, creating an image like a 
reflection in a mirror. 
You can choose to reflect in the directions left to right, right to left, bottom to 
top, top to bottom, or any combination of directions. You can also set the 
position of the border between original and reflections.

Multi Mirror
Divides the image into originals and reflections, lining them up vertically and 
horizontally.
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You can set the width of the original, the center position of the original, the 
offset of the image with fixed mirrors, the direction of the mirrors, and other 
parameters.

Kaleidoscope
Creates an image like a view into a kaleidoscope. 
You can set the number of blocks, the partition reference point and angle, 
horizontal and vertical offsets, a reflection position, and other parameters. 

Lens
Creates an image like a view through a lens.
You can set the shape and aspect ratio of the lens, the angle, the magnification 
ratio, the curve ratio, the size, the center position, and other parameters. 
You can also choose to display only the portion of the image that is seen 
through the lens.

Circle
Makes a circle with the image.
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You can set the size of the circle, and make the axis of modulation vertical.

Panorama
Curves the upper and lower edges of the image to emphasize the sense of 
perspective.
You can set the horizontal and vertical curve ratio, and the curve center 
position.

Page Turn
Turns the image like a turning page.
There are four modes: H&V, H, V, and Off. You can select the turn position, 
the radius of the turned portion, the amount and angle of turning, and the input 
video for the front and back pages. 

Roll
Rolls the image up.
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There are four modes: H&V, H, V, and Off. You can select the turn position, 
the radius of the turned portion, the amount and angle of turning, and the input 
video for the front and back pages. 

Cylinder
Winds the whole image onto a cylinder.
You can set the degree of winding onto the cylinder, the radius, the horizontal 
position of the wound image, and front and back side output for the image.

Sphere
Winds the whole image onto a sphere.
You can set the degree of winding onto the sphere, the radius, the horizontal 
position of the wound image, and front and back side output for the image.

Note
You cannot monitor the part of a rotating sphere that corresponds to its axis on 
the monitor screen.

Explosion
Divides the image into fragments which expand as they fly out. 
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You can set the pattern shape and aspect ratio, the center position, the amount 
of movement by fragments, the curvature of the transition path, and other 
parameters.

Swirl
Swirls the image.
You can set the amount of swirl, the swirl region, the amount of rotation, and 
the swirl center position.

Melt
Melts the image away from a specified part.
You can set the degree of transition, the degree of extension in the image, the 
jaggedness of the melting sections, and the amplitude, frequency, amount of 
movement, and speed of the melting sections. You can also set the slant of the 
borders, the shape of the sections that begin to melt, and other parameters.

Character Trail
Extends the edge of the image like a trail.
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You can set the effect starting position, the degree of expansion, the slant angle 
of the effect region, and trail direction, the degree to which the image 
disappears, the trail type and amount of stardust, and other parameters.

Lighting
Provides the effect of light striking the image. You can specify the intensity and 
color of the light and the lighting pattern. The following lighting patterns are 
available:
Plane: Illumination of the entire screen.
Bar: Bar illumination. You can specify the width and angle of the bar, and its 

softness.
Preset: Lighting pattern suitable for nonlinear effects.

When Bar is selected, the following modes can be selected.

Normal: Emphasizes the bar highlight area.
Specular: An effect like light striking a surface with metallic reflections.
Mat: An effect like light striking paper, cloth, or another diffusively reflective 

surface.

Note
The function for setting the bar mode of the lighting area is not supported on 
the MVE-8000/8000A.

Normal Specular Mat
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Combine Shadow
When there are several images, adds a flex shadow in the depth of an image or 
overlays multiple flex shadows.

OverOver UnderUnderOver Under

Video Video

Example 1: When Flex Shadow is enabled on both of two channels.

OverOver UnderUnderOver Under OverOver UnderUnderOver Under

Combine shadow is enabled.
Density is set to 100.00.

Combine shadow is enabled.
Density is set to 0.00. 

Shadow Shadow
No combine shadow is set.
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Trail
Recursively freezes the input video at regular intervals so that a trail of 
afterimages is created. You can make the afterimages stardust trails.

Note
Of the three effects of trail, motion decay and keyframe strobe, only one can be 
on at a time. When one of them is on, turning another of them on automatically 
turns off the one that has been on.

Motion Decay
Blurs the motion of a moving video by creating afterimages of the moving 
video. (See “Note” in the preceding section “Trail.”)

OverOver UnderUnderOver Under

Video Video

Example 2: Flex Shadow is enabled on one channel only.

OverOver UnderUnderOver Under OverOver UnderUnderOver Under

Combine shadow is enabled.
Density is set to 100.00.

Combine shadow is enabled.
Density is set to 0.00. 

Shadow

No combine shadow is set.
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You can make the afterimages stardust trails.

Keyframe Strobe
Freezes the video each time the effect passes a keyframe. (See “Note” in the 
section “Trail.”)
You can make the afterimages stardust trails.

Wind
This effect strobes the image at regular intervals, and moves the frozen image 
in a fixed direction, leaving an afterimage.

Note 
The Wind function is not supported on the MVE-8000/8000A.

Spotlighting
Creates the effect of a spotlight striking the surface of the image.
You can set up to three light sources (lights 1 to 3).

Notes 
• The Spotlighting function is not supported on the MVE-8000/8000A.
• The BZDM-9050 Texture Lighting Software (for MVE-9000) is required to 

set lights 2 and 3.
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Adjustments to the image surface
The following adjustments can be made to the image surface struck by the 
light.
• Adjusting the brightness of the whole image
• Selecting the image surface effect

Flat: The image surface is unchanged, causing the selected light source to 
appear as the effect.

Texture: A texture appears on the surface of the image. Textures can be 
selected from among 30 patterns.

See the appendix “Texture Patterns” (Volume 2) for the texture 
patterns.

Non Linear: Spotlighting effect is applied to an area to which a DME 
nonlinear effect is applied. 

Note
The BZDM-9050 is required to enable Texture and Non Linear settings.

• Test sphere function
A test sphere is a translucent sphere virtually embedded in the center of the 
input picture to provide an intuitive way for you to check the position and 
direction of the spotlight. When you change the position or direction of a 
light source, the side of the sphere closest to the light source grows brighter. 
You can easily check the position and direction of the light source by 
viewing the test sphere.

For more information about test sphere, see “Relation between test spheres 
and parallel rays” (page 137).

• Adjusting the bumpiness of the image surface
• Coordinate axis on surface of image 

Specify where to apply the texture or test sphere on the image surface.
Move: The texture moves together with the DME image.

Fix: The texture does not move, even if the DME image moves.

Image before movement Coordinate axis = Move
Texture moves together 
with DME image.
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• Texture deformations
You can change the texture pattern, position, and size, and use the repetition 
function.
The following figure shows examples of a texture pattern repeated in the X 
and Y directions.

Setting lights
• Light source types

The following type of light sources are available (see figure). 
Parallel: Parallel light source
Point: Point light source. As the light source is placed further away, the 

illuminated range becomes wider and the light become weaker.
Line: Line light source
Whole: Non-directional light source which illuminates the whole image.

Image before movement Coordinate axis = Fix
Texture does not move, even 
if DME image moves.

Original image

Repetition in X 
direction

Repetition in Y 
direction

Repetition in X and Y 
directions
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• Linking and unlinking image and spotlight
The spotlight can move together with a DME image, or be fixed in place.

Source: Place the light source in source coordinate space. The spotlight is 
linked and moves when the image moves.

Target: Place the light source in target coordinate space. The spotlight 
does not move, even when the image moves.

• Selecting the lighted area
You can select the area lit by the spotlight.

FRGD: The light strikes the image foreground.
BKGD: The light strikes the image background.
Both: The light strikes both foreground and background.

Light source Light source Light source

Parallel Point Line Whole

Spotlight

Image before movement Coordinate axis = Source
Spotlight moves together 
with DME image.

Coordinate axis = Target
Spotlight does not move, 
even if DME image 
moves.
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• Surface Flat
For the currently selected light source only, you can forcibly make the image 
surface effect flat. 
This is effective when you have selected texture as image surface effect and 
want a flat effect for one light source only.

• Light shape
Creates the light shape.
– Select the shape pattern

For shape patterns, see the appendix “Shape Patterns” (Volume 2).

– Set the size, degree of deformation, softness, and rotation.
• Ring settings

Shines the light with a hole in the middle, like a doughnut. Adjust the 
following parameters.

Offset: Distance to move the center of the ring from the initial position (the 
position set when selecting the light source in the <Spot Mode> 
group).

Radius: Inner side radius of the ring.
Angle: When an Offset is set, the rotation angle of the ring around the 

initial center position. 

No effect

Background

Foreground Spotlight

FRGD selected BKGD selected Both selected

RadiusAngle

Offset

Angle: Rotation angle
Initial center position
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• Fill blending modes
Specifies the way in which the light is blended with the image.

Mix: Light as if reflected from a mirror. The light can be given a color.
Multiply: Light as if reflected from a dull surface (diffuse reflection).

Relation between test spheres and parallel rays
The following figure shows an example of the effect of parallel rays on a test 
sphere.

The direction of a ray is defined by longitude and latitude.
• Longitude: A direction (angle), expressed as a plus value for clockwise 

rotation in the plus direction with respect to the X axis of the input picture.
• Latitude: Latitude

The following figure shows the relationships between the longitude and 
latitude of parallel rays, input picture, and test sphere.

Test sphere

Ray

0.00

0.00

Parallel rays

Input picture

Z-axis
Latitude=+0.25

Latitude=−0.25

X-axis

Y-axis

Longitude

Test sphere

Latitude
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The unit of these direction parameters is the number of rotations, with 360° 
(1 rotation) expressed as 1.00, in the same way as 3D rotation parameters.
The following relationships apply in the example shown in the figure.

The fractional part of the setting after the decimal point corresponds to an angle 
0 to 360°. If the fractional parts of two setting values are the same, the effect is 
the same even if the integral parts are different.
The integral part of a setting value is used when moving a light source with 
keyframes.
For example, when the longitude of a light source rotates in the clockwise 
direction from 0.88 (315°) to 0.12 (45°), it rotates in the counterclockwise 
direction (the angle grows smaller) if the above values are used. In this case, 
the value of the second keyframe can be set to 1.12 (330° + 45°).

Keyframe trajectory

User texture pattern
In the spotlighting function, a user generated texture pattern can now be 
selected for the pattern with which the light falls on the image surface.
To add a texture pattern, create a texture package from a bitmap file, and install 
it.
The installed texture pattern can be selected in the same way as the texture 
patterns provided by default.

Parameter Setting Angle

Longitude 0.12 45°

Latitude 0.12 45°

KF2 = 1.12

KF2 = 0.12

KF1 = 0.88

Test sphere
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Note 
The user texture pattern function is not supported on the MVE-8000/8000A.

For details of spotlighting, see page 132.

For details of how to create a user texture pattern, see “Adding user texture 
patterns” in Chpater 16 (Volume 2) , and for how to select a pattern once 
created, see “To select a texture pattern” in Chapter 11 (Volume 2).

Background
Adds a color or inputs an external signal to the background of the image.

Note 
Signal selection for this purpose is not supported on the MVE-8000/8000A.

Separate Sides
Applies separate video signals and key signals to the front and back of the 
image.

Front and back sides

Shaped Video
For each of the front and back sides of the image, specifies whether to handle 
input video from the switcher as shaped video (key processed signals).

Note 
The shaped video function can only be used with the MVE-8000A/9000 (SDI 
interface).

Front Back
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Invert
Inverts the input video signal and/or key signal horizontally or vertically. You 
can make separate settings for the front and back.

Inversion of input signal

Interpolation

Specifies the methods used for interpolation processing of input video signals 
and input key signals.
For input video signals, you can select from the following four methods.

• Detect changes in the luminance and chrominance signals separately, and 
switch automatically between fields and frames. You can select the degree of 
change detection.

• Detect changes in the luminance signal separately, and switch automatically 
between fields and frames. You can select the degree of change detection.

• Do interpolation in field units.
• Do interpolation in frame units.

For input key signals, you can select from the following three methods.
• Detect changes in the luminance signal separately, and switch automatically 

between fields and frames. You can select the degree of change detection.
• Do interpolation in field units.
• Do interpolation in frame units.

You can also select the number of pixels used in interpolation processing, and 
select the method used to show the picture reduced or expanded.
Further, you can apply an anti-moire filter to reduce the moire patterns created 
by interpolation.

Notes
• Interpolation processing is possible for the following signal formats and 

DME systems.

Horizontal inversion Input signal Vertical inversion
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– MVE-8000/8000A: 480i/59.94, 576i/50
– MVE-9000: 480i/59.94, 576i/50, 1080i/59.94, 1080i/50, 1080i/60

• The anti-moire filter function is only effective when the MVE-8000/8000A 
is used in an HD system.

Key Density Adjustment

You can adjust the key density for the key signal input to the DME.

Key Source Selection

You can select either the key signals received from the switcher or the key 
signals generated in the DME for application to the front and back of the image 
(see page 139).

Global Effects

Global effects are special effects created by combining the images of 
successive channels. The Global Effect menu is used to add these effects.

For details of this menu, see “Global Effect Operations” in Chapter 11 
(Volume 2).

The following types of global effects are available.

Combiner
When multiple channels are selected on one keyer or for one transition, the 
Combiner automatically combines the selected images. Up to four channels 
can be combined.
You can also control the way in which the combination is carried out, as a mix 
or an overlap with priority set automatically. For a mix, you can control the 
relative amounts of each channel.
Images can also be crossed in three dimensions. 

Note 
Three-dimensional image crossing is not supported on the MVE-8000/8000A.
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Combination of channel 1 (Ch1) and channel 2 (Ch2)

Combination of Ch1, Ch2, and Ch3

Ch1

Ch2
Ch1

Ch3

Ch4

Ch3

Ch4

1

2
1

2

3

4

3

4

Combiner

Ch1

Ch2
Ch1

Ch4Ch4

1

2

Ch3 3

2 3
1

44

Combiner
Digital Multi Effects (DME)



  C
hapter 1 

M
V

S
-8000 F

unctions

Combination of Ch1 and Ch2 / combination of Ch3 and Ch4

Combination of Ch1, Ch2, Ch3, and Ch4

Mixing Ch1 and Ch2

If the Mix1 setting is 70, the proportion of the channels in the mixed portion in 
the previous illustration is as shown in the following table.

Ch1

Ch2
Ch1

Ch3

Ch4

1

2 1 1
2

Ch3
2 43

3

4

Combiner

Combiner

Ch1
Ch1

1

Ch4 4

Ch2 2

Ch3 3

2 3
1

4
Combiner

Ch1

Ch2

1

2

Mix1
Ch1

Ch2
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Mixing Ch1, Ch2, and Ch3

If the Mix1 setting is 70 and the Mix2 setting is 40, the proportions of the 
channels in the mixed portions in the previous illustration are as shown in the 
following table.

Pairwise mixing of Ch1 and Ch2, and Ch3 and Ch4

Combination Indication in figure Ch1 Ch2

Ch1 and Ch2 30% 70%

Combination Indication in figure Ch1 Ch2 Ch3

Ch1 and Ch2 30% 70% –

Ch2 and Ch3 – 60% 40%

Ch1 and Ch3 30% – 70%

Ch1, Ch2, and Ch3 30% 42% 28%

Ch1

Ch2

1

2

Mix1

Ch3 3

Mix2

Ch2

Ch1

Ch3

Ch1

Ch2

1

2

Mix1
Ch1

Ch2

Ch3

Ch4

3

4

Mix2
Ch3

Ch4
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If the Mix1 setting is 70 and the Mix2 setting is 40, the proportions of the 
channels in the mixed portions in the previous illustration are as shown in the 
following table.

Ch1 crossed with Ch2

Brick
This effect creates a rectangular parallelepiped from 3 successive channels. 
The Brick effect can combine Ch1, Ch2, and Ch3, or combine Ch2, Ch3, and 
Ch4. The three images are displayed as shown in the following figure.

An example of the Brick effect

Combinations of Ch1, Ch2, and Ch3
Upper side: Ch1 image
Side V: Ch2 image
Side H: Ch3 image

Combination Indication in figure Ch1 Ch2 Ch3 Ch4

Ch1 and Ch2 30% 70% – –

Ch3 and Ch4 – – 60% 40%

Ch1

Ch2

1

2

Depth

X

Y
Z

Side V Side H

Height

Upper side
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Combinations of Ch2, Ch3, and Ch4
Upper side: Ch2 image
Side V: Ch3 image
Side H: Ch4 image

You can adjust the height of the brick, the overlap between the three images 
and the way to insert the side images.

Shadow
This effect gives the image a shadow. The effect uses two successive channels. 
You can adjust the position and density of the shadow with respect to the 
image, and the color of the shadow. The channel with the largest number (for 
example, Ch2 in the case of Ch1 and Ch2) becomes the shadow.
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External Devices

In this system, you can operate while controlling the following types of 
external device:
• Devices supporting P-Bus (Peripheral II protocol) (referred to as “P-Bus 

devices” in the manual)
• Devices supporting GPI
• VTRs
• Disk recorder (Sony disk 9-pin protocol and video disk communications 

protocol)
• Extended VTR (Abekas A53 protocol)

The following is an outline of external device control.

For external device control operations, see Chapter 12 “External Devices” 
(Volume 2). 
For details on the devices that can be connected, consult your Sony 
representative.

Shared Functions for External Device Control

Keyframe functions
There are 99 registers, numbered 1 to 99, holding external device control data 
as keyframe data.
The following are the keyframe functions that can be used.
• RECALL (1-99), STORE (1-99), RECALL UNDO, STORE UNDO, empty 

register search, AUTO SAVE, RECALL MODE (RECALL, RECALL & 
REWIND)

• EDIT ENABLE, EDIT UNDO
• CONST DUR, EFF DUR, KF DUR, DELAY, PAUSE, INSERT BEFORE, 

INSERT AFTER, MODIFY, DELETE, COPY, PASTE BEFORE, PASTE 
AFTER, FROM TO, ALL

• PREV KF, NEXT KF, GOTO TC, GOTO KF, RUN, REWIND, FF, STOP 
NEXT KF, NORMAL, JOG, KF FADER

Note 
Actions set in a keyframe are executed only when the keyframe effect is 
executed in the normal direction. Take care when executing simultaneously 
with a switcher or DME keyframe effect, since the actions are not executed in 
the reverse direction.
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The following keyframe functions cannot be used.
• KF LOOP, EFFECT LOOP, REVERSE, NORMAL/REVERSE
• PATH

Saving to registers
Set the data for controlling external devices in the Device menu. You can save 
the set data in keyframe, snapshot, or shotbox registers. You can recall the 
register in which the data is saved, and carry out operations on it with the 
keyframe control block.

For details, see Chapter 12 “External Devices” (Volume 2).

Editing registers
You can carry out the following operations on the registers in which the data 
for controlling external devices is saved.
• Copy
• Move
• Swap
• Merge (this cannot be carried out for registers holding VTR, disk recorder, 

or Extended VTR control data.)
• Lock
• Name

File related functions
As effect data, you can save and recall, using the File menu.

Control of P-Bus Devices

You can control P-Bus devices from this system through the 9-pin serial port 
of a DCU.

P-Bus device control modes
There are two modes of P-Bus device control, as follows.
P-Bus trigger mode: Operating a previously specified button outputs the 

command for an action assigned to that button.
P-Bus timeline mode: Carrying out a keyframe effect under the control of the 

center control panel controls external devices.

In the setup, select which of P-Bus trigger mode and P-Bus timeline mode to 
use.
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P-Bus trigger mode actions
The actions that can be used in P-Bus trigger mode are as follows.
• Store
• Recall
• Trigger

For details of the buttons assigned to each action, see Chapter 12, “External 
Devices” (Volume 2).

P-Bus timeline
At a keyframe point on the P-Bus timeline, you can set an action (setting what 
action command is output to which device). At any single keyframe point you 
can set actions for a maximum of 24 devices.

P-Bus timeline mode actions
The actions that can be used in P-Bus timeline mode are as follows.
• Store
• Recall
• Trigger
For the action setting (or P-Bus timeline editing), use the Device menu.
You can save the data set in the Device menu in keyframe effect registers. 
Recalling the register starts execution of the keyframe effect, and when this 
reaches the keyframe point at which actions are set, action commands are 
output to external devices through the 9-pin serial port assigned to P-Bus.

For details, see Chapter 12 “External Devices” (Volume 2).

Control of GPI Devices

You can control GPI devices from the control panel of this system, or through 
the GPI output port of a DCU.

GPI timeline
For a keyframe effect controlled from the center control panel, the GPI timeline 
allows you to set an action (setting a trigger output from a particular GPI output 
port) at a keyframe point on the GPI timeline. At any keyframe point, you can 
make a maximum of eight GPI output port settings.

GPI timeline actions
The actions that can be used on the GPI timeline are as follows.
• Control panel GPI output port
• DCU GPI output port
For the GPI output settings (keyframe editing), use the Device menu.
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The data set in the Device menu are saved in a keyframe effect register. When 
you recall this register and start execution of the keyframe effect, and advance 
the effect to the keyframe point for which the GPI output is set, a trigger pulse 
is output to the external device from the specified GPI output port.

VTR/Disk Recorder/Extended VTR Control

In this system, for up to 12 VTRs, disk recorders or Extended VTRs connected 
to a DCU, you can carry out the following manual operations and timeline 
settings.

• Controlling manually from the device control block (trackball or search dial)
• Saving a start point, stop point, start delay time and variable speed in a data 

register, then recalling the register to control automatically from the 
keyframe control block. (Cueup & Play and VTR/disk recorder/Extended 
VTR timeline)

• In the Device menu, you can check the following VTR, disk recorder and 
Extended VTR information:
– Device name
– Register number
– VTR/disk recorder/Extended VTR status
– Current time
– Start point
– Stop point
– Variable speed
– Start delay time

Manual operation
In the device control block, you can carry out the following operations 
manually.
• VTR, disk recorder or Extended VTR selection
• Tape transport and disk drive control: You can use the following tape 

transport and disk drive control buttons:
REC, REW, PLAY, FF, CUE UP, VAR PLAY, SHTL, JOG, STANDBY 
OFF, STOP, and ALL STOP. (For details of the operation of the buttons, 
see “Device Control Block (Trackball)” (page 250), “Device Control 
Block (Joystick)” (page 255) and “Device Control Block (Search Dial)” 
(page 256).)

Depending on the settings made in the Setup menu, the CUE UP, PLAY and 
STOP operations can be carried out from the transition control block. (For 
details of the operation of the buttons, see “Transition Control Block 
(Standard Type)” (page 240) and “Transition Control Block (Compact 
Type)” (page 287).
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• Setting a start point: For each selected VTR/disk recorder/Extended VTR  

you can set the start point timecode value as keyframe data.
• Setting a stop point: For each selected VTR/disk recorder/Extended VTR  

you can set the stop point timecode value as keyframe data.
• Setting a start delay time: For each selected VTR/disk recorder/Extended 

VTR you can set the start delay time as keyframe data.
• Recording to VTR or disk recorder: Record video to the selected VTR/

disk recorder.

Cueup & Play
By saving the start point timecode, stop point timecode, and start delay time for 
a VTR, disk recorder or Extended VTR in an effect register, and recalling this 
register, you can operate the following buttons in the keyframe control block 
to automatically control the VTR, disk recorder or Extended VTR.
[REWIND] button: Cue up to the start point timecode
[RUN] button: Play
With this function you can also stop the VTR, disk recorder or Extended VTR 
used for playback at the stop point timecode recalled from the same register.

VTR/disk recorder/Extended VTR timeline
For a keyframe effect controlled from the center control panel, the timeline 
allows you to set a VTR, disk recorder or Extended VTR action at a keyframe 
point on the timeline.

Timeline actions
The actions that can be used on the timeline are as follows.
• Start
• Stop
• Cue up
• Variable speed

Note
For a disk recorder, the maximum number of files for a single register is 8.

For the action settings (VTR/disk recorder/Extended VTR timeline editing), 
use the Device menu.
The data set in the Device menu are saved in a keyframe effect register. When 
you recall this register and start execution of the keyframe effect, and advance 
the effect to the keyframe point for which the action is set, an action command 
is output to the external device through the 9-pin serial port assigned to the 
VTR, disk recorder or Extended VTR.
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Recalling disk recorder/Extended VTR files
Material held on a disk recorder/Extended VTR is managed in units of files. 
You can recall a file to play it back. (In the case of an Extended VTR, the 
register number is recalled.)

Accessing the file list
Before playback and suchlike operations on a disk recorder/Extended VTR, it 
is first necessary to display a list of the disk recorder files on the DCU. The file 
list includes the following information.
• File name
• Date of last update 1)

• Duration of recorded material 1)

To recall the file list, use the Device menu.

1) Not displayed in the case of an Extended VTR

Recalling a file
In the recalled list of files, select the file you want to play back, and open the file.

File list sharing
You can connect multiple DCU serial ports to a single disk recorder/Extended 
VTR.
You can share the recalled list of files between serial ports connected to the 
same disk recorder/Extended VTR.

For settings relating to file list sharing, see “Serial Port Settings (Serial Port 
Assign Menu)” in Chapter 16 (Volume 2).

File creation
To record a new file on the disk recorder, use the Device menu to create a new 
file.

Note 
In the case of an Extended VTR, it is not possible to record a new file.
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Regions and Registers

Regions

The term “region” refers to some sort of functional block of the system.
When saving or recalling snapshot registers and effect registers, or creating or 
editing effects, you first select the region to which the operation applies. You 
can also select multiple regions simultaneously.

Classification of the regions
The regions are classified as follows.
• MASTER region
• The following 35 regions

– Switcher: M/E1 to M/E3, PGM/PST, USER1 to USER8
– DME: DME1 to DME8 (inclusive of Global)
– External devices: P-Bus, Router, Device 1 to Device 12, GPI

Only the regions assigned to the region selection buttons of the numeric keypad 
control block can be used simultaneously.

For details of the region assignment to the region selection buttons, see 
“Overall Control Panel Settings (Config Menu)” in Chapter 16 (Volume 2).

Regions applicable to keyframe operations
Thirty-four regions, that is, the above 35 regions less the Router region.

Regions applicable to snapshot operations
Twenty-one regions, that is, the above regions less the P-Bus, Device 1 to 
Device 12, and GPI external devices.

“USER” regions
You can optionally assign the following regions to the regions USER1 to 
USER8. The USER regions shown in parenthesis are the default assignments.
• Color backgrounds 1 and 2 (USER1)
• AUX1 to AUX48 (USER2)
• Monitor 1 to 8 (USER3)
• Frame Memory 1 to 8 (USER4)
• Color correctors 1 and 2

For details of the USER1 to USER8 region assignment, see “Overall Control 
Panel Settings (Config Menu)” in Chapter 16 (Volume 2).
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Reference region
When multiple regions are selected, only one region appears in the displays for 
menu and numeric keypad operations. This is called the “reference region.”
The reference region is determined according to the following precedence.

M/E1 >M/E2 >M/E3 >P/P >USER1 >USER2 >USER3 >USER4 
>USER5 >USER6 >USER7 >USER8 >DME1 >DME2 >DME3 
>DME4 >DME5 >DME6 >DME7 >DME8 >P-Bus

Master region
The regions saved in a master snapshot register or master timeline register and 
the register numbers saved in such regions can be recalled at a time as the 
master region.
The master region can be saved or recalled using the numeric keypad control 
block.

Registers

A register is an area of memory in a device which holds a snapshot, keyframe, 
macro, and so on.

For details of macros, see page 196.

Keyframe effect registers

Dedicated effect registers
There are 99 dedicated registers for keyframe effects in each region, numbered 
1 to 99.

Shared user-programmable DME registers
In addition to the 99 DME registers for each region (i.e. each channel), there 
are also shared registers for each processor as shown in the following table. 
These are used for user-programmable DME.

Note
When operating with these shared registers, be sure to select the appropriate 
regions depending on the number of channels. When recalling registers in the 
200 range, select two consecutive channels for the regions, as for example 

Register number Register allocation

101 to 199 Shared register for one-channel effects

201 to 299 Shared register for two-channel effects

301 to 399 Shared register for three-channel effects
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[DME1] and [DME2]. Similarly, for registers in the 300 range, select three 
consecutive registers.

Work register
This is a temporary register used when editing keyframes.
When you recall an effect, it is read from the effect register into the work 
register, and when you save, the contents of the work register are written to the 
effect register.

Master timeline registers
There are 99 master timeline registers, numbered 1 to 99, for each control 
panel. They store keyframe effect regions and the register numbers saved in the 
regions.

Snapshot registers
These are registers for snapshots, and there are 99, numbered 1 to 99 for each 
region.

Master snapshot registers
There are 99 master snapshot registers, numbered 1 to 99, for each control 
panel. They store snapshot regions and the register numbers saved in the 
regions.
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Keyframes

A keyframe represents an instantaneous state of an image; it can be saved and 
recalled for reuse.

Effects

By arranging a number of keyframes on the time axis, and interpolating 
between successive keyframes, you can create an effect in which there is a 
continuous change from each keyframe to the next.
The following figure shows three keyframes created with a wipe pattern (the 
circle) in different positions. This is interpolated to create the effect shown.

Example of keyframes and effect execution

You can save the sequence of keyframes representing a single effect in a 
register. Then by recalling this register, you can replay the same effect.

For details of keyframe effect registers, see “Regions and Registers” (page 
153).

Background A

Background B
Interpolated images

Keyframe 1 Keyframe 2 Keyframe 3

Effect execution
Keyframes
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Saving and Recalling Effects

To create a new effect, first recall an empty register, then create the keyframes 
one at a time in this register. To run an effect, it is also necessary to set the time 
and the path.
To edit an existing effect, recall the register holding the effect, then make the 
changes.
When you have finished creating or editing the effect, save it in the recalled 
register or another specified register.

Auto save function
When you recall an effect, the currently recalled effect is automatically saved 
in a register. This is called the auto save function. You can disable this function 
in a Setup menu.

Effect Attributes

An individual effect may also have attached special conditions relating to 
switcher or DME operation when the effect is recalled.
These conditions are called “attributes” of the effect, and can be added when 
the keyframe effect is saved or recalled.

Type of attribute
The attribute that can be attached to an effect is as follows.
Effect dissolve: The transition from the state before the effect recall to the state 

at the effect start point is carried out smoothly, by a dissolve. The dissolve 
duration can be set in the Effect menu.

Temporary attributes
When a keyframe is recalled, independently of the attributes held in the 
register, you can also enable or disable temporary attributes. These temporary 
attributes are set when the keyframe effect is recalled. 

Effect Editing

For editing operations such as to insert, delete, or modify a keyframe, it is 
necessary to stop the effect at the corresponding point on the time axis. This is 
termed an “edit point.”
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You can edit either on a keyframe within the effect, or at any point between 
keyframes.
Insert: Insert the current image as a keyframe. Inserting a keyframe in an 

existing effect may change the duration of the effect (see page 160).
Modify: Modify a keyframe. You can modify a single keyframe or a range of 

keyframes in the effect together.
Delete: Delete a keyframe. You can delete a single keyframe or a range of 

keyframes in the effect together. Deleting keyframes from an effect 
reduces the duration of the effect (see page 161).
After deleting a keyframe, you can reinsert the keyframe with a paste 
operation.

Copy: Copy a keyframe. You can copy a single keyframe or a range of 
keyframes in the effect together.

Paste: Paste the keyframe last copied or deleted anywhere within the effect.
Pause: You can set a pause on a particular keyframe, so that when the effect is 

run it pauses on this keyframe. You can make this setting on any number 
of keyframes. To restart the paused effect, repeat the operation to run the 
effect.

KF Loop: Execute the effect the specified number of times through the 
keyframes in the specified range.

Undo an edit operation: Undo the effect of the last operation to insert, 
modify, delete, or paste a keyframe.

Duration modes
In keyframe editing, there are two duration modes; switch between them in the 
keyframe operation section. (See “Time Settings” in Chapter 13 (Volume 2).)
Variable duration mode: In this mode, inserting or deleting a keyframe 

increases or reduces the duration.
Constant duration mode: In this mode, inserting or deleting a keyframe does 

not change the duration. This is useful for keyframe editing of an effect 
with a fixed duration.

In the variable and constant duration modes, the keyframes to which a modify 
operation applies, and the effect of a paste operation are different.

Difference in keyframes to which a modify operation applies

a) A new keyframe is inserted at the effect position.

Effect position Variable duration mode Constant duration mode

On a keyframe Applies to currently 
selected keyframe

Applies to currently selected keyframe

Between two 
keyframes

Applies to previous 
keyframe

Modify operation not possible a)
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Difference in the effect of a paste operation
Variable duration mode: The copied keyframe is inserted at the specified 

position.
Constant duration mode: The copied keyframe is written over the specified 

position.

Transition mode
You can use an effect created with keyframes as a DME wipe pattern on the 
switcher. In this case, it is necessary to set the transition mode (the way in 
which the effect behaves).

For details of the setting, see “User Programmable DME Transition Mode” 
(page 442).

Time Settings

Keyframe duration and effect duration
You can determine the execution time of an effect by setting either the 
keyframe durations or the effect duration.
Keyframe duration: This is the time from the keyframe to the next keyframe. 

You can set this time in the keyframe control block. (See “Time Settings” 
in Chapter 13 (Volume 2).)
In constant duration mode (see page 158), it is not possible to change the 
keyframe duration setting.

Effect duration: This is the total execution time of the effect, from the first 
keyframe to the last. You can set this time in the keyframe control block.
(See “Time Settings” in Chapter 13 (Volume 2).)
When you change the effect duration, the keyframe duration for each 
keyframe in the effect is automatically recalculated proportionally.

Schematic view of keyframe duration and effect duration

1 2 3 4 5   

Keyframe duration

Keyframe number

 Effect duration
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The effect duration may also be changed by inserting or deleting keyframes.

Changes in the effect duration caused by inserting a keyframe
• When the effect is stopped on a keyframe, inserting a keyframe increases the 

effect duration by the duration of the inserted keyframe.
• When the effect is stopped between two keyframes, inserting a keyframe 

does not change the effect duration.

Note
In constant duration mode (see page 158), the duration of the current keyframe 
is reduced to zero, and the new keyframe is inserted with the previous duration 
of the current keyframe. Thus the effect duration does not change.

Keyframe insertion position and the change in effect duration

Insertion position Change in effect duration

Insertion before the first 
keyframe

Insertion between two 
keyframes

Insertion at an existing 
keyframe

Insertion at the last 
keyframe

0 1 2 3 4

1 2 3 4 5

1 2 3 4

1 2 3 4 5

1 2 3 4

1 2 3 4 5

1 2 3 4

1 2 3 4 5
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Changes in the effect duration caused by deleting a keyframe

• When the effect is stopped on a keyframe, a delete operation deletes the 
keyframe, and reduces the effect duration by the duration of the deleted 
keyframe.

• When the effect is stopped between two keyframes, a delete operation 
deletes the preceding keyframe, and reduces the effect duration by the 
duration of the deleted keyframe.

Note
In constant duration mode (see page 158), the duration of the keyframe before 
the deleted keyframe is increased by the duration of the deleted keyframe. Thus 
the effect duration does not change.

Keyframe deletion position and the change in effect duration

Deletion position Change in effect duration

Deletion of the first 
keyframe

Deletion of an 
intermediate keyframe

Deletion between two 
keyframes

Deletion of the last 
keyframe

1 2 3 4

1 2 3

1 2 3 4

1 2 3

1 2 3 4

1 2 3

1 2 3 4

1 2 3
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Delay setting
You can set the delay from the time of executing an operation to run the effect, 
and the effect actually starting (that is, the delay until the first keyframe). You 
can make this setting in the keyframe control block. (See “Time Settings” in 
Chapter 13 (Volume 2).)
Note that changing the delay does not alter the duration of the effect.

Paths

The term “path” refers to the specification of how interpolation is carried out 
from one keyframe to the next.

For details of the path setting procedure, see “Path Settings” in Chapter 13 
(Volume 2).

Switcher path settings
Carry out path settings in the Key Frame menu.
For each menu, the following settings are available.

M/E-1 to M/E-3, and P/P menus

Item Paths that can be set

M/E1 to M/E3, P/P All For each M/E and PGM/PST, path settings for 
the following items are made simultaneously.

Key1 to Key4 Overall path settings for items relating to keys 
1 to 4 are made simultaneously.

Key 1 All to Key 4 All

Source Key source path for keys 1 to 4

Fill Key fill path for keys 1 to 4

Proc Proc path for keys 1 to 4

Trans Transition path for keys 1 to 4

Bkgd/Util Overall path settings for items relating to 
backgrounds and utility buses are made 
simultaneously.Bkgd/Util All

Bkgd A Path for background A

Bkgd B Path for background B

Util 1 Path for utility 1

Util 2 Path for utility 2

DME 2nd Video Path for video to be used for second DME 
channel
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User1 to User8 menus
The items that can be adjusted depend on the settings in the Setup menu.

For details, see “Overall Control Panel Settings (Config Menu)” in Chapter 
16 (Volume 2).

Wipe/DME Wipe Overall path settings for items relating to wipes 
and DME wipes are made simultaneously.

Wipe Wipe/DME
Wipe All

Wipe Path for wipes

DME Wipe Path for DME wipes

Trans – Transition path for each M/E and P/P bank

Item Paths that can be set

User1 All to User8 All Overall path settings for the following items for 
each “User” are made simultaneously.

FM All Overall path settings for frame memory items 
are made simultaneously.

FM Src Overall path settings for frame memory source 
items are made simultaneously.

FM Src All

FM Src1 Path for frame memory source 1 and video 
process

FM Src2 Path for frame memory source 2 and video 
process

FM Proc Overall path settings relating to the signal 
processing other than frame memory source 
and frame memory freeze outputs are made 
simultaneously.

FM Proc All

FM Proc1 Path for frame memory signal processing 1

FM Proc2 Path for frame memory signal processing 2

FM Still Store Overall path settings for frame memory freeze 
image output are made simultaneously.

FM Still Store All

FM Still Store 1 to 8 Paths for frame memory freeze image outputs 
1 to 8

Aux Overall path settings for AUX buses are made 
simultaneously.

Aux All

Aux 1 to 48 Paths for Aux 1 to 48

Mon Overall path settings for monitor buses are 
made simultaneously.

Mon All

Mon 1 to 8 Paths for monitor buses 1 to 8

Item Paths that can be set
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Paths relating to DME

DME 3D Trans Local menu

Color Bkgd Overall path settings for color backgrounds are 
made simultaneously.

Color Bkgd All

Color Bkgd 1 Paths for color background 1

Color Bkgd 2 Paths for color background 2

CCR Overall path settings for color corrector

CCR All

CCR 1 Path for color corrector 1

CCR 2 Path for color corrector 2

Item Paths that can be set

Item Paths that can be set

3D Trans Local All Overall path settings for local channel three-
dimensional transform items are made 
simultaneously.

Loc Size Overall path settings for items relating to 
image size changes and movement are made 
simultaneously.Loc Size All

Size Path for image size

Post Loc X, Post Loc 
Y

Paths for movement in the x- and y-axes

Post Size Path for size

Loc XYZ Overall path settings for items relating to 
image movement are made simultaneously.

Loc XYZ All

Loc X, Loc Y, Loc Z Paths for the x-, y- and z-axes

Rot Overall path settings for items relating to 
image rotation are made simultaneously.

Rot All

Rot X, Rot Y, Rot Z Paths for the x-, y- and z-axes

Spin Overall path settings for items relating to spin 
are made simultaneously.

Spin All

Spin Src X, Spin Src 
Y, Spin Src Z

Paths for the x-, y- and z-axes

Spin X, Spin Y, Spin 
Z

Paths for the x-, y- and z-axes

Asp Overall path settings for items relating to 
aspect ratio are made simultaneously.

Asp All

Rate X, Rate Y Paths for the x- and y-axes
Keyframes
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DME 3D Trans Global menu

Skew Overall path settings for items relating to skew 
are made simultaneously.

Skew All

Skew X, Skew Y Paths for the x- and y-axes

Aspect Path for aspect ratio

Pers Overall path settings for items relating to 
perspective are made simultaneously.

Pers All

Pers X, Pers Y, Pers Z Paths for the x-, y- and z-axes

Axis Loc Overall path settings for items relating to 
image rotation axis are made simultaneously.

Axis All

Axis X, Axis Y, Axis Z Paths for the x-, y- and z-axes

Item Paths that can be set

3D Trans Global All Overall path settings for three-dimensional 
transform items in the global channel are made 
simultaneously.

Loc Size Overall path settings for items relating to 
image size changes and movement are made 
simultaneously.Loc Size All

Size Path for image size

Post Loc X, Post Loc 
Y

Paths for movement in the x- and y-axes

Post Size Path for size

Loc XYZ Overall path settings for items relating to 
image movement are made simultaneously.

Loc XYZ All

Loc X, Loc Y, Loc Z Paths for the x-, y- and z-axes

Rot Overall path settings for items relating to 
image rotation are made simultaneously.

Rot All

Rot X, Rot Y, Rot Z Paths for the x-, y- and z-axes

Spin Overall path settings for items relating to spin 
are made simultaneously.

Spin All

Spin Src X, Spin Src 
Y, Spin Src Z

Paths for the x-, y- and z-axes

Spin X, Spin Y, Spin 
Z

Paths for the x-, y- and z-axes

Pers Overall path settings for items relating to 
perspective are made simultaneously.

Pers All

Pers X, Pers Y, Pers Z Paths for the x-, y- and z-axes

Item Paths that can be set
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DME Effect menu

Axis Loc Overall path settings for items relating to 
image rotation axis are made simultaneously.

Axis All

Axis X, Axis Y, Axis Z Paths for the x-, y- and z-axes

Item Paths that can be set

Effect All Overall path settings for DME effect items are 
made simultaneously.

Edge Overall path settings for edge items are made 
simultaneously.

Edge All

Border Path for border

Crop/Edge Soft Path for crop/edge softness

Beveled Edge Path for beveled edge

Key Border Path for key border a)

Art Edge Path for art edge a)

Flex Shadow Path for flex shadow a)

Wipe Crop Path for wipe crop a)

Color Mix Path for color mix a)

Video Modify Overall path settings for video modify items are 
made simultaneously.

Video Modify All

Defocus/Blur Path for defocus/blur

Multi Move Path for “multi-move”

Color Modify Path for color modify

Mosaic Path for mosaic

Mask Path for mask b)

Sketch Path for sketch b)

Metal Path for metal b)

Dim/Fade Path for dim/fade a)

Glow Path for glow b)

Freeze Path for freeze

Non-Linear Path for nonlinear effects

Item Paths that can be set
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a) This cannot be used on the MVE-8000/8000A.
b) This cannot be used on the MVE-8000.

DME Global Effect menu

Types of path

Path types for Curve
There are five types, as follows.

OFF: Executing the effect causes no change.

Step: There is no interpolation between keyframes, so that the effect 
parameters are updated each time a keyframe is passed.

Linear: Linear interpolation between keyframes, resulting in constant 
speed movement.

S-Curve: The rate of change accelerates and decelerates before and 
after a keyframe, so that the rate of change is maximum midway 
between two keyframes.

Spline: The effect follows a smooth curved path from each keyframe to 
the next.

Path types for Hue
There are four types, as follows.

Light Overall path settings for lighting items are 
made simultaneously.

Light All

Lighting Path for lighting

Spot Lighting Path for spotlighting a)

Trail Path for trails

In/Out Overall path settings for items relating to input/
output are made simultaneously.

In/Out All

Bkgd Path for background

Video/Key Path for video/key

Item Paths that can be set

Global Effect All Overall path settings for DME global effect 
items are made simultaneously.

Combine Path for combiner

Shadow Path for shadow

Brick Path for brick

Item Paths that can be set
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CW: The hue changes in a clockwise direction as seen on a 
Vectorscope.

CCW: The hue changes in a counterclockwise direction as seen on a 
Vectorscope.

Short: The hue changes in whichever of the clockwise and 
counterclockwise directions is shorter.

Long: The hue changes in whichever of the clockwise and 
counterclockwise directions is longer.

Path types for Xpt
There are two types, as follows.

Xpt Hold off: When replaying a keyframe, change the inputs to the 
settings saved in memory.

Xpt Hold on: When replaying a keyframe, do not change the inputs.

Effect Execution

By pressing the [RUN] button in the keyframe control block, you can replay 
the effect as a continuous sequence of images. This is referred to as effect 
execution.
It is also possible to execute effects from the device control block (see page 
250) or the Flexi Pad control block (see page 244). 

Range of execution
Each time the [RUN] button is pressed, the range of execution of the effect is 
from timecode 01:00:00:00 or the current time (the position at which the 
current effect is stopped) to the end point of the effect. However, if there is a 
pause set on a keyframe, the execution range is up to that point. Pressing the 
[RUN] button again resumes the effect, which then runs to the next pause point 
or the end of the effect.

Run mode setting
You can select from the following run modes for when the effect is executed.
DIRECTION: Specify the effect execution direction.
STOP NEXT KF: Run the effect, and stop at the next keyframe.
EFFECT LOOP: Repeat the effect in an endless loop.
Make these settings in the keyframe control block. (See “Run Mode Setting” 
in Chapter 13 (Volume 2).)
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Master Timelines

You can save the regions selected for a keyframe effect and the register 
numbers saved in the regions in a master timeline register so that operation can 
be applied to two or more regions at a time.
To save master timeline registers, use the numeric keypad control block or 
menu; to recall them you can use the numeric keypad control block, menu, or 
the Flexi Pad control block. 

For more details, see “Creating and Saving a Master Timeline” in Chapter 13 
(Volume 2).
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Snapshots

The term “snapshot” refers to a function whereby the various settings required 
to apply a particular effect to an image are saved in memory as a set of data, for 
recall as required, to recover the original state.
You can carry out snapshot operations using the numeric keypad control block, 
the Flexi Pad control block in each of the M/E-1 to M/E-3 and PGM/PST 
banks, and the Snapshot menu.

Note
If the M/E bank has the Inhibit setting (see “Overall Control Panel Settings 
(Config Menu)” in Chapter 16 (Volume 2)), it is not possible to recall a 
snapshot on that M/E bank.

For details of snapshot operations, see Chapter 14 “Snapshots” (Volume 2).

Snapshot Types

Snapshots are divided as follows.

Snapshots applying to a particular region (functional block of the 
switcher or DME)
The term “snapshot” alone usually refers to this type of snapshot. This only 
applies to regions assigned to region selection buttons in the numeric keypad 
control block.
Master snapshot: This applies to the selected regions and the register numbers 

saved in the regions. A master snapshot can be saved and recalled using the 
numeric keypad control block.

Snapshots applying only to particular functions
This type of snapshot includes the following.
Key snapshot: This includes the key on/off state and all key settings other than 

key priority for each keyer. (See “Key Snapshots” (page 52).)
Wipe snapshot: This includes the wipe settings of each of the M/E-1 to M/E-

3 and PGM/PST banks. (See “Wipe Snapshots” (page 65).)
DME wipe snapshot: This includes the DME wipe settings of each of the M/

E-1 to M/E-3 and PGM/PST banks.

The rest of this section describes the snapshots that apply to a particular region 
or regions.
Snapshots
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Snapshot Attributes

An individual snapshot may also have attached special conditions relating to 
switcher or DME operation when the snapshot is recalled.
These conditions are called “attributes” of the snapshot, and can be added when 
the snapshot is saved or recalled.

Types of attribute
There are five snapshot attributes, as follows.
Cross-point hold: When the snapshot is recalled, the cross-point button 

selection remains unchanged. This can be set independently for each bus.
Key disable: When the snapshot is recalled, the key settings remain 

unchanged. This can be set independently for each keyer. A Setup menu 
allows you to select whether or not the key on/off state should also remain 
unchanged.

Effect dissolve: The transition from the state before the snapshot recall to the 
snapshot settings is carried out smoothly, by a dissolve. The dissolve 
duration can be set in the Snapshot menu.

Auto transition: An auto transition starts the instant the snapshot is recalled. 
The auto transition setting is valid only for M/E-1, M/E-2, M/E-3, and 
PGM/PST.

Note
If both effect dissolve and auto transition are selected as attributes, the auto 
transition takes precedence.

GPI output: A GPI output is sent to the allocated GPI port the instant the 
snapshot is recalled.
The trigger type depends on the switcher GPI output settings made in the 
Setup menu.

For details, see “Interfacing With External Devices (Device Interface 
Menu)” under “Setup Relating to Switcher Processor” in Chapter 16 
(Volume 2).

Clip event: Recall a frame memory clip immediately after the snapshot is 
recalled.

Auto play: Play a frame memory clip immediately after the snapshot is 
recalled.

Table of available attributes
The attributes that can be used depend on the region, as follows.
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Yes: Can be used   No: Cannot be used

Attribute display
You can view the attributes of a snapshot in the Snapshot menu.

For more details, see “Snapshot Operations in the Menus” in Chapter 14 
(Volume 2).

Temporary attributes
When recalling a snapshot, you can temporarily apply attributes distinct from 
the attributes set for each register. These are called “temporary attributes.”
You can set temporary attributes when recalling a snapshot.

For details of snapshot operations, see Chapter 14 “Snapshots” (Volume 2).

Bus override
If you recall a snapshot while holding down an A or B bus button, the selection 
of the signal on the A or B bus does not change when the snapshot is recalled. 
This function is called “bus override.”
This function is effective when cross-point hold is off, and you want to 
temporarily maintain the cross-point setting. When cross-point hold is on, the 
above operation is not necessary.

Attribute Region

M/E-1, M/E-2, M/E-3, and 
PGM/PST

USER 1 to USER 8 DME 1 to DME 8

Cross-point hold Yes Yes Yes

Key disable Yes No No

Effect dissolve Yes Yes Yes

Auto transition Yes No No

GPI outputs Yes Yes No

Clip event No Yes No

Auto play No Yes No
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Utility

The utility function refers to a function whereby you can assign an arbitrary 
action or a shortcut for frequently used menu to a particular button, then 
instantly recall the action or menu by pressing the button.
The functions you can assign include menu shortcuts, enabling/disabling 
functions (recalling utility commands), and recalling (shotbox registers or 
macro registers).
Carry out the button assignment in the Setup menu.

For details of the operation, see “Setting Button Assignments (Prefs/Utility 
Menu)” in Chapter 16 (Volume 2).

You can carry out the utility function in the utility/shotbox control block (see 
page 275) or using the user preference buttons in the menu control block (see 
page 271).
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Shotbox

The term “shotbox” refers to a function whereby for each specified region any 
snapshot or keyframe effect can be recalled simultaneously.
The simultaneous recall setting data such as region names, snapshot numbers 
and keyframe effect numbers are stored in “registers.” There are 99 registers 
for each control panel.

The previous figure shows schematically the settings in the 99 shotbox 
registers.
Each register may contain any combination of the regions to which the register 
applies, with the snapshots or effects to be recalled.
The Auto Run function is an attribute which can be set for each register. When 
this is set to On, an effect recalled by a shotbox operation is automatically run.
• When register 1 is executed, this recalls M/E-1 snapshot 1, User2 effect 5, 

and DME3 effect 1. For register 1, auto run is on, and therefore the User2 and 
DME3 effects are run as soon as they have been recalled.

• When register 3 is executed, M/E-1 effect 1, P/P effect 90, and User1 effect 
1 are recalled. For register 3, auto run is off, and therefore to run the recalled 
effects, press the [RUN] button in the keyframe control block.

Shotbox settings and execution
Carry out shotbox register settings from the Shotbox menu or using the 
numeric keypad control block.
You can carry out shotbox execution using the numeric keypad control block, 
the Flexi Pad control block, or the utility/shotbox control block.

For details of operation, see Chapter 15 “Shotbox” (Volume 2).

Register #1

M/E-1: Snapshot #1
User2: Effect #5
DME3: Effect #1

Auto Run: On

Register #2

M/E-1: Snapshot #1
DME1: Snapshot #15
GPI: Effect #1

Auto Run: Off

Register #3

M/E-1: Effect #1
P/P: Effect #90
User1: Effect #1

Auto Run: Off

Register #99

P/P: Effect #2
DME1: Snapshot #1

Auto Run: On

Shotbox registers
Shotbox
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Setup

Overview of Setup

Various settings are required, in order to operate the switcher, control panel, 
DME, external devices, and so on, connected together in a single system.
This is referred to as “setup,” and you can carry out the setup operations from 
the Engineering Setup menu.

For details of the operations, see Chapter 16 “Engineering Setup” (Volume 2).

The settings in the Engineering Setup menu are grouped under the following 
headings.
• System setup (System): Settings relating to the whole system (see the 

following section “System Setup.”)
• Panel setup (Panel): Settings particular to the control panel (see page 181)
• Switcher setup (Switcher): Settings particular to the switcher processor 

(see page 184)
• DME setup (DME): Settings particular to the DME processor (see page 

187)
• DCU setup (DCU): DCU input and output settings (see page 188)
• Router/tally setup (Router/Tally): Router interface and tally settings (see 

page 188)

System Setup

The system setup settings apply to the whole system. Here the “whole system” 
refers to all devices connected on the Control LAN.
The DCU is connected through the control panel, but is also included in the 
“whole system.”
You can make the following settings.

Network configuration (Network Config)
This provides automatic configuration of all devices connected to the Data 
LAN (excluding the DCU), and displays a list of them.

System configuration (System Config)
Specify the overall system operation mode and the hierarchical relationship of 
the devices.
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Operation mode setting
• Single Proc mode: The control panel controls a single switcher and up to 

two DMEs.
• Single Simul mode: See “Special system setting (Single Processor Simul 

mode)” (page 176).
• Dual Simul mode: The control panel controls two switchers and DMEs 

simultaneously.

Device hierarchical relationship setting
• Panel Assign: Specify the switcher controlled by a control panel.
• Switcher Assign: Specify the DME connected to a switcher.

Special system setting (Single Processor Simul mode)
When using a combination of a 4M/E switcher processor and a 4-channel DME 
processor in an HD system, the Single Processor Simul mode is available. In 
this mode, M/E-1 on the switcher processor is linked to M/E-3, and M/E-2 is 
linked to P/P. As a result, the M/E-1 and M/E-2 panel buttons go off, and 
cannot be operated.
In this mode, the screen aspect ratio is fixed, as follows.

Relation between switcher and DME: Operations are linked with the screen 
aspect ratios the same.

Notes
• The waveforms for wipe pattern numbers 23, 24, 26, and 27 are the same 

in 4:3 and 16:9 modes.
• Color backgrounds, frame memory, and other functions used on the 

whole switcher operate at 16:9.

Note on creating a user programmable DME: The keyframe registers used 
for creating a user programmable DME are divided by screen aspect ratio 
as shown in the following table.

Processor Bank or channel Screen aspect ratio

Switcher processor M/E-3 and P/P 16:9

M/E-1 and M/E-2 4:3

DME processor Channels 1 and 2 16:9

Channels 3 and 4 4:3

Register 
numbers

Screen aspect 
ratio

Switcher bank Channel

101 to 149, 
201 to 249, 
301 to 349

16:9 M/E-3 P/P Ch1 Ch2
Setup
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The actual operation is linked between the top and bottom rows of the table 
(e.g. M/E-3 and M/E-1), but the common setting values cannot be used 
between the two screen aspect ratios. The edges of the screen, for example, 
differ between 16:9 and 4:3.
For image operations in the device control block, first make the settings 
separately on the different channels.

Recalling a user programmable DME: When recalling a user programmable 
DME, select pattern numbers 1901 to 1949, 2901 to 2949, or 3901 to 3949. 
The effects for the 16:9 and 4:3 screen aspect ratios will be recalled linked 
together.

Signal format settings (Format)
Make the following settings.

Signal format
Specify the signal format to be handled by the devices.
The combinations of signal formats that can be selected are as follows.

Screen aspect ratio
Switch the screen aspect ratio to 4:3 or 16:9.

Changing the input reference signal in an HD system
This changes the input reference signal.

151 to 199, 
251 to 299,
351 to 399

4:3 M/E-1 M/E-2 Ch3 Ch4

Register 
numbers

Screen aspect 
ratio

Switcher bank Channel

System Field frequency Effective number of scan lines

HD system 50 1080i

59.94

60

23.976 1080PsF

24

25

29.97

30

50 720p

59.94

SD system 59.94 480i

50 576i
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• Tri Sync: tri-level sync for an HD system
• BB (Black Burst): black burst or sync for an SD system
The following table shows the relation between signal format and the 
frequency of a signal that can be used as the input reference signal.

a) Interlock mode

Selecting the start up state (Start Up)
Set the initial state of the devices when the system is powered on.
For each device, you can select Resume mode or Custom mode.

Resume mode
This resumes the setting state at the previous power-off operation. This setting 
is only available for the switcher processor and panel.

Custom mode
This uses the settings saved in non-volatile memory or ROM within the device. 
In this mode, there are Setup and Initial Status settings which can be set 
separately.
• Setup mode: Select the setup state to be used after powering on from the 

following.
User: Start up using the user data previously saved with [Setup Define].
Factory: Start up with the factory default settings.

• Initial status mode: Select the state of each device after powering on 
(excluding the settings to which “setup” applies).

User: Start up using the user data previously saved with [Initial Status 
Define]. For the control panel, this applies to the key bus delegation 
buttons only. 

Factory: Start up with the factory default settings.

For details of saving and recalling setup data, see “Saving and Recalling Setup 
Data” (page 180) and the appendix “Data Saved by [Setup Define] and [Initial 
Setup Define]” (Volume 2).

Signal format Input reference signal

Tri Sync Black burst

1080PsF/29.97, 
1080i/59.94

59.94 Black Burst 59.94 Sync 59.94

1080PsF/25, 1080i/50 50 Black Burst 50 Sync 50

1080PsF/23.976 47.952 Black Burst 59.94 a) Sync 59.94 a)

1080PsF/30, 1080i/60 60 –

1080PsF/24 48 –

720p/59.94 59.94 Black Burst 59.94 Sync 59.94

720p/50 – Black Burst 50 Sync 50
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Autoload function
Switch on or off the function to automatically load predetermined register data 
or frame memory image data at power on. Set the data to be read in the File 
menu.

System reset and memory initialization (Initialize)
• Reset: Reset to state after powering on.
• All Clear: Clear the memory, and carry out initialization. The Network 

Config, System Config, Format, and Start Up setup values are set by 
reference to data stored in non-volatile memory, and the system 
automatically starts up. It is not necessary to reset the Date/Time settings.

For more details, see “Saving and Recalling Setup Data” (page 180).

Installation and device settings (Install/Unit Config)
This installs the software and firmware in all devices (including the DCU) 
connected to the Data LAN.
Install: Automatically detects the software that can be installed on each device, 

and installs the selected software.

There are also the following functions.
Detail Information: Gives details of the software and firmware installed in 

each device.
Unit Config: Carries out device settings. Switches the color corrector function 

of the switcher processor between secondary color correction and spot 
color adjustment, sets the field polarity of frame memory images, and so 
on.

License: Makes the license valid or invalid.

Device management (Maintenance)
• Date and time setting
• Formatting a memory card
• Primary settings for USB external storage device
• Reloading a USB driver
• Formatting the hard disk
• Locking setup menu operations

– For each VF button group, selecting a set of candidate menus to be locked, 
then locking all of the candidates using a password. Except for list 
scrolling, moving menus, and similar operations, menu operations for all 
settings can be locked.

– Changing the password
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Saving and Recalling Setup Data

Concept of saving and recalling setup data

Updating the switcher or control panel setup data saves the updated setup data 
in RAM in each device.
• In Resume mode (see page 178), even if devices are reset or powered off, the 

data is preserved in RAM, and recalled when the power is turned back on.

Note
The Resume mode cannot be used for DMEs and DCUs.

• In Custom mode (see page 178), the user-defined settings (user setup data) 
saved in non-volatile memory or factory default setup data held in ROM in 

 Hard disk / memory card
User setup data

Load Save

File menu: 
[Load]

File menu: 
[Save]

Current setup data
(If in Resume mode, settings data is saved.)

Store
In Custom mode, power on 
or reset

Initialize

User setup data Factory default setup data

Setup menu:
[Setup Define]

Setup 
menu:
[All Clear]

 RAM

 ROM Non-volatile memory
Setup
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each device is recalled when a reset is made or the power is turned back on. 
(See “Selecting the start up state (Start Up)” (page 178).)

Note that the setup data in RAM can also be saved to the control panel hard disk 
or memory card.

Panel Setup

In panel setup, you carry out settings particular to the control panel.
You can make the following settings.

For details of the operations, see “Setup Relating to Operations From the 
Control Panel” in Chapter 16 (Volume 2).

Panel settings (Config)
• M/E Assign: Set the logical configuration of the M/E and P/P banks.
• M/E Operation: For each of the M/E and P/P banks, make operations 

possible, not possible, or disabled (Enable/Disable/Inhibit).
• Dual M/E Assign: Using two M/E banks, assign the shift and non-shift 

button rows of a single M/E bank.
• Dual M/E Xpt Swap: When a setting has been made for Dual M/E Assign, 

swap the shift and non-shift button rows.
• DSK Fader Assign: Carry out fader function assignment and key delegation 

for the key delegation buttons, in each of the maximum of four downstream 
key control blocks.

• External Bus Link: Make link settings relating internal switcher buses to 
routing switcher destinations.

• Key Trans Link: Select whether or not to link transitions between keyers, 
and if so which keyer to link to. You can set the links between keyers for each 
M/E bank separately.

• Reference Module: When a trackball module and a joystick module are both 
connected as device control blocks, select which is used as the reference.

• 10 Key Region Assign: Assign any regions to the region selection buttons 
in the numeric keypad control block. Also used for setting the regions 
included in the selection when the [All] button is pressed.

• Program Button: Make assignments for buttons of some control blocks 
such as assigning the buttons in a transition control block for controlling a 
VTR and assigning the Flexi Pad control block to macro operation.

• Compact Key Module Assign: You can select which keys can be operated 
with an independent key transition control block (simple type).

• M/E Operation Inhibit: For each M/E or P/P bank, enable or inhibit utility 
2 bus and key-related operations.
181Setup



182

   C
hapter 1 

M
V

S
-8000 F

unctions
Cross-point button settings (Xpt Assign)
• Xpt Assign: For each control block or bus, display and set the assignments 

to the main table and tables 1 to 14.
• Main, V/K Pair Assign: Make cross-point settings for the main table.

– Assign video/key sources for button numbers 1 to 128.
– For each table, specify whether the rightmost cross-point button in each 

row is used as a shift button, and the operation mode when it is used as a 
shift button.

– For the [SHIFT] button in the cross-point control block and for each table, 
select the mode in which this is a shift button dedicated to the source name 
displays, or the mode in which it is a shift button for all buses.

– Disable cross-point buttons to work.
• Table Button Assign: Create tables 1 to 14 in the same way as the main 

table.
• Src Name: Set source names of up to 16 characters.
• LCD Color: Set the LCD color for source name display.
• Table Copy: Copy table contents from the main table to tables 1 to 14 or 

between tables 1 to 14 (it is not possible to copy tables 1 to 14 to the main 
table).

• Name Export: This function sends the source name and destination name to 
the S-Bus.

• Side Flags Button Assign: Assign the rightmost button in the background 
A/B row to the side flag function (inserting a selected image on both sides of 
a 4:3 image).

Auxiliary bus control block settings (Aux Assign)
• Aux Assign: Assign the AUX delegation buttons in the auxiliary bus control 

block to any bus.
• Shift Mode: Specify whether the rightmost button of the AUX delegation 

buttons is used as a shift button, and when it is used as a shift button, the 
operation mode.

• RTR Mode Setting: Carry out the following settings for using the auxiliary 
bus control block for router control.
– Assigning destinations
– Setting the shift operation in the destination selection button rows
– Source table settings
– Setting the shift operation in the source selection button rows
– Assigning levels to the level selection buttons
– Setting destination selection buttons to be used for snapshots

Button assignment settings (Prefs/Utility)
Assign the [PREFS 1] to [PREFS 8] buttons in the menu control block, and the 
utility/shotbox control block buttons.
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• User Preference: Make the settings for the user preference buttons in the 

menu control block. This assigns recalling frequently used menus (menu 
shortcuts), enabling/disabling functions (recalling utility commands) and 
recalling shotbox registers or macro registers.

• Utility Module Assign: Make the utility/shotbox control block settings. This 
assigns recalling frequently used menus (menu shortcuts), enabling/
disabling functions (recalling utility commands) and recalling shotbox 
registers or macro registers.

External device connections (Device Interface)
• GPI Input: Set the GPI input ports and trigger type, and make the action 

settings.
• GPI Output: Set the GPI output ports and trigger type, and make the action 

settings.
• P-Bus Control: Set the control mode for P-Bus devices.
• DCU Serial Port Assign: Assign the devices (disk recorder/VTR/Extended 

VTR) connected to a DCU and accessible from the control panel to the 
[DEV1] to [DEV12] buttons which become operative when you press the 
[DEV] button on the device control block. For a disk recorder or Extended 
VTR, you can also make settings relating to sharing of file lists. Further, you 
can make settings for devices (disk recorder/VTR/Extended VTR) operable 
from an editing keyboard.

• Editor Port Assign: When the BZS-8050 license is valid, make settings for 
the SCU editor panel port.

Operation settings (Operation)
• Button Tally: Set whether or not the system tally generation results are 

reflected in the panel tally.
• Trans Rate Display: Select whether the transition rate display mode is in 

frames or timecode units.
• S-Bus Name Link: Copy the S-Bus description name to the source name.
• Effect: For keyframe effects, you can make the following settings. (See 

Chapter 13 “Keyframe Effects” (Volume 2).)
– Recall mode
– Automatically turning off the [EDIT ENBL] button when an effect is 

recalled
– Automatic insertion of a first keyframe when an empty register is recalled
– Effect Auto Save
– Default KF Duration
– Setting whether or not to replay the first keyframe after rewinding a GPI/

P-Bus/disk recorder/VTR/Extended VTR effect
• Source/Dest Name: For the Source/Dest (source/destination) names used by 

the system, select one of the following:
– Source name set by cross-point assignment or fixed bus name
– Description name set on routing switcher
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– “Type + Num” name set on routing switcher
Names assigned with Xpt Assign can be replaced later with description 
names.

• Name Display: Specify the number of characters for display of the names 
selected in Source/Dest Name above, as two characters, four characters, or 
Auto.

• Flexi Pad: Carry out Flexi Pad settings. Specify the delegation selection 
coupling, and display mode for the LCD buttons.

• Custom Button: Set the following button operation modes.
– [ALL] button for next transition selection
– [AUTO TRANS], [TAKE] or [FTB] button during auto transition 

execution
– [RUN] button during keyframe execution
– [AUTO TRANS] and [CUT] button replacement
– [TRANS PVW] button
– [UTIL] button
– [XPT HOLD] button in key rows

• Sensitivity: Adjust trackball, joystick and double-click sensitivity, or set the 
relationship between the angle of the search dial and the playback speed.

• Main Split Fader: When the split fader is active, specify whether the fader 
to control other than mix is the left side or the right side.

• Macro: Set the macro execution mode and the mode in which to edit macros 
using the standard type Flexi Pad control block.

Screen saver and other settings (Maintenance)
• Screen Saver: Make the menu screen saver settings.
• LCD Brightness: Adjust the LCD brightness.
• LED Brightness: Adjust the LED brightness.
• Switch Brightness: Adjust the switch brightness.
• Touch Beep: Select whether or not to sound a beep when a menu operation 

is carried out.
• Touch Panel Calibration: Calibrate the touch panel.

Switcher Setup

In switcher setup, make settings particular to the switcher processor.
You can make the following settings.

Settings relating to overall switcher configuration (Config)
• System Phase: Adjust the switcher internal reference phase.
• Switch Timing: Specify the timing of video switching.
• M/E Config: Set the program configuration for the M/E and P/P outputs.
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– Standard mode: Fix the maximum of four outputs (Out1 to 4) and 

program output configuration as follows.
Out1: Program output 
Out2: Preview output 
Out3: Clean output 
Out4: Key preview output 
Program output: Clean output + key 1 + key 2 + key 3 + key 4

–  Multi-program mode: Increase the number of M/E or P/P programs, and 
assign any of the following to the maximum of six outputs (Out1 to 6). (M/
E Output Assign)

Program outputs 1 to 4, preview output, key preview outputs 1 and 2, 
clean output.

Further, you can select the program background from Clean or Utility2, 
and change the combination of signals from which it is configured. (PGM 
Config)

– DSK mode: Treat P/P as four DSKs, with no background transitions. Of 
backgrounds 1 to 4, set one to configure the program output. (PGM 
Config) The signals which can be selected as the background are limited 
to Out1 to 6 from M/E-1 to M/E-3.
Regardless of the current M/E Config mode, you can set the key preview 
configuration to be video mode or key mode. In key mode, select whether 
to link the key state to the on/off operation, or have it always on. (K-PVW 
Config)

• User 1 to 8 Config: Assign the User regions, being color backgrounds 1 and 
2, AUX1 to 48, monitor 1 to 8, frame memory 1 to 8, and color correctors 1 
and 2, to any of USER1 to USER8.

• Logical M/E Assign: Make settings for handling PGM/PST hardware 
logically as an M/E.

• DME Config: Set the DME channel assignments used on the individual M/
E and PGM/PST banks.

• Side Flags: Make settings relating to the side flag function (inserting a 
selected image on both sides of a 4:3 image).

Input signal settings (Input)
• Input Phase Adjust: Carry out phase adjustment for each primary input.
• Through Mode: Set through mode for the input side. This applies only to 

the primary inputs, and can be set independently for each primary input.
• Video Process: Switch video processing on or off for each input signal, and 

adjust the brightness, hue and so forth.
• Matte Illeg. Color Limit: Switch the illegal limiter on or off for the signal 

generated by the switcher internal matte generator.

Output signal settings (Output)
• Output Assign: Assign the signals output from the Output1 to 48 ports.
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• Video Clip: Adjust the clip levels (White Clip, Dark Clip, and Chroma Clip) 
for the output signals from each of the Output1 to 48 ports.

• V Blank: Adjust the vertical blanking width for the output signals from each 
of the Output1 to 48 ports. The setting is the number of scan lines from the 
reference blanking position of field 1 for the particular format which should 
be masked.

• Through Mode: Enable or disable through mode. Through mode can be 
enabled for AUX1 to 48 outputs, M/E and PGM/PST program outputs, and 
clean output.

• Safe Title: Enable or disable safe title, and carry out settings for box 1 and 2 
and cross.

• Ref. Output Phase: Set the reference output mode and phase adjustment.
• 4:3 Crop: Set the actual video image to be cropped to a 4:3 aspect ratio when 

an HD system has a screen aspect ratio of 4:3.

Settings relating to video switching (Transition)
• Transition Preview: Specify the operation mode for transition preview for 

each of the M/E and P/P banks.
• Key Transition: Specify the operation mode for independent key 

transitions.
• Bus Toggle: Switch the bus toggle for each of the M/E and P/P banks on or 

off.
• Split Fader: When the bus toggle is off, the split fader settings are enabled. 

For each of the M/E and P/P banks, select enable or disable.
• Fade To Black: Enable or disable fade-to-black for each final program 

output.
• Preset Color Mix: Set the stroke mode for a preset color mix, the key status 

for a transition including a key, and the mode in which the transition type 
after a transition ends returns to the previous setting.

• Transition Curve: Set the relationship when carrying out a transition, 
between the fader lever position and the advancement state of the transition.

Key, wipe and frame memory settings (Key/Wipe/FM)
• Key Memory: Set the key memory operation mode for each of the M/E and 

P/P banks.
• Video Proc Memory: Enable or disable video process memory.
• Show Key: Enable or disable show key for edit preview, M/E and P/P Pvw/

K-Pvw.
• DSK Auto Drop: Specify a DSK to be turned off automatically when a 

cross-point button on the P/P program bus is pressed.
• Mask/Border Process: Set the processing order of masks and borders for 

each M/E and P/P bank.
• Key Priority: Set the key priority operation mode for each of the M/E and 

P/P banks. In DSK mode, the key priority is fixed.
• Xpt Hold mode: Set the operation mode for the cross-point hold button 

provided on the key bus for each of the M/E and P/P banks.
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• Pattern Limit Transition: Set the operation mode when the pattern limit is 

released for each of the M/E and P/P banks.
• Wipe Edge Default: Adjust the wipe edge softness for each of the M/E and 

P/P banks.
• FM Auto Store: Switch on or off the function to automatically attach a name 

and save in frame memory.

Link settings (Link)
• Internal Bus Link: Make a setting of the bus link function that links 

together two buses internal to the switcher.
• GPI Link: Make settings for linking any cross-point buttons or [CUT] and 

[AUTO TRANS] buttons in the cross-point control block and GPI output 
ports.

• M/E Link: Make settings to link together two M/E banks.
• Key Trans Link: Make settings to link key transitions.

External device connections (Device Interface)
• Remote Assign: Set the use of the four 9-pin ports.
• GPI Input: Set the GPI input ports and trigger polarities, and make the 

action settings.
• GPI Output: Set the GPI output ports and trigger polarities, and make the 

action settings.
• Aux Control: Set whether operations on the AUX buses from the four 9-pin 

ports are inhibited.
• DME Type Setting: When the DME is an MVE-9000 or MVE-8000A, carry 

out interface settings, and for an SDI interface set the AUX bus outputs and 
reentry inputs.

DME Setup

In DME setup, carry out settings particular to the DME processor.
You can make the following settings.

Input signal settings (Input)
• Initial Crop: Make the initial crop setting.
• Matte Illeg. Color Limit: Switch the illegal limiter for the signal generated 

by the DME internal matte generator on or off.
• System Phase: Adjust the operation timing of the whole system with respect 

to the reference signal.
• TBC Center: Set the TBC window center position.
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Output signal settings (Output)
These settings are possible only when the DME is an MVE-9000 or SDI-
interfaced MVE-8000A.
• Monitor Output: Set the signals output from the four monitor output 

connectors.
• Clip Adjust: Adjust the clip levels of DME1 and DME2 outputs.

Interface with external devices (Device Interface)
• Editor Protocol: Set the protocol to be used on the Editor port.
• Editor Port Setting: Make settings relating to the control of the four editor 

ports installed in the DME.
• GPI Input: Set the GPI input ports and trigger polarities, and make the 

action settings.
• GPI Output: Set the GPI output ports and trigger polarities, and make the 

action settings.

Setup Relating to DCU Input/Output

In DCU setup, carry out settings particular to the DCU.
You can make the following settings.
• Input Config: Assign GPI inputs to Parallel input ports.
• GPI Input Assign: Make GPI input settings.
• Output Config: Assign GPI outputs to parallel output ports inserted in an 

option slot.
• GPI Output Assign: Make GPI output settings.
• Serial Port Assign: Set the protocol to match the devices connected to a 9-

pin serial port. You can also select the control panel used to control each 
device.

Setup Relating to the Router Interface and Tally 
Interface

Carry out settings relating to the interface with the routing switcher, and 
settings relating to the tally interface.
You can make the following settings.

Router interface setup (Router)
These settings are common to the parallel tally and serial tally.
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• Matrix Size: Assign the switcher matrix of each switcher processor to S-Bus 

space, and select the matrix size and positioning level, source address 
settings, and so on.

• External Box: To obtain the signal selection status of external devices with 
a parallel input, assign a matrix as an external selector in the S-Bus space. 
Make the matrix size, assignment level, source address, and other settings.

• Alias Name Gp: Set the group number for an S-Bus description name to be 
displayed in the source name displays for a cross-point operation.

Tally interface setup (Tally)

Group tally settings (Group Tally)
• Tally Group: Select the group tally (Gp1 to 4 or Gp5 to 8) which can be 

used. (For the parallel tally, all groups can be used regardless of this setting.)
• S-Bus Tally Enable: Specify S-Bus tally enabled or disabled.

Wiring information input (Wiring)
Input the information which specifies the physical wiring between switcher 
and routing switcher or between two routing switchers.
These settings are common to the parallel tally and serial tally.

Tally enable settings (Tally Enable)
Specify the destination to be the reference for tally generation, and make 
various settings.
These settings are common to the parallel tally and serial tally.
• Tally Type: Specify the tally type.
• Destination: Specify the address and level.
• Tally Enable: Specify the timing at which a tally is enabled.

Enable: Always enabled.
Disable: Always disabled.
Tally Input: Follow the tally input status.

Copy (Tally Copy)
Copy the tally information pertaining to a particular source to a different 
source.
These settings are common to the parallel tally and serial tally.

Parallel port settings (Parallel Tally)
Make the parallel port settings for output of tally information pertaining to 
sources and destinations.
For each of the tally output terminal numbers, specify the tally type, and source 
address or destination level and address.
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Serial tally settings (Serial Tally)
Make the serial tally settings, including tally type and source address for each 
serial tally port.

Simple Connection to MKS-8080/8082 AUX Bus Remote 
Panel (Option)

To connect the MKS-8080/8082 AUX Bus Remote Panel to a CCP-8000 
Center Control Panel using an S-Bus data link requires a BKPF-R70A Routing 
Switcher Controller Board or similar primary station and various settings for 
connection.
However, using a simple connection, the need for an S-Bus data link primary 
station is avoided, and direct connection to the MKS-8080/8082 is possible.
A simple connection is possible if the following conditions are met:
• There are no devices other than the CCP-8000 and MKS-8080/8082 

connected on the S-Bus data link.
• There are no more than 16 MKS-8080/8082 units connected on the S-Bus 

data link.

For details of the connection procedure, see “Procedure for Simple 
Connection” in Chapter 16 (Volume 2).
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Files

You can save register data, including setup information and snapshot 
information, as a file on a hard disk or memory card, and recall it as required.
You can operate on individual files or registers, or together in a batch.
Regarding frame memory, it is possible to capture image data stored in an 
external device into frame memory. You can also convert the format of image 
data in frame memory into a different format and save it in an external device.

Files that can be manipulated
The following files can be saved and recalled.
• Operation mode setup data for system as a whole and individual devices
• Device status data for system startup
• Key memory setting data
• Video process memory setting data
• Keyframe effect setting data
• Snapshot setting data
• Wipe snapshot setting data
• DME wipe snapshot setting data
• Key snapshot setting data
• Shotbox setting data
• Macro setting data
• Macro attachment data
• Frame memory image data

File operations
You can carry out the following file operations.

When operating on individual files or registers
Save: Save the data in a register to the hard disk or memory card.
Load: Load a file from the hard disk or memory card.
Copy: Copy a file within a directory or from one directory to another. When a 

remote panel is used, this function applies to it, too.
Rename: Rename a file on the hard disk or memory card.
Delete: Delete a file from the hard disk or memory card.

When operating on files or registers in a batch
The Save, Load, Copy and Delete operations are performable.
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Importing or exporting files to or from frame memory
Import: Import a file in a different format from hard disk or memory card into 

frame memory after changing its format.
Export: Export a file in a register to hard disk or memory card after changing 

its format.

You can import TIFF, BMP, and TARGA files as follows into frame memory. 

a) Windows is a registered trademark or trademark of Microsoft Corporation in the United States 
and/or other countries.

Note
This functionality has been tested and confirmed to work with TIFF files 
created by Photoshop, but it may not be possible to use TIFF files created
with some other software. (Photoshop is a trademark of Adobe Systems 
Incorporated.)

About import image size
Pay attention to the following, depending on the signal format which you use.

SDTV (480i)
Images 720 × 487 pixels in size are exactly the size which fills the full screen.
The following figure shows how an import image is processed when the 480i/
59.94 format is used.
Images are placed with the upper left of the screen as the origin.
When an image is smaller than the screen, the remainder of the screen is filled 
with black. When it is larger, parts which extend beyond the screen are 
discarded.

File type Format File name Notes

TIFF file RGB 
uncompressed 
format

Maximum eight 
characters, plus 
extension .tif required

• Layers cannot be used.
• If an alpha channel is 

present, two files are 
created as a pair.

BMP file Windows a) 24-
bit format

Maximum eight 
characters, plus 
extension .bmp required

–

TARGA file RGB 
uncompressed/
compressed 
format

Maximum eight 
characters, plus 
extension .tga required

• Layers cannot be used.
• If an alpha channel is 

present, two files are 
created as a pair.
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No pixel ratio conversion is performed when images are imported for the 
SDTV format. When the signal format is 480i/59.94, if you create an image 
with a size of 720 × 540 on a computer and then import it just as it is, the image 
will be too tall. To maintain the shape of the image, first create it as a 720 × 540 
image and then use computer software tools to compress the vertical dimension 
to 487 pixels before importing it.

HDTV (1080i)
Images of 1920 × 1080 pixels in size are exactly the size which fills the full 
screen.
Like SDTV, images are placed with the upper left of the screen as the origin.
When an image is smaller or larger than the screen, processing is the same as 
for SDTV.
Since the pixel ratio of the HDTV format is 1:1, files created on computers are 
imported in their original shapes.

The following table shows the image sizes which exactly fill the full screen for 
the various signal formats.

Signal format Image size (H × V)

480i/59.94 720 × 487

576i/50 720 × 576

720 pixels

487 pixels

Position of small picture

Section filled with black for 
a small picture

Parts discarded when 
image is too large
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Directory operations
You can create a new directory within a hard disk or memory card, and carry 
out other operations, such as renaming and deleting.

For details of operations, see “Directory Operations” in Chapter 17 (Volume 
2).

File copying between different unit IDs
Switcher and DME files within the hard disk or memory card are managed by 
unit ID.
To copy files between different unit IDs, use the Unit ID Copy menu.

For details of operations, see “Copying Files Between Different Unit IDs” in 
Chapter 17 (Volume 2).

 Saving data recalled by autoload
At power on, you can automatically recall data previously stored on the hard 
disk. (Autoload function)
The following data can be loaded by the autoload function.
• Keyframe effect setting data
• Snapshot setting data
• Wipe snapshot setting data
• DME wipe snapshot setting data
• Key snapshot setting data
• Shotbox setting data
• Macro setting data
• Macro attachment data
• Frame memory image data

To use the autoload function, the data required must first be saved.

1080i/50 1920 × 1080

1080i/59.94

1080PsF/23.976

1080PsF/24

1080PsF/25

1080PsF/29.97

720p/50 1280 × 720

720p/59.94

Signal format Image size (H × V)
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For the on/off setting of the autoload function, see “Selecting the State After 
Powering On (Start Up Menu)” in Chapter 16 (Volume 2).

For details of saving operations, see “Saving Files Recalled by Autoload” in 
Chapter 17 (Volume 2).
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Macros

Overview

The term “macro” refers to the function whereby a sequence of signal 
selections and other operations on the control panel is saved as data in memory, 
so that it can be recalled as required to automatically execute the same 
sequence of operations.

For details of macro operations, see “Macros” in Chapter 18 (Volume 2).

Macro registers
The area of memory that holds a macro is termed a “macro register.” For each 
control panel there are 99 macro registers, numbered 1 to 99.

Events
The individual control panel operations constituting a macro are termed 
“events.” One macro can contain a maximum of 99 events.
The following table shows the operations for each control block of the control 
panel that can be saved as events in a macro.

Control block Event

Auxiliary bus control block Cross-point selection

Cross-point selection in router control mode

Cross-point control block Cross-point selection
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Transition 
control block

standard type • Auto transition and cut for the transition execution 
section

• Auto transition and key on/off for the independent 
key transition execution section a)

• Next transition setting
• Transition type selection
• Pattern limit on/off
• Key snapshot recall
• VTR/disk recorder/Extended VTR playback b)

• VTR/disk recorder/Extended VTR stop b)

• VTR/disk recorder/Extended VTR cue-up b)

simple type • Transition execution section take
• Tansition type selection
• Pattern limit on/off

compact type • Transition execution section auto transition and cut 

• Independent key transition execution section auto 
transition a)

• Next transition setting
• Transition type selection
• Pattern limit on/off
• VTR/disk recorder/Extended VTR playback b)

• VTR/disk recorder/Extended VTR stop b)

• VTR/disk recorder/Extended VTR cue-up b)

Independent key transition 
control block
(simple type)

• Independent key transition execution section take 
and key on/off a)

• Key snapshot recall
• Selection of independent key transition type

Flexi Pad 
control block

standard type Recalling the following data
• Snapshots
• Wipe snapshots
• DME wipe snapshots

simple type Recalling the following data
• Snapshots
• Wipe snapshots
• DME wipe snapshots

Numeric keypad control block Recalling the following data
• Effects
• Snapshots
• Shotbox
• Master snapshots
• Master timeline

Keyframe control block • Effect rewind
• Effect execution
• Effect fast forward
• Selection of effect execution direction

Control block Event
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a) In the case of an event that inserts or deletes a key, the key state at the time of event registration 
(inserted or not inserted) is also saved in the macro. When the macro is executed, the event is 
only replayed if the key state matches the saved state. (Example: For a macro with an event that 
deletes a key, when the macro is executed, if the key is inserted it is deleted, but otherwise 
nothing occurs as concerns keying.)

b) Function valid only when [PLAY], [STOP], and [CUEUP] have been set in the Setup menu.

Macro Creation and Editing

You can create or edit a macro by recalling a macro register.
To create a new macro, recall an empty macro register, and create the desired 
sequence of events (by executing the sequence of operations on the control 
panel that you want to save as events in the macro).
To add an event to an existing macro, recall the register holding the macro, and 
create the event you want to add. 

Note
While editing a macro, it is not possible to execute another macro.

Creating a macro

To include all information associated with an operation when 
registering a macro event
When registering an auto transition operation as an event, you can register the 
auto transition event to include the transition rate and background A/B bus 
selection status. When registering an effect execution, rewind, or fast forward 
as an event, you can also save the region to which this applies.

Device control 
block

trackball,
joystick,
search dial

• VTR/disk recorder/Extended VTR start point setting
• VTR/disk recorder/Extended VTR playback
• VTR/disk recorder/Extended VTR stop
• VTR/disk recorder/Extended VTR cue-up
• VTR/disk recorder/Extended VTR fast forward
• VTR/disk recorder/Extended VTR rewind

Downstream key control block • Independent key transition execution section auto 
transition and cut a)

• Key snapshot recall

Fade to black control block Execution of fade to black transition

Menu control block • Disk recorder/Extended VTR file recalling
• Recalling the functions assigned to [PREFS 1] to 

[PREFS 8] buttons

Utility/Shotbox control block Recalling the functions assigned to memory recall 
buttons

Control block Event
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To use this capability, assign the following functions to user preference buttons 
in the menu control block or buttons in the utility/shotbox control block, and 
turn the relevant button on before you start an event to register.

Macro AT with Rate (Macro Auto Trans Event with/without Rate): When 
registering an auto transition macro event in the M/E or PGM/PST bank, 
include the transition rate.

Macro AT with A/B Bus (Macro Auto Trans Event with/without A/B Bus): 
When registering an auto transition macro event in the transition control 
block, include the background A/B bus cross-point.

Macro TL with Region (Macro Timeline with Region): When registering an 
effect execution, rewind, or fast forward as a macro event, save the 
affected region together in the macro.

For details of the method of assigning these functions to buttons, see “Setting 
Button Assignments (Prefs/Utility Menu)” in Chapter 16 (Volume 2).

Events requiring adjustment when creating a macro
The following events require time for execution to complete, and therefore 
when executed within a macro sequence, a pause event must be inserted to 
adjust the timing.
• Rewinding effects involving external device control
• VTR/disk recorder/Extended VTR cue-up

For example, create a macro to cue up a VTR and then play back as follows.

Auto insert mode on/off setting
You can switch on or off the mode (auto insert mode) in which at the same time 
that a control panel operation is carried out, the event is automatically saved in 
a macro. 

Editing a macro
You can carry out the following macro editing operations.

Event insertion
Insert the control panel operation as an event in a macro.

Macro event execution order:

Macro events:
199Macros



200

   C
hapter 1 

M
V

S
-8000 F

unctions
Event modification
Modify any event. You can modify all events within a macro, or events within 
a specified range in a single operation.

Event deletion
Delete any one event. You can delete all events within a macro, or events 
within a specified range in a single operation. You can then paste the deleted 
event using the paste function.

Event copy
Copy any one event. You can copy all events within a macro, or events within 
a specified range in a single operation.

Event paste
Paste a copied or deleted event at a desired position within a macro.

Undoing an editing operation
You can undo the last event insertion, modification, deletion, or paste 
operation.

Macro merging
During macro editing, you can recall and copy another register to merge it with 
the macro being edited.

For example, while editing macro register 2 you can recall and copy register 1 
to merge it as shown in the following figure.
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Macro Execution

To execute a macro, recall the register in which the macro is held. 
Simultaneous with the register recall, all events stored in the macro are played 
back (executed) in sequence without pause.

Pausing and restarting macro execution
It is also possible to execute a macro in the following ways.

Pause event
To adjust the execution timing of a particular event (to delay the start of 
execution of the event by a particular time interval), you can store a special 
event which pauses macro execution. This event is called a “pause event.” 
When you store a pause event, you can set the interval for which the macro is 
paused (the pause length) to any value in the range 1 to 999 frames. When the 
set time has elapsed, the macro is automatically executed.

Pause zero event
By including a pause event with the time set to zero, you can make macro 
execution pause at the pause event.

41 2 3 1 2 3

1 2 3

1 2 3 4 5 6 7

Recall macro register 2, and 
move to another event. Recall register 1.

Macro being edited (register 2) Newly recalled macro (register 1)

Copy contents of 
register 1 and add 
after current event 
(register 2).

Contents of 
register 1 remain 
unchanged.
201Macros



202

   C
hapter 1 

M
V

S
-8000 F

unctions
Step execution (requires a Setup menu setting)
By selecting step execution mode in the Setup menu, you can make macro 
execution pause every time an event is executed.

Take operation
When a paused macro is restarted, this is referred to as a “Take” operation.

Macro take operation using a GPI input
You can carry out a macro take operation using a GPI input on the control panel 
and DCU.

For GPI input settings, see “Interfacing With External Devices (Device 
Interface Menu” and “GPI Input Setting (GPI Input Assign Menu)” in Chapter 
16 (Volume 2).

Macro Editing Using Menus

Macro Register Editing
You can lock, copy, and delete the contents of macro registers, and rename 
macro registers.
Lock: Write-protect the contents of a macro register.
Copy: Copy the contents of a macro register to another macro register.
Delete: Delete the contents of a macro register.
Rename: Rename a macro register.

Online editing of macro events
Using the On Line Edit menu, you can carry out the following editing 
operations while checking the control panel operation sequence. You can also 
carry out editing using the panel and menu.
Insert: Insert a macro event.
Delete: Delete a macro event.
Modify: Modify a macro event.

Offline editing of macro events
Using the Off Line Edit menu, you can carry out the following editing 
operations in the menu only, unrelated to operation of the control panel.
Insert: Insert a macro event.
Add: Add a macro event.
Delete: Delete a macro event.
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You can also create a new macro.

Macro Attachment

Macro attachment is a function whereby a macro register is assigned to a 
control panel button or a particular position of a fader lever, linking the 
execution of the button function or a fader lever operation with a macro 
execution.

Setting a macro attachment to a button
Select one of the following three linking modes to make the macro attachment.
Pre-macro: Mode in which the button function is executed after macro 

execution has completed
Post-macro: Mode in which the macro is executed after carrying out the button 

function
Macro only: Mode in which the button function is not executed, and the macro 

only is executed

The selection of pre- or post-macro mode is carried out in the cross-point 
control block of the PGM/PST bank or the M/E banks. For the macro-only 
mode, assign the selection function to a utility/shotbox control block button or 
user preference button, and make the selection by pressing the button.

You can assign any one of the 99 macro registers to a button.
For a button whose function is switched by delegation, you can make a separate 
macro attachment for each function.
For each control panel, you can make up to 1000 macro attachment settings.
The macro attachment setting is possible for the following bus buttons. For 
button locations, see pages in parentheses.
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Block Button

PGM/PST or M/E bank • Background A row cross-point buttons (page 236) 
• Background B row cross-point buttons (page 236)
• Key 1 bus cross-point buttons (page 236)
• Key 2 bus cross-point buttons (page 236)
• Key 3 bus cross-point buttons (page 236)
• Key 4 bus cross-point buttons (page 236)
• Utility 1 bus cross-point buttons (page 236)
• Utility 2 bus cross-point buttons (page 236)
• DME external video bus cross-point buttons (page 

236)
• DME utility 1 bus cross-point buttons (page 236)
• DME utility 2 bus cross-point buttons (page 236)
• [AUTO TRANS] button a) (page 240)
• [CUT] button (page 240)
• [KEY1 ON] to [KEY4 ON] buttons a) (pages 240, 

281)
• The button to which the same function as that of 

VTR/disk recorder/Extended VTR play button 
(page 240)

• Buttons set to “Inhibit” (page 236)

Auxiliary bus control block • Cross-point button1st row b) (page 265)
• Cross-point button 2nd row b) (page 265)

Keyframe control block • [RUN], [REWIND] and [FF] buttons (page 259)
• [NORM], [REV], and [NORM/REV] buttons (page 

259)

Device control block (trackball, 
joystick)

The buttons to which the same functions as those of 
VTR/disk recorder/Extended VTR play, cue, stop, 
and start tc buttons (page 250)

Device control block (search 
dial) 

[PLAY], [CUE], [STOP] and [START TC] buttons

Downstream key control block • [DSK1 ON] to [DSK4 ON] buttons a) (page 283)
• [TAKE] button a) (page 283)
• [MIX], [WIPE], [DME], and [CUT] buttons (page 

283)

Transition control block • [PTN LIMIT] button c) d) (page 240)
• [LIMIT SET] and [KF] buttons c) d) (page 240)
• [NORM], [NORM/REV], and [REV] buttons c) e) 

(pages 240, 287)
• [MIX], [NAM], [SUPER MIX], [PST COLOR MIX], 

[WIPE], and [DME] buttons (pages 240, 276, 287)
• [MIX], [WIPE], and [DME] buttons d) (page 240)
• [ALL], [KEY PRIOR], [BKGD], and [KEY1] to  

[KEY4] buttons (pages 240, 276, 287)
• [CUT] button f) (page 281)

Fade to black control block [FTB] button (pages 264, 285)

Downstream key/fade to black 
control block

• [DSK1 ON] and [DSK2 ON] buttons
• [AUTO TRANS] button
• [FTB] button
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a) In the case of an event that inserts or deletes a key by an independent key transition, the key state 
at the time of event registration (inserted or not inserted) is also saved in the macro. When the 
macro is executed, the event is only replayed if the key state matches the saved state. (Example: 
For a macro with an event that deletes a key, when the macro is executed, if the key is inserted 
it is deleted, but otherwise nothing occurs as concerns keying.)

b) Cross-point buttons of the bus assigned by AUX delegation setting.
c) Macro attachment can be set with these buttons only when they are assigned to [Play/Stop/Cue] 

in the Engineering Setup >Panel >Config >Program Button >Transition Module menu and when 
the [DEV] button in the device control block is lit.

d) Buttons on the standard type module only.
e) Buttons on the standard type module and compact type module only.
f) Independent key transition control block (simple type only).
g) “KEYx” refers to any of KEY1 to KEY4 and DSK1 to DSK4, depending on the key assigned in 

setup.
h) When there are a number of control blocks on the control panel, and the keys assigned to them 

in setup are the same, then the macro attachment settings for the above buttons are the same.
The keys being the same includes cases such as “Key1,2”  assigned to PGM/PST being the same 
as “DSK1,2”, “Key1,2”  assigned to M/E-1 being the same as “M/E-1 Key1,2”, and so on.

Notes
• After setting a macro attachment to a cross-point button in the auxiliary bus 

control block, if in the Setup menu you change the assignment of buses to the 
AUX delegation buttons, the macro attachment setting disappears.

• After setting a macro attachment to a button for which you can perform 
function replacement or function assignment, if you change the function 
assignment to the button, the macro attachment setting disappears.

• After setting a macro attachment to a cross-point button in the cross-point 
control block, if you change the function assignment to the button, the macro 
attachment setting disappears.

Enabling and disabling macro attachment
You can temporarily disable the macro attachment settings. When a macro 
attachment is disabled, pressing the button does not cause execution of the 
assigned macro.
You can enable and disable macro attachments for the PGM/PST bank and M/
E banks individually.

Utility/shotbox control block Memory recall buttons (page 275)

Menu control block [PREFS 1] to [PREFS 8] buttons (page 271)

Independent key transition 
control block (simple type) h)

• [KEYx ON] button a) g)

• [TAKE] button a)

• [MIX], [WIPE], [DME], and [CUT] buttons

Block Button
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Setting a macro attachment to a fader lever
You can set a macro attachment to any particular position of a fader lever in the 
transition control block.

Notes
• In macro-only mode it is not possible to set a macro attachment.
• It is not possible to set a macro attachment to a fader lever in the keyframe 

control block or downstream key control block.
• For a split fader, you can set a macro attachment to the main split fader.

For details of a split fader, see “Split Fader” (page 346).

Clearing the macro attachments
You can clear all of the macro attachments in a single operation.

Displaying the macro attachment list
You can display the macro attachment settings in the form of a list in the menu 
display to check them.
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Color Corrector

The color corrector enables video signal color correction (black balance/white 
balance adjustment, gamma correction, knee correction, etc.).

Note
To use the color corrector function requires the MKS-8420M Color Corrector 
Board.

The color corrector includes the following functions.

Input video processing
Carrying out the following corrections to a YUV signal before conversion to 
an RGB signal.
• Overall gain adjustment of the video signal
• Gain adjustment of the Y signal
• Gain adjustment of the C signal
• Hue delay
• Black level adjustment

Primary color correction
Carrying out the following corrections to each of the R, G, and B signals.
Black balance adjustment: setting the output level for a 0% level input signal.
White balance adjustment: setting the output level for a 100% level input 

signal.
Gamma correction: adjusting the curvature of the gamma curve.
Knee correction: adjusting the position of the maximum point of the gamma 

curve.
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It is also possible to mask part of the region to be corrected.

Secondary color correction
For the six colors R (red), G (green), B (blue), Y (yellow), C (cyan), and M 
(magenta), adjust the luminance and saturation, and also the hue within a range 
of ±30 degrees of the center value for each color.
You can mask a part of the region to be corrected.

Note
This function is disabled when spot CCR is enabled with a setup setting. For 
details, see “Installation and Device Setup (Install/Unit Config Menu)” in 
Chapter 16 (Volume 2).

RGB clip
For each of the R, G, and B signals, you can make dark clip and white clip 
adjustments.

Luminance processing
After converting a signal to which RGB color correction has been applied to a 
YUV signal, dividing the luminance levels into three regions, referred to as 
Dark, Middle, and Bright, and applying video signal adjustments to these 
regions.

Output level

Black balance adjustment

White balance adjustment

Input level

Unadjusted signal

Input level

Output level

Knee correction

Gamma 
correction

Adjusted signal
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There are three modes for luminance processing, as follows.
Tint mode: adding a specified color to the original video signal.
Color Modify mode: adjusting the original video signal.
Y Modify mode: adjusting the output levels of the input luminance signal.

• White balance adjustment: setting the output level for an input 
luminance signal at the 100% level.

• Black balance adjustment: setting the output level for an input 
luminance signal at the 0% level.

• Y lift correction: adjusting the curvature of the curve.
• Y dark correction: adjusting the position of the maximum point of the 

curve.

It is also possible to mask part of the region to be corrected.

Spot color adjustment
You can change the color of a specified color region to a different color, 
without affecting other regions. You can also mask part of such a region.

Under Dark point Middle/Dark point Bright/Middle point Over Bright point

Dark Middle Bright

Input signal 
luminance level

Output signal 
luminance level

Black balance adjustment

White balance adjustment

Input signal 
luminance 
level

Unadjusted signal

Input signal 
luminance 
level

Output signal luminance level

Y Dark

Adjusted signal

Y Lift
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Then for the region other than the region whose color you have changed, you 
can make the following corrections.
• Video signal overall gain adjustment
• Y signal gain adjustment
• Y signal offset adjustment
• C signal gain adjustment
• C signal hue adjustment

Note 
This function is disabled when secondary CCR is enabled with a setup setting. 
For details, see “Installation and Device Setup (Install/Unit Config Menu)” in 
Chapter 16 (Volume 2).

Output video processing
Carrying out the following corrections on the YUV signal.
• Video signal overall gain adjustment
• Y signal gain adjustment
• Y signal offset adjustment
• C signal gain adjustment
• C signal hue adjustment

YUV clip
For each of the luminance and color difference signals, the following 
processing.
White clip: setting the maximum level of the luminance signal.
Dark clip: setting the minimum level of the luminance signal.
Positive clip: setting the maximum amplitude in the positive direction of the 

color difference signal.
Negative clip: setting the maximum amplitude in the negative direction of the 

color difference signal.

Copy and swap
Copying or swapping data between two color correctors (CCR1 and CCR2).
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Simple P/P Software

Overview

By installing the BZS-8250 Simple P/P Software in the MVS-8000A/8000ASF 
Switcher Processor, you can use a separate program/preset function without 
using the M/E hardware.

Getting access to the software
To use the Simple P/P Software, you are required to enter an install key which 
validates the software. (If the software has been factory installed, the install key 
is not required.)
For the method of obtaining an install key, contact your Sony representative. 
On that occasion, you may be required to submit the unique device ID of the 
switcher you are using. You can check the unique device ID in the Install menu 
of the switcher. For details of operating procedures, see Chapter 16, 
“Installation and Device Setup (Install/Unit Config Menu)” (Volume 2).

Restrictions on Use

Since this software is a simple version of the program/preset function, there are 
some restrictions on use. The following lists the points at which operation is 
different from a normal program/preset function. For details of the normal 
operations, set the relevant sections of this manual.

Restrictions on using a downstream key
• DSK3 and DSK4 cannot be used.

For the key priority, set priority 1 or priority 2.
• The following downstream key types cannot be used.

– Chroma key
– Color vector key
– Wipe pattern key
– Key wipe pattern key

• When using a matte as the key fill for a downstream key, a mix color cannot 
be used.

• It is not possible to modify a downstream key edge. The edge blink also 
cannot be used.

• For a downstream key, main mask and sub-mask cannot be used.
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• A processed key cannot be used. Therefore, it is not possible to apply a DME 
effect to a downstream key.

• As an independent key transition type, wipe and DME wipe cannot be used.

Restrictions on executing transitions in the transition control 
block

• DME wipes cannot be used. 
• Wipes can be used, but there are restrictions on use. For details, see the next 

item, “Restrictions when using wipes.”

Restrictions when using wipes
• The wipe patterns that can be used are standard wipes (pattern numbers 1 to 

24) only.
• A pattern mix cannot be used.
• A split (splitting the wipe pattern) cannot be used.
• When a border or soft border is selected for a wipe edge, the signal to be 

inserted in the edge (edge fill) is restricted as follows.
– The utility 2 bus cannot be selected.
– When using a matte, a mix color cannot be used.
– Even if the wipe border width is set to the same numeric value for M/E and 

Simple P/P, the same image is not obtained.
• The following wipe modifiers cannot be used:

– Replication “Shift” and Multi Adjust menu adjustments
– Pairing
– Modulation
– Spring
– Spiral

• Changing modifier parameter settings changes the wipe pattern size.

Restrictions on utility buses
The utility 1 and utility 2 buses cannot be used.

Assignment of signals to output connectors
The P/P row output signal assignment to output connectors (OUT17 to 
OUT22) is fixed as follows. (Engineering Setup >Switcher >Output >Output 
Assign menu)

Note
Of the P/P row output signals, only two out of the edit preview bus and AUX 
buses can be optionally assigned to the OUT23 and OUT24 connectors. It is 
recommended that you assign such two signals to the OUT23 and OUT24 
connectors.
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a) In DSK mode, the backgrounds that can be selected in the PGM Config menu are restricted to 
background 1 and background 2.

b) Depends on the setting in the Engineering Setup >Switcher >Config >M/E Output Assign menu. 
OUT5 and OUT6 cannot be used.

Logical assignment of the physical PGM/PST
In the Engineering Setup >Switcher >Config >Logical M/E Assign menu, it is 
not possible to assign the physical PGM/PST as a logical PGM/PST.
In the <Logical M/E to Physical P/P> group, you can select from M/E-1, M/E-
2, and M/E-3.

Output 
connector

Fixed assigned outputs

Standard mode Multi-program mode DSK mode a)

OUT17 Program P/P OUT1 b) Program 1

OUT18 Program P/P OUT1 b) Program 2

OUT19 Preview P/P OUT2 b) Key preview 1

OUT20 Clean P/P OUT3 b) Key preview 2

OUT21 Key preview P/P OUT4 b) Clean 1

OUT22 Preset Preset Clean 2
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Multi Program 2

Overview

What is Multi Program 2?
By operating the switcher in Multi Program 2 mode, a single switcher mix/
effects bank can be used to create two separate video outputs, referred to as 
“main” and “sub.” You can set backgrounds, keys, and transitions for each of 
main and sub. Keys 2 to 4, however, are common to main and sub.
For example, immediately after a score in baseball two versions of the scene 
can be provided as shown below, and switched simultaneously.

Note
The Multi Program 2 function is only supported on the MVS-8000A.
To enable this function requires the BZS-8200 Multi Program 2 software. 
Depending on the CPU module, this function may not be supported. For 
details, consult your Sony service representative or sales representative.

Using the software
To use the Multi Program 2 software, you are required to enter an install key 
which validates the software. (If the software has been factory installed, the 
install key is not required.)

TEAM A

TEAM B

Background A

Key 1

Program output for “Main”

Background B

Background A 
(signal from utility 2 bus)

Key 3

Background B 
(signal from utility 3 bus)

Program output for “Sub”
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For the method of obtaining an install key, contact your Sony representative.
To obtain a key, you may be required to submit the unique device ID of the 
switcher you are using. You can check the unique device ID in the Install menu 
of the switcher.

For details of the operation, see “Installation and Device Setup (Install/Unit 
Config Menu)” in Chapter 16 (Volume 2).

Assigning main and/or sub to switcher banks
For Multi Program 2 operations, a single switcher bank may be shared, and 
switched between main and sub, or two separate switcher banks may be used, 
each dedicated to main or sub.

Example 1: Assigning M/E-1 main and sub to a single switcher bank, and 
switching between them

Example 2: Assigning separate switcher banks as “M/E-1 main dedicated” and 
“M/E-1 sub dedicated”

Video creation operations in Multi Program 2 mode
For each of main and sub, there are differences from the operations in standard 
mode.

Used switched between M/E-1 main and sub

Used for M/E-1 main operations

Used for M/E-1 sub operations
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For details, see “Differences Between Multi Program 2 Mode and Standard 
Mode” (page 225).

Sequence of Operations in Multi Program 2

Basic operation sequence
Enter the BZS-8200 install key (first time only)
↓
Set Multi Program 2 operating mode for each switcher bank
↓
Assign output signals, and set the background configuration, key 
configuration, and key preview configuration
↓
For each switcher bank, make a main/sub assignment (one of main dedicated, 
sub dedicated, and main and sub shared)
↓
For a switcher bank assigned to main and sub shared, assign the [MAIN] and 
[SUB] delegation buttons
↓
Create the main and sub images
↓
Execute the transition

Optional operations
• Making cross-point settings
• Enabling DME wipe operations for sub
• Inhibiting utility 2 bus signal selection
• Including Multi Program 2 data in keyframes and snapshots
• Changing the key assignment for each output
• Assigning sub preview output to preview selection buttons in the fade-to-

black control block
• Changing the matrix size to Standard
• Making settings for keyframe timeline operation

Basic Operations (Required)

Entering the BZS-8200 install key (first time only)
After installing the BZS-8200 Multi Program 2 software in the switcher, carry 
out the following procedure.
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1 In the status area of the Engineering Setup >System >Install/Unit Config 

menu, select the switcher (SWRx), and press [License].

The License menu appears.

2 In the License menu, enter the BZS-8200 install key.

For details of the operation, see “Installation and Device Setup (Install/
Unit Config Menu)” in Chapter 16 (Volume 2).

3 Shut down the menus. (see page 309.)

4 Power the switcher and SCU off and on again.

Setting the operating mode for each switcher bank
To set a desired switcher bank to Multi Program 2 mode, use the following 
procedure.

1 Display the Engineering Setup >Switcher >Config menu.

2 Select the switcher bank from M/E-1 to M/E-3, and P/P.

3 In the <M/E Config> group, select [Multi Program2].

Note
In the PGM/PST when using the simple P/P software (see page 211), 
[Multi Program2] cannot be selected.

4 Repeat steps 2 and 3 as required, to set the operating mode for all desired 
switcher banks.

Assigning output signals for Multi Program 2 mode

To assign signals to outputs
Use the Engineering Setup >Switcher >Config >M/E Output Assign menu.
The difference from standard mode is that OUT1 is fixed, set to PGM1 (main 
program), and OUT6 is fixed, set to PGM2 (sub program), and that for the 
OUT2 to OUT5 signals you can assign any signal selected from the following.

PGM1, PGM2, PGM3, PGM4, PVW1, PVW2, K-PVW1, K-PVW2, 
CLEAN, SUB CLEAN

Note
Each of main and sub can use a maximum of four of the six outputs (OUT1 to 
OUT6). The outputs can be used within the following limits.
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• OUT1, OUT2: main only
• OUT3, OUT4: can be used for either main or sub
• OUT5, OUT6: sub only

For details, see “To assign the output of each bank in Multi Program mode” 
in Chapter 16 (Volume 2).

To set the background and key configuration
Use the Engineering Setup >Switcher >Config >PGM Config menu.
The following are the differences from standard mode.
Background configuration: Consists of the following combinations.

• For main: Clean, Bkgd A, Bkgd B
• For sub: Sub Clean, Utility 2, Utility 3

Key configuration: Key1 can be set to “Enable” only when the background is 
Clean, Bkgd A, or Bkgd B.

For details, see “To set the output configuration for each bank” in Chapter 16 
(Volume 2).

To set the key preview configuration
Use the Engineering Setup >Switcher >Config >K-PVW Config menu.
The following are the differences from standard mode.
Background configuration: Clean or Sub Clean
Key configuration: Key1 can be set to “On” or “Link” only when the 

background is Clean.

For details, see “To set the key preview configuration” in Chapter 16 (Volume 
2).

To assign sub outputs to output ports
Use the Engineering Setup >Switcher >Output >Output Assign menu.
You can assign a sub output signal to a switcher output port number.

For details, see “Assigning output signals” in Chapter 16 (Volume 2).

Assigning main and/or sub to switcher banks
For each switcher bank for which Multi Program 2 mode is selected, set 
whether this is main dedicated, sub dedicated, or main and sub shared.

To assign main and sub to a single switcher bank
Use the following procedure.

1 In the Engineering Setup >Panel >Config >MP2 Main/Sub Assign menu, 
select the switcher bank.
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2 In the <Main/Sub Assign> group, select [Main&Sub].

Main: use for main operations.
Sub: use for sub operations.
Main&Sub: use for both main and sub operations.

When “Main&Sub” is selected, it is necessary to assign [MAIN] and 
[SUB] delegation buttons to the control panel.

To assign main and sub to two consecutive switcher banks
For example, to assign the first row (first switcher bank) to M/E-1 main, and 
the second row (second switcher bank) to M/E-1 sub, use the following 
procedure.

1 In the status area of the Engineering Setup >Panel >Config >MP2 Main/
Sub Assign menu, select 1st Row (M/E-1), then press [Main] in the <Main/
Sub Assign> group.

2 Press [Dual M/E Assign] to assign M/E to two banks.

In this state, both 1st Row and 2nd Row are set to main.

3 Set “2nd Row” to [Sub].

This cancels the shift/non-shift assignment for dual M/E in standard mode.

Note
It is not possible to assign the combinations of Main with Main&Sub, or Sub 
with Main&Sub.

Assigning the [MAIN] and [SUB] delegation buttons to buttons 
on the control panel

You can assign the [MAIN] and [SUB] delegation buttons to any of the 
following three places.

To assign to the pattern limit buttons (PTN LIMIT and LIMIT SET) in 
the transition control block (standard type)

For details of the transition control block (standard type), see page 240.

Use the following procedure.

1 In the Engineering Setup >Panel >Config menu, press [Program Button].

The Program Button menu appears.
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2 Press [Transition Module].

The Transition Module menu appears.

3 Select the switcher bank, then in the <PTN LIMIT/LIMIT SET/KF Button 
Assign> group, press [Main/Sub].

You can now use the [PTN LIMIT] button as [MAIN], and the [LIMIT 
SET] button as [SUB].

To assign to the wipe direction selection buttons (NORM and 
NORM REV) in the transition control block
This applies to a standard type and compact type transition control block.

For details of the transition control block (standard type), see page 240, and 
for details of the transition control block (compact type), see page 287.

Use the following procedure.

1 In the Transition Module menu, select the switcher bank.

2 In the <NORM/NORM REV/REV Button Assign> group, press [Main/
Sub].

You can now use the [NORM] button as [MAIN], and the [NORM/REV] 
button as [SUB].

To assign to macro buttons in the cross-point control block

For details of the cross-point control block, see page 236.

Use the following procedure.

1 In the Engineering Setup >Panel >Config menu, press [Program Button].

The Program Button menu appears.

2 Press [Xpt Module].

The Xpt Module menu appears.

3 Select the switcher bank, then in the <PRE MCRO/POST MCRO> group, 
press [Main Sub].

You can now use the [PRE MCRO] button as [MAIN], and the [POST 
MCRO] button as [SUB].
Multi Program 2



  C
hapter 1 

M
V

S
-8000 F

unctions

To assign macro operations to different buttons
If in the above operation you assigned a Multi Program 2 function to the macro 
buttons, you can assign the PRE MCRO and POST MCRO functions to 
different buttons.

For details, see “Assigning functions to user preference buttons” or 
“Assigning a function to a memory recall button in the utility/shotbox control 
block” in Chapter 16 (Volume 2).

Examples of Operations in the Multi Program 2 Mode 
(When Sharing a Switcher Bank)

To create video on the M/E or PGM/PST bank assigned to both main and sub 
operations, use the following procedure.

1 Press the [MAIN] button, turning it on, and turning off the [SUB] button.

2 With the normal operations, create the main video.

3 Press the [SUB] button, turning it on, and turning off the [MAIN] button.

Now you can create the sub video.

4 Create the sub video.

The basic method of operation is the same as for the main video, except 
that the utility 2 bus signal is assigned to background A, and the utility 3 
bus signal is assigned to background B.
For sub, only keys 2 to 4 can be used, and for wipes, standard wipe patterns 
only. There are also other differences in operation from standard mode.

For details, see “Differences Between Multi Program 2 Mode and 
Standard Mode” (page 225) and “Restrictions on Using Multi Program 2 
Mode” (page 227).

5 Press the [MAIN] and [SUB] buttons simultaneously, turning them on.

If both buttons are lit, the control panel shows the status of main.

6 Carry out the transition.

Both main and sub video images are switched.
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Optional Operations

Making cross-point settings
Cross-point assign tables can be set not only for main output but also for sub 
output.
You can set cross-point assign tables for the following banks.

M/E-1 SUB to M/E-3 SUB
P/P SUB

The table actually used is that for which the control panel delegation button is 
lit.

For details, see “Cross-Point Settings (Xpt Assign Menu)” in Chapter 16 
(Volume 2).

Enabling DME wipe operations for sub
By factory default, DME wipe operations are inhibited for sub background. To 
enable them, in the Engineering Setup >Switcher >Config menu, set [DME 
Wipe Sub Enable] to On.
This enables DME wipe operations for sub background.
This setting applies to the whole control panel (all M/E banks and PGM/PST 
bank).

Note
If a DME wipe for sub is recalled in a snapshot or keyframe, the image will not 
be handled correctly.

Inhibiting utility 2 bus signal selection
In Multi Program 2 mode, you can inhibit other uses of the utility 2 bus signal 
in order to use the signal as the background for sub.
This setting applies to the whole control panel (all M/E banks and PGM/PST 
bank).
In the Engineering Setup >Panel >Config >MP2 Main/Sub Assign menu, set 
[Util2 Inhibit] to On.
This inhibits operations of selecting from the background B row while holding 
down the [UTIL] button in the cross-point control block.

Including Multi Program 2 data in recall operations of keyframes 
and snapshots

In the Engineering Setup >Switcher >Config menu, set [Recall M/E Config] to 
On.
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When a keyframe or snapshot is stored or recalled, the following data is 
included.

M/E Config, PGM Config, M/E Output Assign, and Key PVW Config

For details of the above data, see “Setting the operating mode for each 
switcher bank” (page 217) and “Assigning output signals for Multi Program 
2 mode” (page 217).

This setting applies to the whole control panel (all M/E banks and PGM/PST 
bank).

Note
M/E Config data is saved, even when this setting is Off.

Changing the key assignment for each output (Misc menu)
In Multi Program 2 mode you can change the key assignments independently.
The following describes an example using M/E-1, but the operation is the same 
for other banks.

Notes
• This setting is linked to the setting in the Engineering Setup >Switcher > 

Config >PGM Config menu.
• It is not possible to make this setting while the above PGM Config menu is 

locked, or [Recall M/E Config] (see previous item) is set to Off.

1 In the M/E-1 menu, select first VF7 ‘Misc,’ then HF5 ‘Key Assign.’

The Key Assign menu appears, and the current key assignment is shown 
in the status area.

2 Change the setting in “Key Enable” as required.

Assigning sub preview output to preview selection buttons
You can assign the sub preview output to a preview selection button in the 
fade-to-black control block or downstream key/fade-to-black control block.

For details, see “Overall Control Panel Settings (Config Menu)” in Chapter 
16 (Volume 2).

When the Multi Program 2 license is valid, by assigning the “Shift” function to 
a button, you can assign two preview outputs, “Shift” and “Unshift” to a single 
button. To use the shift output, always assign “Shift” to some button.
223Multi Program 2



224

   C
hapter 1 

M
V

S
-8000 F

unctions
Changing the matrix size to Standard
When using a router, if the matrix size is set to [Compact (128×128)], it is not 
possible to control the utility 3 bus on the S-Bus. When using Multi Program 
2, in the <Matrix Size> group of the Engineering Setup >Router/Tally >Router 
menu, select [Standard (136×138)].

For details, see “Assigning switcher inputs and outputs to S-Bus space” in 
Chapter 16 (Volume 2).

As for the bus number of the utility 3 bus, a DME Key bus number is used as 
follows.

Making settings for timeline-related keyframe operations

To assign sub regions to the region selection buttons in the 
numeric keypad control block
In the Engineering Setup >Panel >Config >10 Key Region Assign menu, 
assign regions to the region selection buttons in the numeric keypad control 
block.

For details, see “Overall Control Panel Settings (Config Menu)” in Chapter 
16 (Volume 2).

To make region and reference region selections using a menu
During snapshot or keyframe operations, you can select a region (including 
sub) in the Key Frame >Region Select menu. This is convenient for selecting 
some of the regions assigned to the numeric keypad control block or changing 
the reference region.

For details, see “Specifying the Region and Edit Points” in Chapter 13 
(Volume 2).

To assign regions shown in the Timeline menu
You can select how regions assigned to region selection buttons appear in the 
Key Frame >Timeline menu.

For details, see “Setting the display of regions in the Timeline menu on or off” 
in Chapter 13 (Volume 2).

No. Bus (Standard) Bus (MP2)

70 M/E-1 DME Key M/E-1 Utility3

85 M/E-2 DME Key M/E-2 Utility3

100 M/E-3 DME Key M/E-3 Utility3

115 P/P DME Key P/P Utility3
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Functions Added in Multi Program 2 Mode

• You can set video processing for the utility 3 bus signal.
• In the control panel and DCU GPI input settings and switcher GPI link 

settings, the actions that can be selected now also include “Sub Cut” and 
“Sub Auto Trans.”

• A switcher GPI link can now be set also for the utility 3 bus.
• To the macro event configuration parameters and macro attachment settings, 

“Main & Sub” and “Sub” have been added.
• For cross-point button link settings, M/E-1 to M/E-3, and P/P “Sub 

Program,” “Sub Preset,” and “Sub Trans PGM” have been added to the link 
source bus.

• Snapshot attributes can now be set independently for main and sub.
• There are additional menus for sub which can be recalled by pressing a 

button twice.

Differences Between Multi Program 2 Mode and 
Standard Mode

The differences from operation in standard mode are as follows.

Item Main Sub

Keys a) Keys 1 to 4 can be used Keys 2 to 4 only can be 
used

Wipes
(background)

Patterns Same as standard mode • Only standard patterns 
can be used

• Pattern mix is not 
possible

Modifiers Same as standard mode • Pairing, modulation, 
spring, spiral, and split 
cannot be used

• Edge fill mattes are 
single-color only

• Replication can be 
selected from four 
patterns

Wipes (key) Same as wipes (background) for sub
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a) Keys 2 to 4 are common to main and sub.

Notes
• Allow a transition to complete before carrying out main and sub delegation 

switching.
• The sub background A bus (utility 2 bus) is shared with wipe edge border fill. 

Making a change to one affects the other.
• Even if the wipe border width is set to the same numeric value for main and 

sub, the same image is not obtained.
• Changing the position of the wipe pattern for sub also changes the pattern 

size.

DME wipes Use Can be used Cannot be used (Can be 
used, with a setting 
change)

Patterns for 1 
channel

For a dedicated interface, each of main and sub can be 
used.  
For the SDI interface, only one of main and sub can be 
used.

Patterns for 2 
channels

Only one of main and sub can be used
(For each M/E, the number of DMEs that can be used is 
the same as in standard mode.)

Patterns for 3 
channels

Backgrounds Wipe edge fill matte 
(including color mix and 
other settings in the Matte 
Adjust menu)

Wipe edge fill matte 
(single-color only)

Modifiers Same as standard mode Wipe border colors are 
single-color only

Transitions Key priority Cannot be used

Transition 
preview

Cannot be used

Snapshots Cross-point 
hold

Utility 2 cannot be set Utility 3 is added. BKGD 
A/B and Key1 cannot be 
set.

Control from an editor Same as standard mode Cannot be used

Operation setting for 
switcher GPI inputs and 
outputs

Same as standard mode Cannot be used

DSK Auto Drop Cannot be used

Item Main Sub
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Restrictions on Using Multi Program 2 Mode

• The following functions are not available for sub:
– Data copy and swap
– Default recall (except for parametric recall)
– M/E link
– [TRANS] button function (see page 247)
– [TRACE] button function (see page 249) 
– [AUTO] button function (see page 286)

• Re-entry is limited to four levels. Re-entry is not possible for main and sub 
of the same M/E.

• In the following cases, a transition using the fader lever may not be 
performed correctly:
– When the main and sub bus toggle modes are set differently
– For a pattern mix, preset color mix, and so on

• For an Internal bus link, GPI link, or External bus link, the “Utility 2” bus 
cannot be selected.

• Screen aspect, show key, and [MCRO ATTCH ENBL] button settings are 
common to main and sub.

• If a snapshot is recalled simultaneously for main and sub, or a keyframe is 
executed simultaneously for main and sub, then for the following common 
to main and sub the main settings are reflected.
– Key
– M/E Config
– DME external video bus and utility 1 bus

• When a macro attachment is set on the DME utility 1 bus or DME utility 2 
bus, it is not possible to make separate main and sub settings.

• When snapshots with different M/E Config settings are recalled:
– If M/E Config data is not to be included in the snapshot data, the current 

system settings are used for snapshot reproduction.
– If M/E Config data is to be included in the snapshot data and if it was 

created before Version 5.30, then standard mode is used. If created in 
Version 5.30 or later, first M/E Config data is set, and then other snapshot 
data is recalled. 

• The bus override function is only available on the following buses:
– M/E-1 to M/E-3 Main BKGD A/B buses
– M/E-1 to M/E-3 Sub BKGD A/B buses (UTIL-2, UTIL-3 buses)
– P/P Main PGM/PST bus
– P/P Sub PGM/PST buses (UTIL-2, UTIL-3 buses)

• When a master snapshot or master timeline is executed with a key being 
assigned to both main and sub, it is uncertain which data will be reflected.

• When recalling a master snapshot with different register numbers for main 
and sub, the recall timing may differ by one field or more between main and 
sub.

• The link state is maintained even when M/E Config is changed. Set the link 
setting again, as required.
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• Since keys 2 to 4 are shared between main and sub, when the main and sub 
fader lever positions are different, if you move the fader lever, the video 
changes instantaneously to the value of the most recently moved fader lever.

• When the transition type for main or sub is set to preset color mix, it is not 
possible to carry out independent key transition operation (common to main 
and sub).
Multi Program 2



Chapter 2 Menus and Control 
Panel
Names and Functions of Parts of the Control Panel .............................231
Control Panel: Example Configuration 1

(With Standard Transition Modules) .....................................231
Control Panel: Example Configuration 2

(With Simple Transition Modules) ........................................232
Control Panel: Example Configuration 3

(With Compact Transition Modules) .....................................235
Cross-Point Control Block ................................................................236
Transition Control Block (Standard Type) ........................................240
Flexi Pad Control Block (Standard Type) .........................................244
Key Control Block .............................................................................246
Device Control Block (Trackball) .....................................................250
Device Control Block (Joystick) .......................................................255
Device Control Block (Search Dial) ..................................................256
Keyframe Control Block ...................................................................259
Numeric Keypad Control Block ........................................................262
Fade to Black Control Block .............................................................264
Auxiliary Bus Control Block (for AUX Buses) ................................265
Auxiliary Bus Control Block (for Router Control) ...........................268
Menu Control Block ..........................................................................271
Memory Card/USB Adaptor Block ...................................................272
“Memory Stick”/USB Connections Block ........................................273
Utility/Shotbox Control Block ..........................................................275
Transition Control Block and Flexi Pad Control Block (Simple Type) ..

276
Independent Key Transition Control Block (Simple Type) ..............281
Downstream Key Control Block .......................................................283
Downstream Key/Fade-to-Black Control Block ...............................285
Transition Control Block (Compact Type) .......................................287

Basic Menu Operations ............................................................................290



Menu Organization ............................................................................290
Accessing a Menu .............................................................................297
Interpreting the Menu Screen ............................................................298
Menu Operations ...............................................................................299



  C
hapter 2 

M
enus and C

ontrol P
anel
Names and Functions of Parts of the 
Control Panel

Control Panel: Example Configuration 1
(With Standard Transition Modules)

The MVS-8000 system control panel 
comprises a number of modules.
The following illustration shows a typical 
32-button, 4-M/E configuration, with 

standard transition modules used in the 
transition control block.

Control panel configuration 1 (left side)
(with standard transition modules)

Auxiliary bus control block (page 265)

M/E-1 bank

M/E-2 bank

M/E-3 bank

PGM/PST (program/
preset) bank

Cross-point control block (page 236)
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Control panel configuration 1 (right side)
(with standard transition modules)

Control Panel: Example Configuration 2
(With Simple Transition Modules)

The following illustration shows a typical 
configuration, with simple transition 

modules used in the transition control 
block. 

Memory card/USB adaptor block (page 272)
“Memory Stick”/USB connections block (page 273)

Key control block (page 246)

Keyframe control block (page 259)

Device control block (page 250/page 255)

Menu control block (page 271)

Transition control block 
(standard type) (page 240)

Fade to black control block (page 264)

Flexi Pad control block (standard type) (page 244)

Downstream key control block (page 283)

Utility/Shotbox control 
block (page 275)

Numeric keypad control block (page 262)
Names and Functions of Parts of the Control Panel



  C
hapter 2 

M
enus and C

ontrol P
anel
Except for the simple modules, this is the 
same configuration as in example 
configuration 1.

Control panel configuration 2 (left side)
(with simple transition modules)
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Control panel configuration 2 (right side)
(with simple transition modules)

Transition control block and Flexi Pad control 
block (simple type) (page 276)

Independent key transition control block 
(simple type) (page 281)
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Control Panel: Example Configuration 3
(With Compact Transition Modules)

The following illustration shows a typical 
configuration, with compact transition 

modules used in the transition control 
block. 

Control panel configuration 3
(with compact transition modules)

Transition control block (compact type) (page 287)
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Cross-Point Control Block

In the cross-point control block, you can 
select the signals to be used in this M/E 
bank or PGM/PST bank.
There are also modules without the source 
name displays shown in the following 
figure.

All operations except those of the [SHIFT] 
button are the same as for a module with 
source name displays.

a Cross-point buttons
These buttons select the signals used for 
video creation on this M/E bank or PGM/
PST bank. Each row of buttons corresponds 

to one or more signal buses within the 
switcher.
Key 1 row: The buttons in this row select 

the key 1 or key 3 signals to be inserted 

M/E
1

M/E
1

SHIFT

SHIFT
XPT

HOLD

XPT
HOLD

PRE
MCRO

KEY3

KEY4

POST
MCRO

XPT
HOLD

XPT
HOLD UTIL

M/E
1

M/E
1

M/E
2

M/E
2

M/E
2

M/E
2

M/E
3

M/E
3

M/E
3

M/E
3

SHIFT

SHIFT

SHIFT

MCRO
ATTCH
ENBL

1 Cross-point buttons

5 Source name displays

7 M/E bank display

3 Key bus selection buttons

4 UTIL button

8 Macro buttons

2 XPT HOLD buttons

6 SHIFT button

Key 1 row

Key 2 row

Reentry buttons

Reentry buttons

Background A row

Background B row
Names and Functions of Parts of the Control Panel



  C
hapter 2 

M
enus and C

ontrol P
anel
into the video on this M/E bank or 
PGM/PST bank.
To select the key 1 fill signal, check 
that the right-hand [KEY3] button in 
the M/E bank (or the [DSK3] button in 
the PGM/PST bank) is off, then press 
the button assigned to the desired 
signal. To select the key 3 fill signal, 
press the [KEY3] button, turning it on.
While the [UTIL] button on the right 
hand side is held down, these buttons 
are assigned to the DME external video 
bus allowing you to select the signal on 
that bus.

Key 2 row: The buttons in this row select 
the key 2 or key 4 signals to be inserted 
into the video on this M/E bank or 
PGM/PST bank.
To select the key 2 fill signal, check 
that the right-hand [KEY4] button in 
the M/E bank (or the [DSK4] button in 
the PGM/PST bank) is off, then press 
the button assigned to the desired 
signal. To select the key 4 fill signal, 
press the [KEY4] button, turning it on.
While the [UTIL] button on the right 
hand side is held down, these buttons 
are assigned to the DME utility 1 or 2 
bus as follows.
• When the [KEY4] button is off, 

holding down the [UTIL] button 
assigns these buttons to the DME 
utility 1 bus.

• Holding down the [UTIL] button and 
pressing the [KEY4] button, turning 
it on, assigns these buttons to the 
DME utility 2 bus.

Background A row: Press the desired 
button to select the signal as the current 
background video on this M/E bank or 
PGM/PST bank.
While the [UTIL] button on the right 
hand side is held down in Hold mode, 
these buttons are assigned to the utility 
1 bus, and can be used to select the 
signal on that bus.

Background B row: Press the desired 
button to select the signal as the 
background after the next transition on 
this M/E bank or PGM/PST bank. 
While the [UTIL] button on the right 
hand side is held down in Hold mode, 
these buttons are assigned to the utility 
2 bus, and can be used to select the 
signal on that bus.

Reentry buttons: These allow you to select 
the video created on another bank as 
background A or B or one of the keys 1 
to 4. For example, to use the video 
created on the M/E-1 bank as 
background B on the M/E-2 bank, press 
the reentry button [M/E 1] in the 
background B row of buttons on the M/
E-2 bank.

Cross-point button numbers
This description applies to the example of a 
32-button system.
From the left, the first 31 buttons are 
numbered 1, 2, ... 30, 31. When the 32nd 
button is set to be a [SHIFT] button, these 
buttons can also be switched to select 
signals numbered from 32 to 62. While the 
[SHIFT] button is held down, these switch 
to numbers 32 to 62, or alternatively, every 
time the button is pressed, switching is 
made between numbers 1 to 31 and 32 to 
62. Similarly, the reentry buttons can be 
switched between two sets of numbers: 121 
to 123, and 125 to 127.
Both the assignment of the 32nd button to a 
[SHIFT] button and the selection of the 
button operation mode can be done in a 
Setup menu.

Assigning signals to button
You can assign a signal to each button using 
the Setup menu.
This assignment is common to the cross-
point buttons in the M/E-1, M/E-2, M/E-3, 
and PGM/PST banks, and the auxiliary bus 
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control block. According to the settings 
made in the menu, the video and key signals 
are assigned to the cross-point buttons in 
pairs.
You can also make separate signal 
assignments for each operating control 
block.

Visual indications on cross-point 
buttons
The currently selected button in a row (i.e. 
the last button pressed) lights amber or red.
Amber (“low tally”): The signal selected 

on the bus does not form part of the 
program output from the switcher.

Red (“high tally”): The signal selected on 
the bus forms part of the program 
output from the switcher.

b XPT (cross-point) HOLD buttons
Turning one of these buttons on enables 
you to recall a keyframe or snapshot while 
keeping the current cross-point selection 
unchanged.
When the [XPT HOLD] button in the key 1 
or key 2 row is on, then the operation is as 
follows, depending on the setting in the 
Setup menu.
When the panel setup is “Normal”: The 

operation is as follows, depending on 
the setting in switcher setup.
Key Disable: The snapshot or 
keyframe is recalled without changing 
the current key settings.
Xpt Hold: The snapshot or keyframe is 
recalled without changing the current 
cross-point selection.

When the panel setup is “Protect”: The 
cross-point settings cannot be changed 
by pressing panel buttons.

c Key bus selection buttons
KEY3 button: Press this button, turning it 

on, to assign the key 1 cross-point 
buttons to the key 3 fill bus.

KEY4 button: Press this button, turning it 
on, to assign the key 2 cross-point 
buttons to the key 4 fill bus.

Pressing one of the key delegation buttons 
[KEY1] to [KEY4] in the transition control 
block (standard type) twice in rapid 
succession changes the state of the 
corresponding one of these buttons, so that 
you can make cross-point selections on the 
key bus (see page 243).

d UTIL (utility) button 
While this button is held down, the cross-
point buttons are assigned to the following 
buses, respectively.
Background A row: utility 1 bus
Background B row: utility 2 bus
Key 1 row: DME external video bus
Key 2 row: DME utility 1 bus when the 

[KEY4] button is off, or DME utility 2 
bus when the [KEY4] button is lit.

In a Setup menu, you can select either of the 
following two modes for these buttons.
• The button takes effect while being held 

down.
• Every time the button is pressed, it 

toggles between the on and off states for 
key 1 and key 2 rows. For background A 
and background B rows, utility buses 
remain disabled.

e Source name displays
These show the names of the signals which 
can be selected on the cross-point buttons, 
in two or four characters, or in auto mode.
While the [SHIFT] button on the right hand 
side or the [SHIFT] button assigned to the 
column of cross-point buttons is enabled, 
the source name of the signal assigned to 
the column of cross-point buttons in shift 
mode appears. You can select green, 
orange, or yellow for the background color 
of the source name display, for each source 
separately. You can set the source name 
display mode and background color in a 
Setup menu.
Names and Functions of Parts of the Control Panel
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f SHIFT button
When this button is enabled, either the 
source name displays show the shifted 
signal names, or the shifted signals for all 
buses in this M/E (P/P) bank are enabled. 
You can select either mode in a Setup 
menu.
Each press of the button toggles between 
the enabled and disabled states.
In the case of a module without source 
name displays, when “Display” is selected 
in the Setup menu, this button is invalid.

g M/E bank display
This indicates the notional mix/effect bank 
name to which the particular M/E or PGM/
PST bank is assigned, as a four-character 
identifier.

h Macro buttons
PRE MCRO (pre macro) button: Use this 

button to set a macro attachment in pre 
macro mode. For setting in macro only 
mode, use this in combination with a 
macro only set button assigned to the 
utility/shotbox control block or a user 
preference button.

POST MCRO (post macro) button: Use 
this button to set a macro attachment in 
post macro mode. For setting in macro 
only mode, use this in combination 
with a macro only set button assigned 
to the utility/shotbox control block or a 
user preference button.

MCRO ATTCH ENBL (macro 
attachment enable) button: When 
this button is on, the macro attachments 
set for the buttons of the M/E bank are 
enabled.
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Transition Control Block (Standard Type)

In the transition control block, you can 
modify the output of the M/E bank or PGM/
PST bank, and perform transitions. Both 

common transition and independent key 
transition operations are possible.

BKGD KEY1 KEY2 KEY3 KEY4

KEY1 KEY2 KEY3 KEY4
K-MOD
ENBL K-SS

K-TR
ENBL

K-SS
STOREMIX WIPE DME

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

PTN
LIMIT

LIMIT
SET KF

KEY1
ON

AUTO
TRANS CUT AUTO

TRANS

KEY2
ON

AUTO
TRANS

KEY3
ON

AUTO
TRANS

KEY4
ON

AUTO
TRANS

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

9 PRIOR SET button

1 Next transition selection buttons

8 Key status display

2 Transition type selection buttons

7 KF button

6 Pattern limit buttons

5 TRANS PVW button

3 Transition execution section

4 Wipe direction selection buttons

q; Key delegation buttons

qd Key source name display/key 
snapshot buttons

qf Key snapshot setting buttons

qa Independent key transition type 
selection buttons

qs Independent key transition 
execution section
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a Next transition selection buttons
Press these buttons, turning them on, to 
determine what the next transition will 
apply to.
BKGD: Next transition changes the 

background.
KEY1 to KEY4 (DSK1 to DSK4 in the 

PGM/PST bank): Press this button, 
turning it on, to make the next 
transition insert or remove the 
corresponding key (keys 1 to 4). If a 
key is currently inserted it will be 
removed, and vice versa.
In the PGM/PST bank, this inserts or 
removes downstream keys 1 to 4.

KEY PRIOR (priority): When this button 
is lit, the setting of the key priority after 
the next transition is enabled. The key 
priority after the next transition appears 
in the key status display.

ALL: Pressing this button turns on a 
preselected set of the [BKGD], [KEY1] 
to [KEY4], and [KEY PRIOR] buttons.
Make this setting in a Setup menu.

b Transition type selection buttons
Press one of these buttons, turning it on, to 
determine the type of the next transition.
When multi-program mode is selected in 
the Setup menu (see “Settings for Switcher 
Configuration (Config Menu)” in Chapter 
16 (Volume 2)), two or more of the 
following buttons may light.
MIX: In a background transition, the new 

video fades in as the current video 
fades out. During the transition, the 
overall signal level is maintained at 
100%.
In a key transition, the key fades in (for 
insertion) or out (for removal).

NAM (non-additive mix): The current and 
new video signals are compared, and 
the signal with the higher luminance 
level is given priority in the output.
The current video is maintained at 
100% output for the first half of the 

transition as the new video increases 
progressively to 100%, then the current 
video is progressively reduced from 
100% to zero in the second half while 
the new video is maintained at 100%.

SUPER MIX: The current video is 
maintained at 100% output for the first 
half of the transition as the new video is 
mixed while increasing progressively 
to 100%. The current video is then 
progressively reduced from 100% to 
zero in the second half while the new 
video is maintained at 100%.

PST (preset) COLOR MIX: In the first 
transition, the current video is replaced 
by the color matte in a mix (dissolve), 
then in the second transition the color 
matte is replaced by the new video also 
in a mix (dissolve).

WIPE: The current video is replaced by the 
new video, using the wipe pattern 
selected in the Wipe menu.

DME: A wipe type of transition is carried 
out, using the DME effect selected in 
the DME Wipe menu.

c Transition execution section
Transition indicator: This comprises 

multiple LEDs, which show the 
progress of the transition.

Fader lever: Move this to carry out a 
manual transition.

Transition rate display: This shows the 
“transition rate” (the time from the 
beginning of a transition to its 
completion) set for an auto transition, 
in frames.
You can set the transition rate using the 
numeric keypad control block, Flexi 
Pad control block, or menu.

AUTO TRANS (transition) button: 
Pressing this button carries out an auto 
transition of the set transition rate 
(duration). The transition starts 
immediately, and the button lights 
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amber. When the transition completes, 
the button goes off.

CUT button: Pressing this button carries 
out the transition as a cut (i.e. 
instantaneously).

d Wipe direction selection buttons
When you have selected a wipe or DME 
wipe as the transition type, press one of 
these buttons, turning it on, to select the 
wipe direction.
NORM (normal): The wipe proceeds in 

the direction from black to white as 
shown on the pattern in the lists of 
patterns (see the appendixes “Wipe 
Pattern List” and “DME Wipe Pattern 
List” (Volume 2)), or in the direction of 
the arrow.
When the VTR/disk recorder operation 
mode is enabled in setup, pressing this 
button plays the tape.

REV (reverse): The wipe proceeds in the 
opposite direction to that when the 
[NORM] button is pressed.
When the VTR/disk recorder operation 
mode is enabled in setup, pressing this 
button cues the tape automatically to 
the start point.

NORM/REV (normal/reverse): The wipe 
direction alternates between normal 
and reverse every time a transition is 
executed.
When the VTR/disk recorder operation 
mode is enabled in setup, pressing this 
button stops the tape.

e TRANS PVW (transition preview) 
button

When this button is lit, you can check in 
advance the video changes during the 
transition, on the preview output from the 
M/E or PGM/PST bank.
During the preview, you can use the fader 
lever, [AUTO TRANS] button, and [CUT] 
button. One of the following functions of 
this button can be selected in a Setup mode.

• When the transition completes, the 
system returns to the normal mode.

• The transition preview mode is 
maintained while this button is pressed.

• Switching is made between the transition 
preview mode and normal mode every 
time this button is pressed.

f Pattern limit buttons
PTN (pattern) LIMIT: Pressing this 

button, turning it on, enables the 
pattern limit function.
When the VTR/disk recorder operation 
mode is enabled in setup, pressing this 
button plays the tape.

LIMIT SET: Use this button to set a 
pattern limit when the [PTN LIMIT] 
button is off.
Move the fader lever to the position of 
a particular pattern size, and stop it 
there, then press this button to set the 
pattern limit range.
When the VTR/disk recorder operation 
mode is enabled in setup, pressing this 
button stops the tape.

g KF (keyframe) button
When the VTR/disk recorder operation 
mode is enabled in setup, pressing this 
button cues the tape automatically to the 
start point.

h Key status display
For each of keys 1 to 4, the corresponding 
ON indicator lights when the key is 
inserted. It also shows the priority (1 to 4) 
of each key.

i PRIOR (priority) SET button
While this button is held down, you can set 
the key priority.
The setting mode when this button is 
pressed depends on whether or not the 
[KEY PRIOR] button is lit, as follows.
• When the [KEY PRIOR] button is off, the 

current key priority is set.
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• When the [KEY PRIOR] button is lit, the 
key priority after the next transition is set.

Press the [KEY PRIOR] button as required, 
to switch between these two modes.
In either mode, hold down the [PRIOR 
SET] button, and press the button ([KEY1] 
to [KEY4]) corresponding to the key you 
want to bring to the front.

The following controls are used as the 
independent key transition control block.

j Key delegation buttons
These buttons delegate this independent 
key transition control block to a desired 
keyer. Press one of the [KEY1] to [KEY4] 
buttons ([DSK1] to [DSK4] in the PGM/
PST bank), turning it on.
You can press more than one button to 
select two or more keyers.
While these buttons are held down, you can 
select a key source with the cross-point 
buttons for the key bus.
Pressing one of these buttons twice in rapid 
succession changes its state so that you can 
make cross-point selections on the 
corresponding key bus.

a) The key bus selection button [KEY3] in the cross-
point control block goes off.

b) The key bus selection button [KEY4] in the cross-
point control block goes off.

c) The key bus selection button [KEY3] in the cross-
point control block lights.

d) The key bus selection button [KEY4] in the cross-
point control block lights.

k Independent key transition type 
selection buttons

Press one of the following buttons, turning 
it on, to select the independent key 
transition type.
MIX: Faded in or out.
WIPE: Inserted or deleted with a wipe.
DME (DME wipe): Inserted or deleted 

with a DME wipe.

l Independent key transition 
execution section

KEY1 ON to KEY4 ON (DSK1 ON to 
DSK4 ON in the PGM/PST bank) 
buttons: Press the corresponding one 
of these buttons to cut key 1 to key 4 in 
or out instantaneously. When the key 
corresponding to the button appears in 
the final program output, the button 
lights red, and otherwise lights amber.

AUTO TRANS (transition) buttons: 
These correspond to keys 1 to 4 from 
left to right; press one to carry out an 
auto transition. The transition rate for 
an independent key transition can be 
set in the numeric keypad control 
block, in the Flexi Pad control block, or 
in a menu.

m Key source name display/key 
snapshot buttons

These display the source name selected on 
the corresponding keyer. In key snapshot 
mode, press these buttons, corresponding to 
registers 1 to 4 for the selected keyer, to 
save or recall a key snapshot.

n Key snapshot setting buttons
K-SS (key snapshot): This enables key 

snapshot mode.
K-SS STORE (key snapshot store): To 

save a key snapshot, hold down this 
button, and press the key source name 
display/key snapshot button 
corresponding to the register you want 
to save.

Key delegation button 
(double press)

Corresponding 
key bus

[KEY1] key 1 a)

[KEY2] key 2 b)

[KEY3] key 3 c)

[KEY4] key 4 d)
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K-MOD ENBL (key modifier enable): To 
recall key adjustment values and key 
modifier settings when recalling a key 
snapshot, press this button, turning it 
on.

K-TR ENBL (key transition enable): To 
recall independent key transition 
settings when recalling a key snapshot, 
press this button, turning it on.

Flexi Pad Control Block (Standard Type)

The Flexi Pad control block is used for 
saving and recalling wipe snapshots, DME 
wipe snapshots, and snapshots, for recalling 

effects, and shotbox content, and for 
entering the transition rate.

a Mode selection buttons
WIPE: To save or recall a wipe snapshot, 

or recall the pattern number of a wipe 
pattern, use this in combination with 

the buttons of the memory recall 
section.

DME: To save or recall a DME wipe 
snapshot, or recall the pattern number 

7

WIPE

DME

SNAP
SHOT

EFF

MCRO

SHOT
BOX

UNDO

STORE
STATS

TRANS
RATE

BNAK
0

BANK
1

BANK
SEL

XPT HOLD
A B U1 U2 1 2 3 4

8 9

4 5 6

1 2 3

0 AUTO
TRAN

EFF
DISS

1 Mode selection buttons

5 XPT HOLD status display

3 Memory recall section

2 Bank selection buttons

4 UNDO button

6 Numeric display
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of a DME wipe pattern, use this in 
combination with the buttons of the 
memory recall section.

SNAPSHOT: To save or recall a snapshot, 
use this in combination with the 
buttons of the memory recall section.

EFF (effect): To recall the master timeline 
or run an effect, use this in combination 
with the buttons in the memory recall 
section.

SHOTBOX: To recall or execute a 
shotbox, use this in combination with 
the buttons of the memory recall 
section.

MCRO (macro): To save, recall or edit a 
macro, use this in combination with the 
buttons of the memory recall section.

TRANS RATE (transition rate): To enter 
the transition rate, press this button, 
turning it on. To enter the independent 
key transition rate, hold down this 
button, and press the key delegation 
button in the independent key 
transition control block. To select 
whether the value is entered in frames 
or as a timecode value, switch the [TC] 
button in the memory recall section on 
or off.

b Bank selection buttons
BANK0 (bank 0): Assigns the memory 

recall section to bank 0, of registers 1 to 
10.

BANK1 (bank 1): Assigns the memory 
recall section to bank 1, of registers 11 
to 20.

BANK SEL (bank selection): After 
pressing this button, press a button in 
the memory recall section to select 
banks 0 to 9.

c Memory recall section
This consists of 12 buttons with LCDs. 
These display changes, according to 
various operation modes.

d UNDO button
UNDO: After recalling a register, press this 

button to return to the state before 
recalling the register.
When contents have been saved to a 
register, hold down the [STORE 
STATS] button and press this button to 
return the register to its state before the 
save operation.

STORE STATS (store status): When a 
save or delete operation has been 
carried out on a register, this button 
lights amber. After saving to a register, 
hold down this button and press the 
relevant register button to delete the 
data in the register. Again, after a save 
operation on a register, hold down this 
button and press the [UNDO] button to 
restore the register to its state before the 
save operation.

e XPT HOLD (cross-point hold) status 
display

A bus for which cross-point hold is set 
appears as a green light.

f Numeric display
Depending on the operation mode, this 
shows the pattern number of a wipe or 
DME wipe, a bank number, a register 
number, a transition rate, and so on in up to 
four digits.
245Names and Functions of Parts of the Control Panel



246

   C
hapter 2 

M
enus and C

ontrol P
anel
Key Control Block

Each of the M/E banks and the PGM/PST 
bank includes four keyers (for keys 1 to 4), 
and you can delegate this control block to 

any desired keyer. In this control block, you 
can adjust and modify keys.

a Delegation buttons
Key delegation: Press one of the [KEY1] 

to [KEY4] buttons to delegate the key 
control block to the corresponding 
keyer.

M/E delegation: Press one of the [M/E 1] 
to [M/E 3], and [P/P] buttons to select 
the bank (an M/E bank or the PGM/
PST bank) to which the key control 
block is delegated.

DME
1

DME
2

DME
3

DME
4

M/E
1

M/E
2

M/E
3 P/P

KEY1 KEY2 KEY3 KEY4 TRANS

LUM LIN CRK CVK PTN

AUTO
SEL SPLIT

MATTE
FILL

KEY
DROP

SOFT
EDGE

BDR
DROP
BDR SHDW EMBOS

OUT
LINE

SHOW
KEY

MAIN
MASK

SUB
MASK ZABTN MORE

MON
FM

FEED

OVER
RIDE TRACE

PROC
KEY

AUTO
DELEG

DME
5

DME
6

DME
7

DME
8

3 Key fill/key source selection buttons

2 Key type selection buttons

1 Delegation buttons

4 Key modifier buttons

9 DME channel 
selection buttons 7 Knobs

8 Displays

qf AUTO DELEG button

qa Output destination specification 
buttons

qd TRACE button

qs OVERRIDE button

5 MORE button

6 SHOW KEY button

q; ON AIR indicators
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TRANS: By pressing this button, you can 
check the DME channel used for DME 
wipes on the M/E or PGM/PST bank. 
Also, by pressing this button, then 
pressing one of the DME channel 
selection buttons, you can preset the 
DME channel to be used when a DME 
wipe is selected as the transition type 
for the next transition.
When presetting the DME channel for 
an independent key transition, hold 
down this button, then press one of the 
[KEY1] to [KEY4] buttons, turning the 
two buttons on, beforehand.

b Key type selection buttons
Press one of these buttons, turning it on, to 
select the desired key type.
Depending on the selected key type, 
various parameters are displayed, and you 
can set the values with the knobs.
LUM (luminance key): The background is 

cut out according to the luminance (Y) 
of the key source signal, and at the 
same time the key fill signal is cut out 
and then added to the background 
signal.

LIN (linear key): This is a type of 
luminance key with a reduced variation 
in gain and a higher adjustment 
precision.

CRK (chroma key): A particular hue 
(usually blue) in the key source signal 
is used to determine the hole to be cut 
in the background and filled with the 
key fill signal.

CVK (color vector key): The background 
is cut out with a key source created by 
adding the luminance and chrominance 
components of the key signal. If the 
saturation is high, this allows perfect 
keying even if the luminance level is 
low and the signal is not suitable for 
luminance keying.

PTN (wipe pattern key): A hole is cut in 
the background by a wipe pattern 

selected in the transition, and this is 
filled with the key fill signal.

c Key fill/key source selection buttons
AUTO SEL (selection): Use the signal 

selected on the key fill bus, and the 
paired key source signal. The setting of 
key fill and key source pairs is carried 
out in a Setup menu.

SPLIT: To use the signal selected on the 
key fill bus as key fill, and a signal 
separate from the signal assigned in a 
pair with key fill for key source, press 
this button, turning it on. 
To select the signal on the key source 
bus, hold down this button, and press a 
button in the key 1 or key 2 row in the 
cross-point control block.

To use the signal selected on the key fill bus 
as key source (self keying), press the 
[AUTO SEL] button and [SPLIT] button at 
the same time, so that both are off.
MATTE FILL: To use a color matte from 

the internal generator as key fill, press 
this button, turning it on. You can 
adjust the color matte using the knobs.
When this button is off, the signal 
selected on the key fill bus is used as 
key fill.

d Key modifier buttons
To add an edge modifier to the key, press 
one of these buttons, turning it on.
Depending on the edge type selected, 
parameters appear in the displays, and you 
can set the values with the knobs.
KEY DROP: When drop border or shadow 

is selected, turning this button on 
lowers the key fill and key source 
position by four or eight scan lines as 
set in the key menu.
To select 4H or 8H, use the Key menu.
When the selected edge type is 
“normal” and soft edge is selected or 
when border, outline, or emboss is 
247Names and Functions of Parts of the Control Panel



248

   C
hapter 2 

M
enus and C

ontrol P
anel
selected, this button lights 
automatically.

BDR (border): Apply a border of a 
uniform thickness to the whole key.

DROP BDR (drop border): Apply a 
border to two sides of the key (for 
example, below and to the right, or 
below and to the left).

SHDW (shadow): Apply a shadow to two 
sides of the key (for example, below 
and to the right, or below and to the 
left).

OUTLINE: Use the outline of the key.
EMBOS (emboss): Apply an embossing 

effect to the periphery of the key.
• To select a “normal” as the edge type 

(that is, a plain edge), set all five of the 
above buttons off.

• When border, drop border, or shadow is 
selected, you can use a special color 
matte or a signal selected on the utility 1 
bus for the edge.

• When emboss is selected, you can use the 
dedicated color matte signal for the 
emboss function.

• When outline is selected, the signal 
selected on the key fill bus is used to fill 
the edge.

MAIN MASK: Press this button, turning it 
on, to enable the key mask using the 
main pattern. It also enables you to set 
the parameters with the knobs.

SUB MASK: Press this button, turning it 
on, to enable the key mask using the 
sub pattern. It also enables you to set 
the parameters with the knobs.

ZABTN (zabton): When this is pressed, 
turning it on, a translucent pattern is 
inserted behind the key. With the 
knobs, you can adjust the color, size, 
density, and softness parameters.

SOFT EDGE: Soften the edge of the key.

e MORE button
When there are more than four parameters, 
this button lights amber. When it is pressed, 

it changes from amber to green and the fifth 
and subsequent parameters are assigned to 
the knobs, allowing them to be adjusted.

f SHOW KEY button
While this button is held down, a key 
processed key source signal is output from 
the specified output port. You can make the 
output specification independently for each 
of edit preview and the preview of each M/
E or PGM/PST bank in a Setup menu.

g Knobs
Turn the knobs to adjust the parameter 
values.

h Displays
Each display shows the initial letters of the 
parameter name and the parameter value 
(maximum three digits including a minus 
sign for a negative value).

i DME channel selection buttons
Press one of these buttons, turning it on, to 
delegate a DME channel to the keyer. The 
number of valid DME channel selection 
buttons depends on the number of channels 
installed in the DME processor.
A maximum of four consecutively 
numbered DME channels from the two sets, 
DME 1 to 4 and DME 5 to 8, can be 
assigned to one keyer. A DME channel 
assigned to a keyer cannot be selected on 
another keyer. However, using the override 
function it is possible to allocate a channel 
already allocated to another keyer to the 
currently selected keyer. If DME channel 
allocations have been made in a Setup 
menu, these buttons cannot be used to make 
DME channel allocations. Using the trace 
function, it is possible to check which keyer 
a DME channel is allocated to.
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j ON AIR indicators
These light red when the corresponding 
DME channels are included in the final 
program output.

k Output destination specification 
buttons

MON (DME monitor): Hold down this 
button and press the selection button 
for the DME channel you want to 
assign to the monitor output; you can 
then monitor the output signal on the 
DME monitor output.
While this button is held down, the 
DME channel selection buttons light as 
follows, allowing you to check the 
monitor assignment.
Lit amber: DME channel that can 

currently be monitored
Lit green: DME channel currently 

assigned to the monitor output
FM FEED (frame memory feed): When 

you press this button, it lights 
momentarily amber, then for the 
currently selected keyer, the key 
processed signals are selected for frame 
memory sources 1 and 2. If a DME is 
selected on the currently selected 
keyer, the key fill and key source 
signals to which a DME effect is 
applied are assigned to frame memory 
sources 1 and 2; otherwise the key fill 
and key source are assigned.
Carrying out a frame memory feed 
causes the [PROC KEY] button to light 
amber.

PROC KEY (processed key): When this 
button is on, the key fill/source signal 
subjected to key processing or signal 
subjected to a DME effect on the 
currently selected keyer can be selected 
as a reentry signal (PROC V or PROC 
K) for the M/E or PGM/PST bank, on 
the auxiliary bus or the like.

l OVERRIDE button
To select a DME channel already allocated 
to another keyer or transition to the 
currently selected keyer (or transition), hold 
down this button, and press the DME 
channel selection button.

m TRACE button
When a DME channel is already allocated 
to another keyer or transition, hold down 
this button, and press the corresponding 
DME channel selection button, to switch to 
the state in which the keyer (or transition) to 
which the DME channel is allocated is 
currently selected.

n AUTO DELEG (auto delegation) 
button

When this button is on, the key delegation 
selection state of the key control block is 
linked to the key delegation selection state 
of the independent key transition control 
block.
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Device Control Block (Trackball)

The device control block is used for three-
dimensional transform operations using a 

DME, for wipe pattern position setting, and 
for VTR operation.

a Region selection buttons
The operation mode allocated to the device 
control block depends on the selection state 
of the region selection buttons.
When the [M/E 1], [M/E 2], [M/E 3], and 

[P/P] buttons are selected: This 
enables the wipe pattern position 
setting (positioner) operation mode in 
the device control block. You can 
select multiple buttons simultaneously.

When the [USER] button is selected: This 
enables pattern position setting used 
for color backgrounds.

When the [DME 1] to [DME 8] buttons 
are selected: This enables the three-
dimensional transform operation mode 

in the device control block.
Press a button, turning it on, to select a 
DME channel. You can select multiple 
buttons simultaneously.
The number of valid buttons depends 
on the number of DME processor 
channels installed.

When the [DEV] button is selected: This 
enables the VTR/disk recorder 
operation mode in the device control 
block. In this state, the [M/E 1] to [M/E 
3] buttons, [P/P] button and [DME1] to 
[DME8] buttons function as the device 
1 to device 12 allocation buttons as 
follows.
[M/E1] (DEV1): device 1

DEVUSERM/E1

DME1

DME5

MENU

SHIFT

M/E2

DME2

DME6

ASP
PERS
SUB

LOC
SIZE
FMR1

AXIS
LOC
MAIN

LOCAL
K1

CB1

GLB
K2

CB2

CLR
WORK
BUFR

M/E3

DME3

DME7

SRC
K3

FM1

TRGT
K4

FM2

LOC
XYZ

FMR2

X

P/P

DME4

DME8

ROT
POS

Y Z CTR

RUN
CTRL

1 Region selection buttons

3 Trackball

4 Z-ring2 Operating buttons

5 MENU button
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[M/E2] (DEV2): device 2
[M/E3] (DEV3): device 3
[P/P] (DEV4): device 4
[DME1] (DEV5): device 5
[DME2] (DEV6): device 6
[DME3] (DEV7): device 7
[DME4] (DEV8): device 8
[DME5] (DEV9): device 9
[DME6] (DEV10): device 10
[DME7] (DEV11): device 11
[DME8] (DEV12): device 12
To exit from this mode, press the 
[DEV] button again, turning it off.

When the [RUN CTRL] button is 
selected: This enables the effect run 
control mode in the device control 
block.

The functions of the operation buttons, 
trackball, and Z-ring vary with the 
operation mode as follows.

b Operation buttons

When the positioner operation mode is 
enabled
K1 CB1: Press this button to enable wipe 

pattern position setting for key 1 
(DSK1).
When the [USER] button is selected, 
pattern position setting for color 
background 1 is enabled.

K2 CB2: Press this button to enable wipe 
pattern position setting for key 2 
(DSK2).

K3 FM1: Press this button to enable wipe 
pattern position setting for key 3 
(DSK3).

K4 FM2: Press this button to enable wipe 
pattern position setting for key 4 
(DSK4).

MAIN: Press this button to enable main 
wipe pattern position setting for normal 
transitions.

SUB: Press this button to enable sub wipe 
pattern position setting for normal 
transitions.

Among the [K1 CB1] button, [K2 CB2] 
button, [K3 FM1] button, [K4 FM2] button, 
[MAIN] button, and [SUB] button, you can 
select multiple buttons.

POS: Press this button to enable pattern 
movement in the x-axis and y-axis 
directions with the trackball.
When the [USER] button is selected, 
this enables the trackball to move the 
pattern in the x-axis and y-axis 
directions, and the Z-ring to adjust the 
size of the pattern.

X, Y: These restrict the axes affected by the 
trackball and Z-ring to the x- or y-axis. 

Z: This restricts the axes affected by the 
trackball and Z-ring to the z-axis. 

CTR (center): When this button is pressed, 
the pattern position returns to the 
center. When the [USER] button is 
selected, the pattern size also returns to 
50.00.

SHIFT/CLR WORK BUFR: These are 
not used in positioner operation mode.

When the three-dimensional transform 
operation mode is enabled
LOCAL: Enable operations in the DME 

local coordinate space. 
GLB (global): Enable operations in the 

DME global coordinate space.
The [LOCAL] and [GLB] buttons can be 
selected at the same time.

SRC (source): Enable operations in the 
DME source coordinate space.

TRGT (target): Enable operations in the 
DME target coordinate space.

The [SRC] and [TRGT] buttons cannot be 
selected at the same time. When these 
buttons are held down, trackball and Z-ring 
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operation is switched to a finer control. 
(fine mode)
AXIS LOC (location): When this button is 

lit, the trackball moves the rotational 
axis of the image in the x-axis and y-
axis directions, and the Z-ring moves 
the axis in the z-axis direction.

ASP PERS (aspect/perspective): When 
the [SRC] button is lit, pressing this 
button enables the trackball to control 
the x-axis and y-axis directions 
independently, and the Z-ring controls 
the x-axis and y-axis directions 
together, to vary the aspect ratio. When 
the [SHIFT] button is held down and 
this button is pressed, the trackball 
controls the skew of the image in the x-
axis and y-axis directions.
When the [TRGT] button is lit, 
pressing this button enables the 
trackball to control the perspective of 
the image in the x-axis and y-axis 
directions.
The Z-ring controls the distance to the 
viewpoint.

LOC (location) SIZE: When this button is 
lit, the Z-ring controls the image size.
The trackball moves the image in the x-
axis and y-axis directions.

LOC (location) XYZ: When this button is 
lit, the trackball moves the image in the 
x-axis and y-axis directions, and the Z-
ring moves the image in the z-axis 
direction.

SHIFT: While holding down this button, 
pressing the [ASP PERS] button or 
[ROT] button switches to the shifted 
version of the corresponding function.

CLR WORK BUFR (clear work buffer): 
Press this button once to clear only the 
three-dimensional transform 
parameters of the information held in 
the work buffer. Press twice in rapid 
succession to clear all of the 

parameters, and return to the default 
state.

ROT (rotation): When this button is lit, the 
trackball rotates the image about the x- 
and y-axes, and the Z-ring rotates the 
image about the z-axis.
Pressing this while holding down the 
[SHIFT] button enables rotation of the 
image in the “Spin” mode. The 
trackball and Z-ring operate in the 
same manner.

X, Y, Z: These restrict which axes the 
trackball and Z-ring can control. You 
can select more than one.
When one of these buttons is selected, 
you can enter the parameter value for 
the corresponding axis using the 
numeric keypad control block.

CTR (center): Pressing this button 
changes the values of the three-
dimensional parameters currently 
controlled by the trackball and Z-ring 
to the closest detent values.
Pressing twice in rapid succession 
returns the parameter values to their 
defaults.

When the VTR/disk recorder operation 
mode is enabled
LOCAL (DELAY): Press this button, 

turning it on, to enter a delay value 
from the numeric keypad control block.

GLB (STB OFF: standby off): Press this 
button to switch to standby off mode.

SRC (REC: record): Press this button at 
the same time as the [Y] button to 
record on the VTR.

TRGT (STOP): Press this button to stop 
the tape or disk.

AXIS LOC (START TC: start 
timecode): Press this button to set the 
timecode of the start point at that time 
(start point of the timeline when the 
[MENU] button is On, or start point of 
Cueup & Play when Off) (see page 
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254). The timecode of the start point is 
updated to the current time each time 
this button is pressed.

ASP PERS (STOP TC: stop timecode): 
Press this button to set the timecode of 
the stop point at that time (start point of 
the timeline when the [MENU] button 
is On, or start point of Cueup & Play 
when Off)(see page 254). The 
timecode of the stop point is updated to 
the current time each time this button is 
pressed.

LOC SIZE (VAR: variable speed 
playback): Pressing this button and 
turning the Z-ring plays back the tape 
or disk at a variable speed and direction 
proportional to the rotation angle of the 
Z-ring. The variable speed range is –1 
to +3 times normal playback speed.

LOC XYZ (SHTL: shuttle): Pressing this 
button and turning the Z-ring plays 
back the tape or disk at a speed and 
direction proportional to the rotation 
angle of the Z-ring.

ROT (JOG): Pressing this button and 
turning the Z-ring plays back the tape 
or disk at a speed and direction 
proportional to the rotation of the Z-
ring.

CLR WORK BUFR (CUE): Pressing this 
button cues the tape or disk 
automatically to the start point.

X (REW: rewind): Press this button to 
rewind the tape or disk.

Y (PLAY): Press this button to play the 
tape or disk.

Z (FF): Press this button to fast forward the 
tape or disk.

CTR (ALL STOP): Press this button to 
stop all tape transport/disk drive 
operations.

c Trackball
When the positioner operation mode is 
enabled

By moving this, you can move the pattern 
in the x-axis and y-axis directions.

When the three-dimensional transform 
operation mode is enabled
Move the trackball to control the x- and y-
axes in a three-dimensional transform.
When the [SRC] or [TRGT] button is held 
down, the trackball operation is switched to 
a finer control. (fine mode)

d  Z-ring 
When the positioner operation mode is 
enabled
When the [USER] button is selected, by 
turning the ring you can adjust the size of 
the pattern.

When the three-dimensional transform 
operation mode is enabled
Turn this ring to control the z-axis in a 
three-dimensional transform.
When the [SRC] or [TRGT] button is held 
down, the Z-ring operation is switched to a 
finer control. (fine mode)

When the effect run control mode is 
enabled
By turning the Z-ring, you can run the 
keyframe effect, independent of the STOP 
NEXT KF, EFF LOOP, and similar settings 
in the keyframe control block. Turn 
clockwise to run the effect in the normal 
direction, and counterclockwise for the 
reverse direction.

When the VTR/disk recorder operation 
mode is enabled
Turning the Z-ring controls the tape 
transport/disk drive operations, at a speed 
determined by the operating buttons. Turn 
clockwise for the normal direction, and 
counterclockwise for the reverse direction.
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e  MENU button
Press this button, turning it on, to enable 
adjusting the parameters allocated to the 
knobs in the menu using the trackball and 
Z-ring.
In the case of the DME menu, the operation 
applies to the selected DME channel.
In VTR/disk recorder operation mode, 
press this button, setting it to On. This 
makes it possible to carry out timeline start/
stop point setting operation for the device 
selected with the device selection buttons.
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Device Control Block (Joystick)

All functions of the joystick type device 
control block are equivalent to the functions 
of the trackball type, except that the 

trackball and Z-ring operations are carried 
out with the joystick.

a Joystick

When the three-dimensional transform 
operation mode is enabled
By moving this, you can carry out 
operations in the x-, y-, and z-axes.
When the following buttons are held down, 
the joystick operation is switched to a finer 
control. (fine mode)
• The button on the end of the joystick
• [SRC] button
• [TRGT] button
Depending on the settings made in the 
Setup menu, the operation speed multiple 
can be changed.

When the effect run control mode is 
enabled
By moving the joystick sideways, you can 
run the keyframe effect, independent of the 
STOP NEXT KF, EFF LOOP, and similar 
settings in the keyframe control block. 
Move to the right to run the effect in the 
normal direction, and to the left for the 
reverse direction.

When the VTR/disk recorder operation 
mode is enabled
Moving the joystick sideways controls the 
tape transport/disk operation, at a speed 
determined by the operating buttons. Move 
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to the right for the normal direction, and to 
the left for the reverse direction.

Device Control Block (Search Dial)

Using the device control block (search 
dial), you can directly operate an XDCAM, 
disk recorder, VTR, other external device, 

or shot box. The device control block 
(trackball) and device control block 
(joystick) can be used together.

a Timecode display

This shows the current time (CURRENT) 
and the start and stop point timecode values 
for the current reference device (START 
TC, STOP TC). When you press a device 
selection button, the button lights, selecting 
the assigned device as the reference device, 
and displaying its setting value.
In the case of the [SBOX] buttons, the 
display does not change. The displayed 

setting value depends on whether the 
[TIMELINE] button is on or off, as follows.

When the TIMELINE button is on: 
Displays the start and stop points of the 
last set keyframe on the timeline. When 
the keyframe number is changed and 
the last register and keyframe change, 
the display also changes. (timeline 
setting mode)
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When the TIMELINE button is off: 
Displays the Cueup & Play (rewind 
action) start and stop points.

b Device selection buttons
These buttons are used for selecting 
assigned external devices. Each button can 
only be assigned to a single device. Carry 
out the assignment in the Setup menu (see 
“Overall Control Panel Settings (Config 
Menu)” in Chapter 16 (Volume 2)). To 
select an assigned device, press the 
corresponding button, which lights green. 
To select more than one device 
simultaneously, hold down the button for 
the first selection, while pressing the 
buttons for the other selections in turn. The 
second and subsequent selected buttons 
light amber. If you press another button 
without holding down the first selected 
button, the second button will be the 
reference device and light green.
DEV: Assign external devices DEV1 to 

DEV12.
FM CLIP: Not supported in this version.
Device selection buttons can be set as 
SBOX buttons or DELAY button in the 
Setup menu.

c SBOX (shotbox) buttons
Assign a shotbox saved in registers 1 to 99. 
When you press a button, the assigned 
shotbox is selected, and executed. Carry out 
the assignment in the Setup menu (see 
“Overall Control Panel Settings (Config 
Menu)” in Chapter 16 (Volume 2)).
SBOX buttons can be set as device 
selection buttons or DELAY button in the 
Setup menu.

d DELAY button
When pressed, this button lights green, the 
numeric keypad control block display 
changes to DELAY__  :  , and you can set 
the start delay time for the selected device. 
The setting range is from 00:00 to 59:29 

(depends on the video format). This button 
goes off when another timecode setting 
button ([START TC], [STOP TC], [SET 
START TC], [SET STOP TC], or [SET 
DUR]) is pressed. Carry out the assignment 
in the Setup menu (see “Overall Control 
Panel Settings (Config Menu)” in Chapter 
16 (Volume 2)).
The DELAY button can be set as a device 
selection button or an SBOX button in the 
Setup menu.

e Editing buttons
These carry out Cueup & Play (rewind 
action) operations on material, and timeline 
settings. These operations are only valid 
while a device is selected with the device 
selection buttons.
START TC: When pressed, this button 

flashes amber, and sounds a beep, 
setting the timecode at that time as the 
device start point (on the timeline when 
the [TIMELINE] button is On, and  
Cueup & Play start point when Off). If 
you press once more, the timecode at 
that time is overwritten as a new start 
point.

STOP TC: When pressed, this button 
flashes amber, and sounds a beep, 
setting the timecode at that time as the 
device stop point (on the timeline when 
the [TIMELINE] button is On, and 
Cueup & Play stop point when Off). If 
you press once more, the timecode at 
that time is overwritten as a new stop 
point.

SET START TC, SET STOP TC, SET 
DUR: When pressed, these buttons 
light green, “START TC”, “STOP TC” 
or “DUR” appears in the numeric 
keypad control block display, and you 
can enter a timecode from the numeric 
keypad. If you enter a numeric value 
and press the [ENTER] button, the 
button goes off, whereas if you press 
the [ENTER] button without entering a 
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numeric value the numeric keypad 
control block display shows “-- : -- : -- 
: --”. To exit the numeric value entry 
mode, either repeat pressing the same 
button, or press a different numeric 
keypad control block linked button, or 
a mode selection button such as the 
[EFF] and [SNAPSHOT] buttons in the 
numeric keypad control block. If the 
timecode has been set correctly, the 
entered numeric value appears in the 
timecode display.

STB (standby) OFF: When pressed, this 
button flashes amber, and the device 
selected with the device selection 
buttons exits from the standby mode.

CUE: When pressed, this button flashes 
amber together with the [ALL STOP] 
button, and the device selected with the 
device selection button is cued up to the 
start point of the material. When more 
than one device is selected, the amber 
flashing continues until the reference 
device is cued up, and when the cueing 
up is finished, this button lights green.

REW: When pressed, this button lights 
amber, and material of the device 
selected with the device selection 
buttons is rewound. To stop during the 
rewind, press the [STOP] button or 
[ALL STOP] button.

Note
Frame memory clip rewind is not 
supported in this version.

PLAY: When pressed, this button lights 
amber, and the device selected with the 
device selection buttons plays. The 
playback stops not only if the [STOP] 
button is pressed, but also if any of the 
[STB OFF], [SHTL], [JOG], [CUE], 
[REW], [PLAY], [FF], and [ALL 
STOP] buttons is pressed. When the 
[VAR] button is pressed while the 

device is playing back, the device plays 
at one times normal speed in variable 
mode.

FF: When pressed, this button lights amber, 
and the material of the device selected 
with the device selection buttons is fast 
forwarded. To stop during the fast-
forward, press the [STOP] button or 
[ALL STOP] button.

Note
Frame memory clip fast forward is not 
supported in this version.

ALL STOP: When pressed, all device 
material playback and other operations 
stop. During cueing up of any of the 
devices, this button flashes amber, and 
when all cueing up operations are 
completed, it lights green.

REC: When pressed simultaneously with 
the [PLAY] button, this button lights 
red (the [PLAY] button lights amber), 
and the image from the selected device 
is recorded.

Note
Frame memory clip recording is not 
supported in this version.

f External device operation buttons
ENBL (enable): When this is pressed, 

turning it on, the search dial [VAR], 
[JOG], and [SHTL] button operations 
are enabled.

VAR (variable): Sets the search dial to 
variable mode.

JOG: Sets the search dial to jog mode.
SHTL (shuttle): Sets the search dial to 

shuttle mode.

g TIMELINE button
If this is pressed when a [DEV] button is 
selected, the device selected with the device 
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selection buttons is switched to timeline 
setting mode.

h STOP button
When pressed, this lights amber, and 
operation of the device selected with the 
device selection buttons stops.

i Search dial
Use this for search and other operations on 
the material of an external device. 

For details of the method of use, see 
“Controlling Tape/Disk Transport” in 
Chapter 12 (Volume 2).

Keyframe Control Block

In the keyframe control block, you can 
carry out effect editing and execution.

a EDIT ENBL (edit enable) button
Press this button, turning it on, to enable 
effect editing operations with the keyframe 
control block.

When macro editing is carried out, this 
button lights red.

STOP
NEXT

KF

NORM REV

NORM
/REV

EFF
LOOP

EDIT
ENBL

KF
DUR

DELAY

EFF
DUR

COPY PASTE

DEL

SHIFT INS
PREV

KF
NEXT

KF

MOD UNDO

CONST
DUR

KF
LOOP

GO TO
TC

AUTO
INS

PAUSE

GO TO
KF

ALL
FROM

TO

FF

RE
WIND

RUN

0 EFF LOOP button

1 EDIT ENBL button

2 Edit point 
specification 
buttons3 Editing buttons

4 Duration setting buttons

5 KF LOOP button

6 PAUSE button

7 Effect execution section

8 Effect execution direction selection 
buttons

9 STOP NEXT KF button

qa AUTO INS button
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b Edit point specification buttons
GO TO TC (Go to timecode): Press this 

button, turning it on, to enter a numeric 
value from the numeric keypad control 
block, and move the edit point to the 
specified timecode position.

GO TO KF (Go to keyframe): Press this 
button, turning it on, to enter a numeric 
value from the numeric keypad control 
block, and move the edit point to the 
specified keyframe.
During macro editing, pressing this 
button moves the edit point to the event 
number specified by numeric entry 
with the numeric keypad control block.

PREV KF (previous keyframe): When 
this button is pressed, the edit point 
moves to the keyframe immediately 
before the current time (the position 
where the effect is currently stopped).
During macro editing, pressing this 
button moves the edit point to the event 
immediately before the current event.

NEXT KF (next keyframe): When this 
button is pressed, the edit point moves 
to the keyframe immediately after the 
current time.
During macro editing, pressing this 
button moves the edit point to the event 
immediately after the current event.

c Editing buttons
ALL: Press this button, turning it on, to 

select all keyframes (during macro 
editing, all events) in the effect.

FROM TO: Press this button, turning it on, 
to enter numeric values from the 
numeric keypad control block, and 
select a specified range of keyframes 
(during macro editing, the specified 
range of events).

INS (insert): When this button is pressed, a 
new keyframe is inserted after the 
current keyframe. Pressing this button 
while holding down the [SHIFT] 
button inserts a new keyframe before 

the current keyframe.
During macro editing, pressing this 
button registers an event after the 
current event.

MOD (modify): When this button is 
pressed, the selected keyframe is 
modified with the values of the current 
keyframe. When the edit point is 
between two keyframes, the 
immediately preceding keyframe is 
modified. You can also select multiple 
keyframes, and modify them in a single 
operation. At this time, pressing this 
button while holding down the 
[SHIFT] button modifies all selected 
keyframes with the changed values 
taken as relative values.
During macro editing, pressing this 
button amends the selected event.

DEL (delete): When this button is pressed, 
the selected keyframe is deleted. When 
the edit point is between two 
keyframes, the immediately preceding 
keyframe is deleted. During macro 
editing, pressing this button deletes the 
selected event. You can also select 
multiple keyframes or macro events, 
and delete them in a single operation.

COPY: When this button is pressed, the 
selected keyframe (during macro 
editing, macro event) is copied. You 
can also select multiple keyframes or 
macro events, and copy them in a 
single operation.

PASTE: When this button is pressed, the 
deleted or copied keyframe (during 
macro editing, macro event) is inserted 
after the current keyframe (during 
macro editing, macro event). Pressing 
this button while holding down the 
[SHIFT] button inserts the deleted or 
copied keyframe (during macro 
editing, macro event) before the current 
keyframe (during macro editing, macro 
event).
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SHIFT: Hold down this button, and press 
the [INS] button, [MOD] button, or 
[PASTE] button, to obtain the shifted 
function for the button.

UNDO: When this button is pressed, the 
last executed keyframe (during macro 
editing, macro event) insertion, 
modification, or deletion, or paste 
operation is canceled.

d Duration setting buttons
KF DUR (keyframe duration): Press this 

button, turning it on, to set the 
keyframe duration of the selected 
keyframe, by numeric value entry from 
the numeric keypad control block.

EFF DUR (effect duration): Press this 
button, turning it on, to set the effect 
duration from the numeric keypad 
control block.

DELAY: Press this button, turning it on, to 
enter a delay value from the numeric 
keypad control block.

CONST DUR (constant duration): Select 
the duration mode. When this is lit, the 
mode is constant duration mode, and 
when off, variable duration mode.

e KF LOOP (keyframe loop) button
Press this button, turning it on, to execute 
the effect the specified number of times 
through the keyframes in the specified 
range.

f PAUSE button
When this button is pressed, a pause is 
applied to the selected keyframe.
When editing a macro, press this button, 
turning it on, to include a pause event in the 
macro. The pause length can be set in the 
numeric keypad control block.

g Effect execution section
RUN: When this button is pressed, the 

effect is run from the first keyframe to 
the last keyframe. However, if a pause 

is set on a keyframe, the effect stops at 
that point. Press this button again to 
resume execution, and continue to the 
next pause point or the end of the 
effect.

Effect indicator: This comprises multiple 
LEDs, which show the progress of the 
effect.

Fader lever: Moving this up or down 
manually runs the effect.

REWIND: When this button is pressed, the 
currently recalled effect is rewound to 
the first keyframe.

FF (fast forward): When this button is 
pressed, the currently recalled effect is 
advanced to the last keyframe.

h Effect execution direction selection 
buttons

NORM (normal): When this button is lit, 
effect execution runs from the first 
keyframe to the last keyframe.

REV (reverse): When this button is lit, 
effect execution runs from the last 
keyframe to the first keyframe.

Pressing one of these buttons automatically 
turns the other off.
NORM/REV (normal/reverse): Press this 

button, turning it on, to reverse the 
direction of the effect when it reaches 
the last keyframe or first keyframe.

i STOP NEXT KF (stop next 
keyframe) button

When this button is pressed, turning it on, 
the effect execution range is from the 
current time to the next keyframe.

j EFF LOOP (effect loop) button
When the effect reaches the last keyframe 
with this button on, it returns to the first 
keyframe and repeats.

k AUTO INS (auto insert) button
When editing a macro, press this button, 
turning it on, to enable the auto insert 
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function, so that every control panel 
operation you carry out is added to the 
macro as an event.

Numeric Keypad Control Block

The numeric keypad control block is used 
for region selection, for saving and 
recalling snapshots, effects and shotboxes, 
for entering numeric values for trackball 

operation and keyframe operation, and for 
transition rate entry.

a Mode selection buttons
EFF (effect): Press to save or recall an 

effect.
SNAPSHOT: Press to save or recall a 

snapshot.
SHOTBOX: Press to save or recall a 

shotbox.

MCRO (macro): Press to save, recall or 
edit a macro.

TRANS RATE (transition rate): Press to 
set the transition rate. 
Hold down this button, and press one of 
the key delegation buttons [KEY1] to 
[KEY4] in the transition control block 
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to set an independent key transition 
rate.

b Region selection buttons
These select the functional block (“region”) 
of the control panel to which operations 
apply.
You can select more than one region at the 
same time.
The first button you press is taken as the 
reference region, and lights green, while the 
next pressed button lights amber.
With the exception of the [MASTER] and 
[ALL] buttons, you can change the region 
assignment to the buttons as desired in the 
Setup menu.
MASTR: Press this, turning it on, to save 

region information in a master 
snapshot register or master timeline 
register, or to recall such region 
information.

ALL: Select all regions. When any region 
is already selected, pressing this button 
makes all regions unselected.

M/E 1 to M/E 3, P/P: Select the 
corresponding regions, M/E-1, M/E-2, 
M/E-3, and PGM/PST.

USER 1 to USER 8: Select a USER region.
DME1 to DME8: Select a DME channel.
P-Bus: Select the P-Bus region.
GPI: Select the GPI region.
RTR:Select the router region.
DEV1 to DEV12: Select the device 1 to 

device 12 regions respectively.

c Function selection buttons
UNDO: After recalling a register, press this 

button to return to the state before 
recalling the register.

STORE STATS (store status): This lights 
amber when data is stored in a register. 
After saving data to a register, hold 
down this button and press the 
[UNDO] button to return the register to 
the state before the data was saved.

TC (timecode): Press this button, turning it 
on, to switch transition rate entry to the 
timecode entry mode.

STORE: Press this button to switch to the 
mode for saving a snapshot, effect, 
shotbox or macro in a register.

RCALL (recall): Press this button to 
switch to the mode for recalling a 
snapshot, effect, shotbox or macro  
from a register.

[STORE] button or [RCALL] button 
flashes amber when one or more of the 
regions assigned to the Region selection 
buttons are not selected by the Region 
Select menu.

d Numeric keypad
In addition to the buttons for numeric input, 
this includes buttons for adding attributes to 
snapshots.
0 to 9: Used to input numeric digits.
. (period): Enters the decimal point.

When the [TRANS RATE] button is lit, 
enters “00.” When the [EFF] button, 
[SNAPSHOT] button or [SHOTBOX] 
button is lit, this is used to find an 
empty register.

+/–/ EFF DISS (effect dissolve): Invert the 
sign, negative or positive.
When the [SNAPSHOT] button is lit, 
applies the effect dissolve attribute to a 
snapshot.

CLR/AUTO TRANS (clear/auto 
transition): Clear an input value, 
returning to the previous state.
When the [SNAPSHOT] button is lit, 
applies the auto transition attribute to a 
snapshot.

TRIM/GPI ENBL (enable): After 
entering a difference value to be added 
to an existing setting, press this button 
to confirm the change.

ENTER: Confirm an entered value.
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e Display
This shows the selected region name and 
entered numeric values.

Fade to Black Control Block

a FTB (fade to black) button
Press this button to fade to black the 
program output of the PGM/PST bank, at 
the set transition rate. You can set the fade 
to black transition rate in the menu.

b Preview selection buttons
Press one of these buttons to select a signal 
on the edit preview bus. Each button can be 
assigned to any preview output in setup (see 
Chapter 16 “Overall Control Panel 
Settings (Config Menu)” (Volume 2)).
PST (preset): When this button is pressed, 

the signal selected on the background B 
row of the PGM/PST bank is selected 
on the edit preview bus.

M/E 1 to M/E 3, P/P (M/E1 to M/E 3, P/P 
preview): The preview signal (M/E-1 
PVW, M/E-2 PVW, M/E-3 PVW, P/P 

PVW) of the M/E or PGM/PST bank 
corresponding to the pressed button is 
selected on the edit preview bus.

M/E1 K to M/E3 K, P/P K (M/E1 to M/E 
3, P/P key preview): The key preview 
signal (M/E-1 K-PVW, M/E-2 K-
PVW, M/E-3 K-PVW, P/P K-PVW) of 
the M/E or PGM/PST bank 
corresponding to the pressed button is 
selected on the edit preview bus.

DME V (DME monitor video): When this 
button is pressed, the DME monitor 
output video signal (DME MON V) is 
selected on the edit preview bus.

DME K (DME monitor key): When this 
button is pressed, the DME monitor 
output key signal (DME MON K) is 
selected on the edit preview bus.

AUTO PST P/P

FTB

DME
K

DME
V

M/E
3

M/E
2

M/E
1

M/E
3K

M/E
2K

M/E
IK

P/P
K

3 AUTO button 1 FTB button 2 Preview selection buttons
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c AUTO button
When this button is pressed, the M/E or 
PGM/PST bank preview signal selected on 

the edit preview bus is automatically 
switched to the program signal depending 
on the on-air status.

Auxiliary Bus Control Block (for AUX Buses)

There are also models without the selected 
source name displays and source name 
displays shown in the following figure.

All operations except those of the [DEST] 
button and [SHIFT] button are the same as 
for a model with selected source name 
displays and source name displays.

LEVEL
1

DEST

SHIFT

RTR

2ND

KEY

XPT
HOLD

XPT
HOLD

M/E
1

M/E
1

LEVEL
2

M/E
2

M/E
2

LEVEL
3

M/E
3

M/E
3

LEVEL
4

PGM
SHIFT

PGMSHIFT

DME
3K

DME
4V

DME
4K

FMS
1

FMS
2

EDIT
PVW

1 AUX delegation buttons

2 Selected source name displays

3 DEST button

qs Level selection buttons

7 KEY button

8 2ND button

qa RTR button

0 SHIFT button

6 XPT HOLD buttons

4 Selected bus display

5 Cross-point buttons

9 Source name displays

2nd

1st
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a AUX delegation buttons
Press one of these buttons, turning it on, to 
select the bus to which to assign the cross-
point buttons in the auxiliary bus control 
block. 
The buses that can be selected are as 
follows.
• AUX buses 1 to 48
• MONITOR 1 to MONITOR 8 buses
• FMS 1 (frame memory source 1) and 

FMS 2 buses
• DME 1V to DME 8V buses
• DME 1K to DME 8K buses
• EDIT PVW (preview) bus
• M/E-1 UTILITY 1 and M/E-1 UTILITY 

2 buses
• M/E-2 UTILITY 1 and M/E-2 UTILITY 

2 buses
• M/E-3 UTILITY 1 and M/E-3 UTILITY 

2 buses
• P/P UTILITY 1 and P/P UTILITY 2 

buses
• DSK 1 fill to DSK 4 fill buses
• DSK 1 source to DSK 4 source buses
• M/E-1 Key 1 fill to Key 4 fill buses
• M/E-2 Key 1 fill to Key 4 fill buses
• M/E-3 key 1 fill to M/E-3 key 4 fill buses
• M/E-1 Key 1 source to Key 4 source 

buses
• M/E-2 Key 1 source to Key 4 source 

buses
• M/E-3 key 1 source to M/E-3 key 4 

source buses
• M/E-1 external DME bus
• M/E-2 external DME bus
• M/E-3 external DME bus
• P/P external DME bus
• DME UTILITY1 and DME UTILITY2 

buses

b Selected source name displays
These show the name of the currently 
selected signal (source) on the bus 
corresponding to the delegation button.

c DEST (destination) button
Press this button, turning it on, to display 
the names of buses allocated to the 
delegation buttons in the selection source 
name displays.
In the case of a module without selected 
source name displays, this button is invalid.

d Selected bus display
This shows the name of the bus selected by 
the auxiliary bus delegation buttons.

e Cross-point buttons
The cross-points in the auxiliary bus control 
block are arranged in two rows: an upper 
row (1st row) and a lower row (2nd row), 
and are allocated to the buses selected with 
the AUX delegation buttons. The 1st row 
contains the cross-point buttons for 
unshifted buses, and the 2nd row contains 
the cross-point buttons for shifted buses.
When the DME 1V/K to 8V/K buses are 
selected with the AUX delegation buttons, 
the 1st row cross-point buttons are for the 
currently showing side of DME, and the 
2nd row are for the reverse side.
By holding down the [2ND] button and 
making an AUX delegation selection, you 
can allocate the 2nd row to a different bus 
from the 1st row.
In this case, if the 32nd button is set to be a 
[SHIFT] button (in a 32-button system), the 
cross-point buttons switch to the shifted 
allocation while the [SHIFT] button is 
enabled.

f XPT HOLD (cross-point hold) 
buttons

Press one of these buttons, turning it on, to 
enable cross-point hold.

g KEY button
While this button is held down, you can use 
the cross-point row of buttons to select key 
signals.
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h 2ND button
After selecting a bus with an AUX 
delegation button, hold down this button, 
and select another AUX delegation, thus 
allocating a different bus in the 2nd row 
from the 1st row.

i Source name displays
These show the names of the source signals 
which can be selected by the cross-point 
buttons. While the [SHIFT] button is 
enabled, the shifted signal name is 
displayed. If a different bus is allocated to 
the 2nd row, while the [2ND] button is held 
down, the 2nd row signal name is 
displayed.
While the [KEY] button is held down, the 
source name of the key signal assigned to 
the cross-point buttons appears.

j SHIFT button
While this button is enabled, the shifted 
signal names appear in the source name 
display. Pressing this buttons toggles the 
source name display between the shifted 
signal names and unshifted signal names.
In the case of a module without source 
name displays, this button is invalid.

k RTR (router) button
Press this button, turning it on, to assign the 
auxiliary bus control block to router 
control.

For details of the names and functions of 
parts for router control, see the next 
section.

l Level selection buttons
Used when the auxiliary bus control block 
is carrying out router control.
267Names and Functions of Parts of the Control Panel



268

   C
hapter 2 

M
enus and C

ontrol P
anel
Auxiliary Bus Control Block (for Router Control)

Press the [RTR] button, turning it on, to 
assign the auxiliary bus control block to 
router control.

a Destination selection buttons
Press a button, turning it on, to select the 
destination to which the router source is 
assigned.
The button pressed to assign a destination 
to a source selection button in the 1st row 
lights amber. When another button is 
pressed to assign a different destination to a 

source selection button in the 2nd row, it 
lights green.

b Selected source name displays
These show the source name selected for 
the destination.
If the source names and destination names 
are set in the Setup menu to “SW’er Local” 

LEVEL
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SHIFT

RTR

2ND

KEY

XPT
HOLD

XPT
HOLD

M/E
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M/E
1
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3
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4V
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4K
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1
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2

EDIT
PVW

1 Destination selection buttons

2 Selected source name displays

3 DEST button

4 Selected destination display

5 Source selection 
button rows

6 XPT HOLD buttons

7 KEY button

qs Level selection buttons

qa RTR button

0 SHIFT button
9 Source name displays

8 2ND button

2nd

1st
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mode, then the description names appear 
here.

c DEST (destination) button
Press this button, turning it on, to display 
the names of the destinations assigned to 
the destination selection buttons in the 
selected source name displays.

d Selected destination display
This shows the name of the destination 
selected by the destination selection 
buttons. If a protected destination is 
selected, the indication “PROTECT” 
appears.

e Source selection button rows
The destination selected with a destination 
selection button is assigned to a source 
selection button. Press a source selection 
button to select a source. The 1st row of 
buttons are source selection buttons for the 
unshifted destinations, and the 2nd row are 
shifted source selection buttons. By holding 
down the [2ND] button, and selecting a 
destination, you can assign a different 
destination from the 1st row to the 2nd row. 
In the 1st row, the button to which a 
destination is assigned lights amber. If a 
different destination is assigned to a button 
in the 2nd row, the button lights green.
When the 32nd button is set as a [SHIFT] 
button (in a 32-button system), while the 
[SHIFT] button is active, these switch to the 
shifted source selection buttons. By using 
the [KEY] button, you can expand the 
source selection as follows.

f XPT HOLD (cross-point hold) 
buttons

Not used in router control mode.

g KEY button
When this button is enabled by a setting in 
the Setup menu, by holding it down during 
a source selection you can expand the 
function of the [SHIFT] button. (See 
“Expanding the shift function” in Chapter 
16 (Volume 2).)

h 2ND button
After selecting a destination with the 
destination selection buttons, hold down 
this button and make another destination 
selection to assign a different destination 
from the 1st row to the 2nd row.

i Source name displays
These display the names of signals 
(sources) that can be selected with the 
cross-point buttons. While the [SHIFT] 
button is active, the shifted signal names 
appear. While the [KEY] button is held 
down, the expanded signal names appear.
When a different destination is assigned to 
the 2nd row, the 2nd row signal names 

Source 
selection

[SHIFT] [KEY] Selection 
operation

1 to 31 Off Off Press the source 
selection button.

32 to 62 On Off Press the 
[SHIFT] button, 
then press the 
source selection 
button.

63 to 93 Off On Hold down the 
[KEY] button, 
and press the 
source selection 
button.

94 to 124 On On Hold down the 
[KEY] button, 
and press the 
[SHIFT] button, 
turning it on (the 
[SHIFT] button 
locks here, even 
when in Hold 
mode), then 
press the source 
selection button.

Source 
selection

[SHIFT] [KEY] Selection 
operation
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appear only while the [2ND] button is held 
down.

j SHIFT button
While this button is active, the source name 
displays show the shifted signal names. 
Press this button to toggle between the 
shifted and unshifted states.

k RTR (router) button
Press this button, turning it on, to assign the 
auxiliary bus control block to router 
control.

l Level selection buttons
To each of the four buttons, plural S-Bus 
levels are assigned in the Setup menu. Press 
a button, turning it on, to make operations 
apply to those S-Bus levels.
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Menu Control Block

a Top menu selection buttons
These select the menu appearing in the 
menu display.

b Menu display
This shows the menu currently in use.

c Knobs
These adjust the parameter values 
appearing in the menu.

d User preference buttons
These recall the functions or menus 
assigned to them in the Setup menu. In the 
default setup, nothing is assigned to the 
[PREFS 1] to [PREFS 7] buttons.
PREFS 8 button: When this button is on, 

control of an editor from the Remote1 
port on the rear panel of the switcher is 
possible. However, even when it is off, 
control of the Edit PVW bus is always 
possible.
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Memory Card/USB Adaptor Block

a Memory card slot
This slot accepts a PCMCIA Type II 
compliant memory card. You can use it in 
software installation, and for saving and 
reading in data, such as snapshot, keyframe, 
effect, and setup data.

b DEVICE connectors
There are three USB connectors. 
You can connect a device such as a mouse, 
keyboard, pen tablet, and so on, that is 
equipped with a USB interface to any of 
these connectors.

For details on the devices that can be 
connected, consult your Sony 
representative.

1 Memory card slot 2 DEVICE connectors
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“Memory Stick”/USB Connections Block

a “Memory Stick” status indicator
Lights in red during access to a “Memory 
Stick.”

Note
Do not power the unit off or remove a 
“Memory Stick” when the “Memory Stick” 
status indicator is lit.

b “Memory Stick” slot
Insert “Memory Sticks.” You can use it in 
software installation, and for saving and 
reading data, such as snapshot, keyframe, 
effect, and setup data.

See the next item, “Memory Sticks” for 
more information about the usable 
“Memory Sticks” and their handling.

c DEVICE connectors
There are three USB connectors.
You can connect a device such as a mouse, 
keyboard, pen tablet, and so on, that is 
equipped with a USB interface to any of 
these connectors.

For details on the devices that can be 
connected, consult your Sony 
representative.

About “Memory Sticks”

Usable “Memory Sticks”
This unit has been confirmed to operate 
with those of the following “Memory 
Sticks” that have a capacity of 2 GB 
(gigabytes) or less. However, operation 
with all “Memory Sticks” is not guaranteed.
• “Memory Stick”

1 “Memory Stick” status indicator

2 “Memory Stick” slot

3 DEVICE connectors
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• “Memory Stick PRO”
• “Memory Stick Duo”
• “Memory Stick PRO Duo”

Notes
• When using a “Memory Stick PRO,” 

high-rate data transfer using parallel 
interface is not supported.

• A “MagicGate Memory Stick” can also 
be used, but this system does not support 
the MagicGate function.

• When using a “Memory Stick Duo,” be 
sure to use it with a “Memory Stick Duo 
Adaptor” (MSAC-M2 or equivalent). If 
you insert a “Memory Stick Duo” 
without using the adaptor, there is the 
possibility that the stick cannot be 
removed, resulting in a serious accident.

Handling “Memory Sticks”
When using “Memory Sticks,” pay 
attention to the following points.
• Do not touch the connector of the 

“Memory Stick” with anything, including 
your finger or metallic objects.

• Do not attach anything other than the 
supplied label to the “Memory Stick” 
labeling position.

• Attach the label so that it does not stick 
out beyond the labeling position.

• Carry and store the “Memory Stick” in its 
case.

• Do not strike, bend, or drop the “Memory 
Stick.”

• Do not disassemble or modify the 
“Memory Stick.”

• Do not allow the “Memory Stick” to get 
wet.

• Do not use or store the “Memory Stick” 
in a location that is:
– Extremely hot, such as in a car parked 

in the sun
– Under direct sunlight
– Very humid or subject to corrosive 

substances
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Utility/Shotbox Control Block

a Bank selection buttons
Press any of the [BANK1] to [BANK4] 
buttons to select a bank of 24 memory recall 
buttons. The selected button lights amber.

b Memory recall buttons
You can use these buttons to recall 
frequently used menus, utility functions, 
shotbox registers, or macro registers that 
you have assigned.
When a utility function is allocated to a 
button, the button lights orange (or green 
depending on the status), and the allocated 
function name appears. Pressing the button 
executes the allocated function. When the 
function constitutes a switching on/off 
operation, the button lights green; 
otherwise, it only momentarily lights green.
When a shotbox register or macro register 
recall is assigned to a button, the button 
lights orange, and the assigned register 
name appears. (If the register is empty, the 

button goes off.) In the case of a shotbox 
function, pressing the button executes the 
assigned shotbox function, and the button 
lights yellow. In the case of a macro 
register, pressing the button executes the 
assigned macro, and the button flashes 
yellow.

1
BANK

1 2 3 4

7
BANK

2

BANK
3

BANK
4

5 6

8 9 10 11 12

13 14 15 16 17 18

19 20 21 22 23 24

1 Bank selection buttons

2 Memory recall buttons
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Transition Control Block and Flexi Pad Control Block 
(Simple Type)

The simple versions of the transition 
control block and Flexi Pad control block 
shown in the following figure is designed to 
allow simplified operations than with the 
standard type. The transitions carried out 
using these simple-type control blocks are 
also referred to as “simple transitions” in 
this user’s guide.
Names and Functions of Parts of the Control Panel



  C
hapter 2 

M
enus and C

ontrol P
anel
KEY1
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REV
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2 Key transition selection buttons

6 Key status display

1 Transition type selection buttons

3 Transition execution section

5 Pattern limit buttons

4 Wipe direction selection buttons

qa Numeric display

0 XPT HOLD status display 

7 Mode selection buttons

9 UNDO button

8 Memory recall section 

Shown above is the right-hand type transition control block (with the right-hand fader lever).
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Transition Control Block and Flexi Pad Control Block (with INH 
button)

a Transition type selection buttons
Press one of these buttons, turning it on, to 
determine the type of the next transition for 
a background.
To select the key transition type, hold down 
the [KEY1] or [KEY2] button, and press 
one of the following buttons, turning it on.
When multi-program mode is selected in 
the Setup menu (see “Settings for Switcher 
Configuration (Config Menu)” in Chapter 
16 (Volume 2)), two or more of the 
following buttons may light.
MIX: In a background transition, the new 

video fades in as the current video 
fades out. During the transition, the 
overall signal level is maintained at 
100%.
In a key transition, the key fades in (for 
insertion) or out (for removal).

NAM (non-additive mix): The current and 
new video signals are compared, and 
the signal with the higher luminance 
level is given priority in the output.
The current video is maintained at 
100% output for the first half of the 
transition as the new video increases 
progressively to 100%, then the current 
video is progressively reduced from 
100% to zero in the second half while 
the new video is maintained at 100%.

WIPE: The current video is replaced by the 
new video, using the wipe pattern 
selected in the Wipe menu.

DME: This applies a wipe-like transition, 
using the DME effect selected in the 
DME Wipe menu.

INH

WIPE

DME

SNAP
SHOT

LIMIT
SET

PIN
LIMIT

NORM
/REV

REV

UNDO

MIX

NAM

WIPE

DME

TAKE

XPT HOLD

A B U1 U2 1 2 3 4

qs INH button

Memory recall section

UNDO button
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b Key transition selection buttons
To insert or delete key 1 on the next 
transition, hold down the [KEY1] button, 
and select the type of transition using the 
transition type selection buttons. If the key 
is currently not inserted, the transition will 
insert it, and if the key is currently inserted, 
the transition will delete it. You can use the 
[KEY2] button in a similar way.
While these buttons are held down, you can 
select a key source with the cross-point 
buttons on the key bus.
Pressing one of these buttons twice in rapid 
succession changes the state of the 
corresponding key bus so that a cross-point 
can be selected.

a) The key bus switching button [KEY3] in the cross-
point control block goes off.

b) The key bus switching button [KEY4] in the cross-
point control block goes off.

c Transition execution section
Fader lever: Move this vertically to carry 

out a transition.
When the split fader function is 
enabled, by pressing the projection on 
the left side of the grip you can release 
the lock and separate the two halves of 
the fader lever. With the split fader 
lever, in a background mix transition, 
you can control the background A and 
B buses independently.

Transition indicator: This comprises 
multiple LEDs, which show the 
progress of the transition.

Transition rate display: This displays the 
transition rate (the time from the 
beginning of the transition to its 
completion) set for an auto transition, 
in frames.

You can set the transition rate using the 
numeric keypad control block or menu.

TAKE button: Pressing this button carries 
out an auto transition of the set 
transition rate. The transition starts 
immediately, and the button lights 
amber. When the transition completes, 
the button goes off.

d Wipe direction selection buttons
REV (reverse): When this button is off, the 

wipe proceeds in the normal direction. 
When the button is lit, the wipe 
proceeds in the reverse direction. 
The normal direction refers to the black 
to white direction or in the direction of 
the arrow as shown in the appendixes 
“Wipe Pattern List” and “DME Wipe 
Pattern List” (Volume 2).

NORM/REV (normal/reverse): The wipe 
direction alternates between normal 
and reverse every time a transition is 
executed.

e Pattern limit buttons
LIMIT SET: Move the fader lever to the 

position of a particular pattern size, and 
stop it there, then press this button to 
set the pattern limit range. This button 
is enabled when the [PTN LIMIT] 
button is off.

PTN (pattern) LIMIT: When a wipe or 
DME wipe is selected, pressing this 
button, turning it on, enables the 
pattern limit function.

f Key status display
For each of keys 1 and 2, when the key is 
inserted, the corresponding ON indicator 
lights. The OVER indicators show the 
priority between keys 1 and 2, by lighting 
when the corresponding key is on top. For 
example, when key 1 appears over key 2 on 
the program monitor, the OVER indicator 
for key 1 lights.

Key delegation button 
(double press)

Corresponding 
key bus

[KEY1] key 1 a)

[KEY2] key 2 b)
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The following is the Flexi Pad control 
block.

g Mode selection buttons
WIPE: When saving or recalling a wipe 

snapshot, use this in combination with 
the buttons of the memory recall 
section.

DME: When saving or recalling a DME 
wipe snapshot, use this in combination 
with the buttons of the memory recall 
section.

SNAPSHOT: When saving or recalling a 
snapshot, use this in combination with 
the buttons of the memory recall 
section.

h Memory recall section
This consists of eight buttons with LCDs, 
whose display changes according to the 
operation mode. Use these in combination 
with the mode selection buttons to save, 
recall, or delete wipe snapshots, DME wipe 
snapshots, or snapshots.

i UNDO button
After recalling a register, press this button 
to return to the state before recalling the 
register.
With a setup setting, this can be switched to 
a mode selection button for macro setting, 
and used in combination with the buttons in 
the memory recall section for recalling and 
executing a macro.

j XPT HOLD (cross-point hold) status 
display

A bus for which cross-point hold is set 
appears as a green light.

k Numeric display
Depending on the operation mode, this 
shows a wipe or DME wipe pattern number, 
or a register number in up to four digits.
In macro mode, this provides indications 
for macro editing.

l INH (inhibit) button
Pressing this button, turning it on, disables 
the buttons in the memory recall section 
and the [UNDO] button. This does not 
apply, however, to a macro function 
assigned to the [UNDO] button.
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Independent Key Transition Control Block (Simple 
Type)

The left side of this control block controls 
key 3, and the right side controls key 4.
The control block for key 3 only is 
described as an example, but the operations 
on the key 4 control block are the same.

In setup you can assign any key to either 
side of this control block. For details, see 
“Assigning Keys to the Independent Key 
Transition Control Block (Simple Type)” in 
Chapter 16 (Volume 2).

a Independent key transition type 
selection buttons

Press one of the following buttons, turning 
it on, to select the independent key 
transition type.
MIX: Faded in or out.
WIPE: Inserted or deleted with a wipe.
DME: Switches the key with a DME wipe.
CUT: Inserted or deleted instantaneously.

SHIFT: This has the following functions.
• When setting is made in the Setup 

menu to allow a different transition 
type for inserting or deleting a key, it 
is possible to display and set the 
transition type after the next 
transition while this button is held 
down.

K-SS WIPE DME

SHIFT MIX CUT

KEY3
ON

TAKE

K-SS WIPE DME

SHIFT MIX CUT

KEY4
ON

TAKE

3 K-SS button

4 Key source name display/key snapshot buttons

1 Independent key transition type selection buttons

2 Independent key transition execution section
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• While this button is held down, you 
can select a key source with the 
cross-point buttons for the key bus.

• If you press this button twice in rapid 
succession, the key bus selection 
button [KEY3] in the cross-point 
control block lights, and a key 3 key 
bus cross-point can be selected.

• If you press this button, while 
holding down [TRANS RATE] 
button in the numeric keypad control 
block, you can set the independent 
key transition rate on the control 
block.

b Independent key transition 
execution section

KEY3 ON button: This inserts or deletes 
key 3 instantaneously. When key 3 is 
present in the final program output 
from the switcher, this lights red, and 
otherwise lights amber.

TAKE button: This carries out an auto 
transition on key 3.

c K-SS (key snapshot) button
This enables key snapshot mode. In key 
snapshot mode, it is possible to save and 
recall key snapshots.

d Key source name display/key 
snapshot buttons

These show the signal name of the key fill 
selected for key 3 and the transition rate on 
two buttons. In key snapshot mode, these 
correspond to registers 1 and 2 for key 3; 
press to save or recall a key snapshot.
To save a key snapshot, with the [K-SS] 
button lit amber, hold down [SHIFT] button 
and press one of the key snapshot buttons.
This saves a key snapshot in the button you 
pressed, which lights yellow.
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Downstream Key Control Block

a Key delegation buttons
Press one of the [DSK1] to [DSK4] buttons 
to delegate this control block to the 
corresponding keyer.
Using the Setup menu, it is possible to 
delegate this control block to key 1 to key 4 
of the M/E bank.
While these buttons are held down, you can 
select a key source with the cross-point 
buttons for the key bus.
Pressing one of these buttons twice in rapid 
succession changes its state so that you can 
make cross-point selections on the 
corresponding key bus.

b Independent key transition type 
selection buttons

Press one of these buttons, turning it on, to 
select the downstream key transition type.
MIX: Carry out a dissolve with the key 

selected with the key delegation 
buttons.

WIPE: Carry out a wipe with the key 
selected with the key delegation 
buttons.

DME: This switches the key selected with 
the key delegation buttons, using a 
DME wipe.

CUT: Instantaneously insert or delete the 
key selected with the key delegation 
buttons.

DSK1 DSK2 WIPEUNDO

DSK3 DSK4 SHIFT MIX

K-SS

CUT

DME

K-SS
STORE

DSK1
ON

DSK2
ON

DSK3
ON

DSK4
ON

TAKETAKETAKETAKE

1 Key delegation buttons

5 Key source name display/key snapshot
buttons

4 Key snapshot setting
buttons

3 Independent key transition execution section

2 Independent key transition type 
selection buttons
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SHIFT: When setting is made in the Setup 
menu to allow a different transition 
type for inserting or deleting a key, it is 
possible to display and set the 
transition after the next transition while 
this button is held down.

c Independent key transition 
execution section

DSK1 (downstream key 1) ON to DSK4 
ON buttons: Press these to 
instantaneously cut the downstream 
keys 1, 2, 3, and 4 in or, when the 
downstream keys are already inserted, 
cut them out. When the key 
corresponding to the button appears in 
the final program output, the button 
lights red, and otherwise lights amber.

TAKE buttons: These correspond to 
downstream keys 1, 2, 3, and 4 from 
left to right; press to execute an auto 
transition. The transition starts 
immediately, and the button lights 
amber. When the transition completes, 
the button goes off.

Fader lever: Move this to carry out a 
manual downstream key transition.

Transition indicator: This comprises 
multiple LEDs, which show the 
progress of the downstream key 
transition.

d Key snapshot setting buttons
K-SS (key snapshot): This enables key 

snapshot mode.
K-SS STORE (key snapshot store): To 

save a key snapshot, hold down this 
button, and press the key source name 
display/key snapshot button for the 
register you want to save.

UNDO (key snapshot recall undo): This 
undoes the last key snapshot recall.

e Key source name display/key 
snapshot buttons

These display the selected source name for 
each corresponding keyer. In snapshot 
mode, they correspond to registers 1 to 4 of 
the selected keyer, and pressing the button 
saves or recalls a key snapshot.
Names and Functions of Parts of the Control Panel



  C
hapter 2 

M
enus and C

ontrol P
anel
Downstream Key/Fade-to-Black Control Block

a Key delegation buttons
Press DSK1 or DSK2, to select the keyer. 
Each button can be assigned to any key in 
setup (see Chapter 16 “Overall Control 
Panel Settings (Config Menu)” (Volume 
2)).
While these buttons are held down, you can 
select a key source with the cross-point 
buttons on the key bus.
Pressing one of these buttons twice in rapid 
succession changes its state so that you can 
make cross-point selections on the 
corresponding key bus in the PGM/PST 
bank.

a) The key bus selection button [KEY3] in the P/P 
cross-point control block goes off.

b) The key bus selection button [KEY4] in the P/P 
cross-point control block goes off.

b Independent key transition 
execution section

DSK1 ON, DSK2 ON buttons: Press these 
to cut in the corresponding downstream 
key 1 or 2. When the key is already 
inserted, pressing the button cuts it out. 
Each button lights red when the 
corresponding key is inserted in the 
program output (final output from the 

AUTO PST P/P

FTB

DME
K

DME
V

M/E
3

M/E
2

M/E
1

M/E
3K

M/E
2K

M/E
IK

P/P
K

DSK1 K-SSDSK2

DSK2
ON

DSK1
ON

AUTO
TRANS

AUTO
TRANS

1 Key delegation 
buttons

2 Independent key 
transition 
execution section

3 K-SS button

4 Key source name display/key snapshot buttons

5 FTB button

6 AUTO button

7 Preview selection buttons

Key delegation button 
(double press)

Corresponding 
key bus

[DSK1] key 1 a)

[DSK2] key 2 b)

Key delegation button 
(double press)

Corresponding 
key bus
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switcher), and lights amber at other 
times.

AUTO TRANS buttons: The left button 
applies to DSK1 and the right button to 
DSK2; press these buttons to carry out 
an auto transition. The transition 
immediately starts, and the button 
lights amber. When the transition 
completes, the button goes off.

c K-SS (key snapshot) button
Pressing this button, turning it on, enables 
the key snapshot mode. In this mode, you 
can save and recall key snapshots.

d Key source name display/key 
snapshot buttons

Each column of two buttons relates to the 
corresponding downstream key 1 or 2. The 
upper button displays the name of the key 
fill signal selected for the key, and the 
lower button shows the transition rate.
In key snapshot mode, these buttons 
correspond to registers 1 to 4 of the keyer 
selected with the key delegation buttons, 
and pressing a button recalls the key 
snapshot. To save a key snapshot, hold 
down the [STORE] button in the numeric 
keypad control block, and press the button 
for the desired register.

e FTB (fade to black) button
Press this button to fade to black the 
program output of the PGM/PST bank, at 
the set transition rate. You can set the fade 
to black transition rate in the menu.

f AUTO button
When this button is pressed, the M/E or 
PGM/PST bank preview signal selected on 
the edit preview bus is automatically 
switched to the program signal depending 
on the on-air status.

g Preview selection buttons
Press one of these buttons to select a signal 
on the edit preview bus. Each button can be 
assigned to any preview output in setup (see 
Chapter 16 “Overall Control Panel 
Settings (Config Menu)” (Volume 2)).
PST (preset): When this button is pressed, 

the signal selected on the background B 
row of the PGM/PST bank is selected 
on the edit preview bus.

M/E 1 to M/E 3, P/P (M/E1 to M/E 3, P/P 
preview): The preview signal (M/E-1 
PVW, M/E-2 PVW, M/E-3 PVW, P/P 
PVW) of the M/E or PGM/PST bank 
corresponding to the pressed button is 
selected on the edit preview bus.

M/E1 K to M/E3 K, P/P K (M/E1 to M/E 
3, P/P key preview): The key preview 
signal (M/E-1 K-PVW, M/E-2 K-
PVW, M/E-3 K-PVW, P/P K-PVW) of 
the M/E or PGM/PST bank 
corresponding to the pressed button is 
selected on the edit preview bus.

DME V (DME monitor video): When this 
button is pressed, the DME monitor 
output video signal (DME MON V) is 
selected on the edit preview bus.

DME K (DME monitor key): When this 
button is pressed, the DME monitor 
output key signal (DME MON K) is 
selected on the edit preview bus.
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Transition Control Block (Compact Type)

The compact version of the transition 
control block shown in the following figure 
has fewer buttons than the standard type. 
Independent key transition operations can 

also be controlled with the compact 
transition control block.

a Next transition selection buttons
Press these buttons, turning them on, to 
determine what the next transition will 
apply to.
BKGD: Next transition changes the 

background.

KEY1 to KEY4 (DSK1 to DSK4 in the 
PGM/PST bank): Press this button, 
turning it on, to make the next 
transition insert or remove the 
corresponding key (keys 1 to 4). If a 
key is currently inserted it will be 

KEY1
TRANS

KEY2
TRANS

KEY3
TRANS

KEY4
TRANS

BKGD KEY1 KEY2 KEY3 KEY4

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

AUTO
TRANS CUT

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

7 PRIOR SET button

1 Next transition selection buttons

6 Key status display

2 Transition type selection buttons

5 TRANS PVW button

3 Transition execution section

4 Wipe direction selection buttons

8 Independent key transition 
execution section
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removed, and if it is not currently 
inserted, it will be inserted.
In the PGM/PST bank, this inserts or 
removes downstream keys 1 to 4.

KEY PRIOR (priority): When this button 
is lit, the setting of the key priority after 
the next transition is enabled. The key 
priority after the next transition appears 
in the key status display.

ALL: Pressing this button turns on a 
preselected set of the [BKGD], [KEY1] 
to [KEY4], and [KEY PRIOR] buttons.
Make this setting in a Setup menu.

b Transition type selection buttons
Press one of these buttons, turning it on, to 
determine the type of the next transition.
When multi-program mode is selected in 
the Setup menu (see “Settings for Switcher 
Configuration (Config Menu)” in Chapter 
16 (Volume 2)), two or more of the 
following buttons may light.
MIX: In a background transition, the new 

video fades in as the current video 
fades out. During the transition, the 
overall signal level is maintained at 
100%.
In a key transition, the key fades in (for 
insertion) or out (for removal).

NAM (non-additive mix): The current and 
new video signals are compared, and 
the signal with the higher luminance 
level is given priority in the output.
The current video is maintained at 
100% output for the first half of the 
transition as the new video increases 
progressively to 100%, then the current 
video is progressively reduced from 
100% to zero in the second half while 
the new video is maintained at 100%.

SUPER MIX: The current video is 
maintained at 100% output for the first 
half of the transition as the new video is 
mixed while increasing progressively 
to 100%. The current video is then 
progressively reduced from 100% to 

zero in the second half while the new 
video is maintained at 100%.

PST (preset) COLOR MIX: In the first 
transition, the current video is replaced 
by the color matte in a mix (dissolve), 
then in the second transition the color 
matte is replaced by the new video also 
in a mix (dissolve).

WIPE: The current video is replaced by the 
new video, using the wipe pattern 
selected in the Wipe menu.

DME: A wipe type of transition is carried 
out, using the DME effect selected in 
the DME Wipe menu.

c Transition execution section
Transition indicator: This comprises 

multiple LEDs, which show the 
progress of the transition.

Fader lever: Move this to carry out a 
manual transition.

Transition rate display: This shows the 
“transition rate” (the time from the 
beginning of a transition to its 
completion) set for an auto transition, 
in frames.
You can set the transition rate using the 
numeric keypad control block, Flexi 
Pad control block, or menu.

AUTO TRANS (transition) button: 
Pressing this button carries out an auto 
transition of the set transition rate 
(duration). The transition starts 
immediately, and the button lights 
amber. When the transition completes, 
the button goes off.

CUT button: Pressing this button carries 
out the transition as a cut (i.e. 
instantaneously).

d Wipe direction selection buttons
When you have selected a wipe or DME 
wipe as the transition type, press one of 
these buttons, turning it on, to select the 
wipe direction.
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NORM (normal): The wipe proceeds in 
the direction from black to white as 
shown on the pattern in the lists of 
patterns (see the appendixes “Wipe 
Pattern List” and “DME Wipe Pattern 
List” (Volume 2)), or in the direction of 
the arrow. 
When the VTR/disk recorder operation 
mode is enabled in setup, pressing this 
button plays the tape.

REV (reverse): The wipe proceeds in the 
opposite direction to that when the 
[NORM] button is pressed.
When the VTR/disk recorder operation 
mode is enabled in setup, pressing this 
button cues the tape automatically to 
the start point.

NORM/REV (normal/reverse): The wipe 
direction alternates between normal 
and reverse every time a transition is 
executed.
When the VTR/disk recorder operation 
mode is enabled in setup, pressing this 
button stops the tape.

e TRANS PVW (transition preview) 
button

When this button is lit, you can check in 
advance the video changes during the 
transition, on the preview output from the 
M/E or PGM/PST bank.
During the preview, you can use the fader 
lever, [AUTO TRANS] button, and [CUT] 
button. One of the following functions of 
this button can be selected in a Setup menu.
• When the transition completes, the 

system returns to the normal mode.
• The transition preview mode is 

maintained while this button is pressed.
• Switching is made between the transition 

preview mode and normal mode every 
time this button is pressed.

f Key status display
For each of keys 1 to 4, the corresponding 
ON indicator lights when the key is 

inserted. It also shows the priority (1 to 4) 
of each key.

g PRIOR (priority) SET button
While this button is held down, you can set 
the key priority.
The setting mode when this button is 
pressed depends on whether or not the 
[KEY PRIOR] button is lit, as follows.
• When the [KEY PRIOR] button is off, the 

current key priority is set.
• When the [KEY PRIOR] button is lit, the 

key priority after the next transition is set.
Press the [KEY PRIOR] button as required, 
to switch between these two modes.
In either mode, hold down the [PRIOR 
SET] button, and press the button ([KEY1] 
to [KEY4]) corresponding to the key you 
want to bring to the front.

h Independent key transition 
execution section

KEY1 TRANS (transition) to KEY4 
TRANS (DSK1 TRANS to DSK4 
TRANS in the PGM/PST block) 
buttons: Press the corresponding one 
of these buttons to cut key 1 to key 4 in 
or out automatically at the set transition 
rate. When the key corresponding to 
the button appears in the final program 
output, the button lights red, and 
otherwise lights amber. During a 
transition, the button lights green.
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Basic Menu Operations

Menu Organization

Operations on the MVS-8000 switcher 
system make frequent use of menu 
operations.
This section describes the menus and their 
interrelationships.

Overview
All detailed settings for basic operations 
such as transitions, keys, DME, or wipes, 
are made in menus. There are also menus 
for carrying out general system control, 
managing setting data, and initial setup.

Accessing menus
You can use any of the following methods 
to access a menu, and the initially displayed 
menu page depends on the method used.
• Pressing a top menu selection button in 

the menu control block.
This displays the page you last accessed 
in the particular menu. After initially 
powering on the system, however, the 
page of VF1 - HF1 of the particular menu 
is always selected.

• Pressing a top menu selection button in 
the menu control block twice in rapid 
succession.
The page of VF1 - HF1 of the particular 
menu is displayed.

• Pressing a button other than a top menu 
button twice in rapid succession (see 
page 292).
Depending on the button, this may 
display a fixed page or the page selected 
last time you accessed the menu.

• Press the menu page selection button at 
the top left of the menu display.

The top menu window appears; press the 
top menu selection button for the 
particular menu, or enter the menu 
number with the numeric keypad, and 
press the Enter button.

For details of the VF buttons and HF 
buttons, see “Interpreting the Menu 
Screen” (page 298).
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Menus accessed from a top menu selection button

Buttons Menus Function See

M/E 1 M/E-1 Transition, keys, and wipe 
settings for the M/E-1 bank

page 320 (transitions), page 
352 (keys), page 398 (wipes)

M/E 2 M/E-2 Transition, keys, and wipe 
settings for the M/E-2 bank

M/E 3 M/E-3 Transition, keys, and wipe 
settings for the M/E-3 bank

P/P PGM/PST Transition, downstream key, and 
wipe settings for the PGM/PST 
bank

FRAME 
MEM

Frame Memory Frame memory settings page 448

COLOR 
BKGD

Color Bkgd Color background settings page 482

AUX/MON Aux/Mon AUX bus settings page 499

CCR CCR Color corrector settings Chapter 19 (Volume2)

COPY 
SWAP

Copy/Swap Copy and swap settings page 488

MISC Misc Safe title settings page 492

STATS Status Status display Chapter 11 (Volume2)

DME DME DME special effect settings Chapter 11 (Volume 2)

GLB EFF Global Effect Global effect settings Chapter 11 (Volume 2)

DEV Device Settings for external device 
operation

Chapter 12 (Volume 2)

MCRO Macro Macro register settings Chapter 18 (Volume 2)

KEY 
FRAME

Key Frame Keyframe settings Chapter 13 (Volume 2)

EFF Effect Keyframe effect register settings Chapter 13 (Volume 2)

SNAP
SHOT

Snapshot Snapshot register settings Chapter 14 (Volume 2)

SHOTBOX Shotbox Shotbox register settings Chapter 15 (Volume 2)

FILE File File settings Chapter 17 (Volume 2)

ENG 
SETUP

Engineering Setup Setup functions Chapter 16 (Volume 2)
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Menus accessed by pressing a button twice
For relevant buttons other than the top 
menu selection buttons, pressing twice in 
rapid succession directly recalls a related 
menu page. The following table lists these 

buttons of each control block, together with 
the menus they recall. (XX represents the 
HF menu recalled last in the VF menu.)

Cross-point control block

Buttons Menus See

FM1 to 8 signals assigned 
buttons

Frame Memory >Still >Recall page 457

Color Bkgd1 signal assigned 
button

Color Bkgd >Color Bkgd1 page 482

Color Bkgd2 signal assigned 
button

Color Bkgd >Color Bkgd2

CCR1 signal assigned button CCR >CCR1 >XX Chapter 19 
(Volume 2)

CCR2 signal assigned button CCR >CCR2 >XX

Transition control block (standard type, compact type)

Buttons Menus See

KEY1 (DSK1) a) • M/E-1, 2, 3 >Key1 >XX 
• PGM/PST >DSK1 >XX

page 352

KEY2 (DSK2) a) • M/E-1, 2, 3 >Key2 >XX 
• PGM/PST >DSK2 >XX

KEY3 (DSK3) a) • M/E-1, 2, 3 >Key3 >XX 
• PGM/PST >DSK3 >XX

KEY4 (DSK4) a) • M/E-1, 2, 3 >Key4 >XX 
• PGM/PST >DSK4 >XX

WIPE M/E-1, 2, 3, PGM/PST >Wipe >Main Pattern page 398

DME M/E-1, 2, 3, PGM/PST >DME Wipe >XX page 426

SUPER MIX M/E-1, 2, 3, PGM/PST >Misc >Transition page 321

PST COLOR MIX M/E-1, 2, 3, PGM/PST >Misc >Transition page 322

PRIOR SET M/E-1, 2, 3, PGM/PST >Misc >Key Priority page 317

KEY PRIOR M/E-1, 2, 3, PGM/PST >Misc >Next Key Priority page 317

WIPE (Independent key 
transition type selection 
button (standard type))

• M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select

page 416

DME (Independent key 
transition type selection 
button (standard type))

• M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >DME Wipe 
Adjust >1ch Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >DME Wipe 
Adjust >1ch Pattern Select

page 438
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a) Including the key delegation buttons of the transition control block (standard type).

a) The menu to be recalled depends on the setup of the key assignment.

K-SS STORE Snapshot >Key Snapshot >XX Chapter 14 
(Volume 2)

Independent key transition control block (simple type) a)

Buttons Menus See

WIPE • M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select

page 416

DME • M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >DME Wipe 
Adjust >1ch Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >DME Wipe 
Adjust >1ch Pattern Select

page 438

SHIFT • M/E-1, 2, 3 >Key1, 2, 3, 4 >XX 
• PGM/PST >DSK1, 2, 3, 4 >XX

page 352

Transition control block (standard type, compact type)

Buttons Menus See

Flexi Pad control block (standard type)

Buttons Menus See

WIPE M/E-1, 2, 3, PGM/PST >Wipe >Main Pattern page 398

DME M/E-1, 2, 3, PGM/PST >DME Wipe >XX page 426

SNAPSHOT Snapshot >Snapshot >XX Chapter 14 
(Volume 2)

EFF Effect >Effect 1-99 >XX Chapter 13 
(Volume 2)

SHOTBOX Shotbox >Register >Store/Recall Chapter 15 
(Volume 2)

MCRO Macro >Register >XX Chapter 18 
(Volume 2)

Key control block a)

Buttons Menus See

KEY1 • M/E-1, 2, 3 >Key1 >XX 
• PGM/PST >DSK1 >XX

page 352

KEY2 • M/E-1, 2, 3 > Key2 > XX 
• PGM/PST >DSK2 >XX

KEY3 • M/E-1, 2, 3 >Key3 >XX 
• PGM/PST >DSK3 >XX

KEY4 • M/E-1, 2, 3 >Key4 >XX 
• PGM/PST >DSK4 >XX
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a) The menu recalled depends on which of the M/E delegation buttons and key delegation buttons 
are selected in the key control block.

a) The menu recalled depends on which of the M/E-1 to M/E-3 banks and PGM/PST bank the 
numeric control block is delegated to.

b) When other than [MASTR] is selected with the region selection buttons.
c) When [MASTR] is selected with the region selection buttons.
d) When the [SNAPSHOT] button or [EFF] button is set to On, or lit green.

LUM • M/E-1, 2, 3 >Key1, 2, 3, 4 >Type 
• PGM/PST >DSK1, 2, 3, 4 >Type

page 353

LIN

CVK

PTN

CRK • M/E-1, 2, 3 >Key1, 2, 3, 4 >Type >Chroma Adjust 
• PGM/PST >DSK1, 2, 3, 4 >Type >Chroma Adjust

page 356

Key control block a)

Buttons Menus See

Numeric keypad control block

Buttons Menus See

EFF • Effect >Effect 1-99 >XX b) 

• Effect >Master Timeline >Store c)

Chapter 13 
(Volume 2)

SNAPSHOT • Snapshot >Snapshot >XX b) 

• Snapshot >Master Snapshot >Store c)

Chapter 14 
(Volume 2)

SHOTBOX Shotbox >Register >Store/Recall Chapter 15 
(Volume 2)

MCRO Macro >Register >XX Chapter 18 
(Volume 2)

TRANS RATE a) Misc >Transition page 327

STORE RCALL Key Frame >Region Select d) Chapter 13 
Chapter 14 
(Volume 2)

Downstream key control block a)

Buttons Menus See

DSK1 • M/E-1, 2, 3 >Key1 >XX 
• PGM/PST >DSK1 >XX

page 352

DSK2 • M/E-1, 2, 3 >Key2 >XX 
• PGM/PST >DSK2 >XX

DSK3 • M/E-1, 2, 3 >Key3 >XX 
• PGM/PST >DSK3 >XX

DSK4 • M/E-1, 2, 3 >Key4 >XX 
• PGM/PST >DSK4 >XX
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a) The menu recalled depends on which of keyers 1 to 4 the downstream key control block is 
delegated to.

b) Recalling is possible only when the [K-SS] button is On.

a) When the three-dimensional transformation operation mode is enabled.
b) When the [MENU] button is Off.
c) When the [MENU] button is On.

WIPE • M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select

page 416

DME • M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >DME Wipe 
Adjust >Pattern Select

page 438

K-SS STORE b) Snapshot >Key Snapshot >XX Chapter 14 
(Volume 2)

Downstream key control block a)

Buttons Menus See

Auxiliary bus control block

Buttons Menus See

FMS1, FMS2 Frame Memory >Still >Freeze/Store page 454

FM1 to 8 signals assigned 
buttons

Frame Memory >Still >Recall page 457

Color Bkgd1 signal assigned 
button

Color Bkgd >Color Bkgd1 page 482

Color Bkgd2 signal assigned 
button

Color Bkgd >Color Bkgd2

CCR1 signal assigned button CCR >CCR1 >XX Chapter 19 
(Volume 2)

CCR2 signal assigned button CCR >CCR2 >XX

Device control block (trackball or joystick)

Buttons Menus See

DME1 to DME8 a) DME >XX Chapter 11 
(Volume 2)

DEV1 to DEV12 assigned 
buttons

• Device >DDR/VTR >Cueup & Play b) 
• Device >DDR/VTR >Timeline c)

Chapter 12 
(Volume 2)
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a) When the [TIMELINE] button is Off.
b) When the [TIMELINE] button is On.

a) When a key other than DSK1 or DSK2 is assigned, the menu for the corresponding key appears.

a) When the button is assigned to macro function in the Setup menu.

Device control block (search dial)

Buttons Menus See

DEV1 to DEV12 • Device >DDR/VTR >Cueup & Play a) 
• Device >DDR/VTR >Timeline b)

Chapter 12 
(Volume 2)

Downstream key/fade-to-black control block

Buttons Menus See

DSK1, DSK2 • PGM/PST >DSK1, 2 >XX a) Chapter 16 
(Volume 2)

Transition control block and Flexi Pad control block (simple type)

Buttons Menus See

KEY1 (DSK1) • M/E-1, 2, 3 >Key1 >XX 
• PGM/PST >DSK1 >XX

page 352

KEY2 (DSK2) • M/E-1, 2, 3 >Key2 >XX 
• PGM/PST >DSK2 >XX

WIPE • M/E-1, 2, 3 >Wipe >Main Pattern 
• PGM/PST >Wipe >Main Pattern

page 398

DME • M/E-1, 2, 3 >DME Wipe >XX
• PGM/PST >DME Wipe >XX

page 426

SNAPSHOT Snapshot >Snapshot >XX Chapter 14 
(Volume 2)

MCRO a) Macro >Register >XX Chapter 18 
(Volume 2)
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Accessing a Menu

To display, for example, the M/E-1 >Key1 
>Type menu, use either of the following 
operations.
• Press the top menu selection button [M/E 

1], then press the VF1 ‘Key1’ button and 
the HF1 ‘Type’ button in that order.

• Press the menu page number button in the 
upper left corner of the menu screen to 

display the top menu window, then enter 
the page number of the M/E-1 >Key1 
>Type menu, which is 1111, and press 
the [Enter] button.

For details of the menu page numbers, see 
the appendix “Menu Tree” (Volume 2).

The M/E-1 >Key1 >Type menu appears in 
the menu display as follows.

M/E-1 >Key1 >Type menu

2 Menu page number button

1 Menu title button

6 Function button area

7 Parameter group button

8 Knob 
parameter 
buttons3 VF buttons

4 HF buttons

9 Previous page button

5 Status area

0 Keyframe status

qa Default recall button
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Interpreting the Menu 
Screen

The menu screen consists of the following 
principal parts.
When buttons on the screen are lit or 
represented in a depressed state, this 
indicates that the corresponding item or 
function is selected (set on).

a Menu title button
This shows the title of the menu screen.

b Menu page number button
This shows the menu screen page number. 
When you press this button, the top menu 
window (see page 308) appears. You can 
enter the page number for the desired menu, 
or press one of the top menu selection 
buttons in the window, to display that 
menu.
While the system is accessing the hard disk, 
the indicator lights red.

Note
When the indicator is lit, do not power off 
the switcher, or disconnect the IEEE1394 
cable 1).

1) When an external hard disk drive is connected

c VF buttons
These indicate the larger subdivisions of 
this menu.
Depending on the selected item, the menu 
screen contents including the HF button 
indications change.

d HF buttons
These indicate the items within the menu.

Depending on the selected item, the menu 
indications change.
Depending on the function, if any one is on, 
the status is shown by an orange bar, as in 
the following figure.

e Status area
This shows the status of the settings items 
controlled by the selected menu.

f Function button area
This shows the functions which can be 
operated in the currently selected menu by 
means of buttons.
Each function button corresponds to a 
function which can be set in the currently 
selected menu. Press it to enable the 
function, to display a parameter group and 
adjust the parameters with the knobs, or to 
execute the function.
These buttons are in groups by function. In 
the screen example shown on the previous 
page, the [Key Bus] and [Matte] function 
buttons constitute the <Key Fill> group.

g Parameter group button
This displays parameter group names for 
which the knobs can make adjustments, the 
current parameter setting page number, and 
the total number of the parameter setting 
pages. (Example: Color Vector 1/2)
When there are more than five parameters 
within the same parameter group, press this 
button to display the sixth and subsequent 
parameters, which can then be controlled 
by the knobs.

h Knob parameter buttons
These show the parameters currently 
controlled by the knobs and their values. 
Pressing one of these buttons displays the 

Indicator
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numeric keypad window (see page 306), 
and you can then enter a new value for the 
corresponding parameter with the numeric 
keypad.

i Previous page button
This shows the page number of the 
previously displayed menu screen. Press it 
to go back to that page. When the indication 
[Parent] appears, this displays the parent 
directory.

j Keyframe status
This shows the keyframe status of the 
reference region. Pressing this button 
switches the menu screen as follows.
When a menu other than the Key Frame 

menu is currently shown: The menu 
screen switches to the Key Frame 
menu.

When the Key Frame menu is currently 
shown: The menu screen switches to 
the menu that was on the screen 
immediately before the Key Frame 
menu.

In some parts of menus such as the File 
menu, this functions as a “Region selection 
area,” for selecting the region to which 
operations apply.

k Default recall button
This only appears in those menus for which 
the default recall function is available. (See 
“Menus allowing a return to default 
settings” (page 301).)
Press this button, turning it on, then press a 
VF button or knob parameter button to 
return the settings to their default values, in 
the following groupings.
• Function grouping: the functions within 

an HF menu under the VF button
• Knob parameters (parameters currently 

controlled by the knobs)

Menu Operations

Selecting an item
Use the following procedure.

1 Press the VF button (1 to 7) for the 
desired group of items.

The HF button (1 to 7) indications 
change to show the items within the 
selected group.

2 Press the HF button for the desired 
item.

The indications in the status area and 
function button area change, and you 
can now make various changes to the 
selected item.

Selecting a function
Press the appropriate function button within 
the function button area.

Shape and color of the button
Pressing the button turns it on, and it lights, 
showing the state.

Lit pale blue: The function is enabled, 
and the parameters can currently 
be adjusted with the knobs.

Lit orange: The function is enabled.
Lit purple: Execution button. Pressing 

the button immediately executes 
the function. (Example: [Auto 
Start] button in the Chroma Adjust 
menu)
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Pressing a button of this type displays a 
further menu, allowing more detailed 
settings. (Example: [Chroma Adjust] 
button in the Type menu)

Setting parameters

This marking on a function button indicates 
that there are parameters which can be 
adjusted with the knobs.
Pressing this function button assigns 
parameters to the knobs.
You can set the parameter values by either 
of the following methods.
• Turn the knob (1 to 5) corresponding to 

the parameter, to adjust the value.
• Press the knob parameter buttons (1 to 5) 

corresponding to the parameter. This 
displays the numeric keypad window 
allowing you to enter the desired value.

In the description of specific setting 
procedures, the knob adjustment is 
described, as follows.

Example: When wipe pattern key is selected

When the [MENU] button in the device 
control block is lit, you can use the trackball 
and Z-ring to control the parameters.
• Move the trackball on the x-axis to 

control the parameter for knob 1 or on the 
y-axis to control the parameter for knob 
2. Moving up or to the right increases the 
parameter value, and moving down or to 
the left decreases the parameter value.

• Use the Z-ring to adjust the parameter for 
knob 3. Turning clockwise increases the 
parameter value, and turning 
counterclockwise decreases the 
parameter value.

Going back to the previous menu
To return to the last displayed menu, press 
the previous page button.

Returning to default state in function 
groupings
Use the following procedure.

1 Press the [Default Recall] button, 
turning it on.

This enters the menu default recall 
mode.

2 Press the VF button you want to return 
to the default state.

This returns the settings within the 
function grouping to the default state, 
and the [Default Recall] button goes 
off.

Knob Parameter Adjust-ment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

3 Density Key density 0.00 to 100.00
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Note
The default state of the settings depends on 
the setting of the initial status mode, set in 
the Setup menu of system setup, as follows.
User: The state when [Initial Status Define] 

is executed.
Factory: Factory default settings

Returning knob parameters to 
default state
Use the following procedure.

1 Press the [Default Recall] button, 
turning it on.

This enters the menu default recall 
mode.

2 Press the knob parameter button you 
want to return to the default state.

This returns the knob parameter value 
to the default state, and the [Default 
Recall] button goes off.

Notes
• In the following table, “Menus allowing a 

return to default settings,” the default 
recall function does not apply to some 
knob parameters. For details, see the 
table, “Knob parameters subject to 
restriction on default recall” on page 305.

• The default recall function does not 
return the horizontal (H) and vertical (V) 
position settings to their default state 
individually. Returning the horizontal 
(H) position to its default state also 
returns the vertical (V) position to its 
default state automatically, and vice 
versa. For details, see the table, “Knob 
parameters subject to restriction on 
default recall” on page 305.

Menus allowing a return to default settings

Top menu selection button 
name

VF number 
(HF number)

Menu number Menu name

M/E1 VF1 1110-series Key1 a)

VF2 1120-series Key2 a)

VF3 1130-series Key3 a)

VF4 1140-series Key4 a)

VF5 1150-series Wipe a)

VF6 1160-series DME Wipe a)

VF7 1170-series Misc a)

M/E2 VF1 1210-series Key1 a)

VF2 1220-series Key2 a)

VF3 1230-series Key3 a)

VF4 1240-series Key4 a)

VF5 1250-series Wipe a)

VF6 1260-series DME Wipe a)

VF7 1270-series Misc a)
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M/E3 VF1 1310-series Key1 a)

VF2 1320-series Key2 a)

VF3 1330-series Key3 a)

VF4 1340-series Key4 a)

VF5 1350-series Wipe a)

VF6 1360-series DME Wipe a)

VF7 1370-series Misc a)

P/P VF1 1410-series DSK1 a)

VF2 1420-series DSK2 a)

VF3 1430-series DSK3 a)

VF4 1440-series DSK4 a)

VF5 1450-series Wipe a)

VF6 1460-series DME Wipe a)

VF7 1470-series Misc a)

COLOR BKGD VF1 2210 Color Bkgd 1 a)

VF2 2220 Color Bkgd 2 a)

CCR VF1 2410-series CCR1 a)

VF2 2420-series CCR2 a)

FRAME MEM VF1 2110-series Recall b)

VF2 2120-series Edit b)

VF3 2130-series Reposition/Lock b)

VF4 2140-series File b)

VF5 2150-series Animation b)

AUX/MON VF1 2311 Aux Bus b)

Top menu selection button 
name

VF number 
(HF number)

Menu number Menu name
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a) Menu to return to the default settings for particular functions or for particular knob parameters 
(for the relevant knob parameters, see page 304)

b) Menu to return to the default settings for particular knob parameters (for the relevant knob 
parameters, see page 304)

DME VF1 4110-series Edge b)

VF2 4120-series Video Modify b)

VF3 4131 Freeze b)

VF4 4141 Non-Linear b)

VF5 4150-series Light/Trail b)

VF6 4160-series Input/Output b)

VF7 4170-series Enhanced Video 
Modify b)

GLB EFF VF1 4210-series Ch1–Ch4 b)

VF2 4220-series Ch5–Ch8 b)

KEY FRAME (HF3) 6113 Path b)

Top menu selection button 
name

VF number 
(HF number)

Menu number Menu name
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Knob parameters to which default recall does not apply

Menu number a) Menu name Button name Knob Parameter

1111 Type [Luminance] and [Linear] in 
<Key Type> group

4 Filter

[Color Vector] in <Key Type> 
group

1
2
(Parameter 
group [2/2])

Y Filter, 
C Filter

1111.1 Type >CRK Adjust [Key Active] 5 Filter

[Color Cancel] in <Color 
Cancel> group

5 Filter

1112.1 Edge >Matte [Mix Color] in <Edge Matte> 
group

5 Pattern

[Multi] 3 Invert Type

1113 Main Mask [Pattern] 5 Pattern

[Multi] 3 Invert Type

1116 Transition [Wipe] in <ON Transition Type> 
group

1

5 

Transition 
Rate
Pattern

[Wipe] in <OFF Transition Type> 
group

1

5 

Transition 
Rate
Pattern

[Key Blink] and [Edge Blink] in 
<Blink> group

1 Blink Rate

[Mix] in <Transition Type> group 1 Transition 
Type

[Wipe] in <Transition Type> 
group

1

5 

Transition 
Rate
Pattern

1116.1 Transition >
Wipe Adjust

[Multi] 3 Invert Type

[H] and [V] in <Pairing> group 1 Width

[H], [V], and [Fringe] in 
<Modulation> group

4 Shape

1154 Edge/Direction [Split] in <Edge> group 1 Split No

1154.1 Edge/Direction >
Matte Adjust

[Mix Color] in <Edge Matte> 
group

3 Pattern

[Multi] 3 Invert Type

1155 Main Modify [H] and [V] in <Pairing> group 1 Width

[H], [V], and [Fringe] in 
<Modulation> group

4 Shape

1164 Edge/Direction [Independent Trans Rate] in 
<Pattern Limit Release> group

1 Transition 
Rate
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a) The menu numbers shown by way of example are those for M/E-1: the same applies for M/E-2, 
M/E-3, and P/P. Also, content applying to Key1 applies equally to Key2, Key3, and Key4.

1171 Transition [Mix], [Nam], [Super Mix], 
[Preset Color Mix], [Wipe], [DME 
Wipe], and [FTB] in <Transition 
Type> group

1 Transition 
Rate

Knob parameters to which default recall does not apply

Menu number a) Menu name Button name Knob Parameter

Knob parameters subject to restriction on default recall

Menu number Menu name Button name Knob Parameter

1111.1 a) Type >CRK Adjust [Sample Mark] in the <Auto> group 1
2

Position H
Position V

1112.1 a) Edge >Matte 
Adjust

[Position]

1113 a) Main Mask [Position]

1116.1 a) Transition >Wipe 
Adjust

[Position]

1116.3 a) Transition >DME 
Wipe Adjust

[Position] 1
2

H
V

1154.1 a) Edge Direction 
>Matte Adjust

[Position] 1
2

Position H
Position V

1155 a) Main Modify [Position] in the <Position> group

1155.1 a) Main Modify 
>Multi Adjust

[Position]

1156 a) Sub Modify [Position] in the <Position> group

1156.1 a) Sub Modify >Multi 
Adjust

[Position]

2122.2 Composite 
>Pattern Adjust

[Position] 1
2

Position H
Position V

2131 Reposition [Normal]

[Black&White]

2210 Color Bkgd1 b) [Position]

2412.1 c) Primary CCR 
>Mask1 Adjust d)

[Position]

4116 DME >Edge 
>Wipe Crop

[Position/Size] 5 Pattern

4127 DME >Video 
Modify >Mask

[Position/Size]
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a) The menu numbers shown by way of example are those for M/E-1: the same applies to M/E-2, 
M/E-3, and P/P. Equally, content applying to Key1 applies equally to Key2, Key3, and Key4.

b) The same applies to Color Bkgd2.
c) The menu numbers shown by way of example are those for CCR1: the same applies to CCR2.
d) The sample applies to Mask2 Adjust.

Numeric keypad window

a Item display
This is the name of the parameter being set 
in the numeric keypad window.

b Max./min. (maximum/minimum) 
value indication

This shows the maximum and minimum 
settings of the parameter.

c Input value
This is the value being input into the 
numeric keypad window.

d Close button
This closes the numeric keypad window.

e TC (timecode) button
When the numeric keypad window is 
opened for a setting requiring a timecode 
value to be entered, this button appears in a 
depressed state.
You can enter a timecode value in the range 
that depends on the signal format (see page 
177) as follows:

00:00:00:00 to 23:59:59:nn,
where nn = (number of frames per 
second) – 1.

f  – (minus) button
This toggles the sign of the entered value. 
When it is pressed, the value is negative.

g Clear button
This clears the input. It does not change the 
parameter setting.

h Trim button
After entering the difference from the 
current value, press this button to confirm 
the numeric input.

i Enter button
This confirms the entered value.
If correctly set, the numeric keypad 
window closes.
If not correctly set, the input display 
changes color.

1 Item display

2 Max./min. value indication

3 Input value

4 Close button

5 TC (timecode) 
button

6 – (minus) 
button

7 Clear button

8 Trim button

9 Enter button
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Keyboard window

Note
Except when changing source names, the 
following characters cannot be used. The 
same applies to macro file editing.

space, \, /, :, ;, , (comma), . (dot), <, >, 
*, ?, ", |

a Item display
This is the name of the parameter being set 
in the keyboard window.

b Input string
This is the character string being input in 
the keyboard window.

c Close button
This closes the keyboard window.

d BS button
This clears the character immediately 
before the cursor in the input string.

e Caps Lock button
This enables input of capital letters only.

Note
You can enter items to be displayed on the 
control panel LCD using lowercase letters, 
but these will be converted to capitals for 
display.

1 Item display 2 Input string

4 BS button

3 Close button

0 Left button

6 Shift button

5 Caps Lock button

7 Space button

8 Clear button

9 Del button

qa Right button

qs Enter button

qd Line feed
button
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MS-DOS does not distinguish case in 
filenames, and therefore you are 
recommended to enter filenames in capital 
letters.

f Shift button
This selects the characters on the shift side 
of the keys. The shift is released when you 
enter a character.

g Space button
This enters a space character.

h Clear button
This clears all of the characters in the input 
string.

i Del button
This clears the character immediately after 
the cursor in the input string.

j Left button
This moves the cursor one character to the 
left in the input string.

k Right button
This moves the cursor one character to the 
right in the input string.

l Enter button
This sets the input string as a parameter 
value, and closes the keyboard window if 
the value has been entered correctly. If the 
value has not been entered correctly, the 
display color changes.

m Line feed button
After pressing the Shift button, press this 
button to feed a line. The input string shows 
“|”.

Function of the top menu window

1 Top menu selection buttons

2 Input display

3 Numeric entry section

6 Close button

4 Clear button

5 Enter button

7 Shut down button
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a Top menu selection buttons
These are the same as the top menu 
selection buttons in the menu control block. 
Pressing one of these buttons closes the top 
menu window and displays the selected 
menu in the menu display.

b Input display
This shows the page number entered with 
the numeric entry section.

c Numeric entry section
Enter a page number.

d Clear button
Press this to clear the input display.

e Enter button
Pressing this button without entering a page 
number closes the top menu window with 
the current menu remaining in the menu 
display.
If you enter a page number then press this 
button, this confirms the value in the input 
display. If it is a correct page number, the 
top menu window closes, and the menu 
display shows the new menu. If it is not 
correctly set, the input display changes 
color.

f Close button
Press this to close the top menu window.

g Shut down button
Shuts down the menus.

Note 
Be sure to shut down the menus before 
powering off the control panel.

Shutting down the menus
Use the following procedure.

1 In the menu screen, press the menu 
page number button to open the top 
menu window.

For details of the top menu window, see  
“Function of the top menu window” 
(page 308).

2 Press [Shut down].

A confirmation message appears.

3 Press [Yes].

This shuts down the menu system after 
a while, and the menu display changes 
to black. Now power off the system.

To restart menu operations
Power on the control panel once more.

Use of the color palette window
When a parameter is assigned to the knobs 
as a combination of luminance, saturation, 
and hue, pressing a knob parameter button 
displays a color palette window.
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a Color palette buttons

Press one of these to enter the 
corresponding color in the display.
By default the following settings are 
available.
First row: white, yellow, cyan, green
Second row: magenta, red, blue, black
Third row: all black

b Operation buttons
Set: If you press any color palette button 

with this button held down, the color 
shown in the color display is assigned 
to the color palette button.

Copy: If you press a color palette button 
with this button held down, the color is 
used as the source for copying. Next 
press a different color palette button to 
copy to that button.

Swap: If you press two color palette 
buttons in sequence with this button 
held down, the two colors are swapped.

Default: If you press any color palette 
button with this button held down, the 
color palette button is set to the default 
color.

c Color display
This shows the setting color, and the 
parameters (LUM, SAT, and HUE).
By adjusting the parameters with the knobs, 
you can create any color.
If a parameter value is outside the permitted 
range for RGB (0 to 255), the indication 
“Illegal Color” appears, and this is adjusted 
to a value in range.
Cancel: Pressing this button returns to the 

state when the color palette window 
was opened.

d Numeric keypad
Use this to enter numeric values for 
parameters.

For details of use, see page 306.

1Color palette 
buttons

3Color display

4Numeric 
keypad

2Operation 
buttons
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Basic Operating Procedure

The positions of the principal buttons used for basic transition operation are as 
follows.

Transition control block (for standard transitions)

For basic transition operations, use the following procedure.

1 In the cross-point control block, select the background video with the 
background A row of cross-point buttons.

2 Select the way in which the transition will affect the image, using the next 
transition selection buttons in the transition control block.

For an overview, see “Selecting the Next Transition” (page 30).

To change the background: Press the [BKGD] button, turning it on.
To insert or delete a key: Press one of the [KEY1] to [KEY4] buttons (or 

[DSK1] to [DSK4] buttons in the PGM/PST bank), turning it on.
To enable the key priority setting, which determines the key overlay 

order after the transition: Press the [KEY PRIOR] button, turning it 
on.

You can press more than one button at the same time.
To change the keys and background presets in Setup menus 

simultaneously: Press the [ALL] button.

To allocate a particular next transition button to the [ALL] button 
function, see “Operation Settings (Operation Menu)” in Chapter 16 
(Volume 2).
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3 For the transition to change the key priority, set the priority for after the 

transition.

For details of the key priority, see “Selecting the key priority” (page 32).
For details of the key priority setting operation, see “Key Priority Setting” 
(page 315).

4 Select the new video used for the transition.

• In the background B row of cross-point buttons, select the new 
background video.

• When inserting a key, select the key signal, and make any required 
settings.

For details of key settings, see Chapter 4 “Keys” (page 351).

To carry out a cut transition, skip to step 7; otherwise continue to step 5.

5 Select one of the transition type selection buttons in the transition control 
block.

To carry out a dissolve to the new video: Press one of the [MIX], 
[NAM], [SUPER MIX], and [PST COLOR MIX] buttons, turning it 
on.

To carry out a wipe: Press the [WIPE] or [DME] button, turning it on.

You can also use the Misc  >Transition menu to select a desired transition 
type for the M/E or PGM/PST bank. (See “Selecting the Transition Type 
by a Menu Operation” (page 320).)

For an overview of the transition types, see “Transition Types” (page 37).

6 Make the required settings, according to the selected transition type.

For details of the settings, see the relevant section.
Super mix: “Super Mix Settings” (page 321)
Preset color mix: “Color Matte Settings” (page 322)
Wipe: “Basic Procedure for Wipe Settings” (page 398)
DME Wipe: “Basic Procedure for DME Wipe Settings” (page 426)
Using the transition preview function (page 335), you can check the 
transition on the preview monitor.

7 Carry out the transition in the transition execution section.

For a gradual transition such as a mix (dissolve) or wipe: Press the 
[AUTO TRANS] button, or operate the fader lever.
To execute a transition by pressing the [AUTO TRANS] button, first 
set the transition rate (specified as the duration of the transition).
 (See “Setting the Transition Rate” (page 324).)
313Basic Operating Procedure



314

   C
hapter 3 

Transitions
When you have selected a wipe or DME wipe as the transition type, 
you can also set the transition range. (See “Pattern Limit” (page 327).)

For an instantaneous transition: Press the [CUT] button.

For details, see “Executing a Transition” (page 323).
Basic Operating Procedure
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Key Priority Setting

You can select the key priority, that is, the order in which the keys are laid over 
each other, in the current video and after the transition. There are two ways of 
setting the priority: either using the [PRIOR SET] button in the transition 
control block, or using the Misc menu to access the Key Priority menu for the 
M/E or PGM/PST bank.

Setting the Key Priority in the Transition Control Block

The positions of the buttons used for the operation are as follows.

Transition control block (standard type)

Changing the currently inserted key priority
Use the following procedure.

1 If the next transition selection button [KEY PRIOR] is on, press another 
next transition selection button to turn the [KEY PRIOR] button off.

(When the [KEY PRIOR] button is on, the transition control block 
switches to the mode for changing the key priority for after the transition.)

2 Holding down the [PRIOR SET] button, press the one of the next transition 
selection buttons [KEY1] to [KEY4] ([DSK1] to [DSK4] buttons in the 
PGM/PST bank) for the key to appear on top.
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The selected key now appears on top, on the program monitor.
The priority of keys other than the selected one does not change.

To change the priority of more than one key, repeat this operation as 
required.

Changing the key priority for after the transition
When executing a transition, turning on the next transition selection button 
[KEY PRIOR] causes the keys to be rearranged based on the set priority.
To set the key priority for after the transition, use the following procedure.

1 In the transition control block, hold down the [PRIOR SET] button and 
press the [KEY PRIOR] button to turn it on. Do not release the [PRIOR 
SET] button before advancing to step 2.

The [KEY PRIOR] button lights green, and it becomes possible to change 
the key priority setting for after the transition.

2 Hold down the [PRIOR SET] button, and press the one of the next 
transition selection buttons [KEY1] to [KEY4] ([DSK1] to [DSK4] 
buttons in the PGM/PST bank) for the key you want to bring to the front 
after the transition.

To set the priority to be the same as before the transition, press the [BKGD] 
button.

Note
The [BKGD] button is only effective when in the mode for changing the 
key priority for after the transition. 

When the next transition selection button [KEY PRIOR] is on, the selected 
key appears on top on the preview monitor. The priority of keys other than 
the selected one does not change.

3 To change the priority of more than one key, repeat the previous operation 
as required.

Key 1 selected.

Key priority: 3, 1, 4, 2 Key priority: 1, 3, 4, 2
Key Priority Setting
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4 Execute the transition.

The keys are rearranged based on the set priority.

Setting the Key Priority by a Menu Operation

Changing the priority of the currently inserted keys
Use the following procedure.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF3 ‘Key 
Priority.’

The Key Priority menu appears.

2 For each of <Priority1>, <Priority2>, <Priority3>, and <Priority4>, select 
a key, to determine the key priority sequence.

The keys are inserted in the key priority sequence with priority 1 at the 
front.

Note
It is not possible to select the same key for two or more priority numbers.

The keys appear in the set order on the program monitor.

Changing the key priority for after the transition
Use the following procedure.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF4 ‘Next 
Key Priority.’

1
2

3
4

Priority 1

Priority 2

Priority 3

Priority 4
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The Next Key Priority menu appears.

2 For each of <Priority1>, <Priority2>, <Priority3>, and <Priority4>, select 
a key, to determine the key priority sequence.

For details of the key priority sequence, see the figure shown for step 2 in 
the previous item (see page 317).

The keys appear in the set order on the preview monitor.

3 Execute the transition.

The keys are rearranged in the set order on the program monitor.

Display of the Key Output Status and Key Priority

You can check whether keys are currently output, and the key priority setting, 
using the key status display in the transition control block of the M/E or PGM/
PST bank.
The display is above the next transition selection buttons [KEY1] to [KEY4] 
([DSK1] to [DSK4] buttons in the PGM/PST bank).

Display of the key output status
When a key is included in the output from the M/E or PGM/PST bank, the 
corresponding ON indicator lights.

Key priority display
The key priority is indicated by numerals 1 to 4 lighting.
The topmost key as seen on the program monitor is priority 1, and the keys 
underneath are numbered 2, 3, 4 away from the viewer (see page 317).
To display the key priority for after the transition, press the [KEY PRIOR] 
button in the transition control block, turning it on. For keys for which the 
priority after the transition is different from the current priority, the 
corresponding numerals 1 to 4 flash. For a key with the same priority, the 
indication remains on.

Example key status display given when the [KEY PRIOR] button is pressed:
Current key priority: 1, 2, 3, 4
Key priority after the transition: 3, 2, 1, 4
Indicators: 1, 3 (flashing), 2, 1 (flashing), 3, 4
Key Priority Setting
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Example key status display (showing the key priority after the transition)
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Selecting the Transition Type by a Menu 
Operation

You can also select the required transition type by a menu operation.
Use the following procedure.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select the required transition type in the <Transition Type> group.

The parameter settings can now be adjusted with the knobs according to 
the selected transition type.

For details, see the following.
• “Super Mix Settings” (page 321)
• “Color Matte Settings” (page 322)
• “Setting the Transition Rate” (page 324)

Note
When multi-program mode is selected in the Setup menu (see “Settings for 
Switcher Configuration (Config Menu)” in Chapter 16 (Volume 2)), there 
may be cases in which two or more transition types have been selected.
Selecting the Transition Type by a Menu Operation
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Super Mix Settings

To make the super mix settings, use the following procedure.

For an overview of the super mix, see page 38.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select [Super Mix] in the <Transition Type> group.

3 Turn the knobs to adjust the output levels.

Knob Parameter Adjustment Setting values

2 A Gain Background A output level 0.00 to 100.00% 

3 B Gain Background B output level 0.00 to 100.00% 
321Super Mix Settings
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Color Matte Settings

To set the color matte of a preset color mix, use the following procedure.

For an overview of the preset color mix, see page 38.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select [Preset Color Mix] in the <Transition Type> group.

3 Turn the knobs to adjust the color matte parameters.

Knob Parameter Adjustment Setting values

2 Luminance Luminance 0.00 to 100.00

3 Saturation Saturation 0.00 to 100.00

4 Hue Hue 359.99 to 0.00
Color Matte Settings
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Executing a Transition

There are two ways of executing a transition: as an auto transition by a button 
operation, and as a manual transition using the fader lever. You can also use a 
combination of these two modes.

For an overview of the auto transitions and manual transitions, see “Executing 
a Transition” (page 40).

Transition Indicator Function

In each of the M/E banks and PGM/PST bank, to the left of the fader lever is a 
transition indicator composed of multiple LEDs. This indicator shows the state 
of the transition, whether auto or manual, by which LEDs are lit.

Transition indicator

For example, in the previous illustration, it can be seen that the transition is 
more than half completed.
When the transition is completed, all of the LEDs go off.

Lit
323Executing a Transition
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Setting the Transition Rate

There are two ways of setting the transition rate: using the Flexi Pad control 
block or numeric keypad control block to enter a numeric value, or using the 
Misc menu to access the Transition menu for the M/E or PGM/PST bank.
You can also display the transition rate, independent key transition rate, and 
fade-to-black transition rate for each of the M/E and PGM/PST banks, and 
change the settings. (See “Displaying a List of Transition Rates and Changing 
the Settings” (page 497).)

Frame input mode and timecode input mode
For numeric input of the transition rate value, there are two modes: frame input 
mode and timecode input mode. You select one of these modes using either the 
Flexi Pad control block (page 325) or the numeric keypad control block (page 
326).
Frame input mode: The entered value is a number of frames.

Example: Entering 123 constitutes an entry of 123 frames
Timecode input mode: The entered value is a timecode value.

Example: Entering 123 constitutes an entry of 1 second 23 frames.

Note
Whereas you can enter a value of up to 999 in frame input mode, a value not 
smaller than 10 seconds cannot be entered in timecode input mode.

Frame display mode and timecode display mode
For the transition rate display in the transition control block, there are two 
modes: frame display mode and timecode display mode. You can select one of 
these modes in setup. (See “Operation Settings” in Chapter 16 (Volume 2).)

Note
The setting is common to all banks of the switcher.

Frame display mode: Values are shown as from 0 to 999 frames. In this 
display mode, a value entered in timecode input mode is converted for 
display as a number of frames.

Timecode display mode: Values are shown as timecode values, consisting of 
seconds and frames. In this display mode, a value entered in frame input 
mode is converted for display as a timecode value. If the value consists of 
four or more digits, the last digit is not shown.
Example: A value of 9 seconds 23 frames appears as “9.23” and a value 

of 10 seconds 1 frame appears as “10.0.”
Executing a Transition
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Setting the transition rate in the Flexi Pad control block

Note
In the PGM/PST bank or when using a simple-type transition control block, 
you cannot use the Flexi Pad control block to set the transition rate.

Use the following procedure.

1 In the M/E bank Flexi Pad control block, press the [TRANS RATE] 
button.

The memory recall section display is now ready to accept the entered 
transition rate.

Flexi Pad control block (standard type)

2 Enter the desired transition rate with the numeric keypad. 
If required, press the [TC] button to toggle the input mode (frame input or 
timecode input).

• Enter a value of up to three digits.
• To cancel the entry, press any of the six buttons in the leftmost column 

([WIPE], [DME], ...) or the [TRANS RATE] button.

3 Press the [ENTR] button.

This confirms the entry, and the new setting appears in the transition 
control block display.
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Setting the transition rate in the numeric keypad control block

Numeric keypad control block

Use the following procedure.

1 In the numeric keypad control block, press the [TRANS RATE] button.

2 Press the region selection button for the M/E or PGM/PST bank for which 
you want to set the transition rate, turning it on.

The numeric keypad control block display now shows the selected region 
name and the current transition rate setting for the region.

3 With the numeric keypad, enter the transition rate.
If required, press the [TC] button to toggle the input mode (frame input or 
timecode input).

• Enter a value of up to three digits.
• To clear the entry, press the [CLR] button.

4 Press the [ENTER] button.

This confirms the entry, and the selected region name and the set transition 
rate appear in the numeric keypad control block display.
The transition control block display of the same bank (M/E or PGM/PST) 
also shows the setting.
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To enter a difference from the current value
After pressing the [+/–] button, enter the difference and press the [TRIM] 
button.
To change the sign (+ or –), press the [+/–] button.

Setting the transition rate by a menu operation
Use the following procedure.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select any transition type in the <Transition Type> group.

3 Turn the knob to set the transition rate.

Displaying the transition rates in a menu and changing the 
settings

For each of the M/E and PGM/PST banks, you can display the transition rate, 
independent key transition rate and fade-to-black transition rate, and change 
the settings.

For more details, see “Displaying a List of Transition Rates and Changing the 
Settings” (page 497).

Pattern Limit

There are two ways of setting a pattern limit: either by operating the fader lever 
to save the fader position, or by using the Wipe menu or DME Wipe menu to 
access the Edge/Direction menu for the M/E or PGM/PST bank.

For an overview of the pattern limits, see page 42.

Notes
• A pattern limit only applies when a wipe or DME wipe is selected as the 

transition type.
• A pattern limit cannot be applied to an independent key transition (see page 

337).

Knob Parameter Adjustment Setting values

1 Transition Rate Transition Rate 0 to 999 (frame count)
327Executing a Transition
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Transition control block (standard type)

Setting the pattern limit with the fader lever
Use the following procedure.

1 Move the fader lever to the position corresponding to a particular pattern 
size.

• First make sure that the [PTN LIMIT] button is off.
• To check the pattern size on the preview monitor, first press the [TRANS 

PVW] button, to select the transition preview mode (see page 335).

2 Press the [LIMIT SET] button.

This sets the current fader lever position as the pattern limit.

Setting the pattern limit by a menu operation
Use the following procedure.

1 When a wipe is selected as the transition type, in the M/E or PGM/PST 
menu, select first VF5 ‘Wipe,’ then HF4 ‘Edge/Direction.’

When a DME wipe is selected as the transition type, in the M/E or PGM/
PST menu, select first VF6 ‘DME Wipe,’ then HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 Press the [Pattern Limit] button, turning it on.
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3 Turn the knobs to adjust the following parameters.

a)  0.00%: Executing the transition does not change the video output at all.
b) 100.00%: The transition is the same as when no pattern limit is set, but the cross-point 

button selections of the background A and B buses do not interchange when the transition 
completes.

Executing a pattern limit transition
Use the following procedure.

1 Press the [PTN LIMIT] button, turning it on.

The button you pressed lights amber.

2 Carry out the transition.

The transition progresses as far as the set pattern limit. Even if the 
transition completes, the cross-point button assignments of the background 
A and B buses do not interchange.

3 Carry out the transition once again.

The status before the previous transition is restored.

To cancel the pattern limit
To cancel the pattern limit after completion of step 3 in the previous procedure, 
press the [PTN LIMIT] button, turning it off.
If after carrying out step 2 in the previous procedure, the pattern limit has been 
reached, carry out the following procedure.

1 Press the [PTN LIMIT] button.

The button you pressed lights green.

2 Carry out the transition.

The [PTN LIMIT] button goes off, and the pattern limit state is released.
Depending on the way in which the transition was executed, the action will 
be as follows.
• When you press the [CUT] button, the pattern limit is immediately 

released, and the image switches instantaneously.
• When you press the [AUTO TRANS] button, until the state of the next 

transition, the transition is carried out over the duration given by the 
transition rate.

Knob Parameter Adjustment Setting values

1 Pattern Limit Pattern limit 0.00 a) to 100.00% b)
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• When you move the fader lever, the transition is carried out from the 
pattern limit state to the state before the pattern limit transition was 
carried out.
Moving the fader lever even a little synchronizes the fader lever position 
with the transition state, and you can move the fader lever either in the 
forward direction or in the reverse direction.

Depending on the Setup settings, the transition may be executed at the 
instant you press the [PTN LIMIT] button, and the button goes off. In this 
case, execution continues for the time specified by the dedicated transition 
rate in the menu setting, as far as the state of the next transition.

For details of the setting, see “Settings Relating to Keys, Wipes and Frame 
Memory (Key/Wipe/FM Menu)” in Chapter 16 (Volume 2).

To set the transition rate when the pattern limit is released
Use the following procedure.

1 In the <Pattern Limit Release> group of the Edge/Direction menu, select 
one of the following.

Auto Trans Rate: Use the transition rate set in the transition rate control 
block

Independ Trans Rate: Independent transition rate

2 If you selected “Independ Trans Rate” in step 1, adjust the following 
parameter.

Knob Parameter Adjustment Setting values

1 Transition Rate Independent transition rate 0 to 999 (frames)
Executing a Transition



  C
hapter 3 

Transitions
Executing an Auto Transition

Transition control block (standard type)

To execute a transition on the M/E or PGM/PST bank by a button operation, 
use the following procedure in the transition control block.

For an overview of the auto transition, see page 40.

To carry out an instantaneous cut transition: Press the [CUT] button.
To carry out a gradual transition: Press the [AUTO TRANS] button.

This executes the transition at the preset transition rate (see page 324).
While the transition is executing, the [AUTO TRANS] button lights 
amber. When it completes the button goes off.

To complete a partially executed transition instantaneously: Press the 
[CUT] button.
The [AUTO TRANS] button goes off.

Executing a Transition With the Fader Lever (Manual 
Transition)

To execute a manual transition with the transition control block fader lever, use 
the following procedure.

For an overview of the manual transition, see page 41.
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To carry out the transition completely: Move the lever over the full range of 
its travel.

To pause a partly executed transition: Stop moving the fader lever.
To resume a paused transition: Resume moving the fader lever.

Combinations of Auto and Manual Transitions

Using the [AUTO TRANS] button, the [CUT] button, and the fader lever, use 
the following procedures.

Moving the fader lever during an auto transition
During an auto transition started by pressing the [AUTO TRANS] button, 
operating the fader lever immediately enables the fader lever, and the [AUTO 
TRANS] button goes off. Thereafter, the fader lever controls the progress of 
the transition.

Executing an auto transition after partly moving the fader lever
• Press the [CUT] button to instantaneously complete the transition.
• Press the [AUTO TRANS] button to complete the rest of the transition at the 

preset transition rate.
If the transition rate is set to 100 frames, and the fader lever has moved 
through 1/4 of the transition, then the remaining 3/4 of the transition is carried 
out in 100 frames.

Non-Sync State

If the fader lever is in an intermediate position when a transition is completed 
as an auto transition, then the lever position no longer agrees with the transition 
state. This is termed a non-sync state.
In a non-sync state, two lit LEDs indicate the position from which a normal 
transition can be carried out. This is either at one end position or both end 
positions of the fader lever travel.
Moving the fader lever toward the position of the lit LEDs does not carry out a 
transition, but when the fader lever reaches the end position the non-sync state 
is released, and it is now possible to carry out the next transition.
Executing a Transition
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• If the fader lever is moved in the direction away from the lit LEDs, this 
carries out the next transition, over the remaining part of the fader lever 
travel.

• Even in a non-sync state, you can carry out an auto transition by pressing the 
[AUTO TRANS] button. During the auto transition, the indicators show the 
transition progress in the usual way, but when the transition completes, they 
once again indicate the non-sync state.

Fader Lever Operation in Bus Fixed Mode

In the bus fixed mode there is a fixed relationship between the position of the 
fader lever and the signal output on each bus. Depending on the direction of the 
transition, the fader lever must therefore always be moved in a particular 
direction, as shown in the following table. This does not affect an auto 
transition, which is executed regardless of the fader lever direction.

For an overview of the bus fixed mode, see “Flip-flop mode and bus fixed 
mode” (page 41).

Fader lever operating direction in bus fixed mode

Manual transition completed as auto 
transition when moving the fader 
lever upward: Top two LEDs light.

Manual transition completed as 
auto transition when moving the 
fader lever downward: Bottom two 
LEDs light.

Once the fader lever is moved 
to this position, the non-sync 
state ends, and the next 
transition (direction shown by 
the arrow) is possible.

Next transition Transition direction Fader lever movement

Background A t B Downward

B t A Upward
333Executing a Transition



334

   C
hapter 3 

Transitions
• When a transition applies to a combination of more than one of the 
background and keys 1, 2, 3, and 4, then the transition for all of these must 
be in the same direction complying with the above table.

• If as a result of an auto transition, for example, the fader lever position does 
not agree with the signal output, this is a non-sync state (see page 332) and 
LEDs light at both end positions of the fader lever travel. Moving the fader 
lever does not carry out a transition, but when the fader lever reaches the end 
position the non-sync state is released, and it is now possible to carry out the 
next transition. If the fader lever is moved in the direction away from the lit 
LEDs, this carries out the next transition, over the remaining part of the fader 
lever travel. 

Keys 1, 2, 3, and 4 On t Off (deletion) Downward

Off t On (insertion) Upward

Next transition Transition direction Fader lever movement
Executing a Transition
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Transition Preview

Carrying out a transition preview
To carry out a transition preview, use the following procedure.

For an overview of the transition preview, see page 42.

1 In the M/E or PGM/PST bank transition control block, press the [TRANS 
PVW] button.

The [TRANS PVW] button lights green, and the switcher is now in the 
transition preview mode. At this point, the preview output is the same as 
the program output before the [TRANS PVW] button was pressed.

2 Operate the fader lever, or press the [AUTO TRANS] button or [CUT] 
button.

On the preview monitor, you can check the effect of the transition.

To terminate a transition preview
There are three modes for a transition preview. To terminate a transition 
preview, carry out the operation which depends on the mode, and press the 
[TRANS PVW] button, turning it off.
Lock: Toggling the [TRANS PVW] button on and off switches between the 

transition preview mode and the normal mode.
Hold: The preview mode obtains only while the [TRANS PVW] button is held 

down.
One Time: Each time a transition ends, it reverts to the normal mode.
Set the transition preview mode in the following combinations. For details, see 
Chapter 16 “Engineering Setup” (Volume 2).

Notes
• During a transition, whether executed with the [AUTO TRANS] button or 

the fader lever, it is not possible to press the [TRANS PVW] button.
• In bus fixed mode (see page 41), transition previews are not available.

Transition Preview 
mode

Switcher setup
(Transition menu)
<Transition Preview> group

Panel setup
(Operation >Custom Button 
menu)
<Trans Pvw> group

Lock Normal Lock

Hold Normal Hold

One Time One Time –
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• When using the simple-type transition control block (see page 344), 
transition previews are not available.
Transition Preview
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Independent Key Transitions

Independent key transition control block (standard type)

To set independent transitions for the keyers on the M/E or PGM/PST bank, 
use the independent key transition control block.

For an overview of the independent key transitions, see page 33.

Basic Independent Key Transition Operations

In the independent key transition control block, use the following procedure.

1 Select one or more of the delegation buttons [KEY1] to [KEY4] ([DSK1] 
to [DSK4] in the PGM/PST bank), turning them on.

2 Select the transition type.

To fade a key in or out: Press the [MIX] button, turning it on.
To insert or delete a key using a dedicated wipe pattern: Press the 

[WIPE] button, turning it on.
To insert or delete a key using a dedicated DME wipe pattern: Press 

the [DME] button, turning it on.

If, in the Setup menus, you set insertion and deletion as independent 
modes, make the settings for the next transition in the independent key 

KEY1 KEY2 KEY3 KEY4
K-MOD
EMBL K-SS

K-TR
ENBL

K-SS
STOREMIX WIPE DME

KEY1
ON

AUTO
TRANS

KEY2
ON

AUTO
TRANS

KEY3
ON

AUTO
TRANS

KEY4
ON

AUTO
TRANS

Independent key transition type 
selection buttons

Independent key transition
execution section

Key delegation buttons

Key source name display/key 
snapshot buttons
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transition control block.
Separate settings are required both when inserting a key and when deleting 
it. For example, with the key not inserted, if you select the transition type 
and carry out a transition, this will be the setting when inserting a key.
You can also use the Transition menu to select a desired independent key 
transition type for each key (see the next section).

For details of the wipe settings, see “Wipe Settings for Independent Key 
Transitions” (page 416). For details of DME wipe settings, see “DME 
Wipe Settings for Independent Key Transitions” (page 438).

3 Execute the transition.

To insert or delete the key gradually with a mix or wipe transition: 
Press the [AUTO TRANS] button.

For details of the transition rate, see “Setting the Independent Key 
Transition Rate” (page 339).
For details of operation together with a common transition, see 
“Combining other transitions with independent key transitions” (page 
34).

To cut the key in or out instantaneously: Press the [KEY ON] button on 
the keyer.

Note
In an independent key transition, the pattern limit function is not available.

Setting the Independent Key Transition Type by a Menu 
Operation

You can also select the required independent key transition type by a menu 
operation.
Use the following procedure.

1 In the M/E or PGM/PST menu, select first the desired one from VF1 
‘Key1’ to VF4 ‘Key4,’ then HF6 ‘Transition.’

The Transition menu for the selected appears.

2 Select the required transition type in the <Transition Type> group.

If, in the Setup menus, you set insertion/deletion as independent modes, 
make the settings for insertion in the <On Transition Type> group, and the 
settings for deletion in the <Off Transition Type> group.
Independent Key Transitions
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Setting the Independent Key Transition Rate

There are two ways of setting the transition rate: using the Flexi Pad control 
block or numeric keypad control block to enter a numeric value, or using the 
Key menu to access the Transition menu for the M/E or PGM/PST bank.
You can also display the transition rate, independent key transition rate, and 
fade-to-black transition rate for each of the M/E and PGM/PST banks, and 
change the settings. (See “Displaying a List of Transition Rates and Changing 
the Settings” (page 497).)
When the setup selection is for separate transition rates for inserting or deleting 
a key, you can set both rates independently. For example, with the system in 
the state with the key not inserted, the transition rate setting applies to key 
insertion.

Setting the independent key transition rate in the Flexi Pad 
control block

Use the following procedure.

Note
In the PGM/PST bank or when using a simple-type transition control block, 
you cannot use the Flexi Pad control block to set the transition rate.

1 In the Flexi Pad control block of the M/E bank, hold down the [TRANS 
RATE] button, and in the independent key transition control block, press 
the delegation button [KEY1] to [KEY4] for the key for which you want 
to set the transition rate.

The memory recall section display is now ready to accept the entered 
independent key transition rate.

2 Enter the desired transition rate with the numeric keypad.

• Enter a value of up to three digits.
• To cancel the entry, press any of the six buttons in the leftmost column 

([WIPE], [DME], ...) or the [TRANS RATE] button.

For details of frame input mode and timecode input mode, see page 324.

3 Press the [ENTR] button.

Setting the independent key transition rate in the numeric 
keypad control block

Use the following procedure.
339Independent Key Transitions
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Note
You cannot use the numeric keypad control block to set the transition rate for 
a simple transition.

1 In the numeric keypad control block, hold down the [TRANS RATE] 
button, and in the independent key transition control block, press the 
delegation button [KEY1] to [KEY4] ([DSK1] to [DSK4] in the PGM/PST 
bank) for the key for which you want to set the transition rate.

The numeric keypad control block changes to the mode for inputting the 
independent key transition rate, and its display now shows the 
corresponding region name and the current transition rate set for the 
region.

2 With the numeric keypad, enter the transition rate.

• Enter a value of up to three digits.
• To clear the entry value, press the [CLR] button.

For details of frame input mode and timecode input mode, see page 324.

3 Press the [ENTER] button.

This confirms the entry, and the selected region name and the set transition 
rate appear in the numeric keypad control block display.

To enter a difference from the current value
After pressing the [+/–] button, enter the difference and press the [TRIM] 
button.
To change the sign (+ or –), press the [+/–] button.

Setting the independent key transition rate by a menu operation
Use the following procedure.

1 In the M/E or PGM/PST menu, select first the desired one from VF1 
‘Key1’ to VF4 ‘Key4,’ then HF6 ‘Transition.’

The Transition menu for the selected key appears.

2 Select any transition type in the <Transition Type> group.

If, in the Setup menus, you set insertion/deletion as independent modes, 
make the settings for insertion in the <On Transition Type> group, and the 
settings for deletion in the <Off Transition Type> group.

3 Turn the knob to set the transition rate.
Independent Key Transitions
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Independent key transition rate display
To check the set independent key transition rate, press the key source name 
display/key snapshot button above the corresponding delegation button when 
the [K-SS] button is off.

Displaying the independent key transition rates in a menu and 
changing the settings

For each of the M/E and PGM/PST banks, you can also display the transition 
rate, independent key transition rate and fade-to-black transition rate, and 
change the settings.

For more details, see “Displaying a List of Transition Rates and Changing the 
Settings” (page 497).

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frame count)
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Fade to Black

Fade to Black Operation

Fade to black control block

Carrying out a fade to black
To carry out a fade to black, press the [FTB] button in the fade to black control 
block.
The fade to black is carried out with the transition rate set for the program 
output of the PGM/PST bank.
During the transition, the [FTB] button lights amber. When the transition 
completes (the video is completely black), the button lit color changes to red.

For an overview of the fade to black, see page 42.

Setting the Fade to Black Transition Rate

Setting the fade to black transition rate
Use the following procedure.

1 In the PGM/PST menu, select first VF7 ‘Misc,’ then HF1 ‘Transition.’

The Transition menu appears.

AUTO PST P/P

FTB

DME
K

DME
V

M/E
3

M/E
2

M/E
1

M/E
3K

M/E
2K

M/E
IK

P/P
K

FTB button
Fade to Black
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2 Select [FTB].

3 Turn the knob to set the fade to black transition rate.

Displaying the transition rates in a menu and changing the 
settings

You can also display the transition rate, independent key transition rate, and 
fade-to-black transition rate for each of the M/E and PGM/PST banks, and 
change the settings.

For more details, see “Displaying a List of Transition Rates and Changing the 
Settings” (page 497).

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frame count)
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Simple Transition

The “simple transitions” refer to the transitions carried out using the simple-
type transition control block (or simple-type independent key transition control 
block).

Transition control block (simple right-hand type)

Basic Operations for Simple Transitions

Carrying out a transition using a simple-type transition control 
block

Use the following procedure.

1 With the background A row of cross-point buttons in the cross-point 
control block, select the background video.

KEY1

NORM
/REV

REV

KEY2

LIMIT
SET

PTN
LIMIT

TAKE

MIX

NAM

WIPE

DME

ON
OVER

ON
OVER

Key status display

Key transition selection buttons

Transition type selection buttons

Transition execution section
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2 Using one of the following methods, select the way in which the transition 

will affect the image.

Use a combination of the transition type selection buttons ([MIX], [NAM], 
[WIPE] and [DME]) and the next transition selection buttons ([KEY1] and 
[KEY2]).

For an overview of the mix, NAM, wipe, and DME wipe transition types, 
see “Transition Types” (page 37). 

To change the background only: Press one of the [MIX], [NAM], 
[WIPE], and [DME] buttons.
The [KEY1] and [KEY2]buttons go off, and the system changes to the 
background transition mode.

To insert or delete key 1: Hold down the [KEY1] button and press one of 
the [MIX], [NAM], [WIPE], and [DME] buttons.

To insert or delete key 2: Hold down the [KEY2] button and press one of 
the [MIX], [NAM], [WIPE], and [DME] buttons.

To insert or delete key 1 and key 2 simultaneously: Hold down the 
[KEY1] and [KEY2] buttons, and press one of the [MIX], [NAM], 
[WIPE], and [DME] buttons.

To use a super mix or preset color mix: Select [Super Mix] or [Preset 
Color Mix] in the Misc >Transition menu for the M/E or PGM/PST 
bank.

To set the key priority, use the Misc >Key Priority menu for the M/E or 
PGM/PST bank. For details, see “Setting the Key Priority by a Menu 
Operation” (page 317).

3 Select the new background for after the transition.

• Select the background video with the background B row of cross-point 
buttons.

• To insert a key, select the key signal, and make various settings as 
required.

For details of key settings, see Chapter 4 “Keys” (page 351).

4 Depending on the transition type selected in step 2, make the required 
settings.

For details of the settings, see the following sections:

Super mix: “Super Mix Settings” (page 321)
Preset color mix: “Color Matte Settings” (page 322)
Wipe: “Basic Procedure for Wipe Settings” (page 398)
DME Wipe: “Basic Procedure for DME Wipe Settings” (page 426)

5 Carry out the transition in the transition execution section.
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For a gradual transition such as a mix or wipe: Press the [TAKE] 
button, or operate the fader lever.

See “Setting the Transition Rate” (page 324) and “Pattern Limit” (page 
327) as required.

Display of the Key Output Status and Key Priority

You can check the output status of keys 1 and 2 and the key priority setting, in 
the key status display in the transition control block.
The key status display includes two ON indicators corresponding to keys 1 and 
2.

Display of the key output status
When the key is inserted in the output from the M/E or PGM/PST bank, the 
indication “ON” lights, and when it is not inserted, the indication goes off.

Key priority display
The key lying in front on the program monitor has an indication “OVER” lit.

To set the key priority, use the Misc >Key Priority menu for the M/E or PGM/
PST bank. For details, see “Setting the Key Priority by a Menu Operation” 
(page 317).

Split Fader

What does “split fader” mean?
The term “split fader” refers to the function of carrying out a transition with the 
fader lever split into left and right halves, so that the background A and 
background B buses can be manipulated separately.
To use the split fader, the following conditions must be met.
• The fader lever is in bus fixed mode. (See “Settings Relating to Video 

Switching (Transition Menu)” in Chapter 16 (Volume 2).)
• The necessary settings have been made in a Setup menu to enable the split 

fader (See “Settings Relating to Video Switching (Transition Menu)” in 
Chapter 16 (Volume 2).)

• A background is selected for the next transition.
• For the transition type, [MIX] or [NAM] is selected.

Split fader operation
The two halves of the split fader lever correspond to the buses as follows.
Right fader lever: Background A bus
Left fader lever: Background B bus
Simple Transition
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The relationship between the positions of the two fader levers and the image 
output in a mix is as follows.

• When the transition type is NAM, the outputs of the A bus and B bus in the 
above table are the outputs subjected to NAM.

• The transition indicators always show the progress of the background A bus.
• The operation of the left lever and that of the right lever can be swapped. (See 

“Operation Settings (Operation Menu)” in Chapter 16 (Volume 2).)

Independent Key Transitions With a Simple Transition 
Module

You carry out independent key transition operations using the independent key 
transition control block (simple type). This controls only keys 3 and 4. 
However, each key button can be assigned to any key in setup (see Chapter 16 
“Overall Control Panel Settings (Config Menu)” (Volume 2)).

Left lever position Right lever 
position

A bus output B bus output

Top Top 100% 0%

Bottom Top 100% 100%

Top Bottom 0% 0%

Bottom Bottom 0% 100%

Center Center 50% 50%
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Independent key transition control block (simple type)

Carrying out a transition using a simple-type independent key 
transition control block

Use the following procedure.

1 Select the transition type for key 3 or key 4 using the independent key 
transition type selection buttons.

To fade a key in or out: Press the [MIX] button, turning it on.
To insert or delete a key using a dedicated wipe pattern: Press the 

[WIPE] button, turning it on.
To insert or delete a key using a dedicated DME wipe pattern: Press 

the [DME] button, turning it on.

For details of wipe settings, see “Wipe Settings for Independent Key 
Transitions” (page 416). For details of DME wipe settings, see “DME 
Wipe Settings for Independent Key Transitions” (page 438).

To cut the key instantaneously in or out: Press the [CUT] button, turning 
it on.

K-SS WIPE DME

SHIFT MIX CUT

KEY3
ON

TAKE

K-SS WIPE DME

SHIFT MIX CUT

KEY4
ON

TAKE

Key 3 control block Key 4 control block

Independent key transition type 
selection buttons

Independent key transition 
execution section

The functions of the key 3 control block and key 4 control block are the same.
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If, in the Setup menus, you set insertion and deletion as independent 
modes, make the settings for the next transition in the independent key 
transition control block.
Separate settings are required both when inserting a key and when deleting 
it. For example, with the key not inserted, if you select the transition type 
and carry out a transition, this will be the setting when inserting a key.

2 Carry out the transition in the independent key transition execution 
section.

To insert or delete the key gradually with a mix or wipe transition: 
Press the [TAKE] button.

To set the independent key transition rate using a simple-type transition 
control block, use the key 3 and key 4 Transition menus. For details, see 
“Setting the Independent Key Transition Rate” (page 339).

To cut the key in or out instantaneously: Press the [KEY 3 ON] button 
or [KEY 4 ON] button.

Note
In an independent key transition, the pattern limit function is not available.
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Key Setting Operations Using Menus

There are two ways of making key settings: either using menus, or using the 
key control block.
This section describes basic procedures for making key settings using the 
menus, taking the M/E-1 >Key1 menu as an example.
Operations in the Key menus are the same for all banks (M/E-1 to M/E-3 and 
PGM/PST).

For details of the method of using the key control block, see “Key Setting 
Operations With the Key Control Block” (page 379).

Key Setting Menus

The key setting menus for each bank (M/E-1 to M/E-3 and PGM/PST) are as 
follows.

Accessing a key setting menu
For example, to access the M/E-1 >Key1 menu, carry out any of the following 
procedures.
• In the menu control block, select the top menu selection button [M/E 1], then 

press VF1 ‘Key1.’
• In the M/E-1 bank transition control block, press the KEY1 next transition 

selection button twice in rapid succession.
• In the M/E-1 bank independent key transition control block, press the key 

delegation button [KEY1] twice in rapid succession.
• In the key control block, press the M/E delegation button [M/E1], then press 

the key delegation button [KEY1] twice in rapid succession.
Any of the above operations displays the M/E1 >Key1 menu.
Note that you can access the DSK menus by pressing the button for the 
corresponding key in the downstream key control block twice in rapid 
succession.

Bank Keys set Menus

M/E-1 Keys 1 to 4 M/E-1 >Key1 to 4

M/E-2 Keys 1 to 4 M/E-2 >Key1 to 4

M/E-3 Keys 1 to 4 M/E-3 >Key1 to 4

PGM/PST Downstream keys 1 to 4 PGM/PST >DSK1 to 4
Key Setting Operations Using Menus
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Key Type Setting

Setting the key type in a menu
Use the following procedure.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

The Type menu appears.

2 In the <Key Type> group, select the key type.

Luminance: luminance key
Linear: linear key
Chroma: chroma key
Color Vector: color vector key
Wipe Pattern: wipe pattern key
Key Wipe Pattern: key wipe pattern key

For the selected key type, you can now set the parameters.

For an overview of the key types, see page 44. 

3 Carry out the following settings as required, depending on the key type 
selected in step 2.

To enable clean mode (see page 45) for a luminance key, linear key or 
color vector key: Select [Clean Mode] so that it is set on.
When clean mode is enabled, key fill is added to the background 
without cutting out with key source.

When chroma key is selected: Select [Chroma Adjust] to access the 
Chroma Adjust menu (see page 356), and make the required settings.

When a wipe pattern key is selected: In the M/E-1 >Wipe menu (see 
page 398), select the pattern and set any modifiers, then return to the 
M/E-1 >Key1 menu.

When a key wipe pattern key is selected: In the M/E-1 >Key1 >
Transition >Wipe Adjust menu (see page 416), carry out pattern 
selection and modifier setting, then return to the M/E-1 >Key1 >Type 
menu.

Note
For a wipe pattern selected for a wipe pattern key or key wipe pattern key, 
the [Edge] and [Direction] modifier settings are not available.

4 Set the parameters.

• When a luminance key or linear key is selected
353Key Setting Operations Using Menus
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a) Setting this value to 1, produces the “through” state in which no filter is applied. The larger 
the value, the more strongly the filter applies.

• When a chroma key is selected

• When a color vector key is selected

• When a wipe pattern key or key wipe pattern key is selected

5 Make the following settings as required.

Knob Parameter Adjustment Setting values

1 Clip Reference level for generating the 
key signal

+109.59 to –7.31

2 Gain Key sensitivity –100.00 to +100.00

3 Density Key density 0.00 to 100.00

4 Filter Filter coefficient 1 to 9 a)

Knob Parameter Adjustment Setting values

3 Density Key density 0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Y Clip Reference level for creating 
luminance signal

+109.59 to –7.31

2 Y Gain Luminance signal sensitivity –100.00 to +100.00

3 C Clip Reference level for creating 
chrominance signal

100.00 to 0.00

4 C Gain Chrominance signal sensitivity –100.00 to +100.00

5 Density Key density 0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Y Filter Luminance signal filter coefficient 1 to 9

2 C Filter Chrominance signal filter 
coefficient

1 to 9

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of edge softness 0.00 to 100.00

3 Density Key density 0.00 to 100.00
Key Setting Operations Using Menus
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To invert the black and white sense of the key source: Press [Key 
Invert], turning it on.

To adjust the horizontal position or key source width for a luminance 
key, linear key, or chroma key: Press [Key Position], turning it on, 
and set the parameters.

To set the key priority: Press [Key Priority] or select VF7 ‘Misc’ and 
HF3 ‘Key Priority’ to access the Key Priority menu.

For details, see “Setting the Key Priority by a Menu Operation” (page 
317).

Chroma Key Composition

Composing an image by chroma keying
There are two types of composition for chroma keying: normal mix, and 
additive mix.
To carry out chroma key composition, use the following procedure.

For an overview of the chroma key composition, see page 45.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

2 Select [Chroma] in the <Key Type> group.

It becomes possible to adjust the key density (see page 354).

3 Select [Chroma Adjust].

The Chroma Adjust menu appears.

4 Carry out auto chroma key adjustments. 
Also carry out manual adjustments if necessary to obtain an optimum 
chroma key image.

For the adjustment procedures, see page 356.

5 In the <Mix Mode> group, select [Normal Mix] or [Additive Mix] 
depending on the desired type of chroma key composition.

Knob Parameter Adjustment Setting values

1 H Phase Key horizontal position –4.00 to +4.00

2 Left Key left edge position –4.00 to +4.00

3 Right Key right edge position –4.00 to +4.00
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When using an additive mix for chroma keying, the (typically blue) 
background parts of the foreground video must be converted to black. For this, 
use the color cancel function (see page 357).

Using the plane function
In an additive mix, since no key is applied to the foreground, any variations in 
the (typically blue) background may appear in the composite image. To avoid 
this, a particular luminance level can be set for the (blue) background, and 
regions of lower luminance forcibly cut.
Use the following procedure.

1 In the Chroma Adjust menu, set [Plane] on.

2 Adjust the following parameter.

Chroma Key Adjustments

There are two ways of making chroma key adjustments: automatically, using 
the auto chroma key function, or manually, making individual adjustments 
such as color cancel adjustments and window adjustments.

Making auto chroma key adjustments
Auto chroma key is an automatic adjustment function which allows you to 
specify a part of the foreground video (for example, the blue background color) 
and use it as a reference for creating the chroma key image.
Use the following procedure.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type,’ then select [Chroma] in the 
<Key Type> group.

2 Select [Chroma Adjust].

The Chroma Adjust menu appears.

3 Select [Sample Mark] in the <Auto> group.

The foreground video only appears on the monitor, with a white box-
shaped sample selector.

Knob Parameter Adjustment Setting values

1 Luminance Luminance level 0.00 to 100.00
Key Setting Operations Using Menus
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4 Adjust the position and size of the sample selector, to specify the color to 
be used as the basis of chroma keying (typically a blue background).

a) The setting ranges depend on the signal format, screen aspect ratio, and size settings.

5 Select [Auto Start] in the <Auto> group.

This executes an auto chroma key based on the color specified by the 
sample selector, and displays the composite image on the monitor.

Making key active adjustments
When the key active function is on, the composite image is output to the 
monitor, and you can watch the monitor while manually adjusting the keying. 
When the key active function is off, only the foreground image appears. Set 
this off when manually adjusting color cancel (see the next section).
Use the following procedure.

1 In the Chroma Adjust menu, set [Key Active] on.

2 Adjust the following parameters.

Making color cancel adjustments
If the background color is leaking into the foreground video, turning the color 
cancel function on allows you to eliminate this leakage.
Use the following procedure.

1 In the Chroma Adjust menu, turn [Key Active] off.

Only the foreground image appears on the monitor.

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –100.00 to +100.00 a)

2 Position V Vertical position –100.00 to +100.00 a)

3 Size Size 1.00 to 100.00

Knob Parameter Adjustment Setting values

1 Clip Chroma key reference level 0.00 to 100.00

2 Gain Key gain –100.00 to +100.00

3 Hue Hue 359.99 to 0.00

4 Density Density 0.00 to 100.00

5 Filter Filter coefficient 1 to 9
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2 In the <Color Cancel> group, set [Color Cancel] on.

3 Adjust the following parameters.

4 Set [Key Active] on.

The chroma key composite image now appears in the monitor.

Making key signal adjustments for color cancel
When the color cancel function is set on, you can adjust the key signal for color 
cancel.
Use the following procedure.

1 In the <Color Cancel> group of the Chroma Adjust menu, set [Color 
Cancel] on.

2 In the <Color Cancel> group, set [Cancel Key] on.

The cancel key is now on, and you can now adjust the key signal for color 
cancel.

3 Make the following settings, as required, in the <Color Cancel> group.

• When setting [Key Position] on and adjusting the color cancel key 
edge position

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

5 Filter Filter coefficient 1 to 9

Knob Parameter Adjustment Setting values

1 Clip Color cancel key reference level 0.00 to 100.00

2 Gain Color cancel key gain –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 H Phase Move left and right edges of the 
color cancel key simultaneously

Left edge position 
value shown

2 Left Move left edge of the color cancel 
key

–3.00 to +3.00

3 Right Move right edge of the color 
cancel key

–3.00 to +3.00
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• When setting [Window] on and adjusting the detection range of the 
color cancel key

For details of the crop and angle parameters, see “Chroma key window” 
(page 46).

• When setting [Y Balance] on and adjusting the ratio in which Y 
balance is added to the color cancel key

Adjusting the window
Setting the window function on allows you to adjust the detection range used 
to determine the key signal. When this function is off, the default range is used 
for the key.

For an overview of the window, see “Chroma key window” (page 46).

After making sure that the values of Clip, Gain, and Hue are adjusted 
appropriately, use the following procedure to make the window adjustment.

1 In the Chroma Adjust menu, set [Window] on.

2 Adjust the following parameters.

Adjusting the Y balance
Setting the Y balance on allows you to specify that, even if the hue is the same, 
only portions of a particular luminance will be replaced by the background.

For an overview of the Y balance, see page 47.

Use the following procedure.

1 In the Chroma Adjust menu, set [Y Balance] on.

2 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Crop Crop value 100.00 to 0.00

2 Angle Angle value 180.00 to 0.00

Knob Parameter Adjustment Setting values

1 Mixture Ratio of Y balance key 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Crop Crop value 100.00 to 0.00

2 Angle Angle value 180.00 to 0.00
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Adjusting the chroma key shadow
This function allows a shadow falling on the (typically blue) background color 
to be rendered more realistically. Since portions of the (blue) background of 
less than a certain luminance are treated as shadows, there is no effect on 
cutting out of the foreground. 
Use the following procedure.

1 In the Chroma Adjust menu, set [Shadow] on.

2 Adjust the following parameters.

Note
When chroma key shadow is on, key edge is changed to normal, and soft edge 
is switched off.

Adjusting the video signal
You can change the gain of the foreground signal, or vary the Hue. There are 
separate adjustments for the gain of the whole video signal, or Y and C 
individually.
Use the following procedure.

1 In the Chroma Adjust menu, set [FRGD CCR] on.

2 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Clip Luminance range 0.00 to 100.00

2 Gain Key gain –100.00 to +100.00

3 Luminance Luminance 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Reference luminance for shadows 0.00 to 100.00

2 Gain Shadow key gain –100.00 to +100.00

3 Density Shadow opacity 0.00 to 100.00

4 Soft Shadow softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Video Gain Overall gain of video signal –100.00 to +100.00

2 Y Gain Y signal gain –100.00 to +100.00

3 C Gain C signal gain –100.00 to +100.00
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Selecting Key Fill and Key Source

Selecting key fill and key source
To select key fill and key source for key 1 on the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

The Type menu appears.

2 In the <Key Fill> group, select either of the following for use as key fill.

Key Bus: signal selected on the key 1 fill bus
Matte: signal from the dedicated color matte generator

3 If you selected [Key Bus] in step 2, select the key fill signal on the key 1 
row in the cross-point control block.

To select key fill for key 3 or key 4 in the cross-point control block, press 
the [KEY3] button or [KEY4] button to the right of the key bus buttons, 
turning it on, to allocate the key 1 row or key 2 row to the key 3 fill or key 
4 fill, then press the desired cross-point button.

4 If you selected [Matte] in step 2, in the same Type menu, press the [Matte 
Adjust] button to display the Matte Adjust menu, then adjust the single-
color or two-color combination color matte. Select whether to use a single-
color matte or a two-color combination in the <Fill Matte> group.

Flat Color: Adjust color 1 with the following parameters.

Mix Color: Carry out a color mix. Adjust color 1 and color 2, and select a 
mix pattern (see the next section).

5 In the <Key Source> group, specify the key source selection mode.

4 Hue Hue offset amount –180.00 to +180.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Self: The key fill bus signal is automatically selected as the key source.
When the key type is selected as chroma key, select [Self].

Auto Select: The signal allocated, being paired with the key fill bus signal, 
to a cross-point button is automatically selected as the key source. The 
setting of key fill and key source pairs is carried out in the Setup menu. 
(See “Cross-Point Settings (Xpt Assign Menu)” in Chapter 16 
(Volume 2).)

Split: You can select a key source signal independently of the key source 
automatically selected in Auto Select mode.

6 When [Split] was selected in step 5, hold down the [SPLIT] button in the 
key control block, then in the cross-point control block key 1 row, select 
the key source signal. Alternatively, hold down the key delegation button 
in the transition control block and press a cross-point button in the key 1 
row to select the key source signal.

Note
When [Split] is selected, the key memory function (see page 52) is 
disabled.

Carrying out a color mix for key fill
When [Matte] is selected for key fill, you can combine color 1 and color 2. For 
the combination, you can use not only a key wipe generator pattern, but also 
the dedicated pattern for key edge color mix.
Use the following procedure.

1 In the <Key Fill> group of the Type menu, select [Matte] and press [Matte 
Adjust].

The Matte Adjust menu appears.

2 Select [Mix Color] in the <Fill Matte> group.

3 Adjust the following parameters.

4 Select the combining pattern in the <Mix Pattern> group.

Key Wipe: The wipe pattern selected for an independent key transition is 
used for combination. You can also press [Pattern Select] to open the 

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of the edge of the 
pattern

0.00 to 100.00
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menu (Pattern Select menu) for key wipe pattern selection, and change 
the pattern.

Key Edge Pattern: Combine using the dedicated pattern selected for the 
color mix in the key edge fill. You can also press [Pattern Select] to 
open the menu (Mix Pattern Select menu) for edge color mix dedicated 
wipe pattern selection, and change the pattern.

For details, see “Carrying out a color mix for the key edge fill matte” 
(page 367).

5 In the Type menu, adjust color 1 and color 2.

To adjust color 1, select [Color1], and to adjust color 2, select [Color2], 
then adjust the following parameters.

6 To interchange color 1 and color 2, press the [Color Invert] button, turning 
it on.

Key Edge Modifications

To modify the key edge of key 1 on the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 >Key1 menu, select HF2 ‘Edge.’

The Edge menu appears.

2 Select the edge type in the <Edge> group.

For an overview of the key edge modifications, see “Edge modifiers” 
(page 48).

Normal: unadorned edge
Border: edge with border applied
Drop Border: edge with drop border applied
Shadow: edge with shadow applied
Outline: edge used as outline
Emboss: embossing effect applied to edge

If you select [Normal], skip to step 7.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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3 Set the border width and other parameters.

When border or outline is selected: The setting parameters depend on 
the key type and whether the separate edge function is enabled or not. 
To enable the separate edge function, press [Separate Edge], setting it 
on.

• Separate edge off

a) In the “4H mode” and when [Fine Key] (page 366) is on, the setting value range is 0.00 
to 4.00.

b) When a wipe pattern key or key wipe pattern key is selected as the key type

• Separate edge on
The left, right, top, and bottom border or outline widths can be adjusted 
independently. The separate edge function is only valid when a 
luminance key, linear key, or chroma key is selected as the key type.

a) In the “4H mode” and when [Fine Key] (page 366) is on, the setting value range is 0.00 
to 4.00.

When drop border or shadow is selected: The setting parameter values 
depend on the on/off setting of key drop and the selection of 4H mode/
8H mode (see page 50).

• “Key drop OFF” mode 

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00 a)

(0.00 to 100.00) b)

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Top Top edge width 0.00 to 8.00 a)

2 Left Left edge width 0.00 to 8.00 a)

3 Right Right edge width 0.00 to 8.00 a)

4 Bottom Bottom edge width 0.00 to 8.00 a)

5 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00

2 Position Position 359.99 to 180.00

3 Density Density 0.00 to 100.00
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• “Key drop ON” mode

a) In the “4H mode” and when [Fine Key] (page 366) is on, the setting value range is 0.00 
to 4.00.

When emboss is selected:

a) The Density adjustment only affects the key edge. This can be adjusted separately from 
Key Density, and if Key Density is set to 0.00, the embossed edge effect only can be 
applied.

To make edge fill adjustments, carry out the settings in step 6.

4 Select the edge fill signal in the <Edge Fill> group.

Utility 1 Bus: signal selected on the utility 1 bus
Matte: signal from dedicated color matte generator.

It becomes possible to adjust color 1.

When the edge type is outline, in place of the edge fill signal, the selected 
key fill signal fills the outline, and elsewhere remains as the background.

5 Carry out the following operation, depending on the selection in step 4.

When [Utility 1 Bus] is selected: Hold down the [UTIL] button in the 
cross-point control block, and select the signal in the background A 
bus row.
While the [UTIL] button is held down, the background A bus changes 
to the utility 1 bus.

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00 a)

2 Position Position 359.99 to 0.00

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 4.00

2 Position Position 359.99 to 0.00

3 Density a) Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Note
To enable the [UTIL] button, its operation mode must be set to [Hold] 
beforehand. (See “Operation Settings (Operation Menu)” in Chapter 
16 (Volume 2).)

When [Matte] is selected: Press [Matte Adjust] in the same EDGE menu, 
to display the Matte Adjust menu, and adjust a single color or two-
color combination color matte.
You can select whether to use a single color matte or a two-color 
combination color matte in the <Edge Matte> group.

For the color mix operation, see “Carrying out a color mix for the key edge 
fill matte” (page 367).

6 When emboss is selected for the edge type, adjust the color in the <Emboss 
Fill> group.

To adjust matte 1 press [Matte1], and to adjust matte 2 press [Matte2], then 
adjust the following parameters.

7 To make the edge soft, press [Soft Edge] to set it on, and adjust the 
softness.

For a normal edge, when [Soft Edge] is enabled, [Key Drop] is kept on.

8 To make separate fine adjustments to the positions of the left, right, top, 
and bottom of the source edge, press [Fine Key], to set it on, and adjust the 
following parameters.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Top Key top edge position –2.00 to +2.00

2 Left Key left edge position –2.00 to +2.00

3 Right Key right edge position –2.00 to +2.00

4 Bottom Key bottom edge position –2.00 to +2.00
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Note
In the emboss function it is not possible to set [Fine Key] on.

• When the edge type is normal, drop border or shadow, enabling the [Fine 
Key] function keeps [Key Drop] on.

• When applying a border to the key edge, enabling the [Fine Key] 
function halves the border width setting range.

Carrying out a color mix for the key edge fill matte
When you select ‘Matte’ for the edge fill of a border, drop border, or shadow, 
you can create a combination of color 1 and color 2 using a wipe pattern 
generated by the dedicated pattern generator.
Use the following procedure.

1 In the <Edge Fill> group of the Edge menu, select [Matte], then press 
[Matte Adjust].

The edge fill Matte Adjust menu appears.

2 In the <Edge Matte> group, select [Mix Color], turning it on.

3 Adjust the following parameters.

a) The patterns are the same as standard wipes. (For details, see the appendix “Wipe Pattern 
List” (Volume 2).)

To select the pattern, display the Mix Pattern Select menu by pressing 
[Mix Pattern] in the edge fill Matte Adjust menu. After selecting one of the 
patterns (standard wipe patterns 1 to 24) displayed in the Mix Pattern 
Select menu, you can adjust the following parameters.

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 H Phase Key horizontal position Left edge position 
value shown

2 V Phase Key vertical position Top edge position 
value shown

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of pattern edge 0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)
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4 Adjust color 1 and color 2.

To adjust color 1 press [Color 1], and to adjust color 2 press [Color 2], 
turning it on respectively, and adjust the following parameters.

5 If required, set the pattern modifiers.

• When turning [Position] on and setting the pattern position

a) See page 59.

• When turning [Multi] on and replicating the pattern

a) See page 62.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 61.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of pattern edge 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)
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• When turning [Angle] on in the <Rotation> group and inclining the 
pattern

a) See page 60.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a constant speed

[

a) See page 60.

6 To interchange color 1 and color 2, press [Color Invert], turning it on.

Applying the zabton effects
Use the following procedure.

1 In the Edge menu, press [Zabton], turning it on.

2 Adjust the following parameters.

Note
If in the pattern selection described below you select “Mask Pattern,” and 
“Box” for the main mask, the “Size” parameter here cannot be adjusted. 
Set “Size” in the Main Mask menu.

3 To adjust the pattern and color, press [Zabton Adjust].

The Zabton Adjust menu appears.

4 In the <Zabton Pattern> group, select the pattern.

Key Wipe: Use a key wipe.
Key Edge Pattern: Use a color mixing pattern for key edge.
Mask Pattern: Use the main mask Box or Pattern.

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Pattern edge softness 0.00 to 100.00

3 Density Density 0.00 to 100.00
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You can also press [Pattern Select], and in the corresponding pattern 
adjustment menu, change the pattern.

5 To adjust the color, press [Zabton Color] and adjust the following 
parameters.

Masks

There are two masks, which can be used to mask off unneeded parts of a key 
or background, or to remove defects, and these are known as the main mask and 
subsidiary mask. You can either use the main mask and subsidiary mask 
independently, or at the same time. 

For an overview of the masks, see page 51. 

Using the main mask
For example, to use the main mask for key 1 on the M/E-1 bank, use the 
following procedure.

1 In the M/E-1 >Key1 menu, select HF3 ‘Main Mask.’

The Main Mask menu appears.

2 In the <Mask Type> group, select the mask type.

Key Mask: Masks a part of a key.
Bkgd Mask: Masks a part of a background.

3 In the <Mask Source> group, select the mask source.

Box: signal from the dedicated box generator
Pattern: signal from the dedicated pattern generator

4 Set the mask source parameters.

Knob  Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

4 Density Density 0.00 to 100.00
Key Setting Operations Using Menus



  C
hapter 4 

K
eys
• When a box is selected

• When a pattern is selected

a) The pattern is the same as a standard wipe. (See the appendix “Wipe Pattern List” (Volume 
2).)

To select the pattern, display the Mask Ptn Select menu by pressing the 
[Mask Ptn Select] button in the Main Mask menu. After selecting one of 
the patterns (standard wipe patterns 1 to 24) displayed in the Mask Ptn 
Select menu, you can adjust the following parameters.

5 To invert the black and white sense of the mask source, press the [Mask 
Invert] button, turning it on.

6 When a pattern is selected as the mask source, set the pattern modifiers as 
required.

• When turning [Position] on and setting the pattern position

a) See page 59.

Knob Parameter Adjustment Setting values

1 Top Top position –100.00 to +100.00

2 Left Left position –100.00 to +100.00

3 Right Right position –100.00 to +100.00

4 Bottom Bottom position –100.00 to +100.00

5 Soft Box softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

5 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)
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• When turning [Multi] on and replicating the pattern

a) See page 62.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 61.

• When turning [Angle] on in the <Rotation> group and setting the 
angle of the pattern rotation

a) See page 60.

• When turning [Speed] on in the <Rotation> group and setting the 
rate of pattern rotation

a) See page 60.

Using the subsidiary mask
For example, to use the subsidiary mask for key 1 on the M/E-1 bank, use the 
following procedure.

1 In the M/E-1 >Key1 menu, select HF4 ‘Sub Mask.’

The Sub Mask menu appears.

2 In the <Mask Type> group, select the mask type.

Key Mask: Masks a part of a key.
Bkgd Mask: Masks a part of a background.

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Pattern angle –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rate of pattern rotation –100.00 to +100.00 a)
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3 In the <Mask Source> group, select the mask source.

Wipe: wipe pattern selected for a transition
If you select [Wipe], select the pattern and make modifier settings in 
the M/E-1 >Wipe menu (see page 398), then return to this M/E-1 
>Key1 menu.
In the case of a wipe pattern selected for a mask, the modifier [Edge] 
and [Direction] settings are not available.

Utility 1 Bus: signal selected on the utility 1 bus
When you selected [Utility 1 Bus], hold down the [UTIL] button in the 
M/E-1 bank cross-point control block, and select the signal with the 
background A bus buttons. While the [UTIL] button is pressed, the 
background A bus switches to the utility 1 bus.

Note
To enable the [UTIL] button, its operation mode must be set to [Hold] 
beforehand. (See “Operation Settings (Operation Menu)” in Chapter 16 
(Volume 2).)

4 Set the mask source parameters.

• When wipe is selected

• When utility 1 bus is selected

5 To invert the black and white sense of the mask source, press the [Mask 
Invert] button, turning it on.

Applying a DME Effect to a Key

Note 
For one M/E bank, DME effects (including DME wipes) can be used in up to 
two places on the dedicated interface and in only one place on the SDI interface 
simultaneously.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Clip Reference level for creating mask 
signal

+109.59 to –7.31

2 Gain Gain –100.00 to +100.00
373Key Setting Operations Using Menus



374

   C
hapter 4 

K
eys
Assigning a DME to a key
Use the following procedure.

1 In the M/E-1 >Key1 menu, select HF5 ‘Processed Key.’

The Processed Key menu appears.

2 In the <DME Select> group, select the DME channel (DME1 to DME8) to 
be used.

The lit colors of [DME1] to [DME8] indicate the DME assignment.
Lit green: Shows the DME assigned to the currently selected key.
Lit amber: Shows the DME assigned to a key other than the currently 

selected key.
Off: DME is not assigned.

To select a DME being used by another keyer
Press [Override], turning it on, then select the DME channel.
The later selection is valid, and the button lights green.

Using two or three DME channels on one keyer
When using the DME dedicated interface, proceed as follows.

1 Select the DME for the first channel (see the previous item, “Assigning a 
DME to a key”), then select the successive channel for the second channel. 
For the third channel select the channel after that.

2 To select the video signal for the second channel, hold down the [UTIL] 
button in the cross-point control block, and select the signal in the Key1 
row (DME external video bus).

3 To select the video signal for the third channel, hold down the [UTIL] 
button in the cross-point control block, and carry out the following 
operation.

• If the selected DME is channel 3 or channel 4, turn off the [KEY4] 
button in the key 2 row, then select the signal in the key 2 row (DME 
utility 1 bus).

• If the selected DME is channel 7 or channel 8, turn on the [KEY4] button 
in the key 2 row, then select the signal in the key 4 row (DME utility 2 
bus).

Using four DME channels on one keyer
When using the DME dedicated interface, proceed as follows.
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1 Select the DME channel 1 (or channel 5) for the first channel (see 
“Assigning a DME to a key” (page 374)). In the same way, select the DME 
channel 2 (channel 6) for the second channel, the DME channel 3 (channel 
7) for the third channel, and the DME channel 4 (channel 8) for the fourth 
channel.

2 To select the video signal for the second channel, hold down the [UTIL] 
button in the cross-point control block, and select the signal in the Key1 
row (DME external video bus).

3 To select the video signal for the third channel, hold down the [UTIL] 
button in the cross-point control block, and carry out the following 
operation.

• If the selected DME is channel 3, turn off the [KEY4] button in the key 
2 row, then select the signal in the key 2 row (DME utility 1 bus).

• If the selected DME is channel 7, turn on the [KEY4] button in the key 
2 row, then select the signal in the key 4 row (DME utility 2 bus).

4 To select the video signal for the fourth channel, hold down the [UTIL] 
button in the cross-point control block, and carry out the following 
operation.

• If the selected DME is channel 4, turn on the [KEY4] button in the key 
2 row, then select the signal in the key 4 row (DME utility 2 bus).

• If the selected DME is channel 8, turn off the [KEY4] button in the key 
2 row, then select the signal in the key 2 row (DME utility 1 bus).

When using the SDI interface
The operations to select the video signals for the third and fourth channels 
differ from those in the previous procedure: select the video signals on the 
AUX bus allocated in a Setup menu (Engineering Setup >Switcher >Device 
Interface >DME Setting >DME SDI Interface menu).

You can check the DME operating status in the Status menu (see page 500).

Assigning a DME output signal as a monitor signal
Use the following procedure.

1 In the Processed Key menu, press [Monitor].

The Monitor menu appears.

2 Press [Monitor Set], turning it on.

3 In the <DME Select> group, select the DME channel (DME1 to DME8) to 
be used.
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This assigns the selected DME output to DME MON V and DME MON K.
The colors with which [DME1] to [DME8] are lit show the key assignment 
status.
Lit green: DME currently being monitored
Lit amber: DME that can be monitored
Off: Unassigned DME

Specifying the Key Output Destination

Using the key processed keyer signals (external processed key)
To select the key processed keyer key fill and key source signals on the AUX 
buses, press [Ext Proc Key], turning it on, in the Processed Key menu.
This assigns the key fill and key source signals for M/E-1 key 1 to reentry 
signals PROC V and PROC K.

Note
You cannot select the PROC V and PROC K signals using the cross-point 
selection buttons of the M/E or PGM/PST bank.

Using the key processed keyer signals or signals to which a DME 
effect is applied in frame memory (frame memory feed)

To use the key processed keyer key fill and key source signals on the frame 
memory source buses, in the Processed Key menu, press [FM Feed]. [Ext Proc 
Key] turns on, and the key fill and key source signals processed on the 
currently selected keyer are automatically assigned to frame memory source 
buses 1 and 2. When a DME is selected on the keyer, the key fill and key source 
signals to which a DME effect is applied are assigned.

Key Modify Clear

Press [Default Recall] at the lower left of the menu display, turning it on, then 
press the corresponding VF button (VF1 to VF4) to return the key settings to 
their initial status.

For details of menu operations, see “Menu Operations” (page 299).
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Blink Function

With the blink function, you can obtain the following effects.
Key blink: The key is alternately inserted and deleted at regular intervals. You 

can set the period of blinking, and the proportion of each cycle for which 
the key is inserted.

Edge blink: The key fill and key edge fill signals are interchanged at regular 
intervals. You can set the period of blinking, and the proportion of each 
cycle for which the original state holds.

Using the blink function
For example, to make the required settings for key 1 on the M/E-1 bank, use 
the following procedure.

1 In the M/E-1 >Key1 menu, select HF6 ‘Transition.’

The Transition menu appears.

2 In the <Blink> group, select [Key Blink] or [Edge Blink] to set it on.

3 Set the blink parameters.

• When key blink is selected

• When edge blink is selected

Video Processing

You can adjust the luminance and hue of the selected key fill signal.
For example, to apply video processing to the signal selected on the M/E-1 
bank key 1 fill bus, use the following procedure.

1 In the M/E-1 >Key1 menu, select HF7 ‘Video Process.’

Knob Parameter Adjustment Setting values

1 Blink Rate Length of blink cycle 1 to 100

2 Duty Proportion of cycle for which key 
inserted

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Blink Rate Length of blink cycle 1 to 100

2 Duty Proportion of cycle for which 
original state holds

0.00 to 100.00
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The Video Process menu appears.

2 Press [Video Process], turning it on.

3 Adjust the following parameters.

To return adjustment values to their defaults
Press [Unity].

Knob Parameter Adjustment Setting values

1 Video Gain Video gain –200.00 to +200.00

2 Y Gain Luminance gain –200.00 to +200.00

3 C Gain Chrominance gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Luminance black level –7.31 to +109.59
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Key Setting Operations With the Key 
Control Block

This section describes the basic procedures for key settings using the key 
control block.

Key control block

Operations in the Key Control Block

Parameter adjustment with the knobs
When the button for a function requiring parameter settings is pressed (that is, 
on), you can set the parameters with the four knobs. If there are more than four 
values to be assigned to the knobs, the [MORE] button lights amber. At this 
point, press the [MORE] button, which turns green, to assign the fifth and 
subsequent parameters to the knobs, so that the parameter settings can be made.
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DME
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DME
4

M/E
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M/E
2

M/E
3 P/P

KEY1 KEY2 KEY3 KEY4 TRANS
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7

DME
8

M/E delegation buttons

Key type selection buttons

Key fill/key source selection buttons

Knobs

Key delegation buttons

Displays

Edge type selection buttons
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Selecting the bank and keyer
To make key settings, first select the bank (from M/E-1 to M/E-3 and PGM/
PST) and keyer, then assign them to the key control block.
For example, to set key 1 on M/E-1 with the key control block, use the 
following procedure.

1 Using the M/E delegation buttons in the key control block, press the [M/
E1] button, setting it on.

2 Using the key delegation buttons in the key control block, press the 
[KEY1] button, setting it on.

This assigns the key control block to M/E-1 key 1.

Selecting the key type
To select the key type, press one of the key type selection buttons in the key 
control block.
[LUM] button: luminance key
[LIN] button: linear key
[CRK] button: chroma key
[CVK] button: color vector key
[PTN] button: key wipe pattern key

When using a wipe pattern key as the key type, in the <Key Type> group 
of the Type menu for the keyer, select [Wipe Pattern] and make the 
settings.

For an overview of the key types, see page 44.

The button you pressed lights green, and you can now adjust the parameters 
with the knobs. The display beside each knob shows the first letter of the 
parameter name and the three-digit setting value.

• When the [LUM] or [LIN] button is lit green

• When the [CRK] button is lit green

Knob Parameter Adjustment Setting values

1 Clip Reference level for generating the 
key signal

+109 to –7

2 Gain Key sensitivity –100 (shown as –00) 
to +100

3 Density Key density 0 to 100

4 Filter Filter coefficient 1 to 9
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• When [Key Active] is off, only the parameters Hue and Density are 
displayed.

• When both [Key Active] and [Color Cancel] are off, only the parameter 
Density is displayed.

• When the [CVK] button is lit green

• When the [PTN] button is lit green

Selecting key fill
Select whether to use a color matte as key fill, or the signal on the key fill bus.

When using a color matte: Press the [MATTE FILL] button, setting it on. The 
button lights green, and you can now set the parameters with the knobs.

Knob Parameter Adjustment Setting values

1 Clip Chroma key reference level 0 to 100

2 Gain Key sensitivity –100 (shown as –00) 
to +100

3 Hue Hue 0 to 359

4 Density Key density 0 to 100

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Y Clip Reference level for Y signal +109  to –7

2 Y Gain Y signal sensitivity –100 (shown as –00) 
to +100

3 C Clip Reference level for chrominance 
signal

100 to 0

4 C Gain Chrominance signal sensitivity –100 (shown as –00) 
to +100

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Y Filter Y signal filter coefficient 1 to 9

2 C Filter Chrominance signal filter coefficient 1 to 9

4 Density Key density 0 to 100

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100

3 Density Key density 0 to 100
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When [Mix Color] is selected in the key fill Matte Adjust menu, you can 
further adjust color 2.

When [Mix Color] is on, and the [MORE] button is lit amber

When [Mix Color] is on, and the [MORE] button is lit green

When using the key fill bus signal: Press the [MATTE FILL] button, turning 
it off. 
To select the key fill signal, use the key 1 or key 2 bus buttons in the cross-
point control block.
To select the key fill signal for key 3 or key 4 in the cross-point control 
block, press the [KEY3] button or [KEY4] button to the right of the key 
bus buttons, turning it on, to allocate the key 1 bus row or key 2 bus row 
to the key 3 fill bus or key 4 fill bus, then press the desired cross-point 
button.

Selecting key source
• To use the key source paired with the key fill signal selected on the key fill 

bus, press the [AUTO SEL] button, turning it on. The pairing of the cross-
point buttons for key fill and key source is carried out in the Setup menu. (See 
“Cross-Point Settings (Xpt Assign Menu)” in Chapter 16 (Volume 2).)

• To select key source independently of the key fill signal selected on the key 
fill bus and paired with key source, hold down the [SPLIT] button, turning it 
on, then press the desired Key 1 or Key 2 button in the cross-point control 
block.

Knob Parameter Adjustment Setting values

1 Luminance Color 1 luminance 0 to 100

2 Saturation Color 1 saturation 0 to 100

3 Hue Color 1 hue 359 to 0

Knob Parameter Adjustment Setting values

1 Luminance Color 1 luminance 0 to 100

2 Saturation Color 1 saturation 0 to 100

3 Hue Color 1 hue 359 to 0

4 Size Pattern size 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Color 2 luminance 0 to 100

2 Saturation Color 2 saturation 0 to 100

3 Hue Color 2 hue 359 to 0

4 Soft Edge softness 0 to 100
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• To use as key source the same signal as the key fill signal selected on the key 
fill bus, select the SELF mode by pressing the [AUTO SEL] button and 
[SPLIT] button simultaneously so that both are off. When chroma key is 
selected as the key type, select the SELF mode.

Key Edge Modifications

To apply a modification to the key edge, press one of the edge type selection 
buttons in the key control block.

[BDR] button: border
[DROP BDR] button: drop border
[SHDW] button: shadow
[OUTLINE] button: outline
[EMBOS] button: emboss

For an overview of the edge modifications, see page 48.

The pressed button lights green, and you can now adjust the parameters with 
the knobs. The display beside each knob shows the first letter of the parameter 
name and the three-digit setting value.

Setting the border parameters
When the [BDR] button is lit green, the parameter settings depend on the key 
type and whether the separate edge function is active. To activate the separate 
edge function, press [Separate Edge], setting it on, in the Edge menu for the 
key.

• Separate edge off

a) In the “4H mode” and when [Fine Key] (page 366) is on, the setting value range is 0 to 4.
b) When a wipe pattern key or key wipe pattern key is selected as the key type

• Separate edge on
The border width settings can be made independently for left, right, top, and 
bottom sides. The separate edge function is only available when luminance 
key, linear key, or chroma key is selected as the key type.

Knob Parameter Adjustment Setting values

1 Width Border width 0 to 8 a)

(0 to 100) b)

4 Density Border density 0 to 100
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a) In the “4H mode” and when [Fine Key] (page 366) is on, the setting value range is 0 to 4.

To adjust the edge fill color
When [BDR] is selected, the [MORE] button lights amber. Pressing the 
[MORE] button to turn it green then allows you to adjust the edge fill color 
parameters with the knobs.

Setting the drop border or shadow parameters
When the [DROP BDR] or [SHDW] button is lit green, the parameter settings 
differ between the “key drop OFF” and “key drop ON” modes (see page 50) as 
shown below. Switching between these two modes is made by turning the 
[KEY DROP] button on or off.

• “Key drop OFF” mode

a) In the “4H mode” and when [Fine Key] (page 366) is on, the setting value range is 0 to 4.

• “Key drop ON” mode

a) In the “4H mode” and when [Fine Key] (page 366) is on, the setting value range is 0 to 4.

Knob Parameter Adjustment Setting values

1 Top Top edge width 0 to 8 a)

2 Left Left edge width 0 to 8 a)

3 Right Right edge width 0 to 8 a)

4 Bottom Bottom edge width 0 to 8 a)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Width Width 0 to 8 a)

2 Position Position 359 to 180

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Width Width 0 to 8 a)

2 Position Position 359 to 0

4 Density Density 0 to 100
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To adjust the edge fill color
When [DROP BDR] or [SHDW] is selected, the [MORE] button lights amber. 
Pressing the [MORE] button to turn it green then allows you to adjust the edge 
fill color parameters with the knobs.

Setting the outline parameters
When the [OUTLINE] button is lit green, the parameter settings depend on the 
key type and whether the separate edge function is active. To activate the 
separate edge function, press [Separate Edge], setting it on, in the Edge menu 
for the key.

• Separate edge off

a) In the “4H mode” and when [Fine Key] (page 366) is on, the setting value range is 0 to 4.
b) When a wipe pattern key or key wipe pattern key is selected as the key type

• Separate edge on
The outline width settings can be made independently for left, right, top, and 
bottom sides. The separate edge function is only available when luminance 
key, linear key, or chroma key is selected as the key type.

a) In the “4H mode” and when [Fine Key] (page 366) is on, the setting value range is 0 to 4.

When [Outline] is selected with separate edge on, the [MORE] button lights 
amber. Pressing the [MORE] button to turn it green then allows you to adjust 
the key fill density parameter with a knob.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Width Outline width 0 to 8 a)

(0 to 100) b)

4 Density Outline density 0 to 100

Knob Parameter Adjustment Setting values

1 Top Top edge width 0 to 8 a)

2 Left Left edge width 0 to 8 a)

3 Right Right edge width 0 to 8 a)

4 Bottom Bottom edge width 0 to 8 a)
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Setting the embossing parameters
When the [EMBOS] button is lit green, adjust the following parameters.

Selecting a normal edge
When all five edge type selection buttons are off, a normal edge is selected. If 
one of the buttons is lit, press it, turning it off. 

Softening the edge
Press the [SOFT EDGE] button, turning it on. The button lights green, and you 
can now adjust the softness with the knob.

• For a normal edge, when [SOFT EDGE] is enabled, “Key Drop” mode turns 
on.

• When a luminance key or linear key is selected as the key type, and clean 
mode is enabled, enabling [SOFT EDGE] ends the clean mode.

Applying the zabton effects
When the [ZABTN] button is lit green, adjust the following parameters.

Press the [MORE] button lit amber, changing it to green, then adjust the 
following parameters.

Knob Parameter Adjustment Setting values

4 Density Outline density 0 to 100

Knob Parameter Setting values

1 Width 0 to 4

2 Position 359 to 0

4 Density 0 to 100

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0 to 100

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Pattern edge softness 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100
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Masks

Using the main mask
In the key control block, press the [MAIN MASK] button, turning it on. The 
parameter settings depend on the mask source selected as [Box] or [Pattern] in 
the <Mask Source> group of the Main Mask menu for the key.

• When box is selected

When box is selected and the [MORE] button is lit amber, there are more 
settings. Press the [MORE] button, so that it changes from amber to green to 
make the extra setting.

• When pattern is selected

a) The pattern is the same as a standard wipe. (See the appendix “Wipe Pattern List” (Volume 2).)

Using the subsidiary mask
In the key control block, press the [SUB MASK] button, turning it on. The 
parameter settings depend on the mask source selected as [Wipe] or [Utility 1 
Bus] in the <Mask Source> group of the Sub Mask menu for the key.

• When wipe is selected

3 Hue Hue 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Top Top position –100 (shown as –00) to +100

2 Left Left position –100 (shown as –00) to +100

3 Right Right position –100 (shown as –00) to +100

4 Bottom Bottom position –100 (shown as –00) to +100

Knob Parameter Adjustment Setting values

1 Soft Box softness 0 to 100

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100

3 Pattern Pattern number 1 to 24 a)
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• When utility 1 bus is selected

Applying a DME Effect to a Key

Note
For one M/E bank, DME effects (including DME wipes) can be used in up to 
two places on the dedicated interface and in only one place on the SDI interface 
simultaneously.

Assigning a DME to a key
Use the following procedure.

1 In the key control block, press the delegation buttons [M/E1] and [KEY1].

2 Using the DME channel selection buttons, select the DME channel (DME1 
to DME8) for applying the effect.

The lit colors of the [DME1] to [DME8] buttons indicate the DME 
assignment.
Lit green: Shows the DME assigned to the currently selected key.
Lit amber: Shows the DME assigned to a key other than the currently 

selected key.
Off: DME is not assigned.

To select a DME being used by another keyer
Press [Override], turning it on, then select the DME channel.
The later selection is valid, and the button lights green.

Using two or three DME channels on one keyer
When using the DME dedicated interface, proceed as follows.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100

Knob Parameter Adjustment Setting values

1 Clip Reference level for 
creating mask signal

+109 to –7

2 Gain Gain –100 (shown as –00) to +100
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1 Select the DME for the first channel (see the previous item, “Assigning a 
DME to a key”), then select the successive channel for the second channel. 
For the third channel select the channel after that.

2 To select the video signal for the second channel, hold down the [UTIL] 
button in the cross-point control block, and select the signal in the Key1 
row (DME external video bus).

3 To select the video signal for the third channel, hold down the [UTIL] 
button in the cross-point control block, and carry out the following 
operation.

• If the selected DME is channel 3 or channel 4, turn off the [KEY4] 
button in the key 2 row, then select the signal in the key 2 row (DME 
utility 1 bus).

• If the selected DME is channel 7 or channel 8, turn on the [KEY4] button 
in the key 2 row, then select the signal in the key 4 row (DME utility 2 
bus).

Using four DME channels on one keyer
When using the DME dedicated interface, proceed as follows.

1 Select the DME channel 1 (or channel 5) for the first channel (see 
“Assigning a DME to a key” (page 388)). In the same way, select the DME 
channel 2 (channel 6) for the second channel, the DME channel 3 (channel 
7) for the third channel, and the DME channel 4 (channel 8) for the fourth 
channel.

2 To select the video signal for the second channel, hold down the [UTIL] 
button in the cross-point control block, and select the signal in the Key1 
row (DME external video bus).

3 To select the video signal for the third channel, hold down the [UTIL] 
button in the cross-point control block, and carry out the following 
operation.

• If the selected DME is channel 3, turn off the [KEY4] button in the key 
2 row, then select the signal in the key 2 row (DME utility 1 bus).

• If the selected DME is channel 7, turn on the [KEY4] button in the key 
2 row, then select the signal in the key 4 row (DME utility 2 bus).

4 To select the video signal for the fourth channel, hold down the [UTIL] 
button in the cross-point control block, and carry out the following 
operation.

• If the selected DME is channel 4, turn on the [KEY4] button in the key 
2 row, then select the signal in the key 4 row (DME utility 2 bus).
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• If the selected DME is channel 8, turn off the [KEY4] button in the key 
2 row, then select the signal in the key 2 row (DME utility 1 bus).

When using the SDI interface
The operations to select the video signals for the third and fourth channels 
differ from those in the previous procedure: select the video signals on the 
AUX bus allocated in a Setup menu (Engineering Setup >Switcher >Device 
Interface >DME Setting >DME SDI Interface menu).
You can check the DME operating status in the Status menu (see page 500).

Assigning the DME output signal to a monitor signal
Use the following procedure.

1 Holding down the output destination specification button [MON] in the 
key control block, use the DME channel selection buttons to select the 
DME channel (DME1 to DME8) you want to use.

The selected DME output is assigned to DME MON V and DME MON K.

2 To check the DME assignment status, hold down just the [MON] button.

While it is held down, the lit color of the [DME1] to [DME8] buttons 
shows the key assignment status.
Lit green: Shows the DME currently being monitored.
Lit amber: Shows a DME which can be monitored.
Off: DME is not assigned.

Other Key Setting Operations

Using an external processed key
You can select and use the key processed keyer key fill and key source signals 
on the AUX buses.
Use the following procedure.

1 Select the keyer to be allocated.

2 In the key control block, press [PROC KEY], turning it on.

The button lights amber, and on the currently selected keyer, the key fill 
and key source are assigned to reentry signals PROC V and PROC K.
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Note
You cannot select the PROC V and PROC K signals using the cross-point 
selection buttons of the M/E or PGM/PST bank.

Using a frame memory feed
When you press the [FM FEED] button in the key control block, it lights 
momentarily amber, then the key fill and key source signals processed in the 
currently selected keyer are assigned to frame memory sources 1 and 2.
If a DME is selected on the currently selected keyer, then the key fill and key 
source signals to which a DME effect is applied are assigned to frame memory 
sources 1 and 2.
Carrying out a frame memory feed causes the [PROC KEY] button to light 
amber.

Using the show key function
While the [SHOW KEY] button is held down, the key-processed key source 
signal appears on the specified output. (Show key mode)

Even when the [SHOW KEY] button is released, for a preset time the show key 
mode is maintained. You can specify the output to which the show key function 
is applied and set the time for which the show key mode is maintained after 
releasing the button in a Setup menu.

For details see “Settings Relating to Keys, Wipes and Frame Memory (Key/
Wipe/FM Menu)” in Chapter 16 (Volume 2).

Using the auto delegation function
To couple the selection in the key delegation buttons of the independent key 
transition control block so that the key control block delegation selection is 
automatically switched, in the key control block press the [AUTO DELEG] 
button, turning it on.

Returning the key adjustment values to their defaults
Holding down a key type button ([LUM], [LIN], [CRK], [CVK], or [PTN]) 
recalls the key default values (page 53).

Key modify clear
When an M/E delegation button is held down, holding down a key delegation 
button together returns the key settings to the initial status settings.

For details of the initial status, see “Selecting the State After Powering On 
(Start Up Menu)” in Chapter 16 (Volume 2).
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Key Snapshots

Using the key snapshot function, you can instantaneously save all of the key 
settings, except the key insertion state (on/off) and key priority, in dedicated 
registers for later recall as required.

For an overview of the key snapshots, see page 52.

Key Snapshot Operations

Key snapshot operations are carried out in the independent key transition 
control block or downstream key control block. Each keyer is provided with 
four dedicated key snapshot registers.

Independent key transition control block (standard type)

Saving a key snapshot
For example, the following procedure saves the state of the M/E-1 key 1 
settings.

1 In the M/E-1 independent key transition control block, press the key 
delegation button [KEY1], turning it on.

2 Press the [K-SS] button, turning it on. 
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K-MOD
EMBL K-SS

K-TR
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K-SS
STOREMIX WIPE DME

PTN
LIMIT

LIMIT
SET KF

DSK1
ON

AUTO
TRANS
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Key source name display/key snapshot buttons
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Key Snapshots



  C
hapter 4 

K
eys
The system switches to key snapshot mode, and the key source name 
display/key snapshot buttons show the status of registers 1 to 4 for key 1.
Off: Nothing is saved in the register.
Lit orange: Settings are saved in the register.
For a register holding a snapshot, the register name is shown as up to eight 
characters.

3 Hold down the [K-SS STORE] button, and press the key source name 
display/key snapshot button corresponding to the register in which you 
want to save the snapshot.

The key source name display/key snapshot button which you pressed lights 
yellow.

Note
If you save a key snapshot in a register for which the button is lit orange or 
yellow, the existing contents of the register are overwritten.

Recalling a key snapshot
For example, the following procedure recalls the state of the M/E-1 key 1 
settings.

1 In the M/E-1 independent key transition control block, press the key 
delegation button [KEY1], turning it on.

2 Press the [K-SS] button, turning it on.

3 Set the following buttons on or off, depending on the information you want 
to recall.
(These buttons are not provided in the downstream key control block.)

[K-MOD ENBL] button: When this is on, the key settings and key 
modifiers are recalled. When this is off, they are not recalled.

[K-TR ENBL] button: When this is on, the independent key transition 
settings are recalled. When this is off, they are not recalled.

If both buttons are off, the key memory function is enabled and only the 
saved selection of key fill and key source signals is recalled.

4 Press the key source name display/key snapshot button corresponding to 
the register you want to recall.

The button you pressed lights yellow, and this recalls the key snapshot.

To cancel a recall carried out in the downstream key control block, press 
the [UNDO] button in the downstream key control block.
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Key Snapshot Operations Using a Simple Transition 
Module

When using a simple transition module, the key snapshots hold the settings for 
key 3 and key 4. However, each key control block can be assigned to any key 
in setup (see Chapter 16 “Overall Control Panel Settings (Config Menu)” 
(Volume 2)).
You can carry out key snapshot operations in the independent key transition 
control block (simple type) and Flexi Pad control block (simple type).
There are two dedicated key snapshot registers for each of keys 3 and 4.

Independent key transition control block (simple type)

Saving a key snapshot
For example, to save the settings of M/E-1 key 3, use the following procedure.

1 In the M/E-1 independent key transition control block, press the [K-SS] 
button in the key 3 control block, turning it on.

This switches to key snapshot mode, and the key source name display/key 
snapshot button shows the state of registers 1 and 2 for key 3.
Off: Nothing is saved in the register.
Lit orange: Settings are saved in the register.
For a register holding a snapshot, the register name is shown as up to eight 
characters.

K-SS WIPE DME

SHIFT MIX CUT

KEY3
ON

TAKE

K-SS WIPE DME

SHIFT MIX CUT

KEY4
ON

TAKE

The functions of the key 3 control block and key 4 control block are the same.

K-SS button

Key 3 control block Key 4 control block

Key source name display/key 
snapshot buttons
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2 In the Flexi Pad control block, hold down the [SNAPSHOT] button and 
press the key source name display/key snapshot button corresponding to 
the register in which you want to save the snapshot.

The key source name display/key snapshot button which you pressed lights 
yellow.

Note
If you save a key snapshot in a register for which the button is lit orange or 
yellow, the existing contents of the register are overwritten.

Recalling a key snapshot
For example, the following procedure recalls the state of the M/E-1 key 3 
settings.

1 In the M/E-1 independent key transition control block, press the [K-SS] 
button in the key 3 control block, turning it on.

2 Press the key source name display/key snapshot button corresponding to 
the register you want to recall.

The button you pressed lights yellow, and this recalls the key settings 
(excluding the key insertion state (on/off) and key priority).
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Basic Procedure for Wipe Settings

You carry out wipe setting operations principally using the Wipe menu for each 
of the M/E-1 to M/E-3 and PGM/PST banks.
This section describes the basic procedures for wipe settings, taking the M/E-
1 >Wipe menu as an example.

For details of independent key transition wipe settings, see “Wipe Settings for 
Independent Key Transitions” (page 416).

Wipe Settings Menu

Accessing the wipe settings menu
To access the M/E-1 >Wipe menu, use any of the following operations.
• In the menu control block, select the top menu selection button [M/E 1], and 

press VF5 ‘Wipe.’
• In the transition control block of the M/E-1 bank, press the transition type 

selection button [WIPE] twice in rapid succession.
• In the Flexi Pad control block of the M/E-1 bank, press the [WIPE] button 

twice in rapid succession.
Any of the above operations displays the M/E-1 >Wipe menu.

Wipe Pattern Selection

You can select a wipe pattern in the Wipe menu, or by entering a pattern 
number from the Flexi Pad control block.

For how to use the Flexi Pad control block, see “Selecting a wipe pattern in 
the Flexi Pad control block” (page 400).

Selecting a wipe pattern by a menu operation
Use the following procedure.

1 In the M/E-1 >Wipe menu, select HF1 ‘Main Pattern.’

The Main Pattern menu appears.

2 Select the wipe pattern group with the pattern group selection button.
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Standard: standard wipes
Enhanced: enhanced wipes
Rotary: rotary wipes
Mosaic1 to Mosaic3: mosaic wipes
Random/Dust: random/diamond dust wipes

The patterns from the selected pattern group appear on the screen.

For details of wipe patterns, see “Types of Wipe Pattern” (page 54) and 
the appendix “Wipe Pattern List” (Volume 2).

3 Press the button to select the desired pattern.

4 The parameters change according to the selected pattern, and you can 
adjust the pattern.

• When a polygon wipe is selected (pattern number 49)

a) A value of –100.00 completely removes the star “rays,” leaving a circle; at +100.00 the 
“rays” are at their sharpest.

• When a mosaic wipe is selected (pattern numbers 200 to 203, 206 to 
213, 224 to 247, 250 to 257, 260 to 269)

• When a karaoke wipe is selected (pattern numbers 220 to 223)

a) At –100.00 tiles appear from the top (or left edge) of the screen; at +100.00 from the 
bottom (or right edge) of the screen.

b) At –100.00 all rows appear simultaneously; at +100.00 until one row of tiles is completely 
displayed, the next row does not start to appear.

• When a random wipe is selected (pattern number 273)

Knob Parameter Adjustment Setting values

1 No Number of points 3 to 64

2 Star Rate Angularity of star –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 H Tile No Number of tiles horizontally 2 to 36

2 V Tile No Number of tiles vertically 2 to 18

Knob Parameter Adjustment Setting values

1 Start Position of start tile –100.00 to +100.00 a)

2 Row No Number of rows of tiles 1 to 36

3 Phase Delay for next row –100.00 to +100.00 b)
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• When a diamond dust wipe is selected (pattern number 274)

Note
When Flash Rate is set to 0.00, you cannot change the pattern. In this state, 
adjusting H Size or V Size has no effect on the pattern.

For details of a pattern mix, see the next section.
For details of applying pattern modifiers, see “Setting Wipe Modifiers” 
(page 403).

Selecting a wipe pattern in the Flexi Pad control block
To select a pattern with a standard type Flexi Pad control block, use the 
following procedure. (It is not possible to select a wipe pattern with a simple 
type Flexi Pad control block.)

1 In the M/E-1 Flexi Pad control block, press the [WIPE] button.

This switches the Flexi Pad control block to wipe snapshot mode.

2 In the memory recall section, press the [PTN NO] button.

Knob Parameter Adjustment Setting values

1 H Size Tile width 0.00 to 100.00

2 V Size Tile height 0.00 to 100.00

3 Volatility Rate of tile generation 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Size Particle width 0.00 to 100.00

2 V Size Particle height 0.00 to 100.00

3 Flash Rate Rate of generation of particles 0.00 to 100.00
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This switches the Flexi Pad control block to wipe pattern number recall 
mode, and the memory recall section display changes as shown in the 
following figure.

3 Use the buttons in the memory recall section to enter the pattern number 
consisting of up to three digits, and press the [ENTR] button.

The entry is confirmed, and now the numeric display shows the pattern 
number.

For the pattern numbers, see the appendix “Wipe Pattern List” (Volume 
2).

Pattern Mix

Combining two patterns
You can combine two selected patterns (referred to as main and “sub”) to form 
a new pattern. Select a main pattern in the Main Pattern menu, then use the 
following procedure.

1 In the M/E-1 >Wipe menu, select HF3 ‘Sub Pattern.’

The Sub Pattern menu appears.

7

WIPE

DME

SNAP
SHOT

EFF

MCRO

SHOT
BOX

UNDO

STORE
STATS

TRANS
RATE

BNAK
0

BANK
1

BANK
SEL

XPT HOLD
A B U1 U2 1 2 3 4

8 9

4 5 6

1 2 3

0 ENTR
PTN
NQ

WIPE button Numeric display

Memory recall section
401Basic Procedure for Wipe Settings



402

   C
hapter 5 

W
ipes
2 In the same way as for the main pattern, select the sub pattern.

The patterns that can be selected for the sub pattern depend on the pattern 
selected for the main pattern (see the following table).

Possible combinations of main pattern and sub pattern

Yes: Combination possible    No: Combination not possible

3 Select HF2 ‘Pattern Mix.’

The Pattern Mix menu appears.

4 In the <Pattern Mix> group, select the type of pattern mix.

Mix: mix
+Nam: positive Nam
–Nam: negative Nam
Morphing: morphing

For an overview of types of pattern mix, see page 55.

5 Depending on the selection in step 4, set the following parameters.

• When mix, positive Nam, or negative Nam is selected

• When morphing (see page 55) is selected

 Main 
pattern

Sub pattern

Standard Enhanced Rotary Mosaic Random/
diamond 
dust 

Standard Yes Yes No Yes Yes

Enhanced Yes Yes No Yes Yes

Rotary No No No No No

Mosaic Yes Yes No No Yes

Random/
diamond 
dust

Yes Yes No Yes No

Knob Parameter Adjustment Setting values

1 Mix Ratio Proportion of sub pattern to the 
main pattern

0.00 to 100.00

Knob Parameter Adjustment Setting values

2 Start Point in transition at which main 
pattern is at 100%

–50.00 to +150.00

3 End Point in transition at which sub 
pattern is at 100%

–50.00 to +150.00
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6 In the <Main/Sub Link> group, make the main/sub modifier link function 
settings. (See “Main and sub modifier link function” (page 57).)

Full: fully linked mode
Semi: semi-linked mode

Applying the effect of a diamond dust wipe to the selected 
pattern (Dust mix)

Use the following procedure.

1 In the Pattern Mix menu, press [Dust Mix], turning it on.

2 Set the following parameters as required.

You can also apply the dust mix function to the pattern generated by a 
pattern mix.

Note
When a random/diamond dust wipe (pattern numbers 270-274) is selected, 
the dust mix function is not available.

Setting Wipe Modifiers

You can apply various modifiers to the wipe pattern: setting the wipe direction, 
pattern position, and so on.

For an overview of the wipe modifiers, see “Wipe Pattern Variation and 
Modifiers” (page 57).
Note that the available modifiers may depend on the pattern you are using. For 
details, see “Possible combinations of wipe patterns and modifiers” (page 
414).

Main pattern and sub pattern modifiers
You can make independent settings of the modifiers for the main pattern and 
sub pattern.

Knob Parameter Adjustment Setting values

1 Mix Ratio Proportion of diamond dust 
pattern in mix

0.00 to 100.00

2 H Size Particle width 0.00 to 100.00

3 V Size Particle height 0.00 to 100.00

4 Flash Rate Rate of generation of particles 0.00 to 100.00
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• To set the modifiers for the main pattern, in the M/E-1 >Wipe menu, select 
HF5 ‘Main Modify,’ and make the settings in the Main Modify menu.

• To set the modifiers for the sub pattern, select HF6 ‘Sub Modify,’ and make 
the settings in the Sub Modify menu.

Operations in the Main Modify menu and Sub Modify menu are the same.

Independently set modifiers for the main pattern and sub pattern
• Positioner
• Rotation
• Aspect ratio
• Pattern replication (MULTI)
• Pairing
• Modulation
• Spring
• Spiral

The following sections show examples of modifying the main pattern.

Specifying the wipe direction (Direction)
You can specify the wipe direction (normal/reverse).

To specify the wipe direction in a menu
Use the following procedure.

1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Direction> group, specify the wipe direction.

Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

To specify the wipe direction with a button in the transition control 
block
In the transition control block of each of the M/E-1 to M/E-3 and PGM/PST 
banks, press the following direction selection buttons.
NORM: Normal
NORM/REV: Normal/reverse
REV: Reverse

Splitting the wipe pattern
Use the following procedure.
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1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 Press [Split], turning it on.

3 Set the following parameters.

Modifying the wipe pattern edge
Use the following procedure.

1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Edge> group, select the edge type.

Border: border
Soft: soft edge
Soft Border: soft border

For an overview of the edge types, see “Edge” (page 59).

3 Set the parameters according to the selection in step 2.

• When border is selected

• When soft edge is selected

• When soft border is selected

Knob Parameter Adjustment Setting values

1 Split No Number of splits 1 to 4 (integer)

2 Spacing Spacing between adjacent 
patterns

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

2 Inner Soft Border inner softness 0.00 to 100.00

3 Outer Soft Border outer softness 0.00 to 100.00
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4 When you selected border or soft border, select the edge fill signal in the 
<Edge Fill> group.

Utility 2 Bus: signal selected on the utility 2 bus
Matte: signal from the dedicated color matte generator

5 Depending on the operation in step 4, carry out the following operation.

When ‘Utility 2 Bus’ is selected: Hold down the [UTIL] button in the 
cross-point control block, and select the signal on the background B 
bus.
While the [UTIL] button is held down, the background B bus changes 
to the utility 2 bus.

Note
To enable the [UTIL] button, its operation mode must be set to [Hold] 
beforehand. (See “Operation Settings (Operation Menu)” in Chapter 
16 (Volume 2).)

When ‘Matte’ is selected: In the same Edge/Direction menu, press [Matte 
Adjust] to display the Matte Adjust menu, then adjust the single-color 
or two-color combination color matte. Select whether to use a single-
color matte or a two-color combination in the <Edge Matte> group.
Flat Color: Adjust color 1 with the following parameters.

When you select [Mix Color] for a two-color combination, see the next 
paragraph.

Carrying out a color mix for the edge fill matte
When you selected [Matte] for the border or soft border edge fill, you can 
combine color 1 and color 2.
For the combination, you can use not only a normal wipe generator pattern, but 
also the dedicated color mix pattern.
Use the following procedure.

1 In the <Edge Fill> group of the Edge/Direction menu, select [Matte], and 
press [Matte Adjust].

The Matte Adjust menu appears.

2 In the <Edge Matte> group, select [Mix Color], turning it on.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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3 In the <Mix Pattern> group, make one of the following selections.

Wipe: Use the wipe pattern selected for the transition.
Pattern: Use the dedicated pattern.

4 Depending on the selection in step 3, set the following parameters.

• When Wipe is selected

• When Pattern is selected

a) The patterns are the same as for a standard wipe. See the appendix “Wipe Pattern List” 
(Volume 2).

If you selected Pattern, you can also carry out the pattern selection by 
pressing the [Mix Ptn Select] button in the Matte Adjust menu, to display 
the Mix Ptn Select menu. Select any pattern appearing in the Mix Ptn 
Select menu (standard wipe patterns 1 to 24) by pressing the appropriate 
button, and you can then adjust the following parameters.

5 If you selected Pattern in step 4, if required, the following modifiers can 
be added. After selecting a wipe mix, skip to step 6.

• When turning [Position] on and setting the pattern position

a) See page 59.

• When turning [Multi] on and using replications of the same pattern

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)
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a) See page 62.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 61.

• When turning [Angle] on in the <Rotation> group and slanting the 
pattern

a) See page 60.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a constant rate

a) See page 60.

6 To adjust color 1, set [Color 1] on, and to adjust color 2 set [Color 2] on, 
then adjust the parameters.

7 To interchange color 1 and color 2, press the [Color Invert] button, turning 
it on.

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Setting the wipe position (Positioner)
You can set the position independently for the main pattern and sub pattern. 
Use the following procedure.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Position> group, press [Position], turning it on, and set the pattern 
position.

a) See page 59.

To return the pattern position to the center of the screen
In the <Position> group, press [Center].

To move the pattern from its current position to the center through 
the course of a transition
In the <Position> group, press [Auto Center], turning it on.

To set the wipe position using the trackball or joystick
You can also set the wipe position using the trackball or joystick in the device 
control block. Use the following procedure.

1 In the device control block, press the [M/E1], [M/E2], [M/E3], or [P/P] 
button, turning it on.

The buttons in the device control block are assigned to the wipe position 
setting as follows.

Table 1: Buttons and assigned settings

Table 2: Buttons assigned to functions

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)

Button name Setting

MAIN Wipe position for common transition (main pattern)

SUB Wipe position for common transition (sub pattern)

Button name Function

POS Toggle Position on or off.

X, Y Fix the operating direction.
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2 Press the [MAIN] button or [SUB] button, turning it on.

3 Press the [POS] button, turning Position on.

4 Move the trackball or joystick, to set the wipe position. By pressing the [X] 
button, turning it on, you can restrict movement to the horizontal direction, 
and by pressing the [Y] button, turning it on, you can restrict movement to 
the vertical direction. 

Rotating the wipe pattern (Rotation)
You can apply rotation independently to the main pattern and sub pattern. Use 
the following procedure.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Rotation> group, select the rotation type.

Angle: Incline the pattern through a fixed angle.
Speed: Rotate at a fixed rate.
Magnitude: Rotate through a particular angle during the course of the 

transition.

For an overview of the rotation, see page 59.

3 According to the selection in step 2, set the following parameters.

•  When Angle is selected

a) See page 60.

• When Speed is selected

a) See page 60.

• When Magnitude is selected

CTR Return the pattern position to the center of the screen.

Button name Function

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)
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a) See page 61.

Setting the wipe pattern aspect ratio (Aspect ratio)
You can set the aspect ratio independently for the main pattern and sub pattern.
Use the following procedure.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press [Aspect], turning it on.

3 Set the following parameter.

a) See page 61.

Setting the wipe pattern replication (Multi)
You can set pattern replication independently for the main pattern and sub 
pattern. 
Use the following procedure.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press the [Multi] button, turning it on.

3 Set the following parameters.

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation at start of 
transition

–100.00 to +100.00 a)

2 Magnitude Angle of rotation through course 
of transition

–200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63
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a) See page 62.

4 To make more adjustments, press the [Multi Adjust] button.

The Multi Adjust menu appears.

5 Make the following settings, as required.

H Invert: When this is on, alternate tiles are inverted left-to-right.
V Invert: When this is on, alternate tiles are inverted top-to-bottom.
Non-Mask: When this is on, even if the positioner function is used to 

move the pattern position, the pattern is always present on the screen.
Position: By adjusting the following parameters, move the pattern position 

within the divisions determined in step 3.

a) See page 59.

Making a wipe pattern like a Venetian blind (Pairing)
Use the following procedure.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Pairing> group, select the slit direction.

H: Create slits in the horizontal direction.
V: Create slits in the vertical direction.

3 Set the following parameters.

a) See page 62.

3 Shift Replication layout –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Position H Horizontal position of pattern –200.00 to +200.00 a)

2 Position V Vertical position of pattern –200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 Width Width of the slits 1 to 128 (integer)

2 H Offset Spacing in the horizontal direction –100.00 to +100.00 a)

3 V Offset Spacing in the vertical direction –100.00 to +100.00 a)
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Applying modulation to the wipe pattern (Modulation)
You can apply modulation independently to the main pattern and sub pattern. 
Use the following procedure.

Note
When using 1080PsF mode in an HD system, the modulation function is not 
available.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Depending on the desired effect, in the <Modulation> group select one of 
the following.

H: Modulate the pattern, applying waviness in the horizontal direction to 
edges.

V: Modulate the pattern, applying waviness in the vertical direction to 
edges.

Fringe: Modulate the pattern, applying waviness in the radial direction to 
edges.

3 Set the following parameters.
.

a) See page 63.
b) See page 63.

Applying barrel or pincushion distortion to the edge of the wipe 
pattern (Spring)

You can set the spring function independently for the main and sub patterns. 
Use the following procedure.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press [Spring], turning it on.

Knob Parameter Adjustment Setting values

1 Amplitude Amplitude of modulation 0.00 to 100.00

2 Frequency Frequency of modulation 0.00 to 100.00

3 Speed Speed of waves –100.00 to +100.00 a)

4 Shape Form of the modulation 1 to 3 b)
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3 Set the following parameters.

a) See page 65.

Applying a spiral effect to the wipe pattern (Spiral)
You can set the spiral function independently for the main and sub patterns. 
Use the following procedure.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press [Spiral], turning it on.

3 Set the following parameters.

a) See page 65.

Possible combinations of wipe patterns and modifiers

Yes: Can be used    No: Cannot be used

Knob Parameter Adjustment Setting values

1 Gain Degree of barrel distortion –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Magnitude Size and direction of the spiral –100.00 to +100.00 a)

2 Wave Speed Speed of the lateral waves –100.00 to +100.00 a)

Modifiers Type of wipe

Standard Enhanced Rotary Mosaic Random/
diamond dust

Direction Yes Yes Yes Yes Yes

Split Yes Yes No Yes No

Edge Yes Yes Yes Yes Yes

Positioner Yes a) Yes b) Yes c) No No

Rotation Yes Yes Yes c) No No

Aspect ratio Yes d) Yes No No No

Pattern 
replication

Yes Yes Yes Yes e) No

Pairing Yes f) Yes No No No
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a) Not patterns 1 to 16, 19, and 20
b) Not patterns 300 to 303
c) Not patterns 100 to 103, 150, 151, 516, 518, 604, and 606
d) Not patterns 1 to 8, 17, and 18
e) Not patterns 220 to 223
f) Not patterns 19 and 20
g) But patterns 21, 23 and 24 are possible
h) But patterns 21 and 23 are possible

Wipe Modify Clear

Press [Default Recall] at the lower left of the menu display, turning it on, then 
press VF5 ‘Wipe’ to return the wipe settings to their initial status.

For details of menu operations, see “Menu Operations” (page 299).

Modulation
(H/V)

Yes Yes Yes No No

Modulation 
(Fringe)

No g) Yes No No No

Spring No g) Yes No No No

Spiral No h) Yes No No No

Modifiers Type of wipe

Standard Enhanced Rotary Mosaic Random/
diamond dust
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Wipe Settings for Independent Key 
Transitions

You carry out independent key transition wipe setting operations using the 
Wipe Adjust menu for each keyer.

For an overview of independent key transitions, see page 33.

This section describes the independent key transition wipe settings, taking the 
M/E-1 >Key1 >Transition >Wipe Adjust menu as an example.

Basic Procedure for Independent Key Transition Wipe 
Settings

Accessing the independent key transition wipe settings menu
As an example, to access the M/E-1 >Key1 >Transition >Wipe Adjust menu, 
carry out either of the following operations.
• In the menu control block, select the top menu selection button [M/E 1] and 

select VF1 ‘Key1’ and HF6 ‘Transition’ to display the Transition menu for 
key 1, then press [Wipe Adjust].

• In the independent key transition control block of the M/E-1 bank, press the 
key delegation button [KEY1], then press the independent key transition type 
selection button [WIPE] twice in rapid succession.

Carrying out the above operation displays the M/E-1 >Key1 >Transition 
>Wipe Adjust menu (which will be referred to below as simply the Key1 Wipe 
Adjust menu).

Selecting the independent key transition wipe pattern
You select the independent key wipe pattern from the list of patterns displayed 
in the menu.

Note 
In an independent key transition, you can only use the standard wipe patterns 
(pattern numbers 1 to 24).

To select a wipe pattern for independent key1 on the M/E-1 bank, use the 
following procedure.
Wipe Settings for Independent Key Transitions
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1 In the Key1 Wipe Adjust menu, select [Pattern Select].

The Pattern Select menu appears.

2 Press the button for the desired pattern.

Setting Independent Key Transition Wipe Modifiers

Available modifiers
You can use the following modifiers with an independent key transition wipe.
Note that the available modifiers may depend on the pattern you are using.
• Direction
• Edge
• Positioner
• Rotation
• Aspect ratio
• Pattern replication

Setting the wipe direction (Direction)
In the <Direction> group of the Key1 Wipe Adjust menu, make any of the 
following selections.

Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

Softening the wipe pattern edge (Soft edge)
Use the following procedure.

1 Press [Soft] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameter.

Setting the wipe position (Positioner)
There are two methods of setting the wipe position: using the device control 
block, or in a menu.

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00
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To set the wipe position using the trackball or joystick
You can also set the wipe position using the trackball or joystick in the device 
control block. Use the following procedure.

1 In the device control block, press the [M/E1], [M/E2], [M/E3], or [P/P] 
button, turning it on.

The buttons in the device control block are assigned to the wipe position 
setting as follows.

Table 1: Buttons and assigned settings

Table 2: Buttons assigned to functions

2 Press one of the buttons in Table 1 above, to select the wipe position to 
which the operation applies. Multiple selection is possible.

3 Press the [POS] button, turning Position on.

4 Move the trackball or joystick, to set the wipe position. By pressing the [X] 
button, turning it on, you can restrict movement to the horizontal direction, 
and by pressing the [Y] button, turning it on, you can restrict movement to 
the vertical direction. 

To set the wipe position by a menu operation
Use the following procedure.

1 Press [Position] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameters.

Button name Setting

K1 CB1 Wipe position for independent key 1 transition

K2 CB2 Wipe position for independent key 2 transition

K3 FM1 Wipe position for independent key 3 transition

K4 FM2 Wipe position for independent key 4 transition

Button name Function

POS Toggle Position on or off.

X, Y Fix the operating direction.

CTR Return the pattern position to the center of the screen.

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)
Wipe Settings for Independent Key Transitions
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a) See page 59.

To move the pattern from its current position to the center through 
the course of a transition
Press [Auto Center] in the <Position> group, turning it on.

Rotating the wipe pattern (Rotation)
Use the following procedure.

1 In the <Rotation> group of the Key1 Wipe Adjust menu, select the rotation 
type.

Angle: Incline the pattern through a fixed angle.
Speed: Rotate at a speed rate.
Magnitude: Rotate the pattern through a fixed angle during the course of 

the transition.

2 According to the selection in step 1, set the following parameters.

• When Angle is selected

a) See page 60.

• When Speed is selected

a) See page 60.

• When Magnitude is selected

a) See page 61.

2 Position V Vertical position –200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation at start of 
transition

–100.00 to +100.00 a)

2 Magnitude Angle of rotation through course 
of transition

–200.00 to +200.00 a)
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Setting the wipe pattern aspect ratio (Aspect ratio)
Use the following procedure.

1 Press [Aspect] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameter.

a) See page 61.

Replicating the wipe pattern (Multi)
Use the following procedure.

1 Press [Multi] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameters.

a) See page 62.

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)
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Wipe Snapshots

Buttons used
You can snapshot and save a wipe pattern together with the current settings of 
its modifiers and pattern limit in a dedicated register for recall when required.
In a standard transition system there are ten wipe snapshot registers for each of 
the M/E-1 to M/E-3 and PGM/PST banks, and in a simple transition module 
eight registers for each bank.

Flexi Pad control block (standard type)

7

WIPE

DME

SNAP
SHOT

EFF

MCRO

SHOT
BOX

UNDO

STORE
STATS

TRANS
RATE

BNAK
0

BANK
1

BANK
SEL

XPT HOLD
A B U1 U2 1 2 3 4

8 9

4 5 6

1 2 3

0 AUTO
TRAN

EFF
DISS

WIPE button STORE STATS button

UNDO button

Numeric display

Memory recall buttons
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Flexi Pad control block (simple type)

Saving a Wipe Snapshot

Saving a wipe snapshot
Use the following procedure.

1 Make the wipe settings that you want to save.

2 In the Flexi Pad control block, hold down the [WIPE] button, and press the 
memory recall button corresponding to the register in which you want to 
save.

Notes
• If you press a button which is lit orange or yellow, the existing contents 

of the register are overwritten.

WIPE

DME

SNAP
SHOT

UNDO

1 2

3 4

5 6

XPT HOLD
A B U1 U2 1 2 3 4

7 8

WIPE button

Numeric display

UNDO button

Memory recall buttons
Wipe Snapshots
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• If you carry out a pattern mix, and both the main pattern and sub pattern 
are selected, then the memory recall button shows the main pattern.

The pattern appears on the button you pressed, which lights yellow.
The numeric display shows the number of the corresponding pattern.
It is also possible to display the register name using a Setup menu (see 
“Operation Settings (Operation Menu)” in Chapter 16 (Volume 2)).

Meaning of the state of buttons
Off: Nothing is saved in the register.
Lit orange: Settings are saved in the register.
Lit yellow: The most recently recalled register.

Canceling the saving of a wipe snapshot
To cancel the saving of a wipe snapshot immediately after performing it, hold 
down the [STORE STATS] button, and press the [UNDO] button. The 
[STORE STATS] button changes from amber to green.

Note
On a simple type Flexi Pad control block, it is not possible to cancel the saving 
of a wipe snapshot.

Recalling a Wipe Snapshot

Recalling a wipe snapshot
Use the following procedure.

1 In the Flexi Pad control block, press the [WIPE] button.

This switches the Flexi Pad control block to the mode for recalling a wipe 
snapshot.

2 Press the memory recall button for the register from which you want to 
recall the wipe snapshot.

The button lights, and the saved wipe snapshot is recalled. At this point, 
the numeric display shows the pattern number or register name.

Canceling the recall of a wipe snapshot
To cancel the recall of a wipe snapshot, press the [UNDO] button.
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Deleting a Wipe Snapshot

Deleting a wipe snapshot
When the [WIPE] button is lit in the Flexi Pad control block, hold down the 
[STORE STATS] button and press the memory recall button for the register in 
which you want to delete the wipe snapshot.
The indication of the memory recall button reverts from the wipe pattern or 
register name to the register number.

Note
In a simple type Flexi Pad control block, it is not possible to delete a wipe 
snapshot.
Wipe Snapshots
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Basic Procedure for DME Wipe Settings

You carry out DME wipe setting operations principally using the DME Wipe 
menu for each of the M/E-1 to M/E-3 and PGM/PST banks.
This section describes the basic procedures for DME wipe settings, taking the 
M/E-1 >DME Wipe menu as an example.

For details of independent key transition DME wipe settings, see “DME Wipe 
Settings for Independent Key Transitions” (page 438).

Note 
For one M/E bank, DME effects (including external processed keys) can be 
used in up to two places on the DME dedicated interface and in only one place 
on the SDI interface simultaneously.

DME Wipe Settings Menu

Accessing the DME Wipe menu
To access the M/E-1 >DME Wipe menu, use any of the following operations.
• In the menu control block, select the top menu selection button [M/E 1], and 

press VF6 ‘DME Wipe.’
• In the transition control block of the M/E-1 bank, press the transition type 

selection button [DME] twice in rapid succession.
• In the Flexi Pad control block of the M/E-1 bank, press the [DME] button 

twice in rapid succession.
Any of the above operations displays the M/E-1 >DME Wipe menu.

DME Wipe Pattern Selection

You can select a DME wipe pattern in the DME Wipe menu, or by entering a 
pattern number from the Flexi Pad control block.

Selecting a DME wipe pattern by a menu operation
Use the following procedure.

1 In the M/E-1 >DME Wipe menu, select HF1 ‘1ch’ for one-channel mode, 
HF2 ‘2ch’ for two-channel mode or HF3 ‘3ch’ for three-channel mode.
Basic Procedure for DME Wipe Settings
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2 Select the desired DME wipe pattern group with one of the following 

buttons.

• Slide/Squeeze: slide and squeeze
• Split/Door: split and door
• Flip Tumble: flip tumble
• Mirror/Sphere: mirror and sphere
• Character Trail: character trail
• Wave/Ripple: wave and ripple
• Page Turn/Roll: page turn and page roll
• Frame I/O/PinP: frame in/out and picture-in-picture
• 2D Trans/3D Trans: 2D trans and 3D trans
• Sparkle/Split Slide: sparkle and split slide
• Mosaic/Defocus: mosaic and defocus
• Brick: brick
• User Program: user programmable DME

Selectable DME wipe pattern groups in one-channel mode: All of the 
above groups except for Brick.

Selectable DME wipe pattern groups in two-channel mode: Slide/
Squeeze, Page Turn/Roll, Frame I/O, PinP, 3D Trans, Brick and User 
Program.

Selectable DME wipe pattern groups in three-channel mode: User 
Program and Brick.

For details of DME wipe patterns, see “Types of DME Wipe Pattern” 
(page 67) and the appendix “DME Wipe Pattern List” (Volume 2).

The patterns from the selected pattern group appear on the screen.

3 Press the button to select the desired pattern.

Note
For a key transition, the page turn, page roll and picture-in-picture cannot 
be used.

Adjusting DME wipe pattern parameters
Of the DME wipe patterns, the following have parameters that can be adjusted.

When Brick (for two channels) is selected (pattern numbers 2801 
to 2804, 2811 to 2814)

Knob Parameter Adjustment Setting values

1 Side V Size X Horizontal magnification 0.01 to 8.00

2 Side V Size Y Vertical magnification 0.01 to 8.00
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a) The horizontal center position of the video pasted on Side V. At –100.00 the center is at the left 
edge of the screen, and at +100.00 the center is at the right edge of the screen.

b) The vertical center position of the video pasted on Side V. At –100.00 the center is at the bottom 
edge of the screen, and at +100.00 the center is at the top edge of the screen.

When Frame in-out (for two channels) is selected
• Pattern numbers 2851 to 2854

• Pattern numbers 2861 to 2864

When Brick (for three channels) is selected (pattern number 3601)
Parameter group [1/2]

a) Shared with knob 3 for parameter group 2
b) The horizontal center position of the video pasted on Side V. At –100.00 the center is at the left 

edge of the screen, and at +100.00 the center is at the right edge of the screen.

3 Height Height of brick 0.01 to 100.00

4 Center X Horizontal center position –100.00 to +100.00 a)

5 Center Y Vertical center position –100.00 to +100.00 b)

Knob Parameter Adjustment Setting values

5 Delay Timing for video selected on 
a utility bus to appear on the 
screen

–100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Rot X Rotation about the Y axis 
(horizontal direction)

–100.00 to +100.00

2 Rot Y Rotation about the X axis 
(vertical direction)

–100.00 to +100.00

3 Rot Z Rotation about the Z axis –100.00 to +100.00

5 Delay Timing for video selected on 
a utility bus to appear on the 
screen

–100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Side V Size X Side V horizontal 
magnification

0.01 to 8.00

2 Side V Size Y Side V vertical 
magnification

0.01 to 8.00

3 Height Height of brick 0.01 to 100.00 a)

4 Side V Center X Side V horizontal center 
position

–100.00 to +100.00 b)

5 Side V Center Y Side V vertical center 
position

–100.00 to +100.00 c)

Knob Parameter Adjustment Setting values
Basic Procedure for DME Wipe Settings
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c) The vertical center position of the video pasted on Side V. At –100.00 the center is at the bottom 

edge of the screen, and at +100.00 the center is at the top edge of the screen.

a) Shared with knob 3 for parameter group 1
b) The horizontal center position of the video pasted on Side H. At –100.00 the center is at the left 

edge of the screen, and at +100.00 the center is at the right edge of the screen.
c) The vertical center position of the video pasted on Side H. At –100.00 the center is at the bottom 

edge of the screen, and at +100.00 the center is at the top edge of the screen.

Selecting a DME wipe pattern in the Flexi Pad control block
In the standard type Flexi Pad control block, enter a 4-digit pattern number, 
using the [DME] button.

For details, see “Selecting a wipe pattern in the Flexi Pad control block” (page 
400).

Note
You cannot select a DME wipe pattern in the simple type Flexi Pad control 
block.

Setting DME Wipe Modifiers

You can apply various modifiers to the DME wipe pattern: setting the DME 
wipe direction, pattern position, and so on.

For an overview of the DME wipe modifiers, see “DME Wipe Pattern 
Variation and Modifiers” (page 75).

Specifying the DME wipe direction (Direction)
You can specify the DME wipe direction (normal/reverse).

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Side H Size X Side H horizontal 
magnification

0.01 to 8.00

2 Side H Size Y Side H vertical 
magnification

0.01 to 8.00

3 Height Height of brick 0.01 to 100.00 a)

4 Side H Center X Side H horizontal center 
position

–100.00 to +100.00 b)

5 Side H Center Y Side H vertical center 
position

–100.00 to +100.00 c)
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To specify the DME wipe direction in a menu
Use the following procedure.

1 In the M/E-1 >DME Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Direction>group, specify the DME wipe direction.

Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

To specify the DME wipe direction with a button in the transition 
control block
In the transition control block of each of the M/E-1 to M/E-3 and PGM/PST 
banks, press the following direction selection buttons.
NORM: Normal
NORM/REV: Normal/Reverse
REV: Reverse

Modifying the DME wipe pattern edge
Use the following procedure.

1 In the M/E-1 >DME Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time.

3 In the <Edge> group, select the edge type.

Border: border
Soft Border: soft border

4 Set the parameters according to the selection in step 3.

• When border is selected

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00
Basic Procedure for DME Wipe Settings
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• When soft border is selected

Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

Setting the DME wipe position (Positioner)
Use the following procedure.

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the DME wipe pattern is in one-channel mode or 
two-channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time.

3 In the <Position> group, press [Position], turning it on.

4 Set the following parameters.

3 Luminance Luminance 0.00 to 100.00

4 Saturation Saturation 0.00 to 100.00

5 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

2 Inner Soft Border inner softness 0.00 to 100.00

3 Luminance Luminance 0.00 to 100.00

4 Saturation Saturation 0.00 to 100.00

5 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 H Horizontal position –200.00 to +200.00

2 V Vertical position –200.00 to +200.00
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Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

To return the DME wipe pattern position to the center of the screen
In the <Position> group, press [Center].

Displaying and moving the position of the DME wipe pattern 
(position select)

Use the following procedure.

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.
In the <Position Select> group, the one of the [Top Left], [Top Right], 
[Bottom Left], and [Bottom Right] buttons that is on indicates the current 
display position of the DME wipe pattern.

2 In the <Position> group, press [Position], turning it on.

3 Depending on whether the DME wipe pattern is in one-channel mode or 
two-channel mode, proceed as follows.

In one-channel mode: press [1st Ch], turning it on.
In two-channel mode: from the <Ch Select> group, select the 

corresponding channel. You can select more than one channel at the 
same time.

4 To move the position of the DME wipe pattern, press the button where you 
want to move to, turning it on.

The DME wipe pattern displayed on the screen moves to the position of 
the specified button.

Setting relative positions to move the DME wipe pattern
In two-channel mode, use the following procedure. 

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 In the <Ch Select> group, select the target channels.
Basic Procedure for DME Wipe Settings
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3 Press [Position] in the <Position> group, turning it on.

4 Set the following parameters.

For details of the method of DME wipe pattern selection, see “DME Wipe 
Pattern Selection” (page 426).

Setting the DME wipe pattern size (Size)
Use the following procedure.

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time.

3 Press [Size], turning it on.

4 Set the following parameters.

a) The effect size when [Size] is off is taken as 100.00%.

Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

Knob Parameter Adjustment Setting values

4 Relative H Relative movement in the 
horizontal direction

–400.00 to +400.00

5 Relative V Relative movement in the vertical 
direction

–400.00 to +400.00

Knob Parameter Adjustment Setting values

1 Size Set size of effect 0.00 to 200.00 a)
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Adjusting the DME wipe pattern cropping
Use the following procedure.

Note
When pattern numbers 1701 and 1702 are selected, crop cannot be used.

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time. Some patterns need no selection which is fixed in the 
<Ch Select> group.

3 In the <Crop Mode> group, press [Crop], turning it on.

4 Set the following parameters.

Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

In 16:9 mode, to crop to 4:3 aspect ratio
In the <Crop Mode> group, press [4:3], turning it on.

To set the action when a DME wipe crop transition is executed
Use the following procedure.

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

Knob Parameter Adjustment Setting values

1 Top Crop the top of the image –100.00 to +100.00

2 Left Crop the left of the image –100.00 to +100.00

3 Right Crop the right of the image –100.00 to +100.00

4 Bottom Crop the bottom of the image –100.00 to +100.00
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2 Depending on whether the selected pattern is in one-channel mode or two-

channel mode, proceed as follows.

For a pattern in one-channel mode: in the <Ch Select> group, press [1st 
Ch], turning it on.

For a pattern in two-channel mode: from the <Ch Select> group, select 
the corresponding channels. You can select more than one channel at 
the same time.

3 In the <Crop Mode> group, press [Crop] or [4:3 Crop] (to crop from 16:9 
to 4:3 aspect ratio), turning it on.

4 In the <Crop Mode> group, press [Remove From Begin].

The Remove From Begin menu appears.

5 In the <Crop Transition> group, select the execution mode for the DME 
wipe crop transition.

Cut: Cut mode. The cropping does not change during the transition, but at 
the end point of the transition the cropping is removed (enlarges).

Last 5%: The cropping is maintained for the first 95% of the transition, 
and is progressively removed during the last 5% of the transition 
(enlarges).

Linear: The cropping is removed linearly through the whole course of the 
transition (enlarges).
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Setting the timing of transition completion
When the execution mode for a DME wipe crop transition is set to [Last 5%], 
you can select the timing of transition completion from 70% ([Last 30%]), 95% 
([Last 5%]), and 100% ([Off]). Use the following procedure.

1 In the M/E 1 >DME Wipe menu, select HF5 ‘Modify’.

The Modify menu appears.

2 In the <Crop Mode> group select [Remove From Begin].

The Remove From Begin menu appears.

3 In the <Release Transition> group, select the timing of transition 
completion.

Last30%: The transition completes at the end of 70% of the transition 
execution time. The transition has a dead zone from 70% to 95% of the 
transition time.

Last5%: The transition completes at the end of 95% of the transition 
execution time. When the transition completes, the cropping is 
removed during the last 5%.

Off: The transition completes at the end of the transition execution time. 
During the last 5% of the transition, the transition and cropping 
removal proceed together.

0
100 (%)95

[Last 30%]

y

t

(%)
100

70
0

100 (%)95

[Last 5%]

y

t

(%)
100

70
0

100 (%)95

[Off]

y

(%)
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95

t

Transition
Cropping

t: transition execution time
y: change in transition and cropping amount

Transition
Cropping

Transition
Cropping

“Dead Zone”
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DME Wipe Modify Clear

Press [Default Recall] at the lower left of the menu display, turning it on, then 
press VF6 ‘DME Wipe’ to return the DME wipe settings to their initial status.

For details of menu operations, see “Menu Operations” (page 299).
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DME Wipe Settings for Independent Key 
Transitions

You carry out independent key transition DME wipe setting operations using 
the DME Wipe Adjust menu for each keyer.

For an overview of independent key transitions, see page 33.

This section describes the independent key transition DME wipe settings, 
taking the M/E-1 >Key1 >Transition >DME Wipe Adjust menu as an example.

Basic Procedure for Independent Key Transition DME 
Wipe Settings

Accessing the independent key transition DME wipe settings 
menu

As an example, to access the M/E-1 >Key1 >Transition >DME Wipe Adjust 
menu, carry out the following operation.
• In the menu control block, select the top menu selection button [M/E 1], and 

select VF1 ‘Key1’ and HF6 ‘Transition’ to display the Transition menu for 
key 1. Next, press [DME Wipe Adjust].

• Press the key delegation button [Key1] in the independent key transition 
control block of the M/E-1 bank, then press the independent key transition 
type [DME] twice in quick succession.

Carrying out the above operation displays the M/E-1 >Key1 >Transition 
>DME Wipe Adjust menu (which will be referred to below as simply the Key1 
DME Wipe Adjust menu).

Selecting the independent key transition DME wipe pattern
You select the independent key DME wipe pattern from the list of patterns 
displayed in the menu.
To select a DME wipe pattern for independent key1 on the M/E-1 bank, use the 
following procedure.

1 In the <Pattern Select> group of the Key1 DME Wipe Adjust menu, press 
[1ch] for one-channel mode or [2ch] for two-channel mode.

The Pattern Select menu appears.
DME Wipe Settings for Independent Key Transitions
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2 Select the desired DME wipe pattern group with one of the following 

buttons.

In two-channel mode, only Page Turn and Page Roll are selectable.
• Slide/Squeeze: slide and squeeze
• Split/Door: split and door
• Mirror/Sphere: mirror and sphere
• Character Trail: character trail
• Wave/Ripple: wave and ripple
• Page Turn/Roll: page turn and page roll
• Frame I/O: frame in/out
• 2D Trans/3D Trans: 2D Trans and 3D Trans
• Sparkle/Split Slide: sparkle and split slide
• User Program: user programmable DME

For details of DME wipe patterns, see “Types of DME Wipe Pattern” 
(page 67) and the appendix “DME Wipe Pattern List” (Volume 2).

The patterns from the selected pattern group appear on the screen.

3 Press the button to select the desired pattern.

Setting Independent Key Transition DME Wipe 
Modifiers

You can set the pattern position and size for an independent key transition 
DME wipe.

For introductory information, see “Positioner” (page 75) and “Size” (page 
76).

Setting the DME wipe position (Positioner)
For applicable pattern numbers, see page 75.

Use the following procedure.

1 In the <Position> group of the Key1 DME Wipe Adjust menu, press 
[Position], turning it on.

2 Set the following parameters.

Knob Parameter Adjustment Setting values

1 H Horizontal position –200.00 to +200.00
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To return the DME wipe pattern position to the center of the screen
In the <Position> group, press [Center].

Setting the DME wipe pattern size (Size)
For applicable pattern numbers, see page 76.

Use the following procedure.

1 In the Key 1 DME Wipe Adjust menu, press [Size], turning it on.

2 Set the following parameter.

a) The effect size when [Size] is off is taken as 100.00%.

2 V Vertical position –200.00 to +200.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Size Set size of effect 0.00 to 200.00 a)
DME Wipe Settings for Independent Key Transitions
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DME Wipe Snapshots

To carry out DME wipe snapshot operations, use the Flexi Pad control block.
You can save, recall and delete DME wipe snapshots using the procedures 
similar to the procedures for wipe snapshot operations. In DME wipe snapshot 
operations, use the [DME] button instead of the [WIPE] button used in wipe 
snapshot operations. 

Notes
• A button in the memory recall section in which a DME wipe snapshot is 

saved shows the pattern, and lights yellow.
For a user-programmable DME, the register number (see page 442) appears.
Depending on the setting of the Setup menu (see “Operation Settings 
(Operation Menu)” in Chapter 16 (Volume 2)), you can also display a 
register name.

• In a simple type Flexi Pad control block, it is not possible to delete a DME 
wipe snapshot.

For details of the operating procedures, see “Wipe Snapshots” (page 421).
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Creating User Programmable DME Patterns

With a user programmable DME, you can use DME effects created through the 
use of keyframes for a transition on the switcher system.
Note the following points when creating a keyframe effect for use as a user 
programmable DME pattern.

Register numbers and pattern numbers
When saving a keyframe effect as a user programmable DME pattern, specify 
the register number that corresponds to the pattern number as shown in the 
following table.

For details of registers and keyframe effects, see “Registers” (page 154) and 
Chapter 13 “Keyframe Effects” (Volume 2), respectively.

Keyframe effects in the global channel
When the effect with the same number as the reference channel is present on 
the DME global (GLBL) channel, executing the user programmable DME will 
also execute the effect on the global channel simultaneously.
When executing a user programmable DME, take note of whether the effect is 
present on the global channel.

User Programmable DME Transition Mode

To create a user programmable DME, it is necessary to set the transition mode 
(the way in which the effect moves). To set the transition mode, use the Key 
Frame >DME User PGM menu.

For details of the operating procedures, see “Transition Mode Settings for 
User Programmable DME” in Chapter 13 (Volume 2).

Execution mode Register number Pattern number

One-channel mode 101 to 199 1901 to 1999

Two-channel mode 201 to 299 2901 to 2999

Three-channel mode 301 to 399 3901 to 3999
Creating User Programmable DME Patterns
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The following transition modes are available.

a) Transition according to DME wipe patterns 1202, 1203, or 1204
b) Transition according to DME wipe pattern 1201
c) Transition according to DME wipe pattern 1251

For details, see “DME Wipes” (page 67).

Note
For the following group of effects available in two-channel mode, no user 
programmable DME wipe patterns can be created.

Page turn, Page roll, Frame in-out, Brick

Notes on creating keyframe effects
When creating a keyframe effect to be used as a user programmable DME 
pattern, note the following, depending on the transition mode used.

Notes on single transition mode (one-channel mode)
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• Create the last keyframe to be a full-size image.
• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 

select [Single].

Notes on flip tumble (one-channel mode)
• Create the first keyframe image at full size. In the <Back> group of the DME 

>Input/Output >Video/Key menu, depending on the direction of the rotation 
you want during the transition, press [H Invert] or [V Invert], turning it on.

Channels Transition mode Effect group

One-channel mode Single transition mode Slide, Split, Door, Page turn, 
Page roll, Squeeze, Mirror, 
Sphere, Character Trail, Wave, 
Ripple, 2D Trans, 3D Trans, 
Sparkle, Split Slide

Flip Tumble Flip Tumble, Mosaic, Defocus

Frame in-out Frame in-out

Frame in-out H a) Frame in-out

Frame in-out V Frame in-out

Picture-in-picture b) Picture-in-picture

Compress c) Picture-in-picture

Two-channel mode Dual transition mode Slide, Squeeze, 3D Trans

Two-channel picture-in-picture Picture-in-picture
443Creating User Programmable DME Patterns
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• Create the last keyframe with the image inverted so the back side is visible, 
and with the size at full size.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [Flip Tumble].

Notes on frame in-out (one-channel mode)
Create a minimum of three keyframes.
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• Create the first transition to end such that the image can be seen within the 

screen. At this point, press the [PAUSE] button in the keyframe control 
block, turning it on, to set a pause for the keyframe.

• Either create the last keyframe image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [FRAME I/O].

Notes on Frame in-out H (one-channel mode)
Create a minimum of three keyframe points.
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• As the state after completion of the first transition, move the image 

horizontally to make it visible within the screen. At this time, press the 
[PAUSE] button in the keyframe control block, turning it on, to set a pause 
for the keyframe.

• For the last keyframe move the image horizontally to place it outside the 
screen area or set the image size to zero, so that the image is not visible 
within the screen.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [FRAME I/O H].

Notes on frame in-out V (one-channel mode)
Create a minimum of three keyframe points.
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• As the state after completion of the first transition, move the image vertically 

to make it visible within the screen. At this time, press the [PAUSE] button 
in the keyframe control block, turning it on, to set a pause for the keyframe.

• For the last keyframe move the image vertically to place it outside the screen 
area or set the image size to zero, so that the image is not visible within the 
screen.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [FRAME I/O V].

Notes on picture-in-picture (one-channel mode)
Create a minimum of three keyframes.
Creating User Programmable DME Patterns
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• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• Create the first transition to end such that the image can be seen within the 

screen. At this point, press the [PAUSE] button in the keyframe control 
block, turning it on, to set a pause for the keyframe.

• Either create the last keyframe image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [P In P].

Notes on compress (one-channel mode)
Create a minimum of three keyframe points.
• Create the first keyframe with the image at full size.
• In the state at completion of the first transition, create the image to be visible 

within the screen. At this time, press the [PAUSE] button in the keyframe 
control block, turning it on, to set a pause for the keyframe.

• For the last keyframe, once again set the image size to full size.
• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 

select [Compress].

Notes on dual transition mode (two-channel mode)
• Create the first keyframe for each channel as follows.

Channel 1: create the image full-size.
Channel 2: either create the image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.

• Create the last keyframe for each channel as follows.
Channel 1: either create the image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.
Channel 2: create the image full-size.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [Dual].

Notes on picture-in-picture (two-channel mode)
Create a minimum of three keyframes.
• Create the first keyframe for each channel as follows.

Channel 1: create the image full-size.
Channel 2: since the priority is low, it will not be visible on the screen, so 
no particular restrictions apply.
In the Global Effect >Ch1 to Ch4 >Combiner menu, when setting the priority 
of channel 1 and channel 2, set the channel 1 priority higher.

• In the intermediate part of the transition, create the two images so that both 
are visible within the screen. In the Global Effect >Ch1 to Ch4 >Combiner 
menu, when setting the priority of channel 1 and channel 2, set the channel 2 
priority higher.
445Creating User Programmable DME Patterns
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Note
It is recommended to make the priority settings at a keyframe point at which 
the two images are not overlapping.

• During the course of a transition, there is a “dead zone” corresponding to the 
intermediate point of the whole effect (see following figure), during which 
the image does not change. Therefore, it is necessary to create the effect so 
that the image in the intermediate part of the transition is the keyframe for 
the mid-point of the whole effect. The range of this “dead zone” corresponds 
to the central one-third of the range of the transition indicator. This also 
applies to an auto transition. 

• Create the last keyframe for each channel as follows.
Channel 1: since the priority is low, it will not be visible on the screen, so 
no particular restrictions apply.
Channel 2: create the image full-size.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [P In P].

A B C

Keyframe effect

First keyframe Last keyframe 

Mid-point of effect

Change in image through transition

Image at point C 
appears

Image at point B 
appears 
(dead zone)

Image at point A 
appears

Transition indicator
Fader lever
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Still Image Operations

For an overview of frame memory concepts, see “Frame Memory” (page 78).

Note
During playback of a frame memory clip of the pair assigned to either of the 
target FM selection buttons (see page 471), frame memory operations may not 
be performed properly. Carry out frame memory operations after stopping clip 
playback.

Preparations

Allocating the frame memory outputs (FM1 to FM8) to cross-
point buttons

To output a frame memory image to a monitor, for example, the output signal 
from the frame memory (FM1 to FM8) must be allocated to a cross-point 
button. Carry out this allocation in the Setup menu.

Accessing the Frame Memory menu
Most frame memory operations are carried out using the Frame Memory menu.
To access the Frame Memory menu, use either of the following procedures.
• In the menu control block, select the top menu selection button [FRAME 

MEM].
• Press the cross-point button to which the frame memory output is allocated 

twice in rapid succession.

Interpreting the Frame Memory Menu

The menu screen consists of the following principal parts.
The frame memory selection area display is the same for all except the Pattern 
Adjust/Pattern Select/Field Invert/File (excluding Pair Recombination menu)/
External HDD menus.
Still Image Operations
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Frame Memory menu

a Auto store status display
Depending on the setup settings, this appears when the auto store function is 
enabled.

b Display of available image capacity
This shows the remaining number of frames. When no more frames can be 
stored, in pair mode “1” appears in red, and in single mode “0” appears in red.

2 Display of available image capacity

4 Pair selection button

6 File selection area

3Target FM 
selection buttons 5 Pair button

1 Auto store status displayFrame memory 
selection area
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c Target FM selection buttons

Press one of these to select which of the selected outputs (FM1 and FM2 in the 
example shown) the operation applies to.
The following information appears on the button.

Status display
File name (e.g. image001) and thumbnail: when a file is output
Black: when a black signal is output
Through: when the input image is output
Freeze: when a freeze is output
Composite: when a composite image is processed
Record: when continuously capturing images (record) (Frame Memory >Still 

>Animation Record menu only)

Still/duration display
When a still image is selected, “Still” is shown. When a clip is selected, a 
duration indication such as “00:00:10” is shown.

Reposition/Lock status display
This shows “R” when the reposition function (see page 463) is on, and shows 
“L” when the lock function (see page 464) is on.

d Pair selection button
Select the pair to be displayed in the target FM selection buttons.
(in the following figure, the pair of FM1 and FM2 is selected.)

Status display

Still/duration display Reposition/Lock status display

The border color shows the status as follows:
Blue: selected as the reference channel
Amber: selected, but not the reference channel
Black: not selected
Still Image Operations
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The following information appears on the button.

Status display
For a selected pair, shows the status for the reference; for an unselected pair, 
shows the status for main.
Thumbnail: when a file is output
Black: when a black signal is output
Through: when the input image is output
Freeze: when a freeze is output
Compos: when a composite image is processed
Record: when continuously capturing images (record) (Frame Memory >Still 

>Animation Record menu only)

e Pair button
Press this button, turning it on, to enable pair mode.

f File selection area 
You can select from the displayed still image files or clip files.

The border color shows the status as follows:
Blue: selected as the reference channel
Amber: selected, but not the reference channel
Black: not selected

Status display
451Still Image Operations
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Thumbnail indications
Still image files and clip files: Still image files are displayed as gray buttons 

and clip files are displayed as yellow buttons.
Single files and pair files: Single files are displayed with shadow and pair files 

are displayed with no shadow.
Selected file: Pale blue border. When more than one file is selected, only the 

first is pale blue, and the remainders are amber. If the pair file was selected, 
each press switches the front and the back.

File information detail display
For the selected file, this shows the file name, "P" if a pair file, and the duration.

Selecting an Input Image

For the input image to frame memory, you can use either the signal selected on 
one of the two frame memory source buses or a dedicated color matte signal.
When using the signal on frame memory source bus 1 or 2 for the input image, 
select the signal as described below.

For the method of using a color matte signal, see “Freezing an image and 
writing it to memory” (page 454).

Selected file.
When a pair file is selected each press switches the front and the back.

File information detail display
Still Image Operations
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Selecting the signal on a frame memory source bus

As an example, to select a signal on frame memory source bus 1, use the 
following procedure.

1 In the auxiliary bus control block, press the AUX delegation button to 
which frame memory source bus 1 is allocated, turning it on.

 For allocation of buses to the AUX delegation buttons, see “AUX 
Delegation Buttons Settings (Aux Assign Menu)” in Chapter 16 (Volume 
2).

2 In the auxiliary bus control block cross-point buttons, select the signal to 
be used for the input image.

To select a signal with a key or DME effect applied on the frame 
memory source bus
In the key control block, press the [FM FEED] button, turning it on.
This automatically assigns the key fill and key source signals being keyed by 
the currently selected keyer to frame memory source buses 1 and 2.
When DME is selected on the keyer, the key fill and key source signals to 
which a DME effect is applied are assigned.

Selecting Outputs and Target Frame Memory

Selecting outputs (FM) and target frame memory
The following description applies to the case of settings for FM1&2, but the 
procedures are similar for the other cases.

1 In the Frame Memory menu, press one of VF1 to VF4, and select the 
required HF menu.

The current status of frame memory appears. (See page 448).

2 From the pair selection buttons, press the buttons corresponding to FM1 
and FM2.

This assigns the signals to FM1 and FM2.
To the right of the target FM selection buttons, the FM1 and FM2 output 
status appears (see page 450).

3 If required, press [Pair], to select the FM operation mode (pair mode).

On: Operate on FM1(3, 5, 7) and FM2(4, 6, 8) as a pair.
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Off: Operate on FM1(3, 5, 7) and FM2(4, 6, 8) individually.

For more details, see “Pair mode” (page 79).

Note
In the Pair Recombination menu, the [Pair] operation is not possible.

4 Press the target FM selection button [FM1] or [FM2] (see page 450) to 
select the FM operations apply to.

When [Pair] is On: Whichever of FM1 and FM2 you press, the pair is 
selected.

When [Pair] is Off: One of the targets must be selected. However, in the 
Clip >Play menu you can also select both FM1 and FM2.

Capturing an Input Image (Freeze)

Freezing an image and writing it to memory
To freeze the signal selected as input material, and write it to memory, use the 
following procedure.

1 In the Frame Memory menu, select VF1 ‘Still’ and HF2 ‘Freeze/Store.’

The Freeze/Store menu appears.

2 Select the target frame memory.

For the procedure, see “Selecting outputs (FM) and target frame 
memory” (page 453).

3 To enable V/K mode, press [V/K Mode] turning it on.

4 Press [Freeze Enable], turning it on.

The signals of frame memory source buses 1 and 2 are assigned to the pair 
of FMs selected in step 2, a freeze is now possible.

5 If necessary, make the video process settings (see page 456) or mask 
settings (see page 456) for application to the selected signal.

6 In the state in which you want to freeze, press one of the following in the 
<Freeze> group, to write the freeze image to temporary memory.

Frame: Freeze one frame.
Field: Freeze one field.
Still Image Operations
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Off: Release the freeze, and delete the recorded freeze image.

After carrying out the freeze, to return to the state immediately before the 
freeze, press [Undo] in the <Freeze> group.

Notes
• All freeze images written to temporary memory are lost when the system 

is powered off.
• If you change the frame memory to use as in step 2 before saving the 

freeze images written to temporary memory, all the freeze images in 
temporary memory are lost, unless the auto store function has been 
enabled in setup. With the auto store function enabled, the freeze images 
written to temporary memory are saved automatically when the frame 
memory selection is changed.

• For the following signal formats, a field freeze is not possible.
1080PsF/23.976, 1080PsF/24, 1080PsF/25, 1080PsF/29.97, 720P/
50, 720P/59.94

Saving a freeze image
To save a captured still image in a file, use the following procedure in the Still 
>Freeze/Store menu.

1 Press [Store].

The keyboard window (see page 307) appears.

2 In the keyboard window, enter the file name (maximum 8 characters).

3 In the keyboard window, press the [Enter] button.

This saves the still image file in memory.

When the system is powered off, the file saved in memory is erased. However, 
you can recall a backed up file in the Frame Memory menu.

For details, see “File Backups” (page 476), and “Restoring backed up files” 
(page 476).

Carrying out a freeze and store simultaneously
Press [Freeze & Store], turning it on.
The system enters the freeze and store mode.
In this state, if you press [Frame] or [Field], this carries out a freeze, and 
simultaneously stores in a still image file.
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Setting video processing
To set video processing for the signal selected on a frame memory source bus, 
use the following procedure in the Still >Freeze/Store menu.

1 In the <Video Process> group, press [Video Process], turning it on.

2 Use the knobs to adjust the following parameters.

To return the settings to the default values, press [Unity] in the <Video 
Process> group.

Note
When a pair setting is active, it is coupled to the video process on/off 
setting, but the above parameter settings are only valid for frame memory 
source bus 1. The pair setting cannot be used to set the frame memory 
source bus 2. If you want to set video process for frame memory source bus 
1 only with the pair setting when old settings for frame memory source bus 
2 remain, return the frame memory source bus 2 settings to their default 
values. When setting video process for the frame memory source bus 2, 
disable the pair setting.

Setting a mask
Masks can be set separately for frame memory source buses 1 and 2. To apply 
a mask to the signal selected on frame memory source bus 1, for example, use 
the following procedure in the Still >Freeze/Store menu.

1 Press [Box Mask] turning it on.

2 Use the knobs to adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Video Gain Overall gain of the video signal –200.00 to +200.00

2 Y Gain Y signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Y signal black level –7.31 to +109.59

Knob Parameter Adjustment Setting values

1 Top Top position –100.00 to +100.00

2 Left Left position –100.00 to +100.00

3 Right Right position –100.00 to +100.00

4 Bottom Bottom position –100.00 to +100.00
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3 To link the masks on frame memory source buses 1 and 2, press [Mask 

Link], turning it on.

Recalling Still Images

Recalling a still image
To recall a still image file saved in memory using the thumbnails, and assign it 
to an FM output, use the following procedure.

1 In the Frame Memory menu, select VF1 ‘Still’ and HF1 ‘Recall.’

The Recall menu appears.
• When [Pair] is on, only pair files (pairs of main file and sub file) are 

displayed.

• When [Pair] is off, both single files and pair files appear.

Main file

Sub file
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2 In the frame memory selection area, select the FM to be assigned. (See 
page 453.)

3 Using the arrow keys or turning the knob, scroll the file thumbnail display.

4 Press the thumbnail of the clip you want to recall.

5 Press [Recall].

This recalls the still image file, which is assigned to the FM you selected 
in step 2.

Inverting the Field Polarity of a Saved Still Image (Field 
Invert Function)

Note
On the MVS-8000/8000A this function is valid when the signal format is HD 
(excluding 720p).

To invert the field polarity of a saved still image
Use the following procedure.

1 In the Frame Memory >Still menu, press HF7 ‘Field Invert.’

The Field Invert menu appears.
This automatically switches pair mode off, and the status area shows 
thumbnails of all images currently saved in frame memory.

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail display 
scrolling

1 and upwards

Single file
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2 Press the arrow keys or turn the knob to scroll the thumbnail display.

3 Select the thumbnail of the still image on which you want to carry out field 
inversion. You can also select more than one image.
To select all still images, press [Select All].

The file names for the selected still images appear in reverse video.
To cancel the selection, press once more, returning to the normal display.
The last still image selected is automatically recalled, and a pale blue 
border appears around the thumbnail.
You can now select thumbnails while checking the still images.

4 To carry out field inversion, press [Field Invert].

Field inversion starts, and a popup window shows the progress of the 
operation.

Note
When the system is powered off, files held in memory are lost, but backed-up 
files can be recalled in the Frame Memory menu.

For details, see “File Backups” on page 476 and “Restoring Files” on page 
476.

Image Processing

Combining the background image and input signal
Use the following procedure.

1 In the Frame Memory menu, select VF1 ‘Still’ and HF3 ‘Composite.’

The Composite menu appears.

2 In the frame memory selection area, select the FM to be assigned. (See 
page 453.)

3 To select V/K mode, press [V/K Mode], turning it on.

4 Press [Edit Enable], turning it on.

Knob Parameter Adjustment Setting values

1 Scroll Scroll thumbnail display 1 and upwards
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The signals of frame memory source buses 1 and 2 are assigned to the pair 
of FMs selected in step 2, and the combining of the background signal (the 
signal providing the background for combination) and the input signal (the 
signal providing the foreground for combination) is now possible.

Note
The input signal is lowered by one line, but when you apply a freeze, the 
freeze image is returned to the correct position.

5 To use a color matte signal for the input signal, press [Frgd Color], turning 
it on.
Even when pair mode is enabled, you can make separate settings for each 
FM.

6 Turn the knobs to adjust the following parameters.

7 If you turned [Frgd Color] off in step 5, if required press [Input Adjust] to 
display the Input Adjust menu, and make the video process (see page 456) 
and mask (see page 456) settings for the input signal.

8 To set the background signal to black, press [Bkgd Black], turning it on.

Notes
• When the background signal is originally black, [Bkgd Black] remains 

on. 
• When the background signal is a freeze image (an image frozen, but not 

saved), turning [Bkgd Black] on erases the unsaved freeze image and, as 
a result, [Bkgd Black] remains on. 

9 In the <Type> group, set the type of combination (see page 461).

10In the state in which you want to freeze, press one of the following in the 
<Freeze> group, to write the freeze image to temporary memory.

Frame: Freeze one frame.
Field: Freeze one field.
Off: Release the freeze, and delete the recorded freeze image.

After carrying out the freeze, to return to the state immediately before the 
freeze, press [Undo] in the <Freeze> group.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Notes
• All freeze images written to temporary memory are lost when the system 

is powered off.
• If you change the frame memory to use as in step 2 before saving the 

freeze images written to temporary memory, all the freeze images in 
temporary memory are lost, unless the auto store function has been 
enabled in setup. With the auto store function enabled, the freeze images 
written to temporary memory are saved automatically when the frame 
memory selection is changed.

• For the following signal formats, a field freeze is not possible.
1080PsF/23.976, 1080PsF/24, 1080PsF/25, 1080PsF/29.97, 720P/50, 
720P/59.94

Saving a processed freeze image
To save a processed freeze image as a file, in the Still >Composite menu use 
the following procedure.

1 Press [Store].

The keyboard window appears.

2 In the keyboard window, enter the file name (maximum 8 characters).

3 In the keyboard window press [Enter].

This saves the freeze image as a still image file in memory.

Selecting the way in which images are combined
To select the way in which the background image and input signal are 
combined (see page 81), use the following procedure.

1 In the <Type> group of the Still >Composite menu, select one of the 
following methods of combination.

• Pattern Key: pattern key
• Ext Key: external key

(This can only be selected when the pair mode is enabled. The signal 
selected on the frame memory source 2 bus is used as the key signal.)

• Mix: mix
• Nam: non-additive mix
If none of the above is selected, image combination is not carried out.

2 Depending on the selection in step 1, set the following parameters.

• When [Pattern Key] is selected
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a) The patterns are the same as for a standard wipe. See the appendix “Wipe Pattern List” 
(Volume 2).

• When [Ext Key] is selected

• When [Mix] is selected

3 When you selected a pattern key, press [Pattern Adjust].

The Pattern Adjust menu appears. In the menu, set the pattern modifiers as 
required.

• When turning [Position] on and setting the pattern position

a) See page 59.

• When turning [Multi] on and replicating the pattern

a) See page 62.

• When turning [Aspect] on and setting the aspect ratio of the pattern

Knob Parameter Adjustment Setting values

1 Size Size of pattern 0.00 to 100.00

2 Soft Edge softness of pattern 0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Clip Reference level for key 
signal generation

+109.59 to –7.31

2 Gain Key sensitivity –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Mix Rate Mix proportion 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –100.00 to +100.00 a)

2 Position V Vertical position –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of 
pattern horizontally

1 to 63

2 V Multi Number of repetitions of 
pattern vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)
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a) See page 61.

• When turning [Rotation Angle] on and inclining the pattern

a) See page 60.

To select the pattern, display the Pattern Select menu by pressing [Pattern 
Select] in the Pattern Adjust menu. You can change the pattern selected in 
step 2 here. After selecting one of the patterns (standard wipe patterns 1 to 
24) displayed in the Pattern Select menu, you can adjust the following 
parameters.

4 When you selected a pattern key or external key, if required press [Key 
Invert] in the Still >Composite menu to invert the key.

Image Output

There are two functions related to image output: the reposition function for 
moving the output image, and the lock function for fixing the output image.

For an overview of the image output, see page 81.

Moving the output image (reposition function)
Use the following procedure.

1 In the Frame Memory menu, select VF3 ‘Reposition/Lock’ and HF1 
‘Reposition.’

The Reposition menu appears. In this menu, you can also enable the V/K 
mode (see page 454).

2 In the frame memory selection area, select the FM output. (See page 453.)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00
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3 In the <Reposition> group, select the movement mode (see page 81).

Normal: Move in normal mode.
Black&White: Move in black & white mode.

4 With the knobs, adjust the parameters to move the image.

a) See page 59.

The surroundings of the moved image on the screen are filled with black.

5 To return the image moved by the reposition function to the center 
position, in the <Reposition> group press [Center].

Note
It is not possible to write the image moved by the reposition function 
directly to frame memory.

Fixing the output image selection (lock function)
Use the following procedure.

1 In the Frame Memory menu, select VF3 ‘Reposition/Lock’ and HF2 
‘Lock.’

The Lock menu appears.

2 In the frame memory selection area, select the FM output. (See page 453.)

3 Press [Lock], turning it on.

This fixes the currently selected frame memory output image.
To release the lock, set [Lock] to off.

Continuously Capturing Still Images (Record)

Continuously freezing input images and writing to memory
Use the following procedure.

Knob Parameter Adjustment Setting values

1 Position H Move in horizontal direction –200.00 to +200.00 a)

2 Position V Move in vertical direction –200.00 to +200.00 a)
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1 In the Frame Memory menu, select VF1 ‘Still’ and HF4 ‘Animation 

Record.’

The Animation Record menu appears.

2 Select the desired frame memory.

For details of the operating procedures, see “Selecting outputs (FM) and 
target frame memory” (page 453).

3 To use V/K mode, press [V/K Mode], turning it on.

4 Press [Record Enable], turning it on.

The signals of frame memory source buses 1 and 2 are assigned to the pair 
of FMs selected in step 2, the recording function is now possible.

5 Input the file name if required.

Pressing [File Name] displays the keyboard window and you can enter the 
first character string (up to four characters) of the file name.

6 Set the recording time if required.

Pressing [Duration] displays the numeric keypad window, in which you 
can enter the recording time in the form of timecode.
If you set the recording time to zero, this uses all frame memory in which 
storing is possible for recording.

7 If required, set video processing for the selected signal.

For details of the operating procedures, see “Setting video processing” 
(page 456).

8 Press [Record], to start recording.

When the recording time is set, recording stops once the time has elapsed.

9 Press [Stop] to stop recording.

Even if the recording time is set, you can still stop recording before the set 
time has elapsed.
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Recalling a Continuous Sequence of still Images 
(Animation)

To recall a continuous sequence of still images, create an effect in the user 
region with the still image files as a keyframe, and run the created effect.

Note
With the 720p format, you can continuously recall images using the frame 
memory in units of two frames only.

Creating an effect with still image files as a keyframe
Use the following procedure.

1 In the Frame Memory menu, select VF1 ‘Still’ and HF5 ‘Create Key 
Frame.’

The Create Key Frame menu appears.
• A thumbnail appears for each group of files having the same characters, 

except for the last three characters, in the file name.
• When [Pair] is on, only pair files (each pair comprising a main file and 

a sub file) appear.
• When [Pair] is off, both single files and pair files all appear.

2 In the frame memory selection area, select the frame memory to be 
assigned.

This creates the effect in the user region to which the selected frame 
memory is assigned.

For details of the operating procedures, see “Selecting outputs (FM) and 
target frame memory” (page 453).

3 Turn the knob to select the register number in the user region.

Note
To search for an empty register in the user region, use the numeric keypad 
control block (see step 3 in “Recalling a Register” in Chapter 13 
(Volume 2)).

4 Use the arrow keys or turn the knobs to scroll the thumbnail display of the 
files.

Knob Parameter Adjustment Setting values

5 Register Effect register number 1 to 99
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5 Select the thumbnail of the files to be used for the keyframe.

6 If necessary, turn the knob to check the animation effect in the thumbnail 
display.

7 Using the region selection buttons in the numeric keypad control block, 
select one of the regions (USER1 to USER8) to which the frame memory 
output signals have been assigned.

8 Carry out either of the following.

• To clear the effect register selected in step 3, and create a new effect: 
press [Create Key Frame].

• To add to the end of the effect register selected in step 3: press [Append 
Key Frame].

A confirmation message for creating the effect appears.
If there is an inappropriate condition for creating the effect, an error 
message appears.

For details of error messages, see “Error Messages” in the Appendix 
(Volume 2).

9 Press [OK].

This creates the effect in the selected user region register.

To cancel creating the effect
Press [Cancel].

Notes
• The effect is built with the selected files, in increasing order of the last three 

characters of the file name. If you do not want to include some of these files 
in the effect, first delete or rename them.

• A maximum of 99 keyframes can be included in a single effect.

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail display 
scrolling

1 and upwards

Knob Parameter Adjustment Setting values

3 Viewer Animate thumbnail display 
of files

00:00:00 and upwards
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Recalling a sequence of still images
Run the effect created by the foregoing procedure.
The procedure for doing this is the same as for any other effect.

For details, see “Executing Effects” in Chapter 13 (Volume 2).
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Frame Memory Clip Operations

For an overview of frame memory clip concepts, see “Frame Memory Clip 
Function” (page 83).

Note
During playback of a frame memory clip of the pair assigned to either of the 
target FM selection buttons (see page 471), frame memory operations may not 
be performed properly. Carry out frame memory operations after stopping clip 
playback.

Preparations for operation

The preparations for using a frame memory clip (hereafter, a “clip”) are the 
same as for a still image operation. See “Preparations” (page 448) and 
“Selecting Outputs and Target Frame Memory” (page 453).

Recalling Clips

Recalling a clip
You can recall a clip from each of frame memories 1 to 8.
Use the following procedure.

1 In the Frame Memory menu, select VF2 ‘Clip’ and HF1 ‘Recall.’

The Recall menu appears. (See following figure)
• When [Pair] is set to On, only pair files (sets of main file and sub file) 

are shown.
• When [Pair] is set to Off, both of single files and pair files are shown.
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2 In the frame memory selection area, select an assigned target FM. (See 
page 453)

3 Using the arrow keys or turning the knob, scroll the file thumbnail display.

4 Press the thumbnail of the clip you want to recall.

5 Press [Recall].

This recalls the clip file, which is assigned to the FM you selected in step 2.
In pair mode, if a clip is selected, the main file is output to FM1, and the 
sub file to FM2. In single mode, when only one of FM1 and FM2 is 
selected, the front file on the thumbnail is output.

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail display 
scrolling

1 and upwards

Target selection buttons

Pair selection buttons

Clip file selection area

Frame memory 
selection area
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Clip Playback

You can play a recalled clip by a menu operation.

Playing a clip using the menu
Use the following procedure.

1 In the Frame Memory menu, select VF2 ‘Clip’ and HF2 ‘Play.’

The Play menu appears. The status of the clip shown in the current target 
FM selection buttons appears here.

2 When [Pair] is Off, press a target FM selection button to select the target.

3 To set loop playback, press [Loop], turning it on.

4 To start playback, press [Play]. During playback, to stop, press [Stop].

Playback start point 
(pale blue bar)

Current position 
(red bar)

Playback end point 
(yellow bar)

Status buttons
These show the timecode values for 
the start point, current position, and 
end point.
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To cue up
Press [Cue Up].

To play the image at the beginning of the clip (Clip Begin)
Press [Rewind].

To play the image at the end of the clip (Clip End)
Press  [FF].

Clip Output

As for still image operation, you can use the reposition and lock functions.

For details of the operation, see “Image Output” (page 463).
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Image Data Management

You can carry out the following operations on the files in which images are 
saved.
• Pair file processing
• Delete
• Rename
• Backup
• Restore

For an overview of file management, see page 83.

Pair file processing

You can create a pair file from two single files. In the reverse direction, you 
can split a pair file into two single files.

Creating a pair file from two single files

Note
Carrying out the following operation automatically switches [Pair] to On.

The following description applies to the case of FM1&2, but the procedures are 
similar for the other cases.

1 In the Frame Memory >Still >Recall menu or Frame Memory >Clip 
>Recall menu, recall the two single files you want to convert to a pair file, 
to FM1 and FM2.

2 In the Frame Memory menu, select VF4 ‘File’ and HF1 ‘Pair 
Recombination.’

The Pair Recombination menu appears.

3 Press [Couple].

This converts the files output to FM1 and FM2 to a pair.
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Splitting a pair file into two single files

Note
Carrying out the following operation automatically switches [Pair] to Off.

The following description applies to the case of FM1and FM2, but the 
procedures are similar for the other cases.

1 In the Frame Memory >Still >Recall menu or Frame Memory >Clip 
>Recall menu, recall the pair file.

2 In the Frame Memory menu, select VF4 ‘File’and HF1 ‘Pair 
Recombination.’

The Pair Recombination menu appears.

3 Press [Separate].

The FM1 and FM2 pair file is split into separate single files.

Deleting Files

Deleting files
Use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF5 ‘Delete.’

The Delete menu appears. In the status area, whether pair mode is on or 
off, all of the saved files appear as thumbnails.

2 Using either of the following methods, select the file to be deleted. If 
necessary, press the arrow keys to scroll the display.

• Press directly on the thumbnail in the status area.
• Turn the knobs.

• To delete all files, press [Select All], turning it on.
• When a clip thumbnail is selected, the still image files making up the clip 

are also selected for deletion.

Knob Parameter Adjustment Setting values

1 No File selection 1 and upwards

2 Num Selection of number of files in 
sequence

1 and upwards
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3 If necessary, turn the knob to check the contents of the frame memory clip 

through the thumbnail display.

4 Press [Delete].

A message for confirming the deletion appears.

5 To confirm the deletion press [Yes], and to cancel press [No].

Renaming Files

Renaming a file
Use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF6 ‘Rename’

The Rename menu appears. In the status area, whether pair mode is on or 
off, all of the saved files appear as thumbnails.

2 Using either of the following methods, select the file to be renamed. If 
necessary, press the arrow keys to scroll the display.

• Press directly on the thumbnail in the status area.
• Turn the knobs.

3 If necessary, turn the knob check the contents of the frame memory clip 
through the thumbnail display.

4 Press [Rename].

A keyboard window appears.

5 Enter the new name, then press [Enter] in the keyboard window.

This renames the file.

Knob Parameter Adjustment Setting values

3 Viewer For a movie, the current frame 
position. For a still image, no effect.

00:00:00 and 
upwards

Knob Parameter Adjustment Setting values

1 No File selection 1 and upwards

Knob Parameter Adjustment Setting values

3 Viewer For a movie, the current frame 
position. For a still image, no effect.

00:00:00 and 
upwards
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File Backups

To back up a file saved in memory to hard disk, use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF7 ‘Backup/Restore.’

The Backup/Restore menu appears.

2 Press [Backup].

This backs up the saved file.

Restoring Files

Restoring backed up files
To recall files backed up on the hard disk, use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF7 ‘Backup/Restore.’ 

The Backup/Restore menu appears.

2 Press [Restore].

This recalls the backed up file.
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External Hard Disk Drive Access

In an MVS-8000A system, you can connect a hard disk drive to the IEEE1394 
port of the switcher processor, and save and recall image data from frame 
memory.
Since image data saved in memory is lost when the system is powered off, 
using an external hard disk drive allows required data to be preserved.

Notes
• This function is only available on an MVS-8000A system.
• Only one hard disk drive can be connected to a single switcher processor.
• While the hard disk is being accessed, frame memory operations are not 

possible from other panels.

Consult your Sony service representative or sales representative about the 
hard disk drives that can be connected.

Selecting the switcher
When the system is operating in Dual Simul mode, select the switcher on which 
to carry out formatting, file saving, and file recall operations.

For details of Dual Simul mode, see “System configuration (System Config)” 
(page 175).

Use the following procedure.

1 In the Frame Memory menu, select VF6 ‘External HDD’ and HF1 
‘Format’ or HF2 ‘Backup/Restore.’

The Format menu or Backup/Restore menu appears.

2 In the region selection area (see page 299), press [SWR].

A popup window for selecting the switcher appears.

3 Press [SWR1] or [SWR2] to select the switcher.

The button for the selected switcher lights.
You can select two switchers simultaneously. In this case, the last operated 
button lights green, and the other lights amber. The menu shows the 
information for the switcher lit green.

4 Press [OK].
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Hard Disk Formatting

When you connect a hard disk drive for the first time, it is necessary to format 
the hard disk. This partitions the disk, creating five logical drives (FMHDD1 
to FMHDD5).
Use the following procedure.

1 In the Frame Memory menu, select VF6 ‘External HDD’ and HF1 
‘Format.’

The Format menu appears.
If in Dual Simul mode, select the switcher to operate (see page 477).

To get the hard disk drive information
In the button area press [Refresh Status].
The Model Name item shows the product information for the hard disk 
drive.

2 Press [Format].

A popup window for confirming formatting appears.

Note
Carrying out formatting erases any existing data on the hard disk.

3 Press [Yes].

This starts the hard disk formatting. A progress bar and numerical 
indication appear to show the progress of the operation.
When the operation is completed, a popup window reading “Success!!” 
appears.

4 Press [OK].

Saving Files

You can save all of the files from frame memory to the external hard disk drive.
Use the following procedure.

Note
Before carrying out this operation for the first time, it is necessary to format the 
hard disk (see previous item, “Hard Disk Formatting”).
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1  In the Frame Memory menu, select VF6 ‘External HDD’ and HF2 

‘Backup/Restore.’

The Backup/Restore menu appears.
If in Dual Simul mode, select the switcher to operate (see page 477).

To get the hard disk drive information
Press [Refresh Status].
The Model Name item shows the product information for the hard disk 
drive, and the names of directories within the logical drives.

2 Using any of the following methods, select a logical drive (FMHDD1 to 
FMHDD5).

• Press directly on the list to select.
• Press a button in the <Partition> group.
• Turn the knob.

3 Press [Backup].

A popup window for confirming file saving appears.

Note
When you save the files, all of the saved files in the logical drive is erased 
immediately before the saving operations.

4 Press [Yes].

This starts the file saving operation. If there is no directory in the logical 
drive, a directory is automatically created, and the files are saved within it. 
A progress bar and numerical indication appear to show the progress of the 
operation.
When the operation is completed, a popup window reading “Completed.” 
appears.

5 Press [OK].

To rename a directory
Select a directory in the list, and in the button area press [Rename].
In the keyboard window that appears, enter the new directory name, and press 
[Enter]. The name of a directory is limited to eight characters.

Knob Parameter Adjustment Setting values

1 Partition Logical drive selection 1 to 5
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Recalling Files

You can recall all of the saved files on the hard disk drive into frame memory.
Use the following procedure.

1 Carry out steps 1 and 2 of the procedure “Saving Files” (page 478).

Note
It is not possible to select a directory (logical drive) on which files are not 
saved.

2 Press [Restore].

A popup window for confirming file recall appears.

Note
When you recall the files, any existing data in frame memory is lost 
immediately before the recalling operations.

3 Press [Yes].

This starts the file recall operation. A progress bar and numerical 
indication appear to show the progress of the operation.
When the operation is completed, a popup window reading “Completed.” 
appears.

4 Press [OK].
External Hard Disk Drive Access
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Color Background Setting Operations

You carry out color background settings in the Color Bkgd menu. This section 
describes the settings menu for color background 1 as an example.

For an overview of the color background, see page 86.

Color Background Settings Menu

Accessing the Color Bkgd1 menu
Use either of the following operations.
• In the menu control block, select the top menu selection button [COLOR 

BKGD], and press VF1 ‘Color Bkgd1.’
• Press a cross-point button assigned to color background 1 twice in rapid 

succession.
The above operation displays the Color Bkgd1 menu.

Basic Color Background Setting Operations

Making a single-color matte (Flat Color)
If you are not using the “color mix” function to combine two colors, use the 
following procedure.

1 In the <Matte> group of the Color Bkgd 1 menu, press [Flat Color], turning 
it on.

You can now adjust color 1.

2 Set the following parameters.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Making a color combination (color mix)

To combine color 1 and color 2, use the following procedure.

1 In the <Matte> group of the Color Bkgd1 menu, press [Mix Color], turning 
it on.

2 Set the following parameters as required.

a) The patterns are the same as for a standard wipe. See the appendix “Wipe Pattern List” 
(Volume 2).

You can also carry out the pattern selection by pressing the [Mix Ptn 
Select] button, to display the Mix Ptn Select menu. Select any pattern 
appearing in the Mix Ptn Select menu (standard wipe patterns 1 to 24), and 
you can then adjust the following parameters.

3 To adjust color 1, set [Color 1] on, and to adjust color 2 set [Color 2] on, 
then adjust the parameters.

4 If required, set the pattern modifiers.

• When turning [Position] on and setting the pattern position

a) See page 59.

• When turning [Multi] on and using replications of the same pattern 

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of softening of edge 0.00 to 100.00

5 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)
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a) See page 62.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 61.

• When turning [Pairing] on and making a wipe pattern like a 
Venetian blind

• When turning [Angle] on in the <Rotation> group and slanting the 
pattern

a) See page 60.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a constant rate

a) See page 60.

• When selecting H (horizontal) or V (vertical) in the <Modulation> 
group and applying waviness to the pattern
(The modulation is always a sine wave.)

Note
When using 1080PsF mode in an HD system, the modulation function is 
not available.

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Width Width of the slits 1 to 128 (integer)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)
Color Background Setting Operations



  C
hapter 8 

C
olor B

ackgrounds
a) See page 64.

5 To interchange color 1 and color 2, press the [Color Invert] button, turning 
it on.

Knob Parameter Adjustment Setting values

1 Amplitude Amplitude of modulation 0.00 to 100.00

2 Frequency Frequency of modulation 0.00 to 100.00

3 Speed Speed of waves –100.00 to +100.00 a)
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Basic Copy and Swap Operations

Copy and Swap Menu Operations

There are two ways of carrying out a copy operation: by using the menus or by 
a simple button operation. Swap operations, and operations on DME data can 
only be done with a menu operation.

Accessing the Copy/Swap menu
In the menu operation section top menu selection buttons, press the [Copy/
Swap] button. The Copy/Swap menu appears.
Here a copy/swap operation on wipe data is described by way of example, 
using the Copy/Swap >Wipe menu, but the same general procedure applies to 
all of the following menus.
• M/E: Copying and swapping M/E data
• Key: Copying and swapping key data
• Wipe: Copying and swapping wipe data
• DME Wipe: Copying and swapping DME wipe data
• Matte: Copying and swapping matte data
• Color: Copying and swapping color data
• DME: Copying and swapping data by DME channels

For an overview of the concepts involved, see “Copy and Swap” (page 87). 
For details of color corrector copy and swap, see Chapter 19 “Color 
Corrector” (Volume 2).

Copying and swapping wipe data
As an example, to copy or swap wipe data, use the following procedure.

1 In the Copy/Swap menu, select HF3 ‘Wipe.’

The Copy/Swap >Wipe menu appears.
The status area shows lists for the copy/swap source on the left, and the 
copy/swap destination on the right.

2 In the <Data Select> group, select either of the following.

Wipe: The operation applies to wipes in the transition control block.
Key Wipe: The operation applies to wipes in the independent key 

transition control block.
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3 Using any of the following methods, select the data to be copied or 
swapped.

• Press directly on the list appearing in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs to make the setting.

a) Transition control block wipe data
b) Independent key transition control block wipe data

For details of the data affected, see “Copy and Swap” (page 87).

4 To copy, press [Copy], and to swap, press [Swap].

This carries out the copy or swap.

To undo a copy or swap 
Press [Undo], to return to the state before the copy or swap was carried out.

Copy by Button Operation

You can carry out the following copy operations by a simple button operation.
• M/E copy
• Keyer copy
• Wipe copy
• DME wipe copy

For an overview of the copy function, see “Copy and Swap” (page 87).

Basic button operation
The basic button operation is to hold down the copy source button, then press 
the destination button.
You can undo the last operation using [Undo] in the menu (see page 489).

M/E copy button operation
In the Flexi Pad control block of each M/E bank, use the [SNAPSHOT] button.

Knob Parameter Adjustment Setting values

1 Left No Select data for copy/swap 
source

1 to 4 a)

1 to 16 b)

2 Right No Select data for copy/swap 
destination

1 to 4 a)

1 to 16 b)
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To copy from M/E-1 to M/E-2
In the M/E-1 Flexi Pad control block, hold down the [SNAPSHOT] button, 
then press the [SNAPSHOT] button in the M/E-2 Flexi Pad control block.

Keyer copy button operation
To specify the copy source, use the key delegation buttons in the key control 
block, and to specify the copy destination, use the key delegation buttons in the 
independent key transition control block.

To copy from M/E-1 key 1 to M/E-2 key 2
In the key control block M/E delegation buttons, press [M/E1], turning it on, 
then hold down the [KEY1] button, and in the M/E-2 independent key 
transition control block, press the [KEY2] button.

Wipe copy button operation
Use the [WIPE] button in the Flexi Pad control block of each M/E bank.

To copy the M/E-1 wipe to the M/E-2 wipe
In the M/E-1 Flexi Pad control block, hold down the [WIPE] button, then press 
the [WIPE] button in the M/E-2 Flexi Pad control block.

DME wipe copy button operation
Use the [DME] button in the Flexi Pad control block of each M/E bank.

To copy the M/E-1 DME wipe to the M/E-2 DME wipe
In the M/E-1 Flexi Pad control block, hold down the [DME] button, then press 
the [DME] button in the M/E-2 Flexi Pad control block.
Basic Copy and Swap Operations
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Misc Menu Operations

In the Misc menu, you can carry out the following operations.
• Enabling and disabling operation from an external device, System Manager, 

or an editing keyboard.
• Enabling and disabling side flags on the background bus of each of the M/E-

1 to M/E-3 and PGM/PST banks.
• Switching the safe title function on or off for each switcher output.
• Displaying the transition rate, independent key transition rate, and fade-to-

black transition rate for each of the M/E and PGM/PST banks, and changing 
the settings.

Port Settings for Control From an External Device

Enabling or disabling control from an external device
Use the following procedure.

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears with the status area 
showing the settings of the following ports.
• Switcher Remote 1 to Remote 4 ports (RS-422A, D-sub 9-pin)
• Switcher GPI port (parallel, 25-pin) 
• DME1/DME2 Editor ports (RS-422A, D-sub 9-pin)
• DME1/DME2 GPI ports (parallel, 25-pin)

2 In the <Switcher> or <DME> group, press on the name of the port for 
which you want to disable control from an external device, turning it off. 
To re-enable control for the port, press on its name once more.

Note
For the AUX bus operation from the Remote1 to Remote4 ports of the 
switcher, the setting (Enable/Disable/Manual) in the Setup menu takes 
precedence. Only when the setting is “Manual,” the settings made in the 
Port Enable menu apply.

For details, see “Interfacing With External Devices (Device Interface 
Menu)” under “Setup Relating to Switcher Processor” in Chapter 16 
(Volume 2).
Misc Menu Operations



  C
hapter 10 

M
isc M

enu, E
tc.
DME override
Use the following procedure.

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears.

2 In the <DME Override> group, select the DME override mode.

DME Override: When a switcher snapshot or effect using a DME is 
recalled, forcibly select the DME that was used when saving.

On Air Protect: The operation is the same as the DME override function, 
except that a DME being used by an M/E bank or P/P bank that is on 
air will not be forcibly selected.

Note
If effects using the same DME channel are selected simultaneously in two 
or more regions, the DME is selected with the order of precedence P/P >M/
E1 >M/E2 >M/E3.

Enabling or disabling control from System Manager
By installing the BZPS-8000 System Management Software (System 
Manager), you can use a computer connected on a network for management of 
some switcher data and control operations.
To enable or disable this function, use the following procedure.

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears.

2 Press [System Manager].

Each time you press the button toggles between enable and disable.

Editing Keyboard Settings

Note 
The following operations are only possible when a license for the BZS-8050 
Editing Control Software is activated. For details of license registration, see 
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“Installation and Device Setup (Install/Unit Config Menu)” in Chapter 16 
(Volume 2).

Enabling or disabling control from the editing keyboard
Use the following procedure.

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF2 ‘Plug-In Editor.’

The Misc >Enable >Plug-In Editor menu appears.

2 In the <Control From Plug-In Editor> group, press [Editor Enable].

Each time you press the button toggles between enable and disable.

To enable control of the preview bus only
When control from the editing keyboard is disabled (when [Editor Enable] is 
set to Disable), to enable control of the preview bus only, press [PVW Bus 
Enable] in the <Control From Plug-In Editor> group.

Side Flag Settings

Note 
The side flag function is only supported on an MVS-8000A system.

The term “side flags” refers to the areas to left and right of an image with aspect 
ratio 4:3 embedded within a 16:9 frame, when these areas are filled with a 
selected image from the utility 1 bus.

For details of the side flag function, see “Side Flags” on page 91.

Enabling and disabling side flags with a menu operation
You can enable or disable side flags for the backgrounds (A and B) of each of 
the M/E and PGM/PST banks. 
As an example, to enable side flags for background B row on the M/E-1 bank, 
use the following procedure.

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF3 ‘Side Flags.’

The Misc >Enable >Side Flags menu appears.
The status area shows the buttons for Bkgd A and Bkgd B for each of the 
M/E-1 to M/E-3, and PGM/PST (P/P) banks.
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2 In the <M/E-1 Side Flags> group, press [Bkgd B].

Each time you press the button toggles between Enable and Disable.

To display a menu for the aspect ratio 4:3, auto side flags, and auto 
crop settings
In the Misc >Enable >Side Flags menu, press [Setup >SWER >Side Flags].

To display a menu for assigning the side flags on/off function to a 
cross-point button
In the Misc >Enable >Side Flags menu, press [Side Flags Button Assign].

Enabling and disabling side flags with a button operation
For example, to enable side flags for the background B row of the M/E-1 bank, 
use the following procedure.

1 First, in the Setup menu assign the rightmost cross-point button to the 
[SIDE FLAG] button.

For details of the assignment operation, see “Cross-Point Settings (Xpt 
Assign Menu)” in Chapter 16 (Volume 2).

2 Press the [SIDE FLAG] button at the right end of the background B row of 
the M/E-1 bank.

The button you pressed lights amber, and this enables the side flags.

Notes 
• The operations of enabling or disabling the side flags by menu operation 

and by control panel button operation are linked.
• When the auto side flags are on, selecting a 4:3 video material 

automatically lights the [SIDE FLAG] button, but if you press this 
button, turning it off, the side flags are temporarily disabled.
However, when you select a different 4:3 video material, the [SIDE 
FLAG] button automatically lights once again, enabling the side flags.

Creating an image with side flags
For example, to create an image with side flags in the background B row of the 
M/E-1 bank, use the following procedure.

1 In the M/E-1 bank cross-point control block, hold down the [UTIL] button, 
and in the background A row select the signal (utility bus 1 signal) you 
want to insert in the side flag areas.
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2 In the background B row, press the cross-point button corresponding to the 
4:3 video material.

At this point, if auto side flags are on, this automatically adds side flags to 
the 4:3 video material. (See “Settings for Switcher Configuration (Config 
Menu)” in Chapter 16 (Volume 2).)

3 Use either of the following methods to turn the side flags on.

• Use the Misc >Enable >Side Flags menu. (See page 494)
• Use a cross-point button operation. (See previous item.)

This adds side flags to the 4:3 video material.

Safe Title Settings

Switching the safe title function on or off
Use the following procedure.

1 In the menu control block, press the top menu selection button [MISC] and 
select VF2 ‘Safe Title.’

The Misc >Safe Title menu appears.

2 Using any of the following methods, select the signal to which the settings 
apply.

• Directly press the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob to make the setting.

Notes
• It is not possible to change the setting for the output for which the safe 

title is set off in a Setup menu.
• The safe title function cannot be used for output signals for which 

through mode is set to Enable in a Setup menu.

For more information about the Setup menu settings referred to above, see 
“Signal Input Settings (Input Menu)” and “Signal Output Settings (Output 
Menu)” in Chpater 16 (Volume 2).

Knob Parameter Adjustment Setting values

1 Output Signal to which the settings 
apply

1 to 48
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3 Press [Safe Title] to set it on or off.

Displaying a List of Transition Rates and Changing the 
Settings

In the Transition menu, for each bank you can display a list of the M/E (or 
PGM/PST) transition rates and independent key (or DSK) transition rates, and 
change the settings.
These settings are linked to the other transition rate setting operations.
You can also display and set the fade-to-black transition rate.

Displaying the Transition menu
In the menu control block, press the top menu selection button [MISC], then 
select VF3 ‘Transition.’
The Misc >Transition menu appears.

About the Transition menu display
The display of the independent key transition rate in the Misc >Transition 
menu depends on the selection in the <Key Transition> group of the 
Engineering Setup >Switcher >Transition menu for each of the M/E and PGM/
PST banks.

When [Same] (On direction and Off direction settings the same) is selected 
in the <Key Transition> group: Only “Key” (or “DSK” in the PGM/PST 
bank) appears.

When [Independ] (On direction and Off direction settings independent) is 
selected in the <Key Transition> group: “Key(On)” and “Key(Off)” 
each appear. In the case of the PGM/PST bank, “DSK(On)” and 
“DSK(Off)” appear.

For more details, see “Settings Relating to Video Switching (Transition 
Menu)” in Chapter 16 (Volume 2).

Setting the transition rate in the Transition menu
For example, to make the settings for the M/E-1 bank, use the following 
procedure.

To set the M/E transition rate

1 In the <M/E-1 Transition Rate> group of the Misc >Transition menu, press 
[Transition].
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2 Turn the knob to set the number of frames.

To set the independent key transition rate

1 In the <M/E-1 Transition Rate> group of the Misc >Transition menu, press 
[Key]. 
To set the key On direction or Off direction independently, press Key(On) 
or Key(Off).

2 Turn the knobs to set the number of frames.

To set the fade-to-black transition rate in the Transition menu

Use the following procedure.

1 In the Misc >Transition menu, press [FTB].

2 Turn the knob to set the number of frames.

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frames)

Knob Parameter Adjustment Setting values

1 Key1 Trans Rate Key 1 transition rate 0 to 999 (frames)

2 Key2 Trans Rate Key 2 transition rate 0 to 999 (frames)

3 Key3 Trans Rate Key 3 transition rate 0 to 999 (frames)

4 Key4 Trans Rate Key 4 transition rate 0 to 999 (frames)

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frames)
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AUX Menu Operations

AUX Bus Settings

Making video process settings for an AUX bus
Make the settings as follows.

1 In the Aux/Mon >Aux Bus menu, using any of the following methods, 
select the AUX bus to which the settings apply.

• Directly press the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob to make the setting.

2 Press [Video Process], turning it on.

3 Adjust the following parameters.

To return adjustment values to their defaults
Press [Unity].

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 AUX Bus AUX bus selection 1 to 48

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain –200.00 to +200.00

2 Y Gain Luminance signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Black level –7.31 to +109.59
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Status Menu

The Status menu shows the following information.
• Operating status of the DME

Viewing the DME operating status
To view the DME operating status, press the top menu selection button 
[STATS] in the menu control block.
This selects VF1 ‘DME Status’ and the Status menu appears.

For each DME channel, you can see how the DME is being used in the 
corresponding operation block.
The display background color also indicates the following differences in the 
way in which a DME is being used.
Blue: The DME is currently being used in other than the final program output.
Red: The DME is currently being used in the final program output.

DME status display
Status Menu
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Video Process Settings

This section describes operations on the M/E-1 to M/E-3, and PGM/PST 
background A and B buses, and utility buses 1 and 2.
For these operations, use the Misc >Video Process menu in the respective 
operating bank.

For video process settings on other buses, see the following.
• Settings for a particular input signal: “Signal input settings” in Chapter 16 

(Volume 2)
• Key fill bus settings: “Video Processing” (page 377)
• Settings for frame memory source buses 1 and 2: “Setting video processing” 

(page 456)
• Settings for Aux 1 to 48 buses: “Making video process settings for an AUX 

bus” (page 499)
• Overview of video process: “Video Process” (page 96)

This section describes an example on the background A bus of the M/E-1 bank. 
For the background B bus or utility bus 1 or 2, make the adjustment with a 
similar procedure.

Making video process settings for each bus
Use the following procedure.

1 In the menu control block, press the top menu selection button [M/E1] and 
select VF7 ‘Misc’ and HF2 ‘Video Process.’

2 In the <Bkgd-A> group, press [Video Process], turning it on.

3 Adjust the following parameters.

To return the parameter settings to the defaults
Press [Unity] in the <Bkgd-A> group.

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain –200.00 to +200.00

2 Y Gain Luminance signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Black level –7.31 to +109.59
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33, 337

DME wipe settings   438
simple transitions   347
type   338
type selection buttons   

243, 281, 283
wipe modifiers   417
wipe settings   416

Independent key transition 
control block

simple type   281
standard type   337

Independent key transition 
execution section   243, 282, 
284, 289

Independent key transition rate   
339

display   341
setting by a menu 

operation   340
setting in the Flexi Pad 

control block   339
setting in the numeric 

keypad control block   
339

Input
signal settings   185, 187
string   307
value   306

Installation   179
Installation and device settings   

179
Interpolation   140
Invert   140
Item display   306, 307

J
Joystick   255

K
Kaleidoscope   125
Key   44

1/2 row   236
bus selection buttons   238
control block   246
default   53
delegation buttons   243, 

283
deleting   31
density adjustment   141
disable   171
edge modifications   363, 

383
inserting   31
mask   51
memory   52
modifier buttons   247
modifiers   48

modify clear   53, 376
output destination   376
output status display   318, 

346
settings   186
signal adjustments   358
source selection   141
status display   242, 279, 

289
Key active   46

adjustment   357
Key Border   113
KEY button   266
Key fill

selection   361
selection buttons   247

Key priority   315
display   318, 346
selecting   32
setting by a menu 

operation   317
setting in the transition 

control block   315
Key setting

using menus   352
Key snapshot   392

buttons   243, 284
recalling   393, 395
saving   392, 394
setting buttons   243, 284
using simple transition 

module   394
Key source

name display   243, 284
selection   361
selection buttons   247

Key transition
selection buttons   279

Key type
selection buttons   247
setting   353

Keyboard window   307
Keyer

copy   88
swap   88

Keyframe   156
control block   259
duration   159
Index
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effect registers   154
status   299
strobe   132

KF button   242
Knob   248, 271

parameter buttons   298
K-SS button   282

L
Left button   308
Lens   125
Level selection buttons   267
Lighting   129
Line feed button   308
Linear key   44
Local coordinate space   100
Location

size   107
XYZ   105

Lock function   464
Luminance key   44

M
M/E

bank display   239
copy   87
swap   87

Macro   196
attachment   203
creating   198
editing   198, 199, 202
events   196
execution   201
overview   196
registers   196

Magnitude   60
MAIN and SUB delegation 

button   219
Main mask   51

using   370, 387
Main/sub modifier link   57
Maintenance   179
Manual transition   41, 331
Mask (DME)   119
Masks   51, 370, 387
Master

region   154
snapshot registers   155
timeline registers   155
timelines   169

Matte data
copy   89
swap   89

Max./min. value indication   
306

Melt   128
Memory

card slot   272
initialization   179
recall buttons   275

Memory card/USB adaptor 
block   272

“Memory Stick”/USB 
connections block   273

“Memory Sticks”   273
Menu

accessing   290, 297
control block   271
display   271
operations   299
organization   290
page number button   298
screen   298
shutting down   309
title button   298

MENU button   254
Metal   118
Minus button   306
Mirror   124
Misc menu operations   492
MIX   81, 241, 243, 288
Mix   37, 55
Mode selection buttons   244, 

262, 280
Modulation   63, 413
Mono   116
MORE button   248
Morphing   55
Mosaic   117

glass   121
Motion decay   131
Multi   61, 411, 420

mirror   124
move   116

Multi Program 2   214
basic operation   216
restriction   227

MVE-8000A   98
MVE-9000   98

N
NAM   38, 81, 241, 288
Nega   117
Negative NAM   55
Network configuration   175
Next transition   30

selecting   30
selection buttons   241, 287

Non-additive mix   38, 241, 
288

Nonlinear effects   120
Non-Sync state   332
Normal

edge   386
mix   45

Numeric display   245, 280
Numeric keypad   263

control block   262
window   306

O
ON AIR indicators   249
One-stroke mode   38
One-time mode   38
Operation

buttons   251
modes   79
settings   183

Outline   50
parameters   385

Output
destination specification 

buttons   249
signal settings   185

OVERRIDE button   249

P
Page turn   126
Pair file processing   83, 473
Pair mode   79
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Pairing   62, 412
Panel setup   181
Panorama   126
Parameter group button   298
Paths   162

DME   164
switcher   162
types   167

Pattern key   81
Pattern limit   42, 327

buttons   242, 279
setting by a menu 

operation   328
setting with the fader lever   

328
transition   329

Pattern mix   54, 401
types   55

Pattern replication   61
P-BUS devices

control   148
P-Bus devices   147
Perspective   108
Plane function   46
Positioner   59, 409, 417, 431, 

439
Positive NAM   55
Posterization   117
Preset color mix   38
Preview   42, 335

selection buttons   264
Previous page button   299
PRIOR SET button   242, 289
PST COLOR MIX   241, 288

R
Reentry buttons   24, 237
Reference region   154
Regions   153

selection buttons   263
Registers   154
Related manuals   18
Replication   420
Resume mode   178
Right button   308
Rings   122
Ripple   122

Roll   126
Rotation   59, 106, 410, 419
Router interface setup   188
RTR button   267

S
Screen saver   184
Search dial   256
Second (2ND) button   267
Selected

bus display   266
source name displays   266

SEMI LINK   57
Separate sides   139
Sepia   116
Setup   175

DCU input/output   188
overview   175
panel   181
router interface   188
switcher   184
system   175

Setup data saving/recalling   
180

Shadow   49, 146
parameters   384

Shaped Video   139
SHIFT button   239
Shift button   308
Shotbox   174
SHOW KEY button   248
Show key function   391
Side flags

DME wipe action   93
MISC menu   494
overview   91
settings   91
wipe action   92

Signal
assignment to buttons   27
name display   29
selection   23

Simple
transition   344

Simple P/P Software   211
Sketch   118
Skew   109

Snapshot   170
attributes   171
registers   155

Soft edge   50, 417
Softening

edge   386
wipe pattern edge   417

Solarization   117
Source

coordinate space   99
name displays   267

Space button   308
Speed   60
Sphere   127
Spin   106
Spiral   65, 414
Split   58, 124, 404

fader   346
slide   124

Spotlighting   132
Spring   64, 413
Standard wipe patterns   54
Start up state   178
Status area   298
Status menu   500
STOP NEXT KF button   261
Sub (subsidiary) mask   51, 52

using   372, 387
SUPER MIX   241, 288
Super mix   38

settings   321
Swap   87, 488
Swirl   128
Switcher setup   184
System

configuration   175
features   20
reset   179
setup   175

T
Tally interface setup   188
Target coordinate space   99
TC button   306
Temporary attributes   157, 

172
Three-dimensional
Index
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coordinate space   99
parameter display   111
parameters   101
transformations   99

Time offset execution   35
Timecode input mode   324
Top menu selection buttons   

271
Top menu window   308
TRACE button   249
Trail   131
TRANS PVW button   242, 

289
Transformation operation 

modes   105
Transition

auto   40
execution   40, 323
indicator   284
manual   41
mode   159
next   30
operating procedure   312
preview   42, 335

Transition control block
simple type   276
standard type   240

Transition execution
section   241, 279, 288
with the fader lever   331

Transition indicator   241, 288
function   323

Transition rate   324
display   241, 288
setting by a menu 

operation   327
setting in the Flexi Pad 

control block   325
setting in the MISC menu   

497
setting in the numeric 

keypad control block   
326

Transition type   37
selecting by a menu 

operation   320
selection buttons   241, 

278, 288

Trim button   306
Twist   122

U
UNDO button   245, 280
User preference button   271
User programmable DME

Notes on keyframe 
creation   443

patterns   442
transition mode   70, 442

USER regions   153
User texture pattern   138
UTIL button   238
Utility   173
Utility/shotbox control block   

275

V
V/K mode   79
VF buttons   298
Video

processing   22, 377
signal adjustment   47
switching   186

Video process   96
memory   97
settings   501

VTR control   150

W
Wave   120
Wind   132
Window adjustment   47, 359
WIPE   241, 243, 288
Wipe   40, 54

copy   88
enhanced   54
modify clear   415
mosaic   54
random/diamond dust   54
rotary   54
standard   54
swap   88

Wipe crop   115
Wipe direction   404, 417

selection buttons   242, 
279, 288

Wipe modifiers   403
Wipe Modify Clear   65
Wipe pattern

aspect ratio   411, 420
edge modification   405
key   48
modifiers   57
modulation   413
replication   411, 420
rotation   410
selection   398
types   54
variation   57

Wipe pattern/modifier 
combinations   414

Wipe position   409, 417
Wipe settings   186, 398

for independent key 
transitions   416

Wipe snapshot   65, 421
deleting   424
recalling   423
saving   422

Wire frames   109

X
XPT HOLD

buttons   238, 266
status display   280

Y
Y balance   47

adjustment   359

Z
Zabton   50, 369, 386
Z-ring   253
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